1 Working collaboratively within a Tekla Structures model...... 9
1.1 Tekla Model Sharing........................................................................................10
   Prerequisites for Tekla Model Sharing........................................................................ 11
   Tekla Model Sharing licenses................................................................................... 11
   Tekla Model Sharing sharing service........................................................................ 12
   Tekla Model Sharing Cache service.......................................................................... 13
   Work with Tekla Model Sharing................................................................................. 14
      How does Tekla Model Sharing work?.................................................................. 14
      Who can use the shared model?............................................................................ 16
      Share a model in Tekla Model Sharing................................................................. 17
      Join a shared model in Tekla Model Sharing......................................................... 19
      Update the model with other users' changes in Tekla Model Sharing (read in).... 23
      Share your model changes in Tekla Model Sharing (write out)................................. 24
      Detect sharing changes and view the sharing history in Tekla Model Sharing........ 27
      Create a baseline for a model in Tekla Model Sharing............................................. 32
      Exclude a model from the sharing service in Tekla Model Sharing....................... 33
      Manage users in Tekla Model Sharing.................................................................... 34
      Tekla Model Sharing settings.................................................................................. 40
      Set privileges, object locks, and drawing locks in Tekla Model Sharing.................. 43
      Collect model history in Tekla Model Sharing........................................................ 46
      Convert a shared model to a multi-user model in Tekla Model Sharing............... 48
   What is shared in Tekla Model Sharing..................................................................... 49
      How data is shared.................................................................................................... 50
      How different object types work in shared models............................................... 54
      Exclude files and folders from Tekla Model Sharing................................................. 57
      Use a Trimble Connect project as the project or firm folder.................................... 58
      How to share catalog updates................................................................................ 58
      How to share Organizer data.................................................................................. 59
      How property files in the XS_FIRM and the XS_PROJECT folders are shared............ 59
   Best practices in Tekla Model Sharing....................................................................... 60
      Use GUIDs correctly in shared models.................................................................... 61
      Save local versions of shared models on your computer........................................ 61
      Create baselines regularly...................................................................................... 61
      Back up shared models......................................................................................... 61
      Number model objects in Tekla Model Sharing...................................................... 62
      Reference model handling in Tekla Model Sharing................................................ 62
   React to Tekla Model Sharing error messages............................................................ 63
      Licensing, sign-in, and opening errors.................................................................... 63
      File removal errors................................................................................................. 66
      Role and permission errors.................................................................................... 67
      Sharing and connection errors............................................................................... 67
      Read-in and write out errors.................................................................................. 73
   Repair Tekla Model Sharing issues............................................................................ 75
      Restore shared models........................................................................................... 76
      Rejoin the model if the model is not saved after write out...................................... 77
      Start a new Tekla Model Sharing session after a timeout........................................ 78
1.2 Multi-user mode ................................................................. 78
Multi-user system............................................................................. 80
Tekla Structures multi-user server as a service........................................ 80
Install Tekla Structures multi-user server as a service................................. 80
Restart the multi-user server service...................................................... 81
Install a new instance of the multi-user server service............................... 82
Uninstall an instance of the multi-user server service................................. 83
Change the server of a multi-user model................................................. 84
Convert a multi-user model to a single-user model.................................... 84
Convert a single-user model to a multi-user model.................................... 85
How multi-user works........................................................................... 86
Locks for models in multi-user model.................................................... 87
Saving in multi-user mode ...................................................................... 87
Autosaving in multi-user mode ............................................................... 88
Model history in multi-user mode............................................................ 89
Shutting down the model in multi-user mode ........................................... 90
Copy multi-user models......................................................................... 90
Display active multi-users...................................................................... 91
Error messages in multi-user mode......................................................... 91
Remove inconsistencies from a multi-user database................................. 92
Modeling in multi-user mode.................................................................. 93
Numbering setup in multi-user mode....................................................... 97
Synchronize numbering with the master model......................................... 98
Drawings in multi-user mode.................................................................. 98
Guidelines for multi-user drawings......................................................... 99
Locks for drawings in multi-user mode.................................................... 100
Delete unnecessary drawing files in multi-user mode............................... 100
Access rights in multi-user mode......................................................... 102
Change access rights in the privileges.inp file......................................... 102
Options in the privileges.inp file............................................................ 104
User-defined attribute Locked................................................................. 105
Control access to lock and unlock objects in a multi-user model............... 106
Control access to numbering in a multi-user model................................... 106
Control access to save standard files in a multi-user model....................... 107
Control access to remove users from a multi-user model........................ 107
1.3 Trimble Connect ...................................................................... 107
Link a Tekla Structures model to a Trimble Connect project.................... 108
Launch Trimble Connect from Tekla Structures...................................... 109
Upload a Tekla Structures model to a Trimble Connect project................ 110
Work with BCF Topics in Tekla Structures........................................... 113
Create and modify BCF topics............................................................... 114
Create measurements and markups....................................................... 119
Add views............................................................................................ 122
Add comments...................................................................................... 122
Add markers......................................................................................... 123
Link model objects............................................................................... 123
Export BCF topics............................................................................... 124
Change the language of the BCF Topics side pane.................................. 124
Trimble Connector.............................................................................. 124
Manage reference models in a Trimble Connector................................. 126
Manage overlay models in Trimble Connector........................................ 126
Should I use reference models or overlay models in Trimble Connector?..... 130
Manage overlay model versions in Trimble Connector............................... 134
Match views and selections between Tekla Structures and Trimble Connect
for Windows................................................................. 140
Match the camera position, zoom level, and projection of model views........... 140
Select the same objects.................................................................. 140

2 Get started with import and export formats ......................... 142
2.1 Industry standards........................................................... 142
2.2 Tekla Structures data exchange formats.......................... 143
Compatible file formats................................................................ 143
Simplified Trimble to Trimble data exchange.................................. 148
Compatible software with direct links.......................................... 150
Compatible software (file-based workflows)............................... 153

3 Import to and export from Tekla Structures....................... 162
3.1 Reference models and compatible formats....................... 163
Insert a reference model.......................................................... 165
View reference models.............................................................. 168
Modify reference model details.................................................. 173
Lock reference models............................................................... 174
Detect changes between reference model versions.................... 175
Define a comparison set for reference model change detection........... 181
  Create a new comparison set.................................................. 181
  Properties in comparison set................................................... 183
  Define property comparison tolerances................................... 185
Export reference model change detection results to Excel.............. 185
Inquire reference model contents.............................................. 188
Reference model objects........................................................... 189
Examine reference model hierarchy.......................................... 190
Reference model assemblies...................................................... 192
3.2 IFC.................................................................................. 192
IFC interoperability concepts.................................................... 193
Insert IFC models as reference models....................................... 195
Convert IFC objects into native Tekla Structures objects.............. 196
  Check and change the IFC object conversion settings.............. 197
Convert selected IFC objects at one go.................................... 200
Convert IFC objects using conversion change management - first conversion 202
  Convert IFC objects using conversion change management - update conversion ...
  Macro for selecting converted IFC objects.............................. 205
  Class values........................................................................ 205
Example: Convert IFC objects into Tekla Structures objects at one go 207
  Profile conversion logic in IFC object conversion.................... 210
  Limitations in IFC object conversion.................................... 211
IFC export........................................................................... 211
  Modify property sets for IFC export..................................... 212
Export in IFC format............................................................... 218
  Check the exported IFC model.............................................. 233
3.3 DWG and DXF................................................................. 233
Import 2D or 3D DWG or DXF files......................................... 234
Export in 3D DWG or DXF format............................................. 235
  Export 3D DWG files........................................................... 235
  Export 3D DWG or DXF files (old export).............................. 237
3.4 Export a drawing in 2D DWG, DXF, or DGN format.......... 239
Define export settings and export DWG, DXF, or DGN files.................................239

DWG layer rule example.........................................................................................248

Tips..........................................................................................................................249

To use old DWG or DXF drawing export.................................................................250

Export a drawing in 2D DWG or DXF format.........................................................250

Create layers in DWG/DXF files for export.........................................................252

Assign objects to layers in export.........................................................................252

Example: Create a rule for exporting beam marks to their own layer in drawing

export......................................................................................................................254

Copying export layer settings to another project ..................................................255

Define customized line type mappings in drawing export......................................255

Default line types in drawings................................................................................258

Example: Set up layers and export in DWG format (old export).............................258

3.5 DGN.....................................................................................................................265

Insert DGN files......................................................................................................265

Export in 3D DGN format.........................................................................................268

Export in 3D DGN v8 format....................................................................................268

Export in 3D DGN v7 format....................................................................................270

Control tubular parts in 3D DGN export..................................................................270

3.6 LandXML............................................................................................................270

3.7 PDF......................................................................................................................273

3.8 3D PDF.................................................................................................................273

Export a model or selected model objects as 3D PDF.............................................273

3D PDF export settings..........................................................................................274

3.9 SketchUp............................................................................................................278

3.10 Point clouds......................................................................................................279

Attach a point cloud to the model .........................................................................281

Modify point cloud properties and visualization settings.....................................283

Detach a point cloud from a model..........................................................................287

Set the default maximum point count in a view .....................................................287

Clip point clouds and reference models only.........................................................287

Point cloud example..............................................................................................287

Share point clouds with other users........................................................................291

3.11 Layout manager...............................................................................................292

Set up groups in Layout manager..........................................................................293

Base points in Layout manager..............................................................................293

Define a default coordinate system for groups.......................................................295

Define numbering settings for groups.....................................................................295

Create a group in Layout manager.........................................................................296

Create a layout point..............................................................................................298

Create a layout line.................................................................................................299

Create a layout arc.................................................................................................300

Export layout data from Layout manager...............................................................301

Export layout data....................................................................................................301

Define default export settings................................................................................303

Define the drawing scale........................................................................................303

Import layout data to Layout manager....................................................................304

Import layout data....................................................................................................305

Define point file columns.......................................................................................307

Measured points in Layout manager.......................................................................308

Example: Base point use in Layout manager.........................................................310
3.12 Analysis and design systems ................................................................. 314
Analysis and design direct links................................................................. 314
Tekla Structural Designer........................................................................ 315
Example workflow of integration between Tekla Structures and Tekla Structural Designer................................................................. 316
Import from Tekla Structural Designer.................................................... 317
Re-import from Tekla Structural Designer.............................................. 320
Export to Tekla Structural Designer....................................................... 322
Tekla Tedds Integrator........................................................................... 324
Create a new document for a model object.......................................... 326
Link an existing document to a model object........................................ 329
Update document and model............................................................... 329
Update document.................................................................................. 330
Update model....................................................................................... 330
View and modify document................................................................. 330
Create a new project for calculations linked to current model............ 331
Remove a document............................................................................ 331
View model object properties.............................................................. 331
View and modify Tekla Tedds integrator settings............................... 332
Tekla Tedds user-defined attributes..................................................... 334
Robot.................................................................................................... 335
SAP2000.............................................................................................. 335
STAAD.Pro.......................................................................................... 336
ISM....................................................................................................... 336
S-Frame................................................................................................. 337
FEM....................................................................................................... 338
Import FEM.......................................................................................... 339
Export FEM......................................................................................... 342
Supported DSTV entities........................................................................ 343
STAAD table type specifications.......................................................... 344
3.13 Steel fabrication .................................................................................. 344
NC files................................................................................................. 345
Create NC files in DSTV format.......................................................... 346
NC file settings.................................................................................... 348
Create pop-marks in NC files............................................................... 360
Create contour marking in NC files.................................................... 364
Fittings and line cuts in NC files......................................................... 366
Create round tube NC files............................................................... 367
Convert DSTV to DXF......................................................................... 368
Convert DSTV to DXF (old conversion tool)........................................ 383
MIS lists............................................................................................... 384
CIS/2................................................................................................. 386
PDMS/E3D......................................................................................... 386
ASCII files......................................................................................... 386
Import a model in ASCII format......................................................... 386
Export a model in ASCII format....................................................... 387
ASCII file description.......................................................................... 387
Tekla PowerFab.................................................................................. 387
Export model to Tekla PowerFab....................................................... 388
Export settings for Tekla PowerFab.................................................. 390
Customize user-defined attributes for Tekla PowerFab export........ 395
Exported bolt XML data..................................................................... 396
3.14 Automated precast fabrication ........................................................... 402
Unitechnik............................................................................................ 404
3.15 CAD

3.16 Import user-defined attribute values

4 Tekla Warehouse

5 Disclaimer
To work collaboratively within a Tekla Structures model, you can select out of the different methods:

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tekla Model Sharing (page 10)</td>
<td>With Tekla Model Sharing, a global team can work efficiently within one model regardless of the team location and time zones. Each user has a local version of the model on their computer. The model data is shared and synchronized over internet, and stored to a cloud-based Tekla Model Sharing service. It is possible to work also offline. Internet connection is needed only when you want to share your model changes. Tekla Model Sharing requires a license.</td>
</tr>
<tr>
<td>Multi-user mode (page 78)</td>
<td>Multi-user mode also allows several users to access the same model simultaneously. Multi-user mode is suitable for local teams with projects where the team members do not necessarily have an internet connection. In multi-user mode a server computer runs the multi-user server, a file server computer contains the multi-user master model and client computers run Tekla Structures. The multi-user model consists of a single master model on the file server computer and local views to the master model, called working models, on each users’ computer. The model synchronization is done by saving the working model to the master model.</td>
</tr>
<tr>
<td>Trimble Connect (page 107)</td>
<td>Trimble Connect is a collaboration tool that connects the constructible data. Trimble Connect enables architects, engineers, contractors, owners and operators to collaborate in building projects. Trimble Connect is available as a cloud-based platform (Trimble Connect for Browser) and a Windows application</td>
</tr>
</tbody>
</table>
Trimble Connect for Windows. Projects are synchronized between the Windows app and the cloud.

Link a Tekla Structures model to a Trimble Connect project, and then, for example, add, upload, and download files and work in the Trimble Connect 3D Viewer.

To learn more about Trimble Connect, see:
- https://connect.trimble.com/
- https://trimbleconnect.support.tekla.com/

NOTE  Tekla Model Sharing and multi-user mode do not work together. When you want to work collaboratively, you need to select which one of the methods to use.

If your company takes part in external projects, or if more than one user works with the same model at different locations, we recommend that you use Tekla Model Sharing. With Tekla Model Sharing, the users in your company can work with the same shared model, offline and with high performance, and synchronize the changes with other team members even in a low-speed network.

If you work in a local team and prefer not to use internet while working on your models, you can use multi-user mode.

1.1 Tekla Model Sharing

Tekla Model Sharing enables efficient global collaborative modeling within one Tekla Structures model. Tekla Model Sharing gives users the freedom to work with the same model at the same time in different locations and time zones.

With Tekla Model Sharing you can work locally and share the model changes globally. For example, one Tekla Model Sharing team of users can work in New York, one in London and one in Bangkok. They all contribute to the same model, working around the globe during their office hours in different time zones while the model keeps building up all the time.

In Tekla Model Sharing each user has a local version of the model on their computer or on a network drive, and the model data is shared and synchronized over the Internet using a Microsoft Azure cloud sharing service. When a model is shared, it is connected to the cloud-based sharing service. You can check the status of the service at any time.

To easily share your model changes, write out them to the sharing service. When you want to update your model with the changes made by other users, read in (page 23) the changes from the sharing service.

Even though the changes are shared over the Internet, you do not need to be connected to the sharing service all the time. You need to be online only when
you want to write out or read in the changes. This enables offline work if your Internet connection is not always available.

Prerequisites for Tekla Model Sharing
Before you can start using Tekla Model Sharing and share your models, the following prerequisites must be met.

To start using Tekla Model Sharing, you need to have:

- Tekla Structures installed.
  The users of the same shared model must have the same Tekla Structures version, and use the same latest service pack.

- A personal Trimble Identity that is connected to an organization.
  All sharing actions require authentication, and the authentication is done with Trimble Identity username and password.
  If you do not have a Trimble Identity, see Create your Trimble Identity for Tekla products.

- An internet connection to share and download changes.
  You must establish a connection to the Tekla Model Sharing service to perform any model sharing actions. TCP port 443 (the default HTTPS) outbound must be open, and if an HTTP proxy is used, it must support HTTP 1.1.
  For further information, see TCP ports, URLs and IP ranges used by Tekla Model Sharing.

- A valid Tekla Model Sharing subscription.
  The organization's administrator assigns and manages the subscriptions in the Tekla Online Admin Tool.

Tekla Model Sharing licenses
The organization's administrator assigns and manages the subscription licenses in the Tekla Online Admin Tool. To obtain a Tekla Model Sharing license, contact your organization's administrator.

For details about managing model sharing licenses as an administrator, see Manage Tekla Model Sharing licenses.

New users can only purchase Tekla Model Sharing Named User licenses. Existing users can have user licenses or floating licenses. If you have user licenses, each user must have their own Trimble Identity and Tekla Model Sharing subscription license seat.
Floating licenses for Tekla Model Sharing

If you have floating licenses, the same license can be used by different people at different times, but license use is limited to a maximum number of concurrent users. If not enough licenses are available for all users who try to access Tekla Model Sharing at the same time, you might see a message that all license seats are reserved.

A license seat is reserved when a user starts a read in or write out operation in a shared model. Having several shared models open on the same computer only reserves one license seat, but using Tekla Model Sharing on more than one computer reserves a separate license seat on each computer. Users can work on a shared model offline without reserving a license.

Tekla Model Sharing licenses are automatically released when the user shuts down Tekla Structures, changes to working on a model that is not shared, or disconnects from the Tekla Model Sharing service. If a user does not perform any operations that use the Tekla Model Sharing service, such as write out or read in, their session automatically closes after eight hours. We recommend that each user shuts down Tekla Structures at the end of the day to close the session and release the Tekla Model Sharing license without delay.

Floating licenses can be temporarily assigned outside of your organization to any users. If a user is an employee in a different organization and an external license user in your organization, Tekla Model Sharing reserves a license seat in your organization by default. If no licenses are available your organization's license pool, Tekla Model Sharing reserves a license seat in the user's own organization.

Tekla Model Sharing sharing service

When you start to share a model using Tekla Model Sharing, the model is connected to the cloud-based sharing service.

• To send model changes to the sharing service, you write out (page 24).
• To fetch other users' model changes from the sharing service, you read in (page 23).

When you read in other users' changes, the updates to your local version of the shared model are delivered to you as incremental packets. This means that when you read in, the data that is fetched from the sharing service is merged with the data on your computer. You must read in all shared changes before you can write out your own changes to the sharing service.

Note that there is no central model in the sharing service as such, only a model instance that consists of a model baseline and incremental updates. You cannot open the model in the sharing service or access any files.

The image below shows how the model data is stored to the sharing service. Each user fetches the model data from the sharing service to their local versions of the model when they read in. User authentication is based on Trimble Identity.
Tekla Model Sharing Cache service

You can install a separate Tekla Model Sharing Cache service that downloads and caches the model changes on behalf of the Tekla Structures client workstations. Using the cache service for Tekla Model Sharing makes downloading model data faster when the same data is requested more than once, such as when several users in the same office are working in a shared model. The cache service is especially helpful in locations where download speed might be limited.

The cache service downloads model data from the Tekla Model Sharing service and caches the data in the file system in a local area network (LAN). The first time that a user fetches a packet, it is stored in the cache service. Any later requests for the same packet are served from the cache service in the LAN. The cache is not used for packets that are written out.

The cache service is useful even if there is only one Tekla Model Sharing user in the same office. For example, rejoining a model is faster because the model data is available locally in the cache service. Also, because the model data is always loaded in small data blocks, the cache service can download any missing blocks later if the download is interrupted.

The cache server installation file can be downloaded from Tekla Downloads.
Work with Tekla Model Sharing

Tekla Model Sharing is available in all configurations of Tekla Structures. You can find all the Tekla Model Sharing commands in the File menu, under Sharing.

To start using Tekla Model Sharing, you need to have:

- Tekla Structures installed
- A personal Trimble Identity that is connected to an organization
- An internet connection to share and download changes
- A valid Tekla Model Sharing subscription

How does Tekla Model Sharing work?

In short, the workflow in Tekla Model Sharing has the following phases:

1. **Downloading the cache service**
   
   If needed, the person who plans to share a model downloads the Tekla Model Sharing Cache service from Tekla Downloads.
   
   The Tekla Model Sharing cache service downloads and caches the model changes on behalf of the Tekla Structures client workstations. Downloading the cache service speeds up working, as users can fetch the changes to their local versions of the model from the LAN instead of the Tekla Model Sharing sharing service.

2. **Sharing the model to other users**
   
   The model owner shares a single-user model and invites users to join the model.
   
   To share a model, open the single-user model that you want to share, or create a new single-user model.
   
   Before you can start sharing your models in Tekla Model Sharing, you need to be signed in with your Trimble Identity in Tekla Structures. If you are not signed in, the Trimble Identity sign in dialog box opens.
   
   To start sharing the model, go to File --> Sharing --> Start sharing to open the Start sharing dialog box. You can invite other users to join the model and send an email invitation to them, or you can add users later. When you start sharing, you become the Owner of the model.
   
   When you start sharing the model, a model baseline (page 32) is uploaded to the sharing service. The baseline is a snapshot of the current state of the model. A new baseline is typically created once a week. Joining
the baseline is beneficial for users who join the model when many changes have already been made.

When a model is shared, it is connected to a cloud-based sharing service. Each user of the model has a local version of the model on their computer or on a network drive.

3. **Joining the model**
   The invited users accept the invitations they have received.

   You can either join a model someone has shared with you, or you can start sharing your own model. The shared model has an **Owner** who can invite other users to the model. The **Owner** can send an email notification to the invited users.

   You can also join a model you have been invited to without the email notification. You will find all the shared models in which you are a user in **File --> Sharing --> Browse shared models**. Just select the model from the list, and click **Join**. The model is downloaded, and you can start working with it.

4. **Working on the model**
   The invited users can start working on the model offline.

   You do not need to sign in with your Trimble Identity every time you want to work on a shared model. When you have joined the model, you can work offline, provided that you are using the same Windows account as you did when you joined the model.

5. **Sharing and downloading changes**
   You need an internet connection to download other people's changes to the model and share your own changes.

   a. **Downloading changes made by other users**
      To keep your model up to date, you need to **read in the changes other users have made to the model (page 23)** from the sharing service. Only the changed data is read in to the model.

      To read in, you can either go to **File --> Sharing --> Read in**, or click the **Read in** icon on the Quick Access Toolbar.

      The **Read in** icon shows the number of packets that are available to be read in. Each packet contains one or more changes made by another user. After reading in all the packets, the changes are listed in a table at the bottom of the screen.

      The changes are color-coded:
      - Red for deleted objects
      - Yellow for modified objects
      - Green for new objects
b. **Sharing your changes to other users**

When you have made changes to your local model, you can share your changes to other users of the model by writing out the changes to the sharing service.

Before you write out, you always need to read in (page 23) any changes made by other users first. This is done to solve any conflicting changes made by other users.

After you have read in, you will see a green arrow on the **Write out** icon 📝. You can now write out your changes.

When you write out, only the changes that you have made are sent to the sharing service. These changes are then available for other users to read in.

Typically, you want to read in other users' changes and write out your changes a couple of times a day to keep everyone updated. Model changes are collected to packets that are very fast to download and upload.

6. **Track the progress of the project**

Users with the **Owner** role can create new starting points, or baselines, (page 32) for the model. Baselines make the model faster and easier to join for new users, and allow tracking the progress in the model.

**Who can use the shared model?**

For a user to participate in a shared model, the model owner must invite the user to the model.

Any user who has a valid Tekla Model Sharing license can be invited to a shared model. The user's Tekla Online organization membership does not affect which models the user can work in or be invited to.

Tekla Model Sharing has four roles that define what a user can do in a shared model.

- **When you share your model**, you automatically get the **Owner** role. Typically, there are one or two owners who can control everything in the shared model.

  As the model owner, you can invite more users to your shared model and assign appropriate roles for them. The users of a model and their roles are listed in **File --> Sharing --> Users and data**.

- **Editor** can perform all modeling and drawing tasks.

- **Viewer** is for those who just want to follow up on the project.

- **Project viewer** is for those who use the model information and need to update the fabrication status, for example.

The permissions of each role:
<table>
<thead>
<tr>
<th>Read in</th>
<th>Owner</th>
<th>Editor</th>
<th>Viewer</th>
<th>Project viewer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Write out</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Modify objects and drawings</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Modify UDAs</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes (only UDAs that do not affect numbering)</td>
</tr>
<tr>
<td>Invite or remove users, change roles, baseline, exclude from sharing</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

In addition to the **Owner**, the Tekla Model Sharing administrator of the organization can manage all the shared models and the users and their roles in the web-based Management Console for Tekla Model Sharing. The administrator can change the roles in Management Console without opening Tekla Structures, or take role of the model owner. All the users in the shared model can then have, for example, the **Editor** role.

**Share a model in Tekla Model Sharing**

When you start sharing your model in Tekla Model Sharing, you need to be logged in with your Trimble Identity in Tekla Structures. If you are not logged in, the Trimble Identity log in dialog box opens. You can invite other users to the models that you share.

When you start sharing a model in Tekla Model Sharing, you become the **Owner** of the model.

Note that to start sharing a model, you need to belong to an organization as an employee.

If you have an external license, you cannot have model ownership, so you cannot start sharing a model. For more information about employees and external license users, see Manage user accounts for Tekla products and Manage Tekla Structures subscriptions.

1. Open a single-user model that you want to share.
2. On the **File** menu, click **Sharing --> Start sharing**.
   The **Start sharing** dialog box opens.
3. Select the service from the Service list.

When you use Tekla Model Sharing for the first time and the on-premises sharing service is enabled, you need to select the service from the Service list. You can set up and use an on-premises service connection, or you can use the Tekla service. Tekla Model Sharing on-premises server requires a separate license and installation.

4. If needed, enter a Code and a Description for the model.
   • Code can be a site number, a project number, or an accounting number, for example.
   • Type a description according to your company conventions.

5. In Model data storage location, select the location for the model data storage.

There are four model data storage locations available: North America (Virginia/East US), Australia (New South Wales/Australia East), Asia (Singapore/Southeast Asia), and Europe (Ireland/North Europe). The locations are the same locations as in Trimble Connect.

Select the region closest to the majority of the users in the model to improve the performance.

If you use the on-premises sharing service, you cannot select the data storage location.

Note that you can set the data storage location only if the Tekla Model Sharing administrator of your organization has allowed that in Management Console for Tekla Model Sharing. Administrators can set a default data storage location to be used in the organization. For more information, see Manage organization settings in the Management Console.

6. Invite other users to share your model by typing their email addresses to the Invite users box and set their user role to either Editor, Owner, Project viewer, or Viewer.

You can add several users at one go. Separate the email addresses with semicolons. Do not use spaces between the email addresses. If you add several users at one go, they all get the same user role. The role can be changed later.

7. Click the Add button to add the users to the model.

8. Select the Send email notification to user. check box to send a notification email to the invited users, and write a message to the users.

9. Click the Start button to start sharing your model.

The model is saved and written out to the sharing service (page 10).
When you open the model the next time, you have two options:

- In the Tekla Structures start screen when you open Tekla Structures:
  1. Go to the Shared models tab and log in with your Trimble Identity.
  2. Click Continue to open the Shared models dialog box.
  3. Select the Show shared models on this computer check box to list the models.
  4. Click Join.

You can also open shared models on the Recent or All models tabs. Log in with your Trimble Identity to read in and write out.

- In File --> Open --> Browse shared models.

See also
Manage users in Tekla Model Sharing (page 34)

Join a shared model in Tekla Model Sharing
When someone using Tekla Model Sharing has invited you to join a shared Tekla Structures model, you may receive an invitation email.

The email contains information about the model, the used environment, and your user role. The user role defines your permissions in the model. You can join a model at any stage of sharing, and as many times as you need.

NOTE The users of the same shared model need to have the same Tekla Structures version, and use the same latest service pack.

Join a shared model
1. On the File menu, click Sharing --> Browse shared models.
2. In the Shared models dialog box, select the service from the Service list.

When you use Tekla Model Sharing for the first time and the on-premises sharing service is enabled, you need to select the service from the Service list. You can set up and use an on-premises service connection, or you can
use the Tekla service. Tekla Model Sharing on-premises server requires a separate license and installation.

3. In **Save in**, browse for the location where you want to save your local version of the model.

   If you later want to join the same model again, you need to save a new local version of the model on your computer. If you use the same name for the model, the local versions of the model need to be saved in different locations on your computer, because you cannot have two or more models with the same name in the same folder.

4. From the **Shared models** list, select the model you have been invited to.

   You can find the name of the model in the invitation email, if you received one. Otherwise, you can ask the model owner.

5. Click the **Join** button.

   When you join the model:
   - Tekla Structures checks that the local version of the model does not already exist in the selected folder. A warning message is displayed if the selected folder already contains the model. In that case, you need to browse for a different folder where to save the model.
   - Tekla Structures checks the environment you are using and displays a message if you are using a different environment than the shared model. We recommend that all users within the same shared model use the same environment.

   The **Available updates** list opens.
6. From the list of available updates, select an update or a baseline (page 32) that you want to join.

You can join any baseline (a snapshot of the model state on a certain date) or update, not only the latest. Selecting a baseline is beneficial if you join the model when there were many changes made. Joining a baseline instead of an update is also faster.

By joining an earlier baseline or update, you can go back in the model history, and, for example, check the model state on a certain date.

7. Click OK.

8. Start working with the model and share your model changes (page 24).

When you read in, only incremental update packets are fetched from the sharing service.

Information on shared models in Tekla Model Sharing
When you want to join a shared model in Tekla Model Sharing, you select the model to join in the Shared models dialog box, in File --> Sharing --> Browse shared models.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service</td>
<td>Sharing service that is being used.</td>
</tr>
<tr>
<td>Save in</td>
<td>Location where the local version of the model is saved on your computer.</td>
</tr>
<tr>
<td></td>
<td>If you want to save to another location, click the Browse button.</td>
</tr>
<tr>
<td>Shared models</td>
<td>List of models that you have shared or that have been shared with you.</td>
</tr>
<tr>
<td>• Show also</td>
<td>• If you have hidden some models from the Shared models list, select the Show also hidden check box to</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| **Show shared models on this computer** | see the full list of models that have been shared with you, or that you have shared.  
- Select the **Show shared models on this computer** check box to see the models that you have locally saved on your computer. |
| ![Eye](image) | Click to hide the model from the **Shared models** list.  
If you have many models on the list, it can be useful to hide the models you are not actively working with. |
| **Code** | Code of the model.  
The code can be, for example, a site number, a project number, or an accounting number. |
| **Name** | Name of the model. |
| **Description** | Description of the model. |
| **Environment** | Environment of the model. |
| **From** | Person who has invited you to the shared model, or has changed your role the last. |
| **Date** | Date when the sharing of the model was started. |
| **Your role** | Your role and your access level to the model.  
The options are: **Owner**, **Editor**, **Project viewer**, or **Viewer**.  
Only the **Owner** can change the roles of the other users. |
| ![Pencil](image) | If you are the **Owner**, you can edit the **Code** and the **Description** of the model. |
| ![Pencil](image) | If you are the **Owner**, you can invite new users to the model, or remove existing users.  
If you are the **Editor**, you can see which users have been invited or have joined the shared model. |
| ![Trash](image) | If you are the **Owner**, you can remove the model from the sharing service.  
This discontinues the sharing, and the users who have been working with the shared model cannot share changes anymore. |
| **Local copies of selected model on this computer** | When you select a model from the **Shared models** list, the model information is displayed here.  
- **Edited**  
- **Model**  
- ![Box](image)  
  - The date when the local version of the model has been edited.  
  - The location of the local version of the model on your computer. |
### Update the model with other users' changes in Tekla Model Sharing (read in)

To update your model with the changes made by other users, fetch the changes from the sharing service by reading them in.

You always need to read in the most current changes to a model before you can write out your own changes.

1. **On the File menu, click Sharing --> Read in, or click on the Quick Access Toolbar.**

   If there are available packets to read in, the Read in icon shows a green arrow and the number of packets.

   **NOTE** If you have been idle for over 6 hours, the number of packets may not be shown in the Read in icon. That is why we recommend that after a long time of idling, you click the Read in icon to ensure if any packets are available to read in.

   If one of the users who shares the model has selected the **Show available updates when reading in the changes** option in the Sharing settings (page 40) dialog box, the **Available updates** list opens after you have clicked the Read in icon.

   The dialog box lists all the available packets. You can read in the changes packet-by-packet, if you want to check the model changes in phases. If you want to receive all the updates at once, you can select the latest packet and all the previous packets are read in as well.

   When you read in, the updates to the shared model are delivered as incremental packets that only include the changed data. You need to read in all shared changes before you can write out your own changes to the sharing service again.

   If you have selected the **Show changes after read in** option in the Sharing settings (page 40) dialog box, a list of sharing changes opens at the bottom pane after the selected packets are read in. The list shows how the changes affect the model.

   For more information on sharing changes, see Detect sharing changes and view the sharing history in Tekla Model Sharing (page 27).

2. **Continue working with the model.**
If you encounter problems with sharing, check the sharing related log files in the current model folder and in ..\Users\<user>\AppData\Local\Tekla DataSharing for troubleshooting.

If Tekla Model Sharing detects changes that should not appear in the local version of the model after read in, Tekla Structures displays a message and the changes are recorded in the modelsharing.log. We recommend that you contact your local support to solve the issue.

**TIP** You can use the **Sharing automation tool** to automate read in (page 24), so that you can keep the model updated with changes made by other users of the model.

See also

Share your model changes in Tekla Model Sharing (write out) (page 24)
Detect sharing changes and view the sharing history in Tekla Model Sharing (page 27)

*Share your model changes in Tekla Model Sharing (write out)*

After you have modified your local version of the shared model, you can share your changes with other users who are working with the model.

To share your changes with other users, send your changes to the sharing service by writing them out. To ensure that other users will not write out while you are making changes in the model, you can reserve the next write out. You can also use the **Sharing automation tool** to automate sharing your changes.

**Write out**

Before you write out your changes, you need to:

• **Read in (page 23)** the most current changes made to the model.

• **Save** the changes you have made into the model.

1. On the **File** menu, click **Sharing --> Write out**, or click on the Quick Access Toolbar.

   The **Write out** icon shows a green arrow when there are no packets that need to be read in before you can write out. You can write out changes immediately.

   The **Write out** icon shows a gray arrow when there are packets that need to be read in before you can write out changes.

   When you write out, Tekla Structures saves the model, creates a packet of the model changes, writes out the changes to the sharing service and saves the model again.
Only new or changed data is written out. If you attempt to write out your changes, but some other user has shared some changes earlier and you have not yet read in all the available updates, you are asked to read in first. If there is no new data to be read in, Tekla Structures writes out your changes to the sharing service immediately.

If one of the users who shares the model has selected the **Enable write out revision comment** option in the **Sharing settings** (page 40) dialog box, you can enter a code or a comment for the update that you are writing out.

If you delete objects and share the deletion to the sharing service, the deletion is shared with other users, and the deleted objects cannot be recovered.

2. Continue working with the model.
   
   Note that if several users modify the same objects at the same time, the model will contain the changes by the user who first wrote out the changes.

**Reserve the next write out**

1. On the **File** menu, click **Sharing --> Reserve next write out**.

2. In the **Reserve next write out** dialog box, write a comment about why you are reserving the next write out.

3. Click **Reserve**.

   When you have reserved the next write out, the **Write out** icon on the Quick Access Toolbar shows a yellow arrow for all users of the model. Placing the mouse pointer on top of the icon shows who has reserved the next write out and the comment written in the **Reserve next write out** dialog box.

   Other users cannot write out while you have the next write out reserved. If another user has started writing out when you reserve the next write out, the write out of the other user is canceled only if data transfer has not started yet. The other user will get a notification if the write out is canceled.

4. To write out the changes you have made, on the **File** menu, click **Sharing --> Write out**.

   Note that you may need to read in (page 23) before you can write out.

5. In the **Reserve next write out** dialog box, enter a comment about the changes that you have made.

6. Click **Release**.
When you have written out, the arrow in the **Write out** icon on the Quick Access Toolbar changes to green again 🔄. Other users can now write out normally.

You can also release your write out reservation without writing out. To do this, on the **File** menu, click **Sharing --> Release reservation without write out**.

Note that if you do not write out or release the write out reservation within 1 hour, Tekla Structures will automatically release the reservation. An administrator can also release the write out reservation in Management Console for Tekla Model Sharing at any time.

**Share your model changes automatically**

If you want to automate sharing your model changes, you can use the **Sharing automation tool** from the **Applications & components** catalog.

The **Sharing automation tool** first reads in (page 23) and then tries to write out the changes until it succeeds. The tool is useful if there are many packets to read in and you want to make sure you get the write out done, or if you want to have the packets read in when you arrive at the office.

You can also use the tool just to automate read in to keep your local model updated with changes made by other users of the model. You can select the date and set the time for the read in.

1. Click the **Applications & components** button 🌐 in the side pane to open the **Applications & components** catalog.

2. Define the settings that you want to use:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Write out now until successful</strong></td>
<td>Select this option to write out your changes immediately. Note that before writing out, the tool reads in other users’ changes.</td>
</tr>
<tr>
<td><strong>Create baseline</strong></td>
<td>If you are the <strong>Owner</strong> of the shared model, you can select this option to create a baseline (page 32) when writing out.</td>
</tr>
<tr>
<td><strong>Close Tekla Structures after successful write out</strong></td>
<td>Select to close Tekla Structures after write out. Closing Tekla Structures releases licenses and may help with license management.</td>
</tr>
<tr>
<td><strong>Code</strong></td>
<td>Enter the code of the model, for example.</td>
</tr>
<tr>
<td><strong>Comment</strong></td>
<td>Enter a comment, if needed.</td>
</tr>
<tr>
<td><strong>Delayed read in at</strong></td>
<td>Select the date and set the time at which you want to read in. If you have not selected <strong>Write out now until successful</strong>, the tool only reads in.</td>
</tr>
<tr>
<td></td>
<td>If you have selected <strong>Write out now until successful</strong>, the tool first reads in and writes out,</td>
</tr>
</tbody>
</table>
### Detect sharing changes and view the sharing history in Tekla Model Sharing

To see how the model has been changing and who has shared their model changes, use the sharing change detection and sharing history to see what kind of changes the model includes.

#### Detect changes

After you have either read in (page 23) the model changes from the sharing service or made changes in the local model, you can view the changes that have been made in more detail. A list of changes is shown at the bottom of the screen. The changes are visualized with colors both in the Changes list and in the model.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open the changes list</td>
<td>Do one of the following:</td>
</tr>
<tr>
<td></td>
<td>• On the Quick Access Toolbar, click the Show read in changes icon.</td>
</tr>
<tr>
<td></td>
<td>• Click File --&gt; Sharing --&gt; Show read in changes.</td>
</tr>
<tr>
<td></td>
<td>• To automatically show the list after each read in, select the Show changes after read in option in File --&gt; Sharing --&gt; Sharing settings.</td>
</tr>
<tr>
<td>View changes in the list</td>
<td>• Click the separate tabs to see the changes according to how they affect the model. The changes are divided to the following tabs: Physical objects, Other objects, Drawings, Options, Attribute definitions, Model folder files, and UDA changes. The changes are visualized with colors in the list.</td>
</tr>
<tr>
<td>To</td>
<td>Do this</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Deleted objects are listed in the <strong>Changes list</strong> but they do not have any information available in the <strong>Name</strong> column. The <strong>UDA changes</strong> tab includes user-defined attributes that have a definition included in the <em>environment.db</em> file. Reference objects are detected as changed if there are physical or material changes. Tabs do not exist if there are no items on the tab. If the tab content becomes empty because of filtering, the tab is no longer shown.</td>
</tr>
<tr>
<td>View changes in the model</td>
<td>• Select the <strong>Select objects in the model</strong> check box and a row in the list to highlight the changed objects in the model. The changes are visualized with colors in the model. Deleted objects are not visualized in the model. • Added objects = green • Modified objects = yellow • Conflicting objects = orange • Existing objects that have not been modified by another user = gray</td>
</tr>
<tr>
<td>View changes in drawings</td>
<td>You can list the different versions of the same drawing, show their snapshots, and change the current drawing version. You can also view a modified drawing and its snapshot, or clone drawings from other models. When users modify the same drawing in their local version of the model and one user writes out, the <strong>Changes list</strong> will show a conflict in other users’ local version of the model when they read in. To view the versions of a drawing, do the following:</td>
</tr>
</tbody>
</table>
To | Do this
--- | ---
1. | Select the changed drawing on the **Changes list**.
2. | Right-click the drawing.
3. | On the context menu, select **Open versions**.

The **Drawing versions** dialog box opens. In the dialog box, you can select a drawing version, right-click and open the selected version. You can save the drawing version and write out to make the selected drawing version the current version for all users.

To keep the number of drawing files reasonable, use the `XS_DELETE_UNNECESSARY_DG_FILES` and `XS_DELETE_UNNECESSARY_DG_FILES_SAFETY_PERIOD` advanced options.

The `XS_DELETE_UNNECESSARY_DG_FILES` advanced option defines if the unnecessary drawing files (.dg files) are automatically deleted or not. To automatically delete the drawing files that are no longer used, ensure that `XS_DELETE_UNNECESSARY_DG_FILES` is set to `TRUE`.

The `XS_DELETE_UNNECESSARY_DG_FILES_SAFETY_PERIOD` advanced option defines how long the drawing files are kept before they are deleted. The default safety period is 7 days. This means that after 7 days, the drawing files that are not used are deleted when the `XS_DELETE_UNNECESSARY_DG_FILES` advanced option is set to `TRUE`. You can define a different safety period according to your needs.

However, if you want to protect some of the drawing versions from being automatically removed, use the **Always necessary** check box in the **Drawing versions** dialog box. Set the **Always necessary** option individually for each drawing version you want to keep by selecting the corresponding check box.
<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| Filter changes in the list | On each tab, you can fly column.  
1. Hover the mouse pointer over the column.  
2. Click the filter icon next to the column name.  
3. Select how you want to filter the changes.  
The name of the selected filter is shown at the bottom left corner of the list.  
If you right-click the filter icon, you can, for example, sort the columns. |
| Edit the filter | 1. Right-click the filter icon.  
2. In the context menu, select Filter Editor....  
The Filter editor dialog box opens. You can edit the selected filter as needed, or create a new filter. |
| Zoom to changed objects in the model | Select the Zoom to selected check box, and click a row in the list to zoom to the changed object in the model. |
| Search for specific changes | Type a search word to the search box on the bottom right corner of the list. |
| Move the Changes list somewhere else on the screen | You can:  
• move the list around the screen  
• drag the list to a second screen  
• dock the list to the side pane or to the bottom of the screen |
To | Do this
---|---
The list has a button, ![button](image), in the side pane. If you drag the list to a second screen, click the button to return the list to the main screen.

Add new columns to the Changes list or bring back hidden columns
1. Right-click the column title.
2. On the context menu, select the column that you want to add to the Changes list.
3. Hold down the left mouse button and drag the column to the desired location.
4. Release the left mouse button.

View the sharing history
After you have read in and written out model changes, you can check the sharing history of the model. The Sharing history dialog box shows:

- All your read in and write out events
- The packets included in each read-in and write-out event
- The changes that you have made to the model locally and have not yet shared

You can check the sharing history event-by-event, and see how the model has evolved by the changes made by other users.

To | Do this
---|---
Open the sharing history | On the File menu, click Sharing --> Sharing history.
Check the read in and write out events | To see all your read in or write out events and their date and time, click the Collapse all button.
Check the packet information | To see all the packets in each read in or write out event, click the Expand all button.

The packet information shows:
- The packet number
- The user who wrote out the packet
- The packet upload date and time
- The code and comment of the update that is included in the packet
If the comment is too long, it is not shown entirely.
<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>View the model changes included in a single event</td>
<td>Select the event and click the <strong>Show changes</strong> button. A list of model changes is displayed at the bottom pane of Tekla Structures.</td>
</tr>
<tr>
<td>View the local model changes</td>
<td>To view the changes that you have made to the model but have not yet written out, select <strong>Local non-shared changes</strong> and click the <strong>Show changes</strong> button. A list of local model changes is displayed in the bottom pane of Tekla Structures.</td>
</tr>
</tbody>
</table>

The **Undo history** dialog box lists all the commands that you have run and the modifications that you have done in your local version of the model. The **Undo history** list is cleared when you read in or write out.

**Create a baseline for a model in Tekla Model Sharing**

If you are the Owner of a model in Tekla Model Sharing, and you want to keep a record of the current progress in the model or you want to make the model faster to join for a new user, you can create a new starting point for the model in the sharing service. This new starting point is a baseline.

Baseline is a snapshot of the current state of the model. When you create a baseline, a full model is created and uploaded to the sharing service. We recommend that the Owner creates a new baseline when a new user has been invited to the model. Existing users do not need to re-join the model after a new baseline has been created.

1. On the **File** menu, click **Sharing --> Create baseline**.
2. Enter a code or a comment, if entering revision comments has been enabled in the **Sharing settings (page 40)** dialog box.

   A full model is **written out (page 24)** to the sharing service. Files and folders that have been excluded from the sharing are not included in the baseline.

   If you need to read in while you are creating the baseline, you need to repeat the **Create baseline** command after you have read in other users' changes.

   If you make changes in the model before creating the baseline, an incremental update packet is created before the baseline. This ensures that no model data is lost and that the users of the shared model do not need to join the model again.

3. If needed: Invite someone to **join (page 19)** the model.

   When the new user joins the model, the **Available updates** list opens.

   The user can then select a baseline or an update to join. The **Available updates** list shows all the baselines and the updates after the latest
baseline. You can select any baseline or update to join, not only the latest. By joining an earlier baseline or update you can go back in the model history, and, for example, check the model state on a certain date.

Joining a baseline is beneficial for users who join the model when there already are many changes made. Joining a baseline instead of an update is also faster.

After joining a model, only incremental update packets are read in from the sharing service.

**TIP** You can also create a baseline using the Sharing automation tool (page 26) from the Applications & components catalog.

See also

*Share a model in Tekla Model Sharing* (page 17)

**Exclude a model from the sharing service in Tekla Model Sharing**

If needed, you can exclude yourself and your local version of the model from the sharing service.

When you exclude a model, your local version of the model is no longer connected to the sharing service and you cannot share your changes anymore. However, the model instance still exists in the sharing service and other users can continue working with the model normally.

**NOTE** After you have excluded your local version of the model from the sharing service, you cannot merge the excluded model back to the original shared model. The excluded model is completely new and it has no connection to the model in the sharing service.

All users, regardless of their user role (*Owner*, *Editor*, *Project viewer*, *Viewer*), can exclude their local version of the model from the sharing service.

1. **On the File menu, click** **Sharing --> Exclude from sharing**.
   
   A confirmation message is displayed.

2. **Click Continue**.

   Your local version of the model is disconnected from the sharing service, and you cannot write out and read in changes anymore.

   The model automatically becomes a single-user model.

   After you have excluded your local version of the model from the sharing service you can

   • continue working with the model in single-user mode.
   
   • start working with the model in multi-user mode (page 48).
   
   • start working with the model again in Tekla Model Sharing.
If you would like to start working again with the excluded model in Tekla Model Sharing, you can either

- **start sharing** (page 17) the model and invite other users to join the model.
  
  If you start to share the model, the model is completely new and it has no connection to the previous model in the sharing service, even though the model retains its old name.

- **join** (page 19) the same model again in the **Shared models** dialog box in **File --> Sharing --> Browse shared models**.
  
  When you join the model, you can select a baseline or an update (page 32) to join.

  If you join the model again, you need to save a new local version of the model on your computer. If you do not change the name of the model, you may have several models that have the same name in the **Shared models** dialog box. All these local versions of the model need to be saved in different locations on your computer, because you cannot have two or more models of the same name in the same folder.

**See also**

- [Update the model with other users' changes in Tekla Model Sharing (read in)](page 23)
- [Share your model changes in Tekla Model Sharing (write out)](page 24)

**Manage users in Tekla Model Sharing**

Users with the **Owner** role in a shared model can manage the users in that model in several ways. Among other options, owners can invite new users, change user roles and permissions, send email notifications, and remove users.

If you are a Tekla Model Sharing administrator of your organization, you can take the role of the model owner in Management Console for Tekla Model Sharing and manage the shared model and its users. All the users in the shared model can then have, for example, the **Editor** role.

Administrators can manage all the organization's shared models and users and their roles in the Management Console. Managing models in the Management Console does not require using a Tekla Model Sharing license. You can use the Management Console without opening Tekla Structures, and you do not need to be a user in any of your organization's shared models. Note that the **Owner** role is not the same as the administrator of an organization.

For more information, see [Manage users in shared models in the Management Console](#).
Invite new users to a shared model

1. Open the shared model to which you want to invite new users.
2. On the File menu, click Sharing --> Users and data.
3. In the Users and data dialog box, type the email addresses of new users in the Invite users box, and set their user roles to either Editor, Owner, Project viewer, or Viewer.

You can add several users at one go. Separate the email addresses with semicolons. Do not use spaces between the email addresses.

If you add several users at one go, they all get the same user role. The roles can be changed later.

4. Click the Add button to add the new users to the model.
5. If necessary, modify the user roles of the new users.
6. Select the Send email notification to user. check box to send a notification email to the invited users, and write a message to the users.
7. Click Save changes to invite the users.

View information on users and sharing actions

When you want to check the Tekla Model Sharing users and the basic sharing actions on the model, or invite new users to the shared model, open the Users and data dialog box in File --> Sharing --> Users and data.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the user.</td>
</tr>
<tr>
<td>Email</td>
<td>Email address of the user.</td>
</tr>
<tr>
<td>Role</td>
<td>Role of the user: Owner, Editor, Project viewer, or Viewer.</td>
</tr>
<tr>
<td></td>
<td>When you start to share a model, you become the Owner of the model and you can set other users' roles. The roles can be changed later, if needed.</td>
</tr>
<tr>
<td></td>
<td>Use the different roles to control the permissions of users regarding the shared model.</td>
</tr>
<tr>
<td></td>
<td>Note that there can be more than one Owner within one model.</td>
</tr>
<tr>
<td></td>
<td>If you are a Tekla Model Sharing administrator, you can take the role of the model owner in Management Console for Tekla Model Sharing and manage the shared model and its users. All the users in the shared model can then have, for example, the Editor role.</td>
</tr>
<tr>
<td>Joined</td>
<td>Indicates whether the invited user has joined the model.</td>
</tr>
<tr>
<td>Date</td>
<td>Date when the user has joined the model.</td>
</tr>
<tr>
<td>By</td>
<td>Person who invited the user or changed the user role the last.</td>
</tr>
</tbody>
</table>
### Modify user roles in Tekla Model Sharing

User roles define a user's permissions to view and modify the shared model. There are four different user roles in Tekla Model Sharing: **Owner**, **Editor**, **Project viewer**, and **Viewer**. When you start sharing your model in Tekla Model Sharing, you become the **Owner** of the model. The **Owner** can invite other users to join in the model and give them one of the four roles. If you are a Tekla Model Sharing administrator of your organization, you can manage users and their roles in the Management Console.

The permissions of the four different user roles are described in the table below:

<table>
<thead>
<tr>
<th>Role</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Owner</strong></td>
<td>Users with the <strong>Owner</strong> role can:</td>
</tr>
<tr>
<td></td>
<td>• Read in (page 23) other users' changes and write out (page 24) their own changes to the sharing service</td>
</tr>
<tr>
<td></td>
<td>• Invite new users</td>
</tr>
<tr>
<td></td>
<td>• List other users and change their roles</td>
</tr>
<tr>
<td></td>
<td>• Remove users from the model</td>
</tr>
<tr>
<td></td>
<td>• Remove the model instance and all the model related data from the sharing service</td>
</tr>
<tr>
<td></td>
<td>• Change the model code and description properties</td>
</tr>
</tbody>
</table>
### Role Permissions

<table>
<thead>
<tr>
<th>Role</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Owner</strong></td>
<td>Several users can have the <strong>Owner</strong> role within one model. The <strong>Owner</strong> who has started to share the model can give the <strong>Owner</strong> role to any selected user. If you are a Tekla Model Sharing administrator, you can take the role of the model owner in Management Console for Tekla Model Sharing and manage the shared model and its users. All the users in the shared model can then have, for example, the <strong>Editor</strong> role.</td>
</tr>
</tbody>
</table>
| **Editor** | Users with the **Editor** role can:  
  • Read in other users' changes and write out their own changes to the sharing service  
  • Edit the model  
  • List other users |
| **Project viewer** | Users with the **Project viewer** role can:  
  • Read in other users' changes and write out their own changes to the sharing service  
  • View the model, but they cannot modify the model objects  
  • List other users  
  Users with the **Project viewer** role cannot:  
  • Modify user-defined attributes that affect numbering  
  • Insert and modify grids  
  • Import and update models that would create beams and other objects  
  Note that when you open the model in the **Project viewer** role, restarting Tekla Structures is required.  
  The permissions of the **Project viewer** role in a shared model correspond with the set of functionalities available in the Tekla Structures Carbon configuration. |
| **Viewer** | Users with the **Viewer** role can:  
  • Read in other users' changes  
  • View the model  
  Users with the **Viewer** role cannot:  
  • Write out any changes to the sharing service  
  • Modify the model objects  
  • Use the export commands  
  Note that when you open the model in the **Viewer** role, restarting Tekla Structures is required. |
Note that your permission to access the shared model is removed when you detach the model from the sharing using one of the following methods:

- Exclude the model from the sharing (page 33) using the Exclude from sharing command
- Upgrade to the next Tekla Structures version
- Use the Save as command to save the model

A user with the Owner role can change the role of a user as follows:

1. Open the shared model whose user roles you want to modify.
2. On the File menu, click Sharing --> Users and data.
3. In the Users and data dialog box, select the user whose role you want to modify.
4. Click the arrow in the Role column, and select a new role for the user in the list.
5. If you want to send an email notification to the user whose role has been changed, select the Send email notification to user. check box.
6. If needed, write a short message that you want to attach to the email notification.
   - If you include a message, all the invited users and the user whose role has been changed receive the same message.
7. Click Save changes.

**Remove users from a shared model**

Users with the Owner role can remove unnecessary users from a shared model.

1. On the File menu, click Sharing --> Users and data.
2. In the Users and data dialog box, select the user that you want to delete.
3. Click the button to remove the user's permissions to access and modify the model.
   - If you clicked the button accidentally, you can click the button again to cancel removing the user's permissions.
4. Repeat steps 2 and 3 for all users that you want to remove from the model.
5. Click Save changes to remove the users from the model.

**Export and import users**

Users with the Owner role can export the list of users in the current shared model to make changes to users' roles and permissions, or to add the same users into another shared model.
1. On the **File** menu, click **Sharing --> Users and data**.

2. At the bottom of the **Users and data** dialog box, click **Export users**.
   
   The list of users is saved in the `<users.csv` file in the `\ModelSharing` sub-folder under the model folder. The format of the list is `<email address>;<role>`.

3. According to your needs, do any of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| **Change users' roles and permissions in the current model** | a. Open the `<users.csv` file.  
   b. Change user roles according to your needs, or remove users' permissions by setting their roles to **NONE**.  
   c. Save and close the `<users.csv` file.  
   d. Go back to the shared model.  
   e. To apply the changes, at the bottom of the **Users and data** dialog box, click **Import users**.  
   f. Select the `<users.csv` file.  
   g. Click **Open**.  
   The changes made in the `<users.csv` are now updated to the current list of users.  
   h. To save the user changes to the current model, click **Save changes**. |
| **Copy users to another shared model** | a. Close the current model, and open another shared model.  
   b. On the **File** menu, click **Sharing --> Users and data**.  
   c. At the bottom of the **Users and data** dialog box, click **Import users**.  
   d. Find and select the previous model's `<users.csv` file.  
   By default, the `<users.csv` file is saved in the `\ModelSharing` sub-folder under the model folder.  
   e. Click **Open**.  
   The users in the `<users.csv` file are added to the current model with the roles defined in that file.  
   f. To save the user changes, click **Save changes**. |
**Send email notifications**
Users with the **Owner** role can send messages to other model users via email at any point.

1. On the **File** menu, click **Sharing --> Users and data**.
2. In the **Users and data** dialog box, select the **Send email notification to user** check box.
3. In the message box below the **Send email notification to user** check box, type the notification text.
4. According to your needs, do any of the following:
   - To send the notification to particular users, select the users in the list of model users. You can hold down **Shift** to select a range of users, or **Control** to select multiple users.
   - To send the message to all users, ensure that no users are selected in the list of model users.
5. Click **Send**.

**Tekla Model Sharing settings**
To modify the basic Tekla Model Sharing settings, use the options in the **Sharing settings** dialog box in **File --> Sharing --> Sharing settings**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model folder file sharing</td>
<td>Click the <strong>Exclude</strong> button to define files or folders that you do not want to share (page 49).</td>
</tr>
<tr>
<td>Tekla Model Sharing cache</td>
<td>You can set up a separate Tekla Model Sharing Cache service to be used with the Tekla Model Sharing service. With the Tekla Model Sharing Cache service, the model data is stored to the sharing service and then cached inside a LAN. This set-up is useful especially if there are several Tekla Model Sharing users in the same location, or a narrow bandwidth to the Internet. Using a cache reduces the download effort. The first user who reads in a packet from the sharing service loads it to the cache, and the next user gets the data faster from the cache inside the LAN than from the sharing service through the Internet. The cache is not used for packets that are written out.</td>
</tr>
<tr>
<td>Name and Port</td>
<td></td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| • **Name** is the name of the computer on which the cache is installed.  
To check the computer name, click **Windows Control Panel --> System and Security --> System**.  
• **Port** is the cache service port number that you have set when you installed the cache service.  
The default value is 9998.  
• Click the **Set** button to connect to the cache.  
• Alternatively, you can set the advanced option XS_CLOUD_SHARING_PROXY to "name of the server";"port" in a .ini file. This advanced option is user-specific.  
To reset the cache settings in the dialog box to the ones defined in the .ini file, click the **Reset** button. If any .ini file has the advanced option defined, the settings appear in the dialog box. | |
| **Show available updates when joining the model** | Select the check box to enable a list that shows all the available baselines and updates (page 32) when you join the model.  
The **Available updates** list shows all the baselines and the updates after the latest baseline. You can select any of the available baselines or updates to join, not only the latest. By joining an earlier baseline or update you can go back in the model history, and, for example, check the model state on a certain date.  
Alternatively, you can set the advanced option XS_SHARING_JOIN_SHOW_AVAILABLE_VERSIONS to TRUE in a .ini file to enable the showing of updates. This advanced option is user-specific. |
| **Show available updates when reading in the changes** | Select the check box to enable a list that shows all the available updates (page 24) when you read in the model changes.  
The **Available updates** list shows all the available updates. You can select any of the available updates to be read in, not only the latest. By reading in an earlier update you can go back in the |
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>model history, and, for example, check the model state on a certain date. Alternatively, you can set the advanced option XS_SHARING_READIN_SHOW_AVAILABLE_VERSIONS to TRUE in a .ini file to enable the showing of updates. This advanced option is user-specific.</td>
<td></td>
</tr>
<tr>
<td>• Show changes after read in • Only when conflicts exist</td>
<td>Select the check box to enable a list that shows the model changes after you have read in. If you select the Only when conflicts exist option, the list is shown only when there are conflicts in the model after read in. Alternatively, you can set the advanced options XS_SHARING_READIN_SHOW_CHANGEMANAGER and XS_SHARING_READIN_SHOW_CHANGEMANAGER_CONFLICTSONLY to TRUE in a .ini file to enable the showing of model changes. These advanced options are user-specific.</td>
</tr>
<tr>
<td>Enable write out revision comment</td>
<td>Select the check box to enable the entering of revision comments. When you write out, you can enter a revision comment and code in the comment dialog box. If you enable the revision comments, the comment dialog box is displayed for all the model users. Alternatively, you can set the advanced option XS_SAVE_WITH_COMMENT to TRUE in .ini files to enable the revision comment. This advanced option is model-specific.</td>
</tr>
<tr>
<td>• Copy project folder files to model folder • Copy firm folder files to model folder • Overwrite model folder files</td>
<td>If you have stored files, such as property files, report templates (.rpt), or graphical templates (.tpl) in a project folder or a firm folder, or their designated sub-folders, you can copy the files to the model folder. Files that are placed to the model folder are synchronized by Tekla Model Sharing. This means that by having copies of the files in the model folder, you can ensure that the files are shared and synchronized appropriately. Select whether the project or the firm folder files are copied to the model folder that you are going to share. Select the check boxes and click the Copy files button. We recommend that you copy files from the project and firm folders.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>You can also select whether the copied project or firm folder files replace the existing files of the same name in the model folder. Individual files can be copied to the model folder at any time. The next time you write out, the files are shared to all model users.</td>
</tr>
</tbody>
</table>

See also

Best practices in Tekla Model Sharing (page 60)

Set privileges, object locks, and drawing locks in Tekla Model Sharing

You can use privileges, object locks and drawing locks to prevent other users from accidentally modifying the shared model objects and the shared drawings, and to control other users' access to particular attributes, files, and settings.

Set privileges

The user who has created the model, or anyone in the same organization, can control certain access rights to the model using privileges (page 102). By using privileges, you can restrict some users or organizations from modifying your model. In practice, the privileges of the model are controlled via the privileges.inp file.

Setting the privileges in Tekla Model Sharing works the same way as setting the privileges in multi-user mode. (page 102)

By modifying the privileges.inp file, you can control the access to:

- modify user-defined attributes
- access to modify object properties or drawings. This is done by locking and unlocking objects or drawings.
- modify numbering settings
- save standard files

To change the access rights:

1. Close the model.
2. Open the privileges.inp file in any text editor.

   The privileges.inp file is typically located in ..\ProgramData \Trimble\Tekla Structures\<version>\environments\common \inp folder. The exact file location may vary depending on the folder structure of your environment files.

3. Change the desired settings and save the privileges.inp file to your model folder.
4. Re-open the model.
5. Write out (page 24) to share the privileges information.

You can prevent your model and drawings being accidentally modified by using the Locked user-defined attribute (UDA) and drawing locks. Use the Locked UDA and privileges together to control which users or organizations can modify your model or drawings.

**Set object locks**
In addition to using privileges, you can use the Locks dialog box to lock assemblies, cast units and model objects and thus prevent accidental modification and numbering of objects. This is useful when there are multiple organizations working with the same shared model, and the organizations want to prevent changes to the assemblies, cast units, and model objects that they have created.

Organization lock means that assemblies, cast units and model objects are locked so that users who are not employees of a particular organization cannot modify them. The assemblies, cast units and model objects are marked as locked For others in the Object locks dialog box (Manage > Locks). We recommend that you use the Assemblies option for locking as this also prevents the editing of objects in the assembly.

**NOTE** The organization information is based on the Windows user account, not on the Trimble Identity.

We recommend that you use the XS_OBJECTLOCK_DEFAULT advanced option to set the default lock status to ORGANIZATION so that assemblies, cast units and model objects are automatically locked For others when they are created.

**Set the default organization lock status**
You can automatically set the default lock status for all new assemblies and cast units when they are created. Use the XS_OBJECTLOCK_DEFAULT advanced option to set the default lock status. The default lock status can be ORGANIZATION or NO. When you start to share the model, the default lock status is set for all assemblies and cast units that do not have any lock status yet.

To set the default organization lock status:
1. On the File menu, click Settings --> Advanced options --> Modeling properties.
2. Set the XS_OBJECTLOCK_DEFAULT advanced option to ORGANIZATION.
3. Click OK.

   All new assemblies and cast units are locked for your organization, and their lock status in the Object locks dialog box is For others. The users in your organization can modify the objects in the assemblies and cast units. Note that users who are not in your organization see the locked status as For us.
**Change the lock statuses**

To change the lock statuses:

1. On the **Manage** tab, click **Locks**.
   
   The **Object locks** dialog box opens.

2. Select the objects in the model.
   
   You can select the objects on the assembly and cast unit level, or on the model object level. Use the **Assemblies** and **All object types** options, and the **Sub-objects** check box to define the level of selection.

3. Click the **Add objects** button to add the assemblies, cast units, or the objects to the list.
   
   Once the objects are on the list, you can check their **Object type**, **Name** and **Locked** status.

4. To change the status of the locks, select the assemblies or objects in the list or in the model, and a new lock value from the list at the bottom of the dialog box, and click **Set**.
   
   The lock status is changed.

<table>
<thead>
<tr>
<th>How the object locks are set</th>
<th>What is locked</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assembly is set to <strong>Organization</strong> (the Locked status is For others) and the objects in the assembly are set to <strong>No</strong>.</td>
<td>Assembly and the objects in the assembly are locked for your organization, and users in your organization can modify the assembly or the objects in the assembly. Users in other organizations cannot modify the assembly or the objects in the assembly. Assembly and the objects in the assembly are green in the model.</td>
</tr>
<tr>
<td>Assembly is set to <strong>Yes</strong> and the objects in the assembly are set to <strong>No</strong>.</td>
<td>Assembly and the objects in the assembly are locked for all users, no one can modify the object. Assembly and the objects in the assembly are red in the model. It is not possible to delete, modify or number the assembly or the object.</td>
</tr>
<tr>
<td>Assembly is set to <strong>No</strong> and the objects in the assembly are set to <strong>No</strong>.</td>
<td>Assembly or the objects in the assembly do not have any locks, anyone can modify the objects. Assembly and the objects in the assembly are green in the model.</td>
</tr>
</tbody>
</table>

---

*Working collaboratively within a Tekla Structures model*
If you want to clear the list, click the Reset data button.

You can use the following template fields in report templates to report the lock statuses: ASSEMBLY.OBJECT_LOCKED, ASSEMBLY.OWNER_ORGANIZATION and ASSEMBLY.LOCK_PERMISSION.

In addition, you can use the object representation to visualize the locks. When you share the object representations, other members in the project can visually check the lock statuses.

Set drawing locks
You can lock drawings to prevent accidental modifications and to reserve drawings for editing. If a drawing is locked and the lock is shared, use a snapshot instead.

1. Read in (page 23) all the model changes.

2. Open Document manager, enable direct editing, and click the Lock column next to the drawing.
   
   The Locked by column in the Document manager shows the user who has locked the drawing.

3. Write out (page 24) to share the drawing lock information.

4. To edit the drawing, open the drawing locks.

5. Edit the drawing as needed.

6. Write out to share the updated drawings.

Note that the drawing can also be unlocked, unless unlocking drawings has been limited to only particular users in the privileges.inp file. If the drawing is unlocked and a user writes out the changes they made, the changes made by the original lock owner are overridden.

To use the privileges.inp file to restrict the access to drawing editing only to particular users, add the OBJECT_LOCKED user-defined attribute (UDA) for different drawing types in the objects.inp file. The OBJECT_LOCKED attribute in the objects.inp file defines whether the Locked user-defined attribute (UDA) is visible in the Tekla Structures user interface. Create the needed drawings and edit them, and then lock the drawings using both the Locked UDA and the locks in Document manager to prevent editing.

Collect model history in Tekla Model Sharing
In Tekla Model Sharing, you can collect model history information on the actions made in a model. The model history of a shared model shows when the model has been changed, how the model has changed, and who has made the changes.
Collect model history in Tekla Model Sharing

To start collecting model history, do the following:

1. On the **File** menu, click **Settings**  --> **Advanced options**  --> **Speed and accuracy**.
2. Ensure that XS_COLLECT_MODEL_HISTORY is set to **TRUE**.
   Tekla Structures automatically sets XS_COLLECT_MODEL_HISTORY to **TRUE** when a model is shared.
3. Set XS_CLEAR_MODEL_HISTORY to **FALSE**.
4. Click **OK**.
5. To view model history, do one of the following:
   - On the ribbon, click **?** and select an object in the model.
     The model history is shown in the **Inquire object** dialog box.
     If the **Enable write out revision comment** option has been selected in the **Sharing settings** dialog box, the revision comments are displayed as well.
   - Create a model history report.
     a. On the **Drawings & reports** tab, click **Reports**.
     b. Select a report template that shows the model history.
     The name of the report template may vary in different environments. In the Default environment, the report template is called **Q_Model_History_Report**.
     c. Click **Create from all** to create a report on all the objects in the model, or select one or more objects in the model and click **Create from selected** to create a report from the selected objects.

Offline usage history is stored according to the Windows domain user account. Note that in Tekla Model Sharing models, when you write out your changes to the sharing service, the changes are stored using your Trimble Identity.

Clear model history in Tekla Model Sharing

Clearing the model history of a shared model can improve the performance of a large shared model in Tekla Model Sharing and save disc space. Note that if you clear the model history, the model history information can no longer be used in the Tekla Structures user interface, reports, or Tekla Open API.

Before you clear model history, ensure that:
   - The information stored in the model history is no longer needed.
   - All users in the shared model have written out all their changes.
• You are the only user currently working on the shared model. We recommend that you delete the model history at a quiet time, such as during the weekend.

**NOTE** Do not delete the `history.db` file in order to clear the history of a shared model. The `history.db` file is incrementally shared, and deleting the file can cause errors in the shared model.

1. Open the shared model whose history you want to delete.
2. On the **File** menu, click **Sharing** --> **Reserve next write out**.
3. In the **Reserve next write out** dialog box, write a comment about why you are reserving the next write out.
4. Click **Reserve**.
5. On the **File** menu, click **Settings** --> **Advanced options** --> **Speed and accuracy**.
6. In the **Advanced options** dialog box, set the `XS_CLEAR_MODEL_HISTORY` option to `TRUE`.
7. Click **OK**.
8. Save the model.
10. Open the model folder and ensure that the size of the `history.db` file has been reduced.
11. **Write out (page 24)** the baseline.

Other users should now **join the new baseline (page 19)** you have written out.

**Convert a shared model to a multi-user model in Tekla Model Sharing**

If needed, you can stop working with a shared model in Tekla Model Sharing and convert your local version of the model to a multi-user model.

A model cannot be simultaneously shared and used in multi-user mode (page 86). If you want to start using multi-user mode as a means to share your model instead of Tekla Model Sharing, you need to first exclude your local version of the model from the sharing service and then convert it to a multi-user model.

**NOTE** The excluded model has no connection to the original shared model in the sharing service. This means that if you exclude your local version of the model from the sharing service and start to use the model in multi-user mode, you cannot later merge the original shared model and the multi-user model.

1. Exclude your local version of the shared model from the sharing service to make it a single-user model:
a. Open the shared model that you want to convert to a multi-user model.

b. On the **File** menu, click **Sharing --> Exclude from sharing**.  
A confirmation message is displayed.

c. Click **Continue**.

The model automatically becomes a single-user model.

Your local version of the model is disconnected from the sharing service, and you cannot write out or read in changes anymore. However, the model instance still exists in the sharing service and other users can continue working with the model normally.

2. Convert the current single-user model to a multi-user model:
   a. On the **File** menu, click **Sharing --> Convert to a multi-user model**.
   b. Enter the multi-user server name or select the name from the list in the **Convert to multi-user model** dialog box.
   c. Click **Convert**.

The current model is converted to a multi-user model and you can start using the model in multi-user mode.

**See also**

*Share a model in Tekla Model Sharing (page 17)*

**What is shared in Tekla Model Sharing**

By default, all the model data is shared when you share a model in Tekla Model Sharing.

How data is shared in Tekla Model Sharing depends on the type of the shared data.

- Some data is shared incrementally.

  This means that only the new and changed data is shared. When you read in, the data that is fetched from the sharing service is merged to the data on your computer.

  **NOTE** You cannot remove or replace incrementally shared databases. The compatibility of incrementally shared databases is checked when the model is opened.

- Some data is shared, but it cannot be updated incrementally.

  When you read in, the data that is fetched from the sharing service overwrites the data on your computer.
• Some data is not shared.
• Empty folders under the model folder are not shared.
• By default, Organizer data is not shared.
  However, you can use the Organizer import and export with Tekla Model Sharing to share Organizer changes.
• Backup copies of the model database, or .bak files, are not shared.

**NOTE** Some of the catalog files that are located in the environment folders (rebar_database.inp, assdb.db, screwdb.db, matdb.bin, profdb.bin) are copied to the model folder when the sharing is started.

### How data is shared

If you want to check the files that have been overwritten when you read in, click File --&gt; Sharing --&gt; Open file backup folder to open the \ModelSharing\BackUpEnv folder under the model folder. The folder contains overwritten files from the three latest read ins. You can then, for example, copy the files back to your model or check the files for change detection.

**NOTE** We recommend that you do not remove or replace any databases. If you remove or replace a database, you must create a new baseline of the model. All other users must then join this new baseline, and then continue reading in packets.

### Databases

<table>
<thead>
<tr>
<th>Databases</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Model database</strong></td>
<td>Model database .db1 is shared incrementally.</td>
</tr>
</tbody>
</table>
| **Numbering database**     | Numbering database .db2 is shared, but it cannot be updated incrementally.  
If you have modified the family numbering settings and you read in, you lose the changes if another user has changed the family numbering settings and has written out. |

**NOTE** We recommend that one user updates and shares the numbering settings with other users by writing them out. In case the user needs to read in before writing out the numbering
<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>updates, it is important to check that the settings are as they were before starting to share them. We recommend you to use the <strong>Number series of selected objects</strong> command on the <strong>Drawings &amp; reports</strong> tab when numbering.</td>
</tr>
<tr>
<td>Create your model output, such as drawings, reports, NC files and IFC files, after a successful write out.</td>
</tr>
<tr>
<td><strong>Model history database</strong></td>
</tr>
<tr>
<td><strong>Plan database</strong></td>
</tr>
<tr>
<td><strong>Analysis model database</strong></td>
</tr>
<tr>
<td><strong>Custom components and sketched profiles</strong></td>
</tr>
<tr>
<td><strong>Standard-part model database</strong></td>
</tr>
</tbody>
</table>

### Catalogs

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Profile catalog</strong></td>
</tr>
<tr>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>the <strong>profdb.bin</strong> file in the user's model folder is updated to include the added definition.</td>
</tr>
<tr>
<td>You can also <strong>update (page 58)</strong> the profile catalog with new definitions without creating any new objects or change the existing profile definitions of a profile that is already used in the model. For more information, see the 'How to share catalog updates' section below.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Rebar catalog</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Shared model contains the rebar catalog file <strong>rebar_database.inp</strong>.</td>
</tr>
<tr>
<td>When you <strong>add</strong> and <strong>use</strong> a new rebar definition in the shared model, the definition is shared the next time you write out. When another user reads in this new definition, the <strong>rebar_database.inp</strong> file in the user's model folder is updated to include the added definition.</td>
</tr>
<tr>
<td>You can also update the rebar catalog with new definitions without creating any new objects. For more information, see the 'How to share catalog updates' section below.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Bolt catalog</strong></th>
<th><strong>Bolt assembly catalog</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Shared model contains the bolt catalog file <strong>screwdb.db</strong> and the bolt assembly catalog file <strong>assdb.db</strong>.</td>
<td></td>
</tr>
<tr>
<td>When you <strong>add</strong> and <strong>use</strong> a new bolt definition or bolt assembly definition in the shared model, the definition is shared the next time you write out. When another user reads in this new definition, the <strong>screwdb.db</strong> and <strong>assdb.db</strong> files in the user's model folder are updated to include the added definition.</td>
<td></td>
</tr>
<tr>
<td>You can also update the bolt catalog and bolt assembly catalog with new definitions without creating any new objects. For more information, see the 'How to share catalog updates' section below.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Material catalog</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Shared model contains the material catalog file <strong>matdb.bin</strong>.</td>
</tr>
<tr>
<td>When you <strong>add</strong> and <strong>use</strong> a new material definition in the shared model, the definition is shared the next time you write out. When another user reads in this new definition, the <strong>matdb.bin</strong> file in the user's model folder is updated to include the added definition.</td>
</tr>
<tr>
<td>You can also update the material catalog with new definitions without creating any new objects. For more information, see the 'How to share catalog updates' section below.</td>
</tr>
</tbody>
</table>
### UDAs, options, views, pour units

<table>
<thead>
<tr>
<th>User-defined attribute (UDA) definitions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>When a model is created, the user-defined attribute definitions are read from the objects.inp files and the definitions are stored to the environment.db database. Modified and added new attribute definitions are shared incrementally. New attribute definitions are added to the database automatically when the model is opened. If the current objects.inp file has a different definition than the environment.db, it is possible to take changes to use by clicking File --&gt; Diagnose &amp; repair --&gt; Diagnose and change attribute definitions . If the objects.inp file is in the model folder, it is shared as a file and it overrides the local objects.inp file when you read in.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Options</th>
<th>When a model is created, the options are read from the options.ini files and the model-specific options are stored to options_model.db and options_drawings.db databases. Model-specific options can be modified using the Options and Advanced options dialog boxes. Modifications to model-specific options are shared incrementally.</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Some of the options are of the type SYSTEM(ROLE). These options are read from the .ini files and are not shared. It is possible to change SYSTEM(ROLE) model option to MODEL(ROLE) option and the drawing option to DRAWINGS(ROLE) option. The options are then stored to the options_model.db or options_drawings.db databases in the model folder, and the value is shared incrementally.</td>
<td></td>
</tr>
<tr>
<td>• Some of the options are of the type USER. These options are user-specific and they are not shared.</td>
<td></td>
</tr>
<tr>
<td>• Some of the options are of the type SYSTEM. These options are user-specific and they are not shared. It is possible to change a SYSTEM option to a MODEL(SYSTEM) option. If you change a SYSTEM option to MODEL(SYSTEM), the changed value only works for the current model. These options are not shared.</td>
<td></td>
</tr>
</tbody>
</table>

| Other important files in the model folder | The database ID range mapper file db.idrm and the library database ID range mapper file xslib.idrm are related to the handling of IDs. These files are needed, for |

Working collaboratively within a Tekla Structures model

Tekla Model Sharing
To open drawings that have been created in single-user or multi-user modes.

The `plotdev.bin` file contains the print device definitions that you create in Printer Catalog (old printing). The file is shared when located in the model folder.

**NOTE** If your project has users that work in different offices and with different printers, you should not save any local changes to the `plotdev.bin` file in the model folder. Save the local changes in the XS FIRM folder instead.

**View sharing**

By default, views are not shared. Views are shared if they have a name, and the Share option in the View Properties dialog box is set to Shared.

Note that when you join a model, you get all the model views but changes to the views are not shared if the Share option is set to Not shared.

**Pour unit information**

Automatic assignments of objects to pour units are not shared. Each user has to run the Calculate pour units command in their local version of the shared model to update the pour units.

Manual assignments created by using the Add to pour unit and Remove from pour unit commands are shared.

---

**How different object types work in shared models**

When several users modify the model at the same time in Tekla Model Sharing, conflicts may occur.

In general, all object types work similarly in Tekla Model Sharing. When you read in, the changes in the incoming packet override your local changes to the same object. In other words, if several users modify the same object, the user who first writes out the changes to the sharing service wins in conflicts.

Before you start to share models, agree on common ways of working. For example, you can agree that users work on different areas of the model.

<table>
<thead>
<tr>
<th>Object / Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model objects</td>
<td>A shared modification to an object property overrides any other object property modification. For example, one user modifies a beam profile and writes out. Another user has modified the material of the same beam and reads in. The user who modified the beam material loses the changes, because the...</td>
</tr>
<tr>
<td>Object / Property</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>shared changes override the local changes to the same object.</td>
<td></td>
</tr>
<tr>
<td>Family numbering</td>
<td>Check the family numbering settings.</td>
</tr>
<tr>
<td></td>
<td>Family numbering settings are shared but cannot be incrementally updated. We recommend that one user first reads in all the packets, makes the updates and then shares the settings by writing them out. If the user needs to read in before writing out, it is important to check that the settings are as they were before starting to share them.</td>
</tr>
<tr>
<td></td>
<td>Give start numbers in wide ranges so that you do not run out of numbers within a numbering series, and that any numbering series does not overlap with another.</td>
</tr>
<tr>
<td></td>
<td>We recommend you to use the <strong>Number series of selected objects</strong> command on the <strong>Drawings &amp; reports</strong> tab when numbering.</td>
</tr>
<tr>
<td>Grids</td>
<td>If there is a conflict in sharing grids, grids are recreated using the original values that have been set in the grid properties. Any manually added grid lines are lost.</td>
</tr>
<tr>
<td></td>
<td>For example, when two users modify a grid by adding extra grid lines and write out, the added grid lines disappear from the model when they read in.</td>
</tr>
<tr>
<td>Catalogs</td>
<td>Check the catalogs so that they include all the needed definitions.</td>
</tr>
<tr>
<td></td>
<td>Starting from Tekla Structures 2018, the shape geometry files that are in .xml format are automatically converted to .tez format in shared models.</td>
</tr>
<tr>
<td>User-defined attributes (UDAs)</td>
<td>A shared change to a user-defined attribute (UDA) overrides changes to the same UDA only.</td>
</tr>
<tr>
<td></td>
<td>For example, a change in the <strong>Comment</strong> UDA overrides a change to the <strong>Comment</strong> UDA but not to the <strong>Shorten</strong> UDA.</td>
</tr>
<tr>
<td></td>
<td>A shared change to a part does not override UDA changes and vice versa.</td>
</tr>
<tr>
<td>Part and the related component</td>
<td>A shared change to a part does not override component changes and vice versa.</td>
</tr>
<tr>
<td>Custom components</td>
<td>If a user deletes a custom component from the <strong>Applications &amp; components</strong> catalog in the local version of the shared model, reading in causes an instance of the custom component to appear in the model.</td>
</tr>
<tr>
<td>Object / Property</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>model even if the component was not used in the model. You cannot edit the component instance in the model. If you need to edit the component, explode it first.</td>
<td></td>
</tr>
<tr>
<td>Drawings</td>
<td>There can be duplicate drawings from the same part. For example, two users create drawings from the same part when they are working on their local versions of the shared model. When both users write out their changes, two drawings appear in Document manager. Tekla Structures does not delete either of the drawings, and it does not merge the changes from the drawings. You need to visually check the drawings and decide which drawing to delete, or to use drawing locks (page 43) to prevent other users modifying the drawings.</td>
</tr>
<tr>
<td>Pours</td>
<td>Agree whether pour management will be used in the model and set XS_ENABLE_POUR_MANAGEMENT accordingly. If pour management is enabled in the model, do not disable it using XS_ENABLE_POUR_MANAGEMENT, especially in the middle of the project. This may cause problems if you have drawings containing pour objects, and if you are sharing your model. The pour objects and pour breaks in the model and in the drawings may get invalid, and you may lose all pour-related modeling work. Automatic assignments of objects to pour units are not shared. Each user has to run the Calculate pour units command in their local version of the shared model when they need up-to-date pour unit information. For example, user 1 moves a reinforcing bar so that it touches a pour object, runs the Calculate pour units command to add the bar to the pour unit, and writes out. When user 2 reads in, user 2 sees that the reinforcing bar has been moved, but the bar has not been added to the pour unit. Manual assignments, and other modifications to pour objects and to the objects attached to the pour objects (such as changes to geometry or location), are shared. A shared manual change in pour unit assignment overrides a local change. For example, user 1 adds an embed to a pour unit by using the Add to pour unit command, and writes out. User 2 has added the same embed to another pour unit.</td>
</tr>
<tr>
<td>Object / Property</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>unit by using the <strong>Add to pour unit</strong> command. When user 2 reads in, user 2 sees that the embed has been added to the pour unit user 1 added it to.</td>
<td></td>
</tr>
<tr>
<td>Standard files for numbering setup</td>
<td>Standard files for numbering setup are not loaded automatically when you read in. If you want to take them in to use, you need to reload them after reading in.</td>
</tr>
</tbody>
</table>

**WARNING**  If an object deletion has been written out to the sharing service, the object will be deleted in your model when you read in. This happens regardless of whether you have modified the object before reading in. Deleted objects remain deleted if the deletion has been shared. Deleted objects are not visualized when you read in.

**Exclude files and folders from Tekla Model Sharing**

By default, files and sub-folders in the model folder, and in firm and project folders, are shared when you share a model in Tekla Model Sharing. If you do not want to share all of the files or sub-folders, you can select to exclude some of them from sharing.

**NOTE**  Tekla Model Sharing works only if the model is the same for all users. Tekla Structures takes care of model-specific data sharing. You can only exclude files that do not have an effect on the model. You cannot exclude any of the databases that are in the model folder, `xslib.db1`, for example.

Empty sub-folders under the model folder and some files are excluded automatically.

1. On the **File** menu, click **Sharing --&gt; Sharing settings** .
   The **Sharing settings** dialog box opens.
2. Click the **Exclude** button to see which files and folders are excluded from sharing, and to exclude more files or folders.
   Some files and folders are excluded automatically from sharing. These files and folders appear on the **Excluded model folder files and directories** list, and they cannot be removed from the list.
   a. If you want to exclude more folders or files, click the **Directory** or the **File** button.
   b. Select the folder or the file to be excluded.
The excluded folders and files are added to the **Excluded model folder files and directories** list.

If you exclude a folder, all its sub-folders and sub-files are also excluded from Tekla Model Sharing.

You can exclude files in several ways. For example, if you have a file called `TeklaStructures.bbb`, and you use the following settings to exclude the files:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(x.x)</td>
<td><code>TeklaStructures.bbb</code> is excluded from sharing.</td>
</tr>
<tr>
<td>(x.*)</td>
<td>All the files with <code>TeklaStructures.</code> are excluded from sharing.</td>
</tr>
<tr>
<td>(*.x)</td>
<td>All the files with <code>.bbb</code> are excluded from sharing.</td>
</tr>
<tr>
<td>(<em>.</em>)</td>
<td>All the files from that folder, but not from its sub-folders, are excluded from sharing.</td>
</tr>
</tbody>
</table>

You cannot remove a folder or a file that has been excluded automatically.

3. Click **OK** when you have finished selecting the excluded files.

**Use a Trimble Connect project as the project or firm folder**

When you need to set up a project folder `XS_PROJECT` or a firm folder `XS_FIRM` to be used in Tekla Model Sharing, the most convenient way to do this is to use a Trimble Connect project as the project or the firm folder.

The project and firm folder information is only updated from the Trimble Connect project to the local versions of the shared models, not vice versa. In practice, this means that Tekla Structures downloads new files from the project or firm folder to the local model and updates any changed files.

**How to share catalog updates**

Sometimes you may need to update catalogs with new definitions, such as new profiles, and share the changes without creating any objects with the new definitions.

1. Ensure that all users on the shared model write out (page 24) their changes.
2. **Read in (page 23)** all the model changes.
3. Update the needed catalogs.
4. Create a new **baseline (page 32)**.
5. Ensure that all users join (page 19) the created baseline.

After users have joined the baseline:

a. Ensure that users check that their settings for excluded files and folders are up-to-date in File --> Sharing --> Sharing settings --> Exclude, or that they copy the FileSharing.ini file from the previous local version of the model in ..\TeklaStructuresModels \<model>\ModelSharing\Settings.

b. Ensure that users remove their previous local versions of the model.

How to share Organizer data

By default, Organizer data is not shared. However, you can use the Organizer import and export with Tekla Model Sharing to share Organizer changes.

1. Select a user who is responsible for the Organizer data. This is User A.
2. User A creates the Organizer data and exports the data to a model subfolder.

   Note that the selected folder cannot be the default ProjectOrganizer folder.

4. User B reads in (page 23) and notices that there is new data available.
5. User B opens Organizer, synchronizes, and imports the data that User A has exported by using the import and replace option. User B synchronizes Organizer again.

   The data appears as new in Organizer.

How property files in the XS_FIRM and the XS_PROJECT folders are shared

You can store property files in user-defined sub-folders under the firm or project folders. The property files are copied and shared in Tekla Model Sharing in two situations: when you start sharing a model, or when you have a shared model open and click the Copy files button in the Sharing settings dialog box.

Property files are copied and shared from the following folders:

1. The \attributes folder under the model folder.
2. The user-defined sub-folders under the XS_PROJECT folder.
   If the XS_PROJECT folder is empty, Tekla Structures skips it when copying files.
3. The user-defined sub-folders under the XS_FIRM folder.
   If the XS_FIRM folder is empty, Tekla Structures skips it when copying files.
4. The sub-folders of the environment folder.

The folders are searched in the order they are listed above. When Tekla Structures finds the first corresponding file, that file is selected. Other corresponding files are ignored, and the file names are stored in the error log.

Note that if the following folders are immediate sub-folders of project or firm folders, Tekla Structures does not read property files from the folders:

- ProjectOrganizerData
  - ProjectOrganizerData\DefaultCategoryTrees
  - ProjectOrganizerData\PropertyTemplates
  - ProjectOrganizerData\ExcelTemplates
- AdditionalPSets
- macros
  - macros\drawings
  - macros\modeling
- Drawing Details
- CustomInquiry
- PropertyRepository\Templates
- symbols
- template
  - template\mark
  - template\settings
  - template\tooltips
- profil
  - profil\ShapeGeometries
  - profil\Shapes

**Best practices in Tekla Model Sharing**

To keep your shared models in good shape and to share your changes successfully, follow the Tekla Model Sharing best practices below.

**NOTE** The users of the same shared model need to have the same Tekla Structures version, and use the same latest service pack.
Use GUIDs correctly in shared models
Tekla Structures objects have an identifier that is shown as an object GUID, Globally Unique Identifier, that is also used in Tekla Model Sharing. This means that features that do not use GUIDs need to be changed to use GUIDs.

• Interoperability import/export actions:
  • FabTrol XML
  • ASCII
  • All other applications, macros and report processes that rely on static IDs.

Save local versions of shared models on your computer
We recommend that you save the local versions of shared models on your computer instead of a network drive for two main reasons.

• The performance of shared models is better when the local models are saved on your own computer. This means that the models open faster, for example.
• Saving shared models on your own computer prevents other users from accessing them and accidentally blocking important files.

If you still want to save local models on a network drive, use a private network drive that other users cannot access.

Create baselines regularly
The Owner of a model should create baselines of the model regularly. For example, you can create a baseline once a week.

We recommend creating a new baseline each time a new user has been invited to the model. This way, joining the shared model is faster.

Back up shared models
We recommend you to back up the models used in Tekla Model Sharing. In case there are problems with a shared model, it is possible to select any user's local version of the model, or a model that has been backed up, and continue working using that model. Make sure that you have the complete backed up model in use and that the model folder includes, for example, drawings and different databases. This ensures that the model functions properly and you do not lose any data. If the backed up version of the model is old, reading in all the changes may take some time.

Back up your models according to your company conventions, for example, by using Windows Backup. You can also use the File --> Save as --> Save and
create backup copy command to create a backup copy of the model. The backup copy will have the same GUIDs as the original model.

Note that the Save as command cannot be used for backing up the model. If you use Save as, the model gets new IDs and it has no relation to the original model. If you use the Save as command, the model history is not copied with the saved model.

**Number model objects in Tekla Model Sharing**

Numbering a shared model has three main phases: reading in the changes made by other users, numbering a series of objects, and writing out the numbering changes. Always use the Number series of selected objects command when you number parts in a shared model. To avoid unnecessary work and conflicts, do not use the Number modified objects command.

Before you start numbering objects in a shared model, you should plan the numbering carefully. We recommend that you divide the model into phases, and each user only numbers objects within the phase they are working on. This way, you can avoid numbering conflicts in your shared models.

To number a phase, do the following:

1. Finish the changes you are making in the phase that you are working on.
2. Save the model.
3. Read in (page 23) the changes made by other users.
4. Review the changes and save the model.
5. Select the parts in a numbering series that have been modified.
   - You can create selection filters to select objects in a specific numbering series. For example, you can create a selection filter that allows you to select objects with the same assembly start number.
6. On the Drawings & reports tab, select Perform numbering --> Number series of selected objects.
   - Repeat steps 5 to 6 for different numbering series, if needed.
7. When numbering has been performed successfully, save the model.
8. Write out (page 24) your changes immediately.

**Reference model handling in Tekla Model Sharing**

If Tekla Model Sharing uses reference models, one user can insert a reference model to the Tekla Structures model. When other users read in, the data related to the reference model is copied to the ..\TeklaStructuresModels\<model name>\datastorage\ref folder, and the reference model is displayed in the Reference Models side pane.
If you delete the original reference model from the original location, a copy of the reference model remains in the datastorage folder. When a Tekla Model Sharing user writes out, the content in the datastorage/ref folder is shared.

You cannot exclude reference models from Tekla Model Sharing, and all reference models are public for other Tekla Model Sharing users.

**If the reference model needs to be updated**

When an existing reference model is updated, a new version of it is copied to the datastorage/ref folder.

- If there is an updated version of the reference model in the original file location with the same file name, select the reference model in the Reference Models side pane and click the Refresh button. Otherwise the reference model is not taken to use in the Tekla Structures model.

- Alternatively, you can save an updated copy of the reference model with a different name, and then update the new version by using the Change detection functionality.

Do not replace the existing reference model with a totally different reference model. This leads to an error with the following error message:

**Warning: no suitable reference sub object found for id xxxxx.**

Deleting a reference model and replacing it with a new version of an existing reference model as a totally new reference model changes GUIDs, and the references disappear from drawings, for example.

**React to Tekla Model Sharing error messages**

If you encounter problems, check the following error messages for troubleshooting.

**Licensing, sign-in, and opening errors**

**Message:** Failed to open model.

**Description:** This message appears when the selected model cannot be opened.

This can happen if a model is corrupted, or if another program is reserving files that are important for opening the model.

**Solution:**

1. Look for errors in the following log files:
   - In the \logs folder under the model folder: modelsharing.log, error_<user>_YYYYMMDD_<HHMMSS>.log, and sharingfacade.log
• In the \TeklaStructuresModels folder:
  TeklaStructures_<user>.log

• In the \Users\<user>\AppData\Local\Tekla DataSharing folder:
  ClientLog_cat.txt and ClientLog_dog.txt

2. Proceed as the error messages require.
   For example, if another application is blocking a file, close that application.

3. If you do not know how to proceed or the issues persist, contact Tekla Structures support.

---

Message: Invalid database files have been detected: [invalid files]
Description: When you open a shared model, certain database files are checked.
This message appears if there are issues in the database files that are checked.
The invalid files are listed at the end of the error message.
Solution:
1. Look for errors in the following log files:
   • In the \logs folder under the model folder: modelsharing.log,
     error_<user>_<YYYYMMDD>_<HHMMSS>.log, and
     sharingfacade.log
   • In the \TeklaStructuresModels folder:
     TeklaStructures_<user>.log
   • In the \Users\<user>\AppData\Local\Tekla DataSharing folder:
     ClientLog_cat.txt and ClientLog_dog.txt

2. Proceed as the error messages require.
   For example, if another application is blocking a file, close that application.

3. If the model is currently open, diagnose and repair the model.
4. If the problem persists, try to take a backup copy in use by replacing all .db files in the model folder with .db.bak files.

---

Message: Login failed
Description: Signing in to the Tekla Model Sharing sharing service has failed.
Solution:
1. Open Internet Explorer and clear the browser cookies.
2. Optionally, sign out from all Tekla Online services and ensure the services do not automatically remember your sign-in information.
3. Try signing in again.
4. If the issues persist, contact Tekla Structures support.

---

**Message: Model does not exist.**

**Description:** The model that you are trying to open has been deleted from the Tekla Model Sharing Service.

**Solution:** If you need to access the deleted model, contact Tekla Structures support.

---

**Message: Model requires environment: [Environment name]**

**Description:** The model has been shared with a particular environment, but you are trying to join the model using another environment.

We recommend that you use the original environment, if possible. Using another environment might cause problems when you are working with the model.

**Solution:** According to your situation, do either of the following:

- To join the model with another environment, click **OK**.
- To use the original environment, click **Cancel** and switch to the original environment.

---

**Message: The command could not be completed, Tekla Structures must close. After restarting Tekla Structures run diagnose & repair command and try again.**

**Description:** Tekla Structures cannot perform the selected command right now because of errors and inconsistencies in model objects or the library database (xslib).

**Solution:**

1. Restart Tekla Structures.
2. Open the shared model that you were working with when Tekla Structures was closed.
3. On the **File** menu, click **Diagnose & repair**, and select an appropriate command.
4. Try to perform the selected command again.

---

**Message: The command could not be completed, Tekla Structures must close. Try again after restarting Tekla Structures.**

**Description:** Tekla Structures cannot perform the selected command right now.
For example, this might happen because of a database issue or a canceled operation.

**Solution:**
1. Restart Tekla Structures.
2. Open the shared model that you were working with when Tekla Structures was closed.
3. Try to perform the selected command again.
4. If the issues persist, contact Tekla Structures support.

---

**Message:** You do not have permissions to remove model from service.

**Description:** For safety reasons, only Tekla Model Sharing users with the **Owner** role can exclude models from the Tekla Model Sharing sharing service. This message appears if you are trying to exclude a model from the Tekla Model Sharing sharing service, but your role (**Editor**, **Viewer**, or **Project viewer** does not allow doing that.

**Solution:** Do either of the following:

• Ask a user with the **Owner** role to change your role.
• Ask a user with the **Owner** role to exclude the model from the Tekla Model Sharing sharing service.

---

**Message:** Your Tekla Model Sharing license subscription expires in [X] days.

**Description:** Your Tekla Model Sharing subscription is about to expire.

**Solution:** Contact your organization's administrator and ask them to renew your subscription.

---

**File removal errors**

**Message:** Removing model from the service failed.

**Description:** Tekla Structures cannot exclude the model from the Tekla Model Sharing sharing service.

**Solution:**
1. Try again.
2. If the issues persist, contact Tekla Structures support.

---

**Message:** Removing model from the computer failed.
**Description:** You cannot delete the selected model from your computer.

**Solution:**
1. Ensure that the model still exists on your computer.
2. Ensure that the model or any of its files are not open in Tekla Structures or in another application.
3. Try again.

---

**Message:** Removing model from the computer failed. Model is in use.

**Description:** You cannot delete the selected model from your computer because the model is currently open.

**Solution:**
1. Close the model.
2. Try deleting the model again.

---

**Message:** The Tekla Cloud service cannot be removed from list of known services.

**Description:** Users cannot delete the Tekla Cloud service.

---

**Role and permission errors**

**Message:** Your permission level has been modified. You no longer have permissions to manage users for this shared model. You can continue to use the model otherwise. Contact the model owner if you need permissions.

**Description:** A Tekla Model Sharing user with the **Owner** role has changed your role in the shared model, so that you can no longer manage the users of the model in the **Users** dialog box.

**Solution:**
Do either of the following:

- Ask a user with the **Owner** role to change your role to **Owner**. Then, try again.
- Ask a user with the **Owner** role to manage the users as necessary.

---

**Sharing and connection errors**

**Message:** Check the port number.

**Description:** The port number is incorrect.

**Solution:**
1. Find out the correct port number.
2. Type the correct port number, and try again.

Message: Check the server name.
Description: The server name is incorrect.
Solution:
1. Find out the correct server name.
2. Type the correct server name, and try again.

Message: Connecting to model sharing service failed as the email is already in use in another organization.
Description: You cannot connect to the Tekla Model Sharing service because the email address that you are using has been added to another organization. A user can only be added to one organization at a time.
Solution: According to your needs, do one of the following:
• Ask your organization’s administrator to move you back to the original organization and add you to the new organization as an external license user.
  This way, you can work on existing models. Note that as an external user, you cannot start sharing new models.
• Create a new email address in the new organization, and then, create a new Trimble Identity using the new account.
• If you need full access to the models of both organizations, contact Tekla Structures support.

Message: Connection to proxy server failed.
Description: Tekla Model Sharing cannot connect to the proxy server.
Solution:
1. Ensure that you have access to the proxy server.
2. Ensure that the proxy server is running.
Even when Tekla Model Sharing cannot connect to the proxy server, Tekla Model Sharing can retrieve information using the sharing service.
Message: Different Tekla Structures versions cannot be used in the same model sharing project.

You can save the model and start sharing again to create a new project, or close the model without saving and continue with the original version [version number].

Description: All users need to use the same Tekla Structures version when working on a shared model.

This message appears if you try to open a shared model with a different Tekla Structures version.

Solution: Do either of the following:

• Save the model in the Tekla Structures version that you are using, and start sharing the newly saved model.

• Close the model without saving it and open the model using the Tekla Structures version with which the model was originally shared.

Message: Exclude from sharing failed.

Description: Tekla Structures cannot exclude the model from the Tekla Model Sharing sharing service.

Solution:

1. Look for errors in the following log files:

   • In the `\logs` folder under the model folder: `modelsharing.log`, `error_<user>_YYYYMMDD_<HHMMSS>.log`, and `sharingfacade.log`

   • In the `<TeklaStructuresModels folder>`: `TeklaStructures_<user>.log`

   • In the `<Users\<user>\AppData\Local\Tekla DataSharing folder>`: `ClientLog_cat.txt` and `ClientLog_dog.txt`

2. Proceed as the error messages require.

   For example, if another application is blocking a file, close that application.

3. If you do not know how to proceed or the issues persist, contact Tekla Structures support.

Message: Failed to write out model changes. Reason: Failed to create the data. Path is too long. maximum length is 125.

Description: The shared model is located on a network drive whose path is too long.
Message: Fatal database integrity error discovered during the operation. Use the Diagnose Model command to find problematic objects.

Description: Some of the databases that the model uses have been corrupted. Tekla Structures needs to diagnose the model to find out how the model can be repaired.

Solution:
1. Go to File menu and select Diagnose & repair -- Diagnose model.
   The errors and inconsistencies found in the model are listed in a report. Some of them are automatically corrected, some of them are warnings that you need to correct manually.
   For more information, see Diagnose and repair the model.
2. If you do not know how to proceed or the issues persist, contact Tekla Structures support.

Message: Not enough memory.

Description: A change management operation has failed because of insufficient system memory.

Message: Operation is not allowed for shared model.

Description: This message appears when you are trying to fix ID gaps in a shared model. Fixing ID gaps is only used to repair models that are not shared and that have been saved in Tekla Structures 2016i or older.

Solution:
1. To release memory, close some open applications.
2. Try again.

Message: Sharing operation failed.

Description: Tekla Model Sharing cannot find all necessary information.

Solution:
1. Ensure that you have not used characters that Tekla Model Sharing cannot recognize, such as semicolon (;).
2. Look for errors in the following log files:
   • In the \logs folder under the model folder: modelsharing.log, error_<user>_<YYYYMMDD>_HHMMSS>.log, and sharingfacade.log
• In the \TeklaStructuresModels folder:
  TeklaStructures_<user>.log
• In the \Users\<user>\AppData\Local\Tekla DataSharing folder:
  ClientLog_cat.txt and ClientLog_dog.txt

3. Proceed as the error messages require.
   For example, if another application is blocking a file, close that application.
4. If you do not know how to proceed or the issues persist, contact Tekla Structures support.

---

**Message:** Sharing operation failed. Please check the Internet connection and Tekla Model Sharing Status in [https://status.tekla.com/](https://status.tekla.com/).

**Description:** Tekla Model Sharing cannot retrieve all necessary information.

**Solution:**
1. Check that your Internet connection works properly.
2. Go to [https://status.tekla.com/](https://status.tekla.com/) and check the Tekla Model Sharing Status.

---

**Message:** Sharing operation failed. Please check the model sharing log, and contact Tekla Structures support if the problem persists.

**Description:** Tekla Model Sharing cannot retrieve all necessary information.

**Solution:**
1. Open the \logs folder under the model folder.
2. Look for error messages in the modelsharing.log file.
3. Proceed as the error messages require.
4. If you do not know how to proceed or the issues persist, contact Tekla Structures support.

---

**Message:** Sharing operation failed. Service could not be reached - realm or server address could be wrong. Please check the model sharing log, and contact Tekla Structures support if the problem persists.

**Description:** Tekla Model Sharing cannot retrieve all necessary information.

**Solution:**
1. Open the \logs folder under the model folder.
2. Look for error messages in the modelsharing.log file.
3. Proceed as the error messages require.
4. If you do not know how to proceed or the issues persist, contact Tekla Structures support.
Message: Invalid database files have been detected: [invalid files].
The versions of these databases do not match. To enable sharing operations in this model, backup files will be used.
Description: Some of the databases used in the shared model have been deleted or replaced with irrelevant databases. Instead, Tekla Structures automatically uses the available backup files. You do not need to react to this message.

Message: Invalid database files have been detected: [invalid files].
The versions of these databases do not match. To enable sharing operations in this model, databases are needed from a model that has the correct version (packet number).
Description: Some of the databases used in the shared model have been deleted or replaced with irrelevant databases. Because of this, Tekla Structures cannot open the model.
Solution:
1. In the shared model, join (page 19) the packet that is mentioned in the error message.
2. Open File Explorer and copy the necessary database file to the newer version of the model.
3. Try opening the model again.

Message: This model has been shared in a previous version. Sharing operations cannot be used in this release. If you save the model in this version, it will be excluded from sharing.

This model has been shared in a previous version. If you save it now, it will be excluded from sharing.
Description: The current model has been shared in an earlier Tekla Structures version, so you cannot share your changes or read in other users' changes with a newer Tekla Structures version.
Solution:
Do either of the following:
• Close the model without saving, and open it with the earlier Tekla Structures version with which it has been shared.
• If you want to use the current version of Tekla Structures, save the model and start sharing the model again with the newer version.

Note that all other Tekla Structures users in the project also need to use the newer version.

Read-in and write out errors

Message: Another user has reserved the next write out

Description: This message appears if another user has already reserved the next write out.

You cannot reserve the next write out if another user has already reserved it.

Solution: Do any of the following:

• Find out who the other user is and ask them to release the next write out. (page 24)

• Wait for the other user to write out their changes before you write out your changes.

• Wait for an hour.

  If the other user does not write out their changes in that time, the next write out will be released.

• Ask a user with administrator rights to unlock the model in Management Console for Tekla Model Sharing.

  When an administrator unlocks the model, the next write out is released.

---

Message: Failed to populate the changes list

Description: This message appears when change management fails to show the list of latest changes.

Solution:

1. Look for errors in the following log files:
   • In the \logs folder under the model folder: modelsharing.log, error_<user>_<YYYYMMDD>_<HHMMSS>.log, and sharingfacade.log
   • In the \TeklaStructuresModels folder: TeklaStructures_<user>.log
   • In the \Users\<user>\AppData\Local\Tekla DataSharing folder: ClientLog_cat.txt and ClientLog_dog.txt

2. Contact Tekla Structures support.

---

Message: Failed to release next write out.
**Description:** This message appears if you cannot release the write out that you previously reserved. This is usually an Internet connection issue.

**Solution:**
1. Check your Internet connection.
2. Try again.
   OR
   Wait one hour. The write out is automatically released after that time.

---

**Message: Failed to reserve next write out.**

**Description:** This message appears if you cannot reserve the next write out.

**Solution:**
1. Check your Internet connection.
2. Try again.
   OR
   Find out if another user has reserved the next write out. If yes, you can ask them to release the next write out.

---

**Message: No new shared data available.**

**Description:** You can only read in changes that other users have shared. This message appears in the status bar at the bottom of Tekla Structures when you try to read in other users’ changes, but no new changes have been shared.

---

**Message: Please provide comment for operation**

**Description:** A comment is required whenever you reserve the next write out in a shared model. This message appears if you have attempted to reserve the next write out without typing a comment.

**Solution:**
1. Click **OK** to close the error message.
2. Type a comment that describes why you want to reserve the next write out.
3. Click **Reserve**.
Message: The following characters are not allowed in Code or Comment field: < & >

Description: This message appears if you try to use the characters "<", "&", or ">" when you type a revision code or comment at write-out.

Note that you can only type revision codes or comments if the Enable write out revision comment check box is selected in the Sharing settings dialog box.

Solution:
1. Remove the forbidden characters from the revision code or revision comment.
2. Click Save to write out your changes.

Message: The revision code exceeds maximum length ([X] out of [Y] characters used).

Description: The revision code that you have typed is too long.

Solution: Type a shorter revision code.

Message: The revision comment exceeds maximum length ([X] out of [Y] characters used.)

Description: The revision comment that you have typed is too long.

Solution: Type a shorter revision comment.

Message: Write Out is not allowed because the model is not up to date. Use Read In to update the model.

Description: You cannot write out your changes before you have read in the changes that other users have made before you.

Solution:
1. On the File menu, click Sharing --> Read in, or click on the Quick Access Toolbar.
2. View the changes made by other users.
3. To share your changes, on the File menu, click Sharing --> Write out, or click on the Quick Access Toolbar.

Repair Tekla Model Sharing issues
**Restore shared models**

If a shared model has problems that might cause loss of working time, a company administrator can delete the model versions that have problems using Management Console for Tekla Model Sharing.

It is also possible that a user of a shared model restores a previous version of the model in Tekla Structures, and that model is used in Tekla Model Sharing. **Management Console for Tekla Model Sharing** provides a web-based access for administrators to manage all shared models of an organization. An administrator can lock a model and name one user as the lock owner who can investigate the model in Tekla Structures. Once the lock owner finds the problem, the administrator can delete the model versions that are causing the problem, and then unlock the model so that it can be used normally again.

While the model is locked, the sharing commands in Tekla Structures are available as follows:

- The **Read in** and **Write out** icons have yellow arrows. Only the lock owner can use these commands.
- On the **File** menu, the **Read in**, **Write out**, **Create baseline** and **Users** commands are available for the lock owner.
- In the **Shared models** dialog box, the **Edit model**, **Manage users**, and **Remove model from cloud** commands, and joining a particular model are available for the lock owner.

For other users the sharing commands are not available.

If a user of the shared model has already read in or written out any of the model versions that the administrator has deleted, Tekla Structures shows the **Write out** and **Read in** icons with red arrows for this user. The sharing commands on the **File** menu are not available. The user needs to rejoin the model.

If a user is not using any of the deleted versions, the user does not need to rejoin.

Note that it is also possible to revert to an earlier version of the model without further investigating it. The administrator can lock the model in Management Console for Tekla Model Sharing, delete the versions that are not needed or that contain errors, and then unlock the model. After this, the users need to rejoin the valid version of the model.
When the model versions are deleted, the changes that have been made in those versions are lost from the model. The changes that should be included in the model need to be made again and read in.

Another option to take a previous version of the model into use is that a user of the shared model performs the following steps:

1. Join (page 19) the model again.
2. Read in (page 23) the packets until you have reached the preferred level in the model history.
3. Exclude (page 33) the model from sharing.
4. Start sharing (page 17) and invite other users again to the model.

   Ensure that all the users within the model start to use the restored version of the model.

**Rejoin the model if the model is not saved after write out**

If there are errors in writing out changes to the sharing service, you might need to rejoin the model. Tekla Structures will show you an error message if the errors in the write out could cause database inconsistencies and corrupt model data.

When you write out, Tekla Model Sharing does the following:

1. Saves the model.
2. Prepares the incremental packet. The data in the model folder is not changed yet.
3. Uploads the incremental packet to the sharing service.
4. Saves the model again if the incremental packet is uploaded successfully. Local model data is updated with the needed information.

Tekla Structures will not show you an error message if there are errors at any step before step 4. The sharing service has not received the model update yet. You can try to write out again as the model folder does not contain any data that would prevent the write out. If there are new updates available for the model, first read in the updates and then try to write out again.

If there are errors at step 4, Tekla Structures shows you an error message advising you to rejoin the model. After joining, you can check from the sharing history (page 27) that your write out was uploaded to the sharing service.

Errors at step 4 mean that the model might not have been saved correctly, and model data might be corrupted or lost. The model has several different Tekla Structures databases each of them with their own baseline. If there are errors, the Tekla Structures model does not have all the needed information of what has been shared.
**Start a new Tekla Model Sharing session after timeout**

Tekla Model Sharing sessions time out if you do not read in or write out changes for 8 hours. When your session times out, you are disconnected from the Tekla Model Sharing service and the on-premises server, so that your Tekla Model Sharing license can be released to other users.

In these cases, the Read in icon on the Quick Access Toolbar does not show the number of available packets. However, packets might still be available to read in.

To start a new Tekla Model Sharing session and re-connect to the Tekla Model Sharing service, click the Read in icon on the Quick Access Toolbar.

**Get support for sharing issues**

You can contact Tekla Structures support to solve Tekla Model Sharing issues.

Use the Support tool to contact Tekla Structures support directly. With the Support tool you can collect the model, related files, and log files that are needed to investigate the issues with Tekla Model Sharing.

To create a support request:

1. In the shared model, ensure that you have logged in using your Trimble Identity.
2. On the File menu, click Help --> Contact Tekla support.
   a. In Category, select Model Sharing.
   b. In Problem description, describe the problem in detail.
   c. In Steps to reproduce, describe the steps as closely as possibly.
3. Click Next, and ensure that all the check boxes are selected.
4. Click Next, and check the summary.
5. Click Create case to upload your case to Tekla Structures support.
   You will receive a confirmation email from Tekla Structures support.
   Additionally, you can invite Tekla Structures support to join the model to investigate the issue. Remember to remove any support email addresses from the user list after the model has been investigated.

### 1.2 Multi-user mode

Multi-user mode allows several users to access the same Tekla Structures model at the same time.
Several users can work on the same project and be aware of each others' progress. Using multi-user mode eliminates the need to copy and merge models.

**Requirements for using multi-user mode**

- Multi-user models must be saved in a network directory.
- All members of a shared model must use the same environment and role.
- All members of a shared model must use the same version and service pack of Tekla Structures.
- We recommend that all members of a shared model use the same configuration or license type.
  
  If the configuration is not the same, ensure that all licenses generate the same types of (conceptual or detailing components).

**Advantages**

- No duplicate models to control, track or store
- Using only one model reduces on site errors
- Erection plans based on a single master model
- Bolt and material lists generated from a single master model
- Ability to share the workload of large projects among many users
- Ability to collect model history (see XS_COLLECT_MODEL_HISTORY)

**Other issues to consider**

As with all projects, you must plan your multi-user project carefully. Some issues to consider are:

- Only one user at a time can save to the master model.
- Use a numbering plan. When working with multi-user models, always use the option **Synchronize with master model (save-numbering-save)** in the **Numbering setup** dialog box to prevent saving conflicts.
- Schedule numbering sessions appropriately. It can take a long time to number larger models.
- If possible, assign distinct areas of the model to each user to avoid conflicts that may happen when several users are working in the same area.
- Do not use a mix of single-user and multi-user setups on one project. Saving a multi-user model in single-user mode deletes changes by other users working on the model, and can also corrupt the model. See **Saving in multi-user mode (page 87)** to find out how saving works in multi-user mode.

- Multi-user system
- **How multi-user works (page 86)**
• Modeling in multi-user mode (page 93)
• Drawings in multi-user mode (page 98)
• Access rights in multi-user mode

Multi-user system
A Tekla Structures multi-user system runs in a TCP/IP network and consists of:
• A server computer running the multi-user server (xs_server.exe started by the AlwaysUp utility)
• A file server computer containing the master model
• Client computers running Tekla Structures

For information about the recommended multi-user setup, see Tekla Structures multi-user server 2.5.0 hardware recommendations.

Tekla Structures multi-user server as a service
Tekla Structures multi-user server runs as a service that is started automatically when you start the computer. You do not need to sign in to the service.

Tekla Structures multi-user server performs the following main tasks:
• Locks the model when somebody saves or numbers the model
• Identifies client computers
• Keeps track of active users in multi-user models
• Gives numbers for general arrangement drawings and multidrawings
• Shows warnings if an another user has already edited or is currently editing drawings or the same model object

To optimize the performance of a multi-user system, run as few other programs as possible on the Tekla Structures multi-user server.

Server shutdown
We recommend that users save their working models to the master model before the Tekla Structures multi-user server is stopped. If the service is stopped before saving the working models, such as when the server computer needs to be restarted, restart the multi-user server service and have users save their working models to the master model.

Install Tekla Structures multi-user server as a service
The Tekla Structures multi-user server installer installs the multi-user server as a service. When you have installed the server, the service is always available.
and it is automatically started when the server computer is started. There is no need to log in and no need to start the server manually every time you start your computer. Tekla Structures multi-user server allows many users to work on the same model simultaneously.

We recommend that you use the latest multi-user server version available regardless of the Tekla Structures version that you use.

1. Download the multi-user server software installation file from Tekla Downloads.
2. Double-click the installation file to run the installation.
3. Follow the steps in the installation wizard to complete the installation.

   By default, the server is installed to:
   
   c:\Program Files (x86)\Tekla Structures Multiuser Server

   You cannot change the installation path during the installation.

   If you install the multi-user server on your own computer, the server name is the name of your computer.

   The multi-user server uses TCP/IP port 1238.

   The installation log is written to the xs_server.log file that is available in c:\ProgramData\TeklaStructuresServer.

**Restart the multi-user server service**

If you see an error message that the model is locked, it might be useful to restart the Tekla Structures multi-user server service. You can restart the multi-user server service without restarting the server computer.

If you regularly restart the multi-user server service, we recommend that you reserve a particular time during each workday to restart the multi-user server service.

1. Ensure that all users of the Tekla Structures multi-user server have signed out of Tekla Structures.
2. Find and open the computer that hosts the Tekla Structures multi-user server service.

   The name of the computer is the same as the server name that you type when you sign in to the multi-user model.

3. On the server computer, go to ..\ProgramData \TeklaStructuresServer.

   For example, C:\ProgramData\TeklaStructuresServer.

   In the ..\ProgramData\TeklaStructuresServer folder, there might be a file called tcpip_localhost_<xxxx>.db.
4. If the tcpip_localhost_<xxxx>.db file exists in the ..\ProgramData\TeklaStructuresServer folder, delete the file. If the tcpip_localhost_<xxxx>.db does not exist in the <root folder>\ProgramData\TeklaStructuresServer folder, continue to the next step.

5. Restart the Tekla Structures Multiuser Server service.
   a. In the Windows Start menu, type Services.
   b. In the search results, click Services.
   c. In the Services dialog box, find and select Tekla Structures Multiuser Server.
   d. Click Restart and wait until the Tekla Structures multi-user service restarts.

   **TIP** As an alternative to these steps, you can use the Task Scheduler app in Windows to create a task that automatically restarts Tekla Structures multi-user server:

   ```
   net stop "Tekla Structures Multiuser Server"
   net start "Tekla Structures Multiuser Server"
   ``

   If you are an advanced user, you can optionally create a batch file to automate this process:

   ```
   ECHO.
   ECHO ***STOPPING SERVICE***
   ECHO.
   net stop "Tekla Structures Multiuser Server"
   ECHO DELETING MULTIUSER DATABASE
   cd C:\ProgramData\TeklaStructuresServer\del /f tcpip_localhost_1238.db
   ECHO STARTING SERVICE
   net start "Tekla Structures Multiuser Server"
   ECHO DONE
   ```

**Install a new instance of the multi-user server service**
You can have several instances of the Tekla Structures multi-user server service on the same server computer.

Installing new instances of the multi-user server service is very important if you want to have several models with the same name, because the multi-user server uses the model name to identify models.

Note that you can have approximately 80 instances of the Tekla Structures multi-user server service on the same server computer. The exact maximum number of instances is not known. If you need a large number of multi-user server services, we recommend that you divide the services between multiple server computers.
1. Find and open the server computer that hosts the multi-user server service.
   The name of the server computer is the same as the server name that you enter when you sign in to the multi-user model.

2. Go to C:\Program Files (x86)\Tekla Structures Multiuser Server.

3. To create a new instance of the Tekla Structures multi-user server service, right-click **TS_MUSaaS_Install**.

4. Select **Run as administrator** and click **Yes** to confirm.

   The related Command Prompt window opens. You can see the default service name, port number and destination for the new instance. The last character of the service name is the identifier of the instance.

   The default identifier is 2, whereas the default port number is 1239.

5. If necessary, change the identifier or port number of the new instance.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change the identifier</td>
<td>a. Press <strong>I</strong> on the keyboard.</td>
</tr>
<tr>
<td></td>
<td>b. Press <strong>Enter</strong>.</td>
</tr>
<tr>
<td></td>
<td>c. Type the new identifier.</td>
</tr>
<tr>
<td></td>
<td>d. Press <strong>Enter</strong> to change the identifier.</td>
</tr>
<tr>
<td>Change the port number</td>
<td>a. Press <strong>P</strong> on the keyboard.</td>
</tr>
<tr>
<td></td>
<td>b. Press <strong>Enter</strong>.</td>
</tr>
<tr>
<td></td>
<td>c. Type the new port number.</td>
</tr>
<tr>
<td></td>
<td>d. Press <strong>Enter</strong> to change the port number.</td>
</tr>
</tbody>
</table>

6. When you are ready, press any key on the keyboard except for **I**, **P**, or **Q**. A new instance of the Tekla Structures multi-user server is installed and started.

7. Press any key on the keyboard to close the Command Prompt window.

**Uninstall an instance of the multi-user server service**
If you need to uninstall an instance of the Tekla Structures multi-user server service, do the following:

1. Find and open the server computer that hosts the multi-user server service.
   The name of the server computer is the same as the server name that you enter when you sign in to the multi-user model.

2. Go to C:\Program Files (x86)\Tekla Structures Multiuser Server.
3. To create a new instance of the Tekla Structures multi-user server service, right-click **TS_MUSaas_Uninstall**.

4. Select **Run as administrator** and click **Yes** to confirm.
   The related Command Prompt window opens.

5. Type the identifier of the instance that you want to uninstall, and press **Enter**.
   The identifier is the last character of the instance name. For example, if the instance name is **Tekla Structures Multiuser Server 2**, the identifier is 2.

6. Type **Y** to confirm uninstalling the instance, and press **Enter**.
   The selected instance of the Tekla Structures multi-user server service is stopped and uninstalled. All files stored in the associated multi-user server folder are deleted.

7. Press any key on the keyboard to close the Command Prompt window.

**Change the server of a multi-user model**
You can change the Tekla Structures server of a multi-user model.

1. On the **File** menu, click **Sharing --> Change multi-user server**.
2. Enter the new server name or select it from the list.
3. Click **Change**.
   If the connection to the new server cannot be established, the old connection is restored.

**NOTE** The file `.This_is_multiuser_model` located in the model folder defines whether the model is a multi-user or a single-user model. The file includes also the name of the server. You can open the file using any standard text editor.

**Convert a multi-user model to a single-user model**
You can convert a multi-user model to a single-user model and open it in the single-user mode.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Convert a current, open model</td>
<td>On the <strong>File</strong> menu, click <strong>Sharing --&gt; Convert to a single-user model</strong>. The current model is converted to a single-user model.</td>
</tr>
<tr>
<td>Convert some other than the current model</td>
<td>1. On the <strong>File</strong> menu, click <strong>Open --&gt; All models</strong>.</td>
</tr>
</tbody>
</table>
To | Do this
--- | ---
2. | Select the multi-user model to be converted from the list of models and click **Convert to single-user model**.
3. | Click **Convert** in the **Convert to single-user model** dialog box.

**See also**
Convert a single-user model to a multi-user model (page 85)

**Convert a single-user model to a multi-user model**
You can convert a single-user model to a multi-user model and open it in the multi-user mode.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| Convert a current, open model | 1. On the **File** menu, click **Sharing -- > Convert to a multi-user model**.  
2. Enter the multi-user server name or select the name from the list in the **Convert to multi-user model** dialog box.  
3. Click **Convert**.  
The current model is converted to a multi-user model. |

| Convert some other than the current model | 1. On the **File** menu, click **Open -- > All models**.  
2. Select the single-user model to be converted from the list of models, and click **Convert to multi-user model**.  
3. Enter the multi-user server name or select the name from the list in the **Convert to multi-user model** dialog box.  
4. Click **Convert**. |

**See also**
Convert a multi-user model to a single-user model (page 84)
The multi-user model consists of a single master model. Each user can access this model and open their own local view of the model. This local view is called a working model. The above image shows one possible configuration of the multi-user system.

Any changes a user makes to his working model are local and are not visible to other users until he saves the working model to the master model.

The multi-user system can contain several client computers, where users work on their working models. The master model can be located anywhere on the network, including any of the client computers.

When you open a multi-user model on a client computer, Tekla Structures makes a copy of the master model to the memory of the client computer (a working model).

When you click Save to save your working model back to the master model, Tekla Structures:

1. Takes a new copy of the master model and compares your working model with it.
2. Saves the changes in your working model to the copy of the master model (locally).
3. Saves this copy back to the master model. (When other users save their working models, they can now see your changes.)

4. Takes a new copy of the master model and saves it locally as your working model. (You can see your own changes and those uploaded by other users.)

The multi-user model is locked during opening, saving and numbering. When one of the users performs any of these operations, other users cannot perform them during that time.

**Locks for models in multi-user mode**

To preserve the integrity of the multi-user model, Tekla Structures locks the master model when a user:

- Opens the multi-user model
- Saves a working model to the master model
- Runs numbering

When you try to save the model that is locked, Tekla Structures gives you an option to queue for saving until the model is unlocked. Tekla Structures keeps on retrying saving every 15 seconds until the operation is completed or until you cancel the operation.

**See also**

Saving in multi-user mode (page 87)

**Saving in multi-user mode**

Tekla Structures preserves the integrity of the model, even if more than one user modifies the same model objects. If two users modify the same object, then save to the master model, the master model will only contain the changes of the user who most recently saved their working model to the master model.

**TIP** To avoid potential save conflicts, have users work on different areas of the model.

Tekla Structures creates connections to the right parts, even if the part is moved by another user.

Note that if you use the **Save as** command to save the model, the model history is not copied with the saved model.

**Speeding up the saving process**

The following advice may help in speeding up the saving process:
• Check your network connection speed, because it can slow down the saving process significantly.
• Close down all the views of the model before saving.
• Set the advanced options XS_PROJECT and XS_FIRM so that they point to a local drive and move most of the system files there. If there are many system files in the network drive, saving may become slower than when using system files located on your own hard drive. Each user should use the same files to ensure similar outcome.
• Delete any hidden reference models which you do not need anymore.

See also
How multi-user works (page 86)

Autosaving in multi-user mode
Autosave only saves the working model, not the master model. Other users do not see the modifications you make after an Autosave. In multi-user mode, this makes Autosave much faster than the Save command. Save updates the master model.

By default, Tekla Structures saves the Autosave files in the master model folder with the filename <model>.db1_<user>. If several people are using the same username, conflicts will occur.

To avoid conflicts and problems caused by the network traffic, store the Autosave files locally, not in the model folder that is located on a network drive. Set the advanced option XS_AUTOSAVE_DIRECTORY, for example, to XS_AUTOSAVE_DIRECTORY=C:\TeklaStructuresModels\autosave. By saving autosave files locally you make sure that if there are problems in the network traffic, you are still able to save your own work.

1. On the File menu, click Settings --> Options, and in the General settings define the Autosave intervals for operations performed in the drawing and the model.
2. Periodically autosave the model manually.
   To do so, create a shortcut for the Autosave command. Click File menu --> Settings and in the Customize area select Keyboard shortcuts.

   NOTE Remember to save regularly to the master model by clicking Save.

See also
Error messages in multi-user mode (page 91)
Copy multi-user models (page 90)
How multi-user works (page 86)
Model history in multi-user mode
Tekla Structures collects model history on the actions that have taken place in the a model. In a multi-user model, the model history shows when the model has been changed, how the model has changed, who has made the changes, and the model revision comments.

Collect model history in multi-user mode
1. On the File menu, click Settings --> Advanced options.
2. Go to the Speed and accuracy tab.
3. Set XS_COLLECT_MODEL_HISTORY to TRUE.
4. Set XS_CLEAR_MODEL_HISTORY to FALSE.
5. Optional: Go to the Multi-user tab.
   Set XS_SAVE_WITH_COMMENT to TRUE.
   This enables the saving of model revision comments.

View model history in multi-user mode
To view model history, do one of the following:

- On the ribbon, click ? and select an object in the model.
  The model history is shown in the Inquire object dialog box.

- Create a model history report.
  1. On the Drawings & reports tab, click Reports.
  2. Select a report template that shows model history from the list. The name of the report template may vary in different environments.
     In the Default environment, the report template is called Q_Model_History_Report.
  3. Click Create from all to create a report on all the objects in a model, or select one or more objects in the model and click Create from selected to create a report from the selected objects.

Save model revision comments in multi-user mode
You can save model revision comments when working with multi-user models. This means that all objects which have been changed during the last save interval include the revision information in them. You can use this information in filtering and reports. You can also use it to examine which users have modified the objects.

- The Owner is the user, who has added the object into the model.
- History shows when the model has been changed, how the model has changed, who has made the changes, and the model revision comments.
Before you can save model revision comments, check the following:

- Set the advanced option XS_SAVE_WITH_COMMENT to TRUE in File --> Settings --> Advanced options --> Multi-user.
- Set the advanced option XS_COLLECT_MODEL_HISTORY to TRUE in File --> Settings --> Advanced options --> Speed and accuracy.

1. When you have set the advanced options mentioned above to TRUE, Tekla Structures displays the Model revision comments dialog box when you are saving the model. Enter the desired revision comment and code in the Model revision comment and Model revision code boxes.
2. Click OK.

Tekla Structures applies the values of this dialog box to parts that were changed after the last save. When you inquire objects, you can see the model revision information in the Inquire object dialog box. You can use this information also for selection and view filtering.

**Shutting down the model in multi-user mode**

Do not shut down the computer containing the master model while other users are working on their working models. They will not be able to save their changes to the master model.

If this does happen, to avoid losing any changes, follow the steps below:

1. Keep the working models open on the client computers.
2. Restart the computer containing the master model.
3. Open the master model on the computer containing it and autosave the model.
4. Click Save on the client computers to save the working models to the master model.

See also

- Saving in multi-user mode (page 87)
- Autosaving in multi-user mode (page 88)

**Copy multi-user models**

1. Have all users save and close their working models.
2. On the File menu, click Open --> All models.
3. From the list of models, select the multi-user model and click Convert to single-user model --> Convert.
4. Use Save as to make a copy of the model.
5. Exit Tekla Structures and re-open the model in multi-user mode to continue working on it.

**Display active multi-users**
You can display information on users working on the same server.

To display active multi-users, click **File menu --> Sharing --> Active multi-users**.

The **Active Multi-Users** dialog box displays the following information:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Locked</td>
<td>The time when the model was locked.</td>
</tr>
<tr>
<td>Model name</td>
<td>The name of the model.</td>
</tr>
<tr>
<td>User</td>
<td>Users that are currently working on models on the server.</td>
</tr>
<tr>
<td>Latest login</td>
<td>The time when the users have logged in.</td>
</tr>
<tr>
<td>Latest access to server</td>
<td>The time when the users have last accessed the server.</td>
</tr>
<tr>
<td>Editing drawings</td>
<td>The drawings that are currently being edited.</td>
</tr>
<tr>
<td>Edited drawings</td>
<td>The drawings that have been edited and saved to the server.</td>
</tr>
</tbody>
</table>

**TIP** The **Active Multi-Users** dialog box is refreshed every 30 seconds. You can refresh it immediately by clicking **Refresh**.

**Error messages in multi-user mode**

<table>
<thead>
<tr>
<th>Error message</th>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database write conflicts detected</td>
<td>More than one user has changed an object.</td>
<td>Check the conflict.log. It lists the GUID numbers of the objects that more than one user has changed. This is not usually a critical problem. No need to use the <strong>Check database</strong> tool. See also <strong>Saving in multi-user mode</strong> (page 87)</td>
</tr>
<tr>
<td>Error message</td>
<td>Problem</td>
<td>Solution</td>
</tr>
<tr>
<td>------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Could not save model. Possible reasons are:</td>
<td>You tried to save a multi-user model to a computer or folder that you could not access.</td>
<td>• Check that you have permission to write to the model folder.</td>
</tr>
<tr>
<td>- disk is full or write protected</td>
<td></td>
<td>• Check that there is enough disk space to save the model.</td>
</tr>
<tr>
<td>- locked .tmp-file(s) exists in the model directory</td>
<td></td>
<td>• Restart the computer where you want to save the model. Try to save the model again.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Delete the .tmp files from the model directory.</td>
</tr>
<tr>
<td>Database locked</td>
<td>Computer stopped responding while saving the model, which locks the model.</td>
<td>To unlock the model, the user whose operating system stopped responding should open the model in multi-user mode and save it.</td>
</tr>
<tr>
<td>cannot open model</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cannot read autosaved model as a normal model in the multi-use mode</td>
<td>The opening of a multi-user Autosave file has been prevented in single-user mode to prevent the reading of wrong file types.</td>
<td>Do not rename or move Autosave files. Do not open the Autosave file of a single-user model in multi-user mode or versa versa.</td>
</tr>
</tbody>
</table>

**Remove inconsistencies from a multi-user database**

To preserve the integrity of your multi-user model, you need to remove any inconsistencies from the multi-user database at regular intervals, for example once a day. This may also fix assemblies with no main part and drawings of unknown (U) type.

We recommend you to check the multi-user database in single-user mode.

1. Have all other users exit the multi-user model.
2. Save your model to receive the modifications of other users.
3. Exit the model.
4. Open the model in single-user mode.
5. Exit the model without saving.
6. Re-open the model.
7. On the File menu, click Diagnose & Repair and in the Model area, click Repair model.

8. Save the model.

9. Exit the model.

10. Re-open the model in the multi-user mode.

**Modeling in multi-user mode**

Before you start a project, assign each user an area of the model. To prevent potential save conflicts, you need to avoid having more than one user working on the same, or adjacent model objects. See also *Saving in multi-user mode* (page 87).

**Example**

If three users are to model a project, User #1 could model columns, User #2 the 1st floor beams, and User #3 the 2nd floor beams.

In the following example, three users are working on the same model. You can see how modeling and saving works in practice.

The master model contains columns and grids, as you can see here.

Each user opens the model in multi-user mode. All users are now working on working models, locally.

On the working models:
User #1 adds base plates to the columns:

User #2 adds and connects the 1st floor steel beams:

User #3 adds and connects the 2nd floor steel beams:
User #1 clicks **Save** to save to the master model. His working model now shows the base plates he added and looks like this:

User #2 clicks **Save** to save to the master model. His working model now shows his 1st floor framing and User #1’s base plates:
User #3 clicks **Save** to save to the master model. His working model now shows all three users’s work:

To see the updated master model, Users #1 and #2 need to save to the master model again to update their working models.
Numbering setup in multi-user mode

Define the numbering settings as follows:

1. **On the Drawings & reports tab, click Numbering settings.**

2. **In the Numbering setup dialog box, select the Synchronize with master model (save-numbering-save) check box.**

   When you select this check box, you can cancel the numbering before the last save is made. This is useful, for example, if you want to check the numbering results and you find something that you still want to change.

   **NOTE** When working with multi-user models, use this option always to prevent saving conflicts.

3. Modify the other properties as required.

4. **Click OK.**

   Tekla Structures will now save the model before and after you number all parts or modified parts.

When you click **Perform numbering** on the Drawings & reports tab to run numbering, Tekla Structures displays a list that shows the numbering progress. When the numbering is finished, the changed numbering results are highlighted in the list. When you select an item on the list, Tekla Structures highlights the corresponding object(s) in the model. If you keep the F key pressed when you select the item, Tekla Structures fits the work area of the current view around the objects.

If the numbering results are correct, click **Save numbers** to make the second save. To cancel the numbering before the second save, click **Cancel**. If you cancel the numbering, the model is returned to the state before numbering and standard files are read to all dialogs.

To review the numbering results further, click **Stop timer**.

To change the time frame in which Tekla Structures makes the second save, use the advanced option XS_NUMBERING_RESULTS_DIALOG_DISPLAY_TIME.

**NOTE** We recommend that you run the Diagnose & Repair Numbering: All command in File --> Diagnose & repair to remove any numbering inconsistencies from the multi-user database at regular intervals, for example once a day.
See also
Access rights in multi-user mode (page 102)

**Synchronize numbering with the master model**
If you need to include numbering information from areas in the model that have been modeled by other users:

1. Ask all users to save their working models. This updates the master model.
2. Number the model. Make sure that the **Synchronize with master model** (save-numbering-save) check box is selected in the **Numbering setup** dialog box (see Numbering setup in multi-user mode (page 97)). This updates your working model to the master model, numbers the master model, and then saves the numbered master model for all users to access.

**NOTE** If you create drawings and/or reports after numbering, you need to save the master model again to make them visible to other users.

**Drawings in multi-user mode**
The multi-user environment is very useful when several users are simultaneously editing drawings.

Tekla Structures saves each drawing in a unique file. These drawing files are located in the drawing folder in the master model folder.

The file is in the format **D000123456.dg**. The **dg** files are part of the model, so you can only open them using Tekla Structures.

**dg** files contain the locations of views, details of any editing done to the drawing, and the positions of dimensions, part marks, and text. The **dg** filename does not contain any reference to assembly, part, or multidrawing numbers.

If two users open and save the same drawing in their working models, then save their changes to the master model, one set of changes will be lost. The master model will only contain the changes of the user who most recently saved their working model to the master model. See **Saving in multi-user mode** (page 87).

The Tekla Structures multi-user server assigns the general arrangement drawing numbers automatically. This means that each drawing gets the first
free number available. If users A and B both create a general arrangement drawing at the same time, they are automatically assigned different numbers. The same applies to multidrawing numbers.

**See also**

Guidelines for multi-user drawings (page 99)
Locks for drawings in multi-user mode (page 100)

**Guidelines for multi-user drawings**

You may find the following guidelines useful when you edit or check drawings:

<table>
<thead>
<tr>
<th>Action</th>
<th>Recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saving drawings</td>
<td>Periodically save your working model to the master model (every 5–10 drawings).</td>
</tr>
<tr>
<td>Editing drawings</td>
<td>• Assign each user a different range of drawings to edit.</td>
</tr>
<tr>
<td></td>
<td>• Lock finalized drawings.</td>
</tr>
<tr>
<td></td>
<td>• If Tekla Structures displays the message <strong>Database write conflicts detected</strong> and a drawing ID number, two or more users have opened and saved the same drawing. See Drawings in multi-user mode (page 98).</td>
</tr>
<tr>
<td>Checking drawings</td>
<td>Only check locked drawings.</td>
</tr>
<tr>
<td>Printing drawings</td>
<td>Make sure that no-one else is working with the same drawing. If you print a drawing while someone else is editing it and then save the model, the other user’s changes will be lost, even though you have not opened, modified, or saved the drawing. You can disable the print date by using the advanced option XS_DISABLE_DRAWING_PLOT_DATE.</td>
</tr>
<tr>
<td>Creating general arrangement drawings</td>
<td>Create a set of empty general arrangement drawings in the beginning of the project, and assign a certain range of these ready-created empty drawings to each user (for example, GA1 to GA10 to User A, GA11-GA20 to User B and so on). This prevents overlapping general</td>
</tr>
<tr>
<td>Action</td>
<td>Recommendation</td>
</tr>
<tr>
<td>--------</td>
<td>----------------</td>
</tr>
<tr>
<td></td>
<td>arrangement drawing numbers in the project.</td>
</tr>
</tbody>
</table>

See also
Delete unnecessary drawing files in multi-user mode (page 100)

**Locks for drawings in multi-user mode**

When you are about to open a drawing, Tekla Structures displays a notification on the status of the drawing. The options are:

- Someone is already editing it.
- Someone has already edited it (drawing has been saved to their computer, but not yet to the server).
- The drawing has already been saved and there is a newer version available on the server.

**NOTE**

Locks for drawings are only used when a drawing is edited manually, not for example when drawings are automatically edited through cloning.

Note that to lock edited drawings, the XS_COLLECT_MODEL_HISTORY advanced option must be set to TRUE.

**Delete unnecessary drawing files in multi-user mode**

Every time you update a drawing, Tekla Structures creates a new drawing (.dg) file in the drawings sub-folder of the model. After that, the previous drawing file is not used and might become unnecessary. To delete the unnecessary drawing files in multi-user mode, see the following instructions.

**NOTE**

The drawing files that are not used are not always unnecessary. If you close the model without saving, or if Tekla Structures crashes and you cannot save the model, the drawing files that are not used can become necessary again. In these situations, you need the drawing files that were valid when you last saved the model and the drawing files that were valid when the last autosave was performed.

Having different versions of drawings allows you to revert to the previous versions of drawings. This is especially useful if two users have edited the same drawing.
Delete drawing files automatically in a multi-user model

In multi-user models, you can use the XS_DELETE_UNNECESSARY_DG_FILES and XS_DELETE_UNNECESSARY_DG_FILES_SAFETY_PERIOD advanced options to keep the number of drawing files reasonable.

The XS_DELETE_UNNECESSARY_DG_FILES advanced option defines if the unnecessary drawing files (.dg files) are automatically deleted or not. To automatically delete the drawing files that are no longer used, ensure that XS_DELETE_UNNECESSARY_DG_FILES is set to TRUE. The drawing files are deleted when the last user exits the model and saves the model.

The XS_DELETE_UNNECESSARY_DG_FILES_SAFETY_PERIOD advanced option defines how long the drawing files are kept before they are deleted. The default safety period is 7 days. This means that after 7 days, the drawing files that are not used are deleted when the XS_DELETE_UNNECESSARY_DG_FILES advanced option is set to TRUE. You can define a different safety period according to your needs.

The XS_DELETE_UNNECESSARY_DG_FILES and XS_DELETE_UNNECESSARY_DG_FILES_SAFETY_PERIOD advanced options work also in the models that are shared with Tekla Model Sharing.

Delete unnecessary drawing files manually in a multi-user model

The Remove unnecessary drawing files command deletes all drawing files that do not have a corresponding drawing in the current version of the model, regardless of the safety period. Note that also the drawing files that have a corresponding version in the last saved or autosaved version of the model are deleted, if there is no corresponding drawing in the current version of the model.

We recommend that you use the Remove unnecessary drawing files command when you want to archive the model or give the model to another user.

NOTE To avoid deleting drawing files that are still needed, we recommend that you only use the Remove unnecessary drawing files command if you are an experienced Tekla Structures user.

Before you use the Remove unnecessary drawing files command, ensure that:

• You are the only user that has the multi-user model open.

• You have full privileges (page 102) in the multi-user model. If you do not have full privileges in the model, you cannot delete the unnecessary drawing files manually.

To delete the unnecessary drawing files manually:

1. Save the model.

   Saving the model ensures that any drawings that are still needed are not accidentally deleted.
2. Convert the model to a single-user model. (page 84)

3. Search for the **Remove unnecessary drawing files** command in **Quick Launch**.

4. When Tekla Structures finds the command, select it and press **Enter**.
   Tekla Structures deletes all drawings that do not have a corresponding drawing in the current version of the model.

5. Convert the model back to a multi-user model. (page 85)

---

**Access rights in multi-user mode**

You can use privileges to control access rights. The person who has created the model, or anyone from the same organization, can control access rights to the model by using privileges. In practice, the privileges of the model are controlled via the **privileges.inp** file.

By modifying the **privileges.inp** file, you can control:

- access to modify user-defined attributes.
- access to modify object properties. This is done by locking and unlocking objects.
- access to modify numbering settings.
- access to remove users on multi-user server.
- access to save standard files.

You can prevent your model and drawings being accidentally modified by using the **Locked** user-defined attribute (UDA) or drawing locks, or locks in **Phase manager**. Using the **Locked** UDA and privileges together you can even restrict some users or organizations from modifying your model.

For example, you can limit access to the model so that a checker can only change status attributes. Or you could prevent certain users from changing the user-defined attributes used for approval or manufacturing and erection status.

---

*NOTE*  The **privileges.inp** file is also used in Tekla Model Sharing to control which users are allowed to modify the shared model objects or the shared drawings.

---

**Change access rights in the privileges.inp file**

How the privileges work:

- The **privileges.inp** file serves as a user interface for updating the privileges in a model.
• The privileges are loaded from the `privileges.inp` file and stored in the model.

• The privileges are loaded from the `privileges.inp` file only if the current user is allowed to do so.

• If there is no `privileges.inp` file or if it cannot be loaded, then the privileges that are already stored in the model (if any) are used.

• If you do not set any privileges, all users have full rights.

• Tekla Structures checks the privilege defaults in the `privileges.inp` file when you create a model, and each time you open a model.

• Tekla Structures searches for the file first in the current model folder, then in the folder defined for the advanced option XS_INP.

**NOTE** Only the person who created the model, or anyone from the same organization, can modify the privileges of the model via the `privileges.inp` file.

To change the access rights:

1. Close the model.
2. Open the `privileges.inp` file in any text editor.
3. Change the desired settings and save the file.
4. Re-open the model.

**Example**

Below is an example of the `privileges.inp` file. The slash (/) or backslash (\) separates the user name from the organization (`<organization>;<user>`). If no user name is entered, it means anyone in the company. Each row contains three columns, separated by tabs.

If you want to give the privileges only to one user or only to some users, you first have to exclude everyone and then include the users who you want to give the privileges.

Note that the organization and the user names are case sensitive. For example, `COMPANYA` is not the same as `companyA`. 
Options in the privileges.inp file

The following commands are available in the privileges.inp file:

- access to modify any user-defined attribute (UDA) - attribute:UDA_NAME
- access to modify object properties - attribute:OBJECT_LOCKED
- access to modify numbering settings - action:PartnumbersOptions
- access to perform numbering - action:PerformNumbering
- access to remove users in multi-user model - action:AllowMultiuserKick
- access to save standard files - action:SaveStandard
- access to add watermarks to printed drawings - action:DrawingWatermark

When you want to give the right only to one user or some users, you have to first exclude everyone and then include the users.

<table>
<thead>
<tr>
<th>Column</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>protected user-defined</td>
<td>attribute: name</td>
<td>Affects the protected user-defined attribute &quot;name&quot;. Check the exact spelling of the name in the objects.inp.</td>
</tr>
<tr>
<td>defined attribute</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OR</td>
<td>action: name</td>
<td>Affects the action &quot;name&quot;. The available actions:</td>
</tr>
<tr>
<td>action</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- PartnumbersOptions: Controls access to numbering settings.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Limitation: only full/none</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- PerformNumbering: Controls access to performing numbering.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Limitation: only full/none</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- AllowMultiuserKick: Controls access to removing users from a multi-user model.</td>
</tr>
<tr>
<td>Column</td>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>SaveStandard</strong>: Controls access to saving standard files. Limitations: only standard file.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>DrawingWatermark</strong>: Controls access to adding watermarks for printed drawings.</td>
</tr>
<tr>
<td>user</td>
<td>everyone</td>
<td>All users</td>
</tr>
<tr>
<td></td>
<td>domain/</td>
<td>Affects all users within the network domain &quot;domain&quot;.</td>
</tr>
<tr>
<td></td>
<td>domain/nn</td>
<td>Affects the user &quot;nn&quot; in the network domain &quot;domain&quot;.</td>
</tr>
<tr>
<td></td>
<td>nn</td>
<td>Affects the user &quot;nn&quot;.</td>
</tr>
<tr>
<td>rights</td>
<td>full</td>
<td>User can change the user-defined attribute.</td>
</tr>
<tr>
<td></td>
<td>view</td>
<td>User can view the user-defined attribute, but not change it. This option appears dimmed to the user.</td>
</tr>
<tr>
<td></td>
<td>none</td>
<td>The user-defined attribute is hidden from the user.</td>
</tr>
</tbody>
</table>

**User-defined attribute Locked**

To protect objects from being accidentally modified, you can use the **Locked** user-defined attribute (UDA).

You can use it for
- parts (separately for beams, columns, etc.)
- bolts
- welds
- specific drawing types
- project properties
- phase properties

The **Locked** user-defined attribute (UDA) has three values, **Yes**, **No** and **Organization**. When set to **Yes**, the object is locked and you cannot modify its properties. You can only change the object's user-defined attributes that do not affect numbering. If you try to modify a locked object, Tekla Structures displays the following warning message:

"There are locked objects, see report. The operation could not be performed."
The **OBJECT_LOCKED** attribute in the objects.inp file defines whether the **Locked** user-defined attribute (UDA) is visible in the Tekla Structures user interface.

**NOTE**  Make sure that numbering is up-to-date before you lock objects.

### Control access to lock and unlock objects in a multi-user model

Use the **OBJECT_LOCKED** attribute in the privileges.inp file to set users' access to the user-defined attribute (UDA) **Locked** and thus prevent users from locking and unlocking objects in the model.

#### Example

Only users **man** and **man2** have full rights to lock and unlock objects. The attribute is hidden from everybody else:

```
privileges.inp

attribute:OBJECT_LOCKED  everyone  none
attribute:OBJECT_LOCKED  man       full
attribute:OBJECT_LOCKED  man2      full
```

**NOTE**  To protect other user-defined attributes, you need to list them in the privileges.inp file.

### Control access to numbering in a multi-user model

Use the **PartnumbersOptions** in the privileges.inp file to restrict users' access to the numbering properties and thus prevent unauthorized users from modifying the numbering settings.

**NOTE**  Users can still run numbering even if they have no privilege to modify the numbering settings.

If a user who has no privilege to modify properties in the **Numbering Setup** dialog box tries to access the dialog box, Tekla Structures displays a warning message which states that the user does not have the required privilege.

#### Example

Only **admin** can modify the properties in the **Numbering Setup** dialog box:

```
privileges.inp

action:PartnumbersOptions  everyone  none
action:PartnumbersOptions  ORGANIZATION\admin  full
```
Control access to save standard files in a multi-user model
Use the `SaveStandard` action in the `privileges.inp` file to control users' access to save standard files.

Example
Only `admin` has rights to save standard files in network domain `ORGANIZATION`:

```
privileges.inp
  action:SaveStandard   everyone   none
  action:SaveStandard   ORGANIZATION\admin   full
```

Control access to remove users from a multi-user model
Use the `AllowMultiuserKick` action in the `privileges.inp` to restrict permissions to remove users from a multi-user model.

You can define that undesired active multi-users can be removed from the user list in the **Active multi-users** dialog box. This is useful, for example, if an application error has occurred on the user's computer, and the locks on locked objects need to be cleared by removing the user.

Define the `AllowMultiuserKick` action in the `privileges.inp` file and give full permissions to the user who you want to be able to remove other users from the model.

Example
Only user `jsmith` has full permissions to remove users:

```
privileges.inp
  action:AllowMultiuserKick   everyone   none
  action:AllowMultiuserKick   jsmith   full
```

To remove a user:
1. On the **File** menu, click **Sharing --> Active multi-users**.
2. Right-click a user who you want to remove and select **Clear locks**.
3. Click **Refresh** to remove the user.
   All the locks that the user has on objects and the user are removed.

1.3 Trimble Connect
Trimble Connect is a collaboration tool that connects the constructible data. Trimble Connect enables architects, engineers, contractors, owners and
operators to collaborate in building projects. All the data is stored in a cloud service.

You can share model information between Tekla Structures and Trimble Connect for Windows or Trimble Connect for Browser applications. Link the Tekla Structures model to a Trimble Connect project, and then, for example, add, upload, and download files and open the 3D view of the project.

You can upload a Tekla Structures model to a Trimble Connect project as a .tekla file, download a reference model from a Trimble Connect project, or export model objects as .ifc reference models to Trimble Connect projects.

To transfer the reference models and overlay models between Tekla Structures and Trimble Connect, use the Trimble Connector tool.

**Link a Tekla Structures model to a Trimble Connect project**

To start collaboration between Tekla Structures and Trimble Connect, you need to link your Tekla Structures model to a Trimble Connect project.

1. To start linking your model to a Trimble Connect project, do either of the following:
   - To link a new model, select the **Start Trimble Connect collaboration** check box when you create a new model.
   - To link an open model, go to File --> Trimble Connect --> Start collaboration.

2. According to your needs, do either of the following:
   - To link the model to a new Trimble Connect project, type a name for the project in the field at the top of the Select project dialog box.
   - To link the model to an existing Trimble Connect project, select the project from the list at the top of the Select project dialog box.

3. Select the geographical location of the new project from the **Project Server Location** list.
   The options are:
   - asia
   - europe
   - northAmerica
   - australia
   Project server locations cannot be changed after the project has been created.

4. Select your Trimble Connect subscription from the **License** list.
5. Click Create or OK.

The model is linked to the selected Trimble Connect project. You can now start working and, for example, download or upload reference models, add Trimble Connect models as overlays on top of the model, or add BCF topics.

6. To unlink a Tekla Structures model from the Trimble Connect project:
   a. Go to File --> Trimble Connect --> Exclude from collaboration.
   b. To confirm unlinking the model from the linked Trimble Connect project, click OK.

See also

Upload a Tekla Structures model to a Trimble Connect project (page 110)
Launch Trimble Connect from Tekla Structures (page 109)
Work with BCF Topics in Tekla Structures (page 113)
Manage reference models in a Trimble Connector (page 126)

Launch Trimble Connect from Tekla Structures

You can launch Trimble Connect in multiple ways in Tekla Structures.

To launch Trimble Connect for Windows or Trimble Connect for Browser, click one of these buttons on the Trimble Connect ribbon tab:

<table>
<thead>
<tr>
<th>Click this</th>
<th>This is what happens</th>
</tr>
</thead>
</table>
| ![For Browser](image) | • If you have linked the Tekla Structures model to a Trimble Connect project, the project Explorer page opens in Trimble Connect for Browser. You can create new folders, Sketchup models, or map workspaces. You can also upload new files.  
• If you have not linked the Tekla Structures model to a project, the Select project dialog box opens whenever you click ![For Browser](image) or any of the menu options underneath it. To link the model to a project, see Link a Tekla Structures model to a Trimble Connect project (page 108). |
<table>
<thead>
<tr>
<th>Click this</th>
<th>This is what happens</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>For Browser --&gt; Project explorer</strong></td>
<td>The project <strong>Explorer</strong> page opens in Trimble Connect for Browser. You can create new folders, Sketchup models, or map workspaces and manage the attached files. You can also upload new files.</td>
</tr>
<tr>
<td><strong>For Browser --&gt; 3D view</strong></td>
<td>The 3D model view opens in Trimble Connect for Browser 3D Viewer. You can adjust how 3D models in the project are shown, select objects, and add BCF topics, views, markups, clip planes, and measurements.</td>
</tr>
<tr>
<td><strong>For Browser --&gt; Team</strong></td>
<td>The <strong>Team</strong> page for the linked project opens in Trimble Connect for Browser. You can invite new users to the project, create user groups and add members to them, and manage user roles.</td>
</tr>
<tr>
<td><strong>For Windows</strong></td>
<td>• If you have linked the Tekla Structures model to a Trimble Connect project, the project detail view opens in Trimble Connect for Windows. You can see the details of the linked project. You can also add, upload, and download files and open the 3D view of the project. • If you have not linked the Tekla Structures model to a project, the projects view opens in Trimble Connect for Windows. You can see a list of your projects. You can open any project, add new projects, or sort and search for projects. • If you have not installed Trimble Connect for Windows, the web page to download Trimble Connect for Windows opens: <a href="#">Download Connect Apps</a>.</td>
</tr>
</tbody>
</table>

**Upload a Tekla Structures model to a Trimble Connect project**
You can upload the current Tekla Structures model to a Trimble Connect project folder as a read-only .tekla file. The .tekla file can then be used as a lightweight reference model with Tekla Structures or any Trimble Connect product. The .tekla reference models list and visualize model objects, parts, rebars, bolts, welds, surface treatment, surface objects, slotted holes, assemblies, and grids.
Before you upload your model to Trimble Connect, note the following:

- Profiles are exported with high solid accuracy, meaning that the rounding on profiles is visible.

  High solid accuracy affects Tekla Structures performance. If you do not want to use the high solid accuracy, set the advanced option XS_HIGH_ACCURACY_TRIMBIM_EXPORT to FALSE.

- Object colors in the .tekla reference model might be different than in the Tekla Structures model.

- Layers are available in .tekla models. Tekla Structures objects are grouped to different layers according to a template attribute or user-defined attributes. You can include layers in .tekla upload.

To define which template attributes and user-defined attributes are uploaded with the model:

1. Go to ...\TeklaStructures\<version>\Environments\common\system\UploadToConnect.
2. Copy the part.epr file to the \attributes sub-folder under the model folder.
3. Open the part.epr file in a text editor, such as Microsoft Notepad.
4. For each supported object type, define the template and user-defined attributes using the following syntax. Note that to include layers, you need to add a line for the layers in the following format: "layer": ["TEMPLATE_FIELD"].

You cannot change the units that are used for attributes.

```json
{
  "part": ["PART_POS", "NAME", "USERDEFINED.USER_FIELD_1"],
  "assembly": ["ASSEMBLY_POS", "USERDEFINED.PRELIM_ASSEM_MARK" ],
  "bolt": ["NAME", "BOLT_STANDARD", "DIAMETER" ],
  "rebar": ["REBAR_POS", "NAME", "GRADE", "SIZE", "LENGTH", "WEIGHT" ]
  "layer": ["ASSEMBLY_POS"]
  "weld": ["WELD_SIZE1", "WELD_SIZE2", "WELD_TYPE1", "WELD_TYPE2", "LENGTH", "WELD_ASSEMBLYTYPE", "WELD_EDGE_AROUND", "WELD_INTERMITTENT_TYPE"]
}
```

5. Save the part.epr file.

- To include pours and pour units in the .tekla model instead of cast units and cast unit parts, you need to enable pour management.

To disable pours and include cast units and cast unit parts:

1. Go to ...\TeklaStructures\<version>\Environments\common\system\UploadToConnect.
2. Copy the conf.json file to the \attributes sub-folder under the model folder.
3. Open the `conf.json` file in a text editor, such as Microsoft Notepad.
4. Change "pours" : "model" to "pours" : "false".
5. Save the `conf.json` file.

To upload a Tekla Structures model to a Trimble Connect project:
1. On the **File** menu, go to **Settings** --> **Advanced options**.
2. In the **Advanced options** dialog box, find the `XS_CONNECT_UPLOAD_MODEL_FOLDER` option.
3. Type or paste a file path to the Trimble Connect folder where you want to upload the Tekla Structures model.
   The default file path is `Structural\Tekla models`.
4. Click **OK** to save the folder path.
5. Go to the **Trimble Connect** ribbon tab, and click **Upload model**.
6. To confirm saving the model and uploading the entire model folder to the attached Trimble Connect project, click **Save and upload**.

As a result, the Tekla Structures model is uploaded as a `.tekla` file to the Trimble Connect project folder that you defined.

An error message is displayed if the model upload to Trimble Connect fails. In case of upload errors, see the `PublishToTrimbleConnect.log` file, which you can find in the `/logs` sub-folder under the model folder.

If needed, you can later attach the file to your model as an overlay model (page 130).

Note that if you want to move the model to another folder after uploading it, you need to do so manually in Trimble Connect.

To upload a Tekla Model Sharing model to a Trimble Connect project:

The **Upload model** button does not upload Tekla Model Sharing models to a Trimble Connect project. Instead, use the `XS_UPLOAD_SHARED_MODEL_TO_CONNECT` advanced option to select if and when a Tekla Model Sharing model is uploaded to a Trimble Connect project folder.

In the **Advanced options** dialog box, set the value of `XS_UPLOAD_SHARED_MODEL_TO_CONNECT` to one of the following:

- **BASELINE** = The Tekla Model Sharing model is automatically uploaded to the set Trimble Connect project folder each time a user creates a new baseline.
- **WRITEOUT** = The Tekla Model Sharing model is automatically uploaded to the set Trimble Connect project folder after each successful write out.
• If you do not want to upload the model to a Trimble Connect project folder, clear the Value field.

See also

Trimble Connector (page 124)
Manage overlay models in Trimble Connector (page 130)

Work with BCF Topics in Tekla Structures

BCF topics are notes that are added to a linked Trimble Connect project. BCF stands for BIM Collaboration Format and it is an open industry standard from buildingSMART International. Using the BIM Collaboration Format (BCF), you can communicate project-based issues between different BIM applications, such as Tekla Structures, Tekla PowerFab and Trimble Connect, as well as other 3rd party applications. BCF topics are stored and managed in a Trimble Connect project.

Before you can start adding BCF topics in Tekla Structures, your model needs to be linked to a Trimble Connect project. See instructions here: Link a Tekla Structures model to a Trimble Connect project (page 108).
BCF topics can be used with .tekla, .ifc, and .trb files that are created from a Tekla Structures model and uploaded to Trimble Connect.

- A .tekla file that is created when you upload the current Tekla Structures model to a Trimble Connect project. Using a .tekla file is the preferred way of working.
  
  If you are using Tekla Model Sharing with a Trimble Connect project, the model is automatically uploaded when you write out or create a new baseline.

- An .ifc file that is created from a Tekla Structures model and uploaded to a Trimble Connect project.

- A .trb file that is created from a Tekla Structures model when exporting to Tekla PowerFab and uploaded to a Trimble Connect project.

Create and modify BCF topics

Before you start adding BCF topics in Tekla Structures, ensure that your model is linked to a Trimble Connect project.

Use topics to communicate, assign, track and resolve issues within a project. You can view all the topics that you have created or that have been assigned to you in the Tekla Structures BCF Topics side pane.

1. On the Trimble Connect ribbon tab, click BCF Topics.

   The BCF Topics side pane opens and displays the BCF topics added to the Trimble Connect project.

2. To create a new BCF topic, click the plus button.
The **New topic** page opens.
3. Fill in the fields.
   **Title** is mandatory.

4. Assign the topic to a user or a user group.
   The BCF topics are shared to all project members by default, but you can select a user or a user group to whom you want to assign the BCF topic with a due date when it needs to be resolved.

5. Use **Add references** to add references to documents or links.
   A topic can reference several documents or links. You can add, for example, a PDF file for reference.
   a. Click **Add references**.
   b. On the **Add references** page, select the type of reference that you want to add:
      - under 🔍, select the desired reference file from the list of project files.
        Attached project files always point to the latest version of the file stored in the Trimble Connect project.
      - under 🌐, browse for a desired reference file to add a new file.
      - under ☑️, add the display text for the desired link and the URL.
   c. Click **Add references**.
   d. To add or remove reference files:
      - to add more reference files, click ✗ to open the **Add references** page.
      - to remove a reference file, click ✗ next to the file.

   You can work with the references also on the **References** page after the BCF topic is created.

6. Use **Add models** to add model files, if needed.
   To enable the collaboration workflow using BCF topics, you need to have a model uploaded to a Trimble Connect project. The preferred way of working is to upload your model as a .tekla file. If you have already uploaded a .tekla file to the linked Trimble Connect project, you do not need to use the **Add models** option.

   If you are using an .ifc or a .trb file instead of a .tekla file, use the **Add models** option to select the file that contains the objects associated to the BCF topic that you are creating in Tekla Structures.
Note that if you are using .ifc or .trb files, you need to manually associate each BCF topic with an .ifc or a .trb file when you create BCF topics in Tekla Structures. You can associate your BCF topics with several .ifc or .trb files at once.

In Trimble Connect the association happens automatically, and therefore the Add models command is not available in Trimble Connect. When BCF topics are created in Trimble Connect, Trimble Connect knows which models are visible in the view and stores that information with the BCF topics. These BCF topics will work correctly in Tekla Structures.

a. Click Add models.

b. On the Add models page, select the type of model file that you want to add:

   • under , select the desired model file from the list of project files.
   • under , browse for a desired model file to add a new file.

c. Click Add models.

d. To add or remove model files:

   • to add more model files, click to open the Add models page.
   • to remove a model file, click next to the file.

You can work with the models also on the Models page after the BCF topic is created.

7. Click Save.

A view is automatically always added to each new topic.

The saved BCF topic is immediately synchronized to Trimble Connect.

You can then continue by adding, for example, comments and views with graphical markups and measurements.

In Trimble Connect, you can see the BCF topics on the BCF Topics page of the linked project.
8. If you want to further edit a BCF topic in Tekla Structures:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define which topics are shown on the Topics page in BCF Topics side pane</td>
<td>In the BCF Topics side pane, click the arrow under Topics and select the option. By default, the Active topics are shown.</td>
</tr>
<tr>
<td>Sort the topics</td>
<td>In the BCF Topics side pane, click at the top of the side pane and select the sorting option. The default sorting order is by Creation date.</td>
</tr>
<tr>
<td>Edit a topic</td>
<td>You can edit topics that you have created or that have been assigned to you.</td>
</tr>
<tr>
<td>a. In the BCF Topics side pane, select the BCF topic that you want to edit. The topic opens on its own page.</td>
<td></td>
</tr>
<tr>
<td>b. Click Edit.</td>
<td></td>
</tr>
<tr>
<td>c. Adjust the BCF topic information according to your needs.</td>
<td></td>
</tr>
<tr>
<td>d. To save the changes, click Save.</td>
<td></td>
</tr>
<tr>
<td>To</td>
<td>Do this</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Assign a topic</td>
<td>You can assign topics that you have created or that have been assigned to you.</td>
</tr>
<tr>
<td>a.</td>
<td>In the <strong>BCF Topics</strong> side pane, select the BCF topic that you want to assign to someone. The topic opens on its own page.</td>
</tr>
<tr>
<td>b.</td>
<td>Click <strong>Edit</strong>.</td>
</tr>
<tr>
<td>c.</td>
<td>In the <strong>Assignee</strong> field, enter the names of the users or the user groups. There can be multiple users or user groups listed in the <strong>Assignee</strong> field.</td>
</tr>
<tr>
<td>d.</td>
<td>To save the changes, click <strong>Save</strong>.</td>
</tr>
<tr>
<td>Remove a topic</td>
<td>You can delete only the topics which you have created. Deleting topics from the project cannot be undone. If you delete a topic, the topic will be deleted for everyone for who it has been assigned to. All the data is deleted as well.</td>
</tr>
<tr>
<td>a.</td>
<td>In the <strong>BCF Topics</strong> side pane, select the BCF topic that you want to remove.</td>
</tr>
<tr>
<td>b.</td>
<td>Click <strong>Remove</strong>.</td>
</tr>
<tr>
<td>c.</td>
<td>Click <strong>Delete</strong>.</td>
</tr>
</tbody>
</table>

**Create measurements and markups**

You can create measurements and markups in BCF topics and show the measurements and markups both in Tekla Structures and in Trimble Connect. To add measurements and markups in the current model, use the measurement and markup tools in the **BCF Topics** side pane.

Markups and measurements are saved in a view. You cannot add them separately in an already existing view.

You cannot edit the inserted measurements or markups in Tekla Structures. You can edit them in Trimble Connect and transfer them to Tekla Structures by creating a new view.

<table>
<thead>
<tr>
<th>Option</th>
<th>How to use</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="select-type" alt="Left Arrow Straight" /> <img src="measurement-type" alt="Right Arrow Straight" /></td>
<td>Select the type of the measurement that you want to create.</td>
</tr>
<tr>
<td><img src="distance" alt="Left Arrow Double" /> <img src="distance" alt="Right Arrow Double" /></td>
<td>Show the distance between two points.</td>
</tr>
<tr>
<td>1.</td>
<td>In the model, pick the start point for the measurement.</td>
</tr>
<tr>
<td>Option</td>
<td>How to use</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>2. Pick the second point.</td>
<td></td>
</tr>
<tr>
<td>3. Pick the point where you want to place the measurement.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Icon" /> Show the coordinates of a single point.</td>
<td>• In the model, pick the point whose coordinates you want to show.</td>
</tr>
</tbody>
</table>
| ![Icon](image) Show the angle measurement between two points. | 1. In the model, pick the vertex point of the angle.  
2. Pick the first side of the angle.  
3. Pick the second side of the angle. |
| ![Icon](image) Select the type of the markup that you want to create. | Add a cloud markup.  
1. In the model, pick the center point of the cloud.  
2. Pick the second point. Picking the second point defines the size of the cloud markup. |
| ![Icon](image) Add an arrow markup. | 1. In the model, pick a point for the arrow head. This point is the start point of the line.  
2. Pick the second point. This point is the end point of the line. |
| ![Icon](image) Add a line markup. | 1. In the model, pick the start point of the line.  
2. Pick the end point of the line. |
<table>
<thead>
<tr>
<th>Option</th>
<th>How to use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a text markup. Text markup consists of text and a leader line. You cannot edit text after it has been inserted in the model.</td>
<td></td>
</tr>
<tr>
<td>1. Type the text in the text field under the markup tools.</td>
<td></td>
</tr>
<tr>
<td>2. In the model, pick the start point for the text leader line.</td>
<td></td>
</tr>
<tr>
<td>3. Pick the point where you want to place the text.</td>
<td></td>
</tr>
<tr>
<td>Draw a freehand markup.</td>
<td></td>
</tr>
<tr>
<td>1. In the model, pick a point where you want to start drawing.</td>
<td></td>
</tr>
<tr>
<td>2. Move the mouse to draw.</td>
<td></td>
</tr>
<tr>
<td>3. To finish, left-click the mouse.</td>
<td></td>
</tr>
<tr>
<td>Select the color for the measurements and markups.</td>
<td></td>
</tr>
<tr>
<td>In addition to the predefined set of colors, you can use your own custom colors:</td>
<td></td>
</tr>
<tr>
<td>1. Click the plus button to open the color picker.</td>
<td></td>
</tr>
<tr>
<td>2. Define the suitable color.</td>
<td></td>
</tr>
<tr>
<td>Use the color slider on the left to go to the desired color, and the transparency slider at the bottom. Then pick the desired shade in the color area with the color picker.</td>
<td></td>
</tr>
<tr>
<td>3. Click <strong>Save</strong> to save the color to the list of <strong>Custom</strong> colors.</td>
<td></td>
</tr>
<tr>
<td>The custom colors remain on the list of colors even if the model is reopened.</td>
<td></td>
</tr>
<tr>
<td>Remove all markups from the model.</td>
<td></td>
</tr>
<tr>
<td>Click the delete button at the bottom of the measurement tool list or the markup tool list to remove all the measurements or markups from the model.</td>
<td></td>
</tr>
<tr>
<td>You cannot delete single measurements or markups.</td>
<td></td>
</tr>
</tbody>
</table>
**Add views**

1. In the **BCF Topics** side pane, select the BCF topic that you want to add views to.

2. Click **Views** to open the views page.
   
   You can see the views that have been added to the topic. A topic can have multiple views.

3. To add a new view, click **Add**.
   
   A new view is added to the topic. The view is taken from the visible model view.

4. To delete a view, click at the bottom corner of the selected view. Click **Preview --> Delete**.
   
   Deleting views cannot be undone.

**Add comments**

1. In the **BCF Topics** side pane, select the BCF topic that you want to add comments to.

2. Click **Comments** to open the comments page.
   
   The comments made by different project members are listed as a comment thread showing who made the comment and when.

3. To add a new comment, click **Add comment**.

4. Type any comments. You can also add attachments or an image.

   - Click **Add** to add attachments. Attachments can be project files or local files.
   
   - Click **Add** to add an image of the current model view.

5. Click **Comment**.

6. To edit or delete a comment, select the comment and click **Edit**, or **Delete --> Delete**.
   
   Deleting comments cannot be undone.
**Add markers**

A marker can be used to specify the exact location of the topic in the model view by using x, y, and z coordinates.

You can add only one marker to each topic, but all the model markers are displayed in the model.

1. In the **BCF Topics** side pane, select the BCF topic that you want to add markers to.

2. Click ☰️ **Models** to open the models page.

3. To add a marker, click **Add a marker** and pick a point in the model where the marker is added.

   The exact coordinates of the picked point are added to the marker.

4. To delete a marker, click ☰️ next to the marker coordinates and select **Remove**.

**Link model objects**

If a topic is relevant to a specific model objects, you can link the model objects to topics. The model object identifiers are saved to the topic data as references.

Note that BCF topics are not yet supported in the Trimble Connect 2D viewer.

1. In the **BCF Topics** side pane, select the BCF topic that you want to add model objects to.

2. Click ☰️ **Models** to open the models page.

3. To link the selected model objects to the topic, select the objects in the model and click **Link selected**.

   The objects are linked to the topic. The total number of linked objects can be seen in the **Linked model objects** section title.

4. To view the linked model objects, click **View model objects**.

   The objects are highlighted in the model view.

5. To remove some of the linked model objects from a topic, select the objects in the model and click **Unlink selected**.

6. To remove all linked model objects from a topic, click ☰️ and select **Unlink all**.
**Export BCF topics**
You can export BCF topics as `.bcf` files or as in `.pdf` format.

Note that the BCF files contain only the topics data. Often the topics refer to models via 3D views. The models need to be exported separately as the model files are not included in the BCF files.

1. In the **BCF Topics** side pane, select the BCF topic that you want to export.

2. Click at the top row of the topic and select **Export**.
   
   The **Export BCF Topics** page opens.

3. Enter a name for the export and select the file format to export and the details to be included in the export.
   
   Selecting the **Reference documents** does not include the actual documents in the export, but a reference to the original document that is located in a Trimble Connect project.
   
   When the export is ready, it is shown in the **Exporting topics** section of the **BCF Topics** side pane.

4. To download the exported files, click **See export history**.
   
   Exported files are available for download for 31 days after the export job is completed. After the time period the download button is expired and the original export file is not available from the export history.

**Change the language of the BCF Topics side pane**
You can change the language of the **BCF Topics** side pane, if needed. Note that changing the language in Tekla Structures does not affect the language of the **BCF Topics** side pane.

1. In Trimble Connect, go to your Trimble Connect profile.

2. In your **Language Preference**, select a language from the list.
   
   This language selection is for Trimble Connect, and for the **BCF Topics** side pane in Tekla Structures.

3. Click **Save**.

4. Reopen the Tekla Structures model for the change to take effect.

**Trimble Connector**
Trimble Connector enables the connection between Tekla Structures and Trimble Connect for Browser or Trimble Connect for Windows for managing the reference models and overlay models in the linked Trimble Connect project.

Working collaboratively within a Tekla Structures model 124 Trimble Connect
With Trimble Connector, you can:

- link a Tekla Structures model to a Trimble Connect project
- create a new Trimble Connect project
- download a reference model or reference model updates from a Trimble Connect project to a Tekla Structures model
- upload a reference model to a Trimble Connect project
- export Tekla Structures model objects as .ifc reference model to Trimble Connect projects

All operations between Tekla Structures and Trimble Connect use the project base point. This means that, for example, reference models from Tekla Structures are placed in relation to the project base point in Trimble Connect. If you have not defined a project base point, the model origin is used.

**NOTE** Trimble Connect related metadata and all reference models are located in the ..\TeklaStructuresModels\<model>\TConnect folder. Exported reference model settings are stored to the ..\TeklaStructuresModels\<model>\Links folder. Trimble Connector does not work correctly if you manually modify the files in these folders.

### Launch Trimble Connector

You can launch Trimble Connector in multiple ways.

<table>
<thead>
<tr>
<th>To launch Trimble Connector</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Through the ribbon</td>
<td>On the Trimble Connect ribbon tab:</td>
</tr>
<tr>
<td></td>
<td>Click Models.</td>
</tr>
<tr>
<td></td>
<td>The Trimble Connector - Models dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>For more information on managing reference models, see Manage reference models in a Trimble Connector (page 126).</td>
</tr>
<tr>
<td>Using File --&gt; Import command</td>
<td>Click File --&gt; Import --&gt; Trimble Connect to download a reference model from any Trimble Connect project to a Tekla Structures model.</td>
</tr>
<tr>
<td>Using File --&gt; Export command</td>
<td>Click File --&gt; Export --&gt; Trimble Connect to publish an IFC reference model of the open Tekla Structures model to any Trimble Connect project.</td>
</tr>
</tbody>
</table>

The Trimble Connector - Models dialog box opens. You can link your model to a Trimble Connect project if you have not done that earlier. You can also create a new project.
**Manage reference models in a Trimble Connector**

Reference models are part of the Tekla Structures model, and they can be downloaded from, or exported to Trimble Connect projects.

On the Trimble Connect ribbon tab, click Models to start managing reference models.

The Trimble Connector - Models dialog box opens. You can manage reference models on the Reference models tab, and overlay models on the Overlay models tab.

For more information about differences between reference models and overlay models, see Should I use reference models or overlay models in Trimble Connector? (page 133).

**Upload reference models or reference model updates to a Trimble Connect project**

You can upload both new Tekla Structures reference models or updated versions of Tekla Structures reference models to attached Trimble Connect projects.

New and updated reference models are marked in different ways:

<table>
<thead>
<tr>
<th>Icon or label</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>🌲</td>
<td>The Tekla Structures reference model has not been uploaded to a Trimble Connect project.</td>
</tr>
<tr>
<td>🪤</td>
<td>The newest version of the Tekla Structures reference model has not been uploaded to a Trimble Connect project.</td>
</tr>
<tr>
<td>✔️</td>
<td>The reference model has the same version in Tekla Structures and in Trimble Connect.</td>
</tr>
</tbody>
</table>

1. Open the Reference models tab in the Trimble Connector - Models dialog box.
2. To upload a new reference model or a new version of the reference model to the Trimble Connect project, click the 🌲 icon.

**Download reference models or reference model updates from a Trimble Connect project**

You can download and insert either new or updated reference models from a Trimble Connect project to a Tekla Structures model.

The reference models and their versions are marked with different icons depending on whether they are up-to-date:
<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
</tr>
</thead>
</table>
| 🌥 | The reference model has been updated in the Trimble Connect project after the last time that it has been downloaded to Tekla Structures.  
  • Click 🌥 to download the latest version of the model. |
| 🌥 | The updated version of the reference model has not been downloaded to Tekla Structures.  
  • Click 🌥 to insert the version in the Tekla Structures model. |
| +  | The reference model version exists in the Tekla Structures model sub-folder but has not been inserted in the Tekla Structures model.  
  • Click + to insert the version in the Tekla Structures model. |
| ✓  | The reference model has the same version in Tekla Structures and in Trimble Connect. |

   A list of reference models in that folder is shown.
2. To show the versions of an reference model, click the arrow on the left side of the reference model name.
3. Do either of the following:
   • Select the reference model that you want to download and click 🌥.
   • Select the updated reference model version that you want to download and click 🌥.

   The new reference model or the updated reference model version is downloaded to a Tekla Structures model sub-folder and inserted to the Tekla Structures model.

Create new folders for reference models
2. In the **Select folders** dialog box, double-click the project to see the folders inside the project.

   If a folder has sub-folders, you can view them by double-clicking the folder.

3. Select one or more folders where you want to link the reference model and click **OK**.

   You can also create a new folder by typing a name for the folder and clicking **Create**, or remove an existing folder from the list by hovering over the folder and clicking ![trash can].

   The selected folders are added to the **Folders** list on the **Reference models** tab in the **Trimble Connector - Models** dialog box.

**Export Tekla Structures model objects as an .ifc reference model to a Trimble Connect project**

You can create an .ifc coordination view 2.0 file from Tekla Structures model objects and export it to a Trimble Connect project. You can create the file from selected model objects, or from all model objects.

1. Do one of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| Select to which Trimble Connect project and folder the .ifc reference model is exported | a. On the **File** menu, click **Export --> Trimble Connect**.  
The **Trimble Connector - Export IFC to Trimble Connect** dialog box opens.  
b. In the list at the top of the dialog box, select the Trimble Connect project.  
c. In the **Folder** list, select a folder in the selected Trimble Connect project. |

| Export the .ifc reference model to the linked Trimble Connect project | a. On the **Trimble Connect** ribbon tab, click **Models**.  
b. On the **Reference models** tab in the **Trimble Connector - Models** dialog box, double-click the folder where you want to save the exported reference model.  
c. To start the export, click ![arrow].  
The **Trimble Connector - Export IFC to Trimble Connect** dialog box opens. |

2. In the **Name** box, type a name for the exported model or model objects.  
   The name of the export needs to be unique within the project.

3. Select which model objects you want to export:
<table>
<thead>
<tr>
<th>To export</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>All model objects</td>
<td>In the Export list, select All.</td>
</tr>
<tr>
<td>Selected model objects</td>
<td>a. In the Export list, select Selected.</td>
</tr>
<tr>
<td></td>
<td>b. Select the objects in the model view.</td>
</tr>
<tr>
<td></td>
<td>To select the desired objects, ensure that you have the right selection switches activated.</td>
</tr>
<tr>
<td>Filtered model objects</td>
<td>a. In the Export list, select Filter.</td>
</tr>
<tr>
<td></td>
<td>b. Do any of the following:</td>
</tr>
<tr>
<td></td>
<td>• In the Filter list, select an existing filter.</td>
</tr>
<tr>
<td></td>
<td>• To create a new filter, click 🎨 next to Filter list.</td>
</tr>
<tr>
<td></td>
<td>For detailed instructions, see Create new filters.</td>
</tr>
</tbody>
</table>

4. Select which IFC settings you want to use:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use existing IFC export settings</td>
<td>In the IFC export settings list, select the settings file.</td>
</tr>
<tr>
<td></td>
<td>The settings file needs to be located in the model \attributes folder, so that you can select it in the IFC export settings list.</td>
</tr>
<tr>
<td>Create and use new IFC export settings</td>
<td>Click 🎨 next to the IFC export settings list.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Export in IFC format (page 218).</td>
</tr>
</tbody>
</table>

The .ifc file does not include assembly information, which means that you can only export main parts. You can add additional property sets by saving a property set through File --> Export --> IFC. Use the file name ifc.xml.

If you do not select a settings file in the IFC export settings list, Tekla Structures will not know which object types you want to export, so only surface geometry is exported.

5. Click OK.

When the .ifc model has been exported, you can download the reference model to the Tekla Structures model. Select the reference model in the Trimble Connector - Models dialog box, and click 🎨 . After a successful export, the model is marked with ✔️.
If the Tekla Structures model has an updated version of the exported reference model, click to export the updated version of the reference model.

If you have not defined where the .ifc model is positioned in the Export IFC dialog box, the exported IFC model is placed in relation to the project base point in the Trimble Connect 3D view. If a project base point has not been defined, the model is placed in relation to the model origin.

Manage overlay models in Trimble Connector
Overlay models are lightweight reference models that are stored in the attached Trimble Connect project. Overlay models can be quickly attached to the Tekla Structures model to show model objects on top of the Tekla Structures model. You can manage overlay models in many ways: for example, add new overlay models, adjust the scale and position of the overlay models, and inquire the properties of the overlay model objects.

Because overlay models are saved in the Trimble Connect project, you cannot use them in a Tekla Structures model unless the Tekla Structures model has been linked to a Trimble Connect project. Before you can start working with overlay models, link your Tekla Structures model to a Trimble Connect project. See instructions here: Link a Tekla Structures model to a Trimble Connect project (page 108).

To start managing overlay models:

1. On the Trimble Connect ribbon tab, click Models.
   The Trimble Connector - Models dialog box opens. You can manage overlay models on the Overlay models tab, and regular reference models on the Reference models tab.

2. In the Trimble Connector - Models dialog box, open the Overlay models tab.

Manage the visibility of overlay models
Do any of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Only show overlay model objects within the current work area</td>
<td>Select the Show inside work area only check box.</td>
</tr>
<tr>
<td>Show a list of all folders and overlay models in the Trimble Connect project</td>
<td>In the list at the top, select Everything in project.</td>
</tr>
<tr>
<td>Show a list containing only the folders and</td>
<td>In the list at the top, select Used in this model.</td>
</tr>
<tr>
<td>To</td>
<td>Do this</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>Overlay models that you can currently show or hide in this model</td>
<td></td>
</tr>
</tbody>
</table>
| Hide or show overlay models | • To hide an overlay model, click on the left side of the model.  
• To show an overlay model, click on the left side of the model.  
• To hide all overlay models in a folder, click on the left side of the folder.  
• To show all overlay models in a folder, click .  
If a folder or its sub-folders do not have any overlay models that can be shown in Tekla Structures, the arrow symbol is not shown next to the eye icon.  
If a model cannot be converted to the right format and therefore, cannot be shown, a warning icon (⚠️) is shown on the left side of the model. |
| Zoom to an overlay model | 1. In the list of overlay models, select the model to which you want zoom in.  
2. Click .  
3. Select Zoom to model.  
4. Select the model view in which you want to zoom.  
5. Click Yes to confirm zooming to the selected model view. |

**Add Overlay Models**

1. Select the folder in which you want to add a new overlay model.
2. Click .
3. Select Attach model.
4. In the Attach model dialog box, click Browse... and browse to find the overlay model.
5. Select the overlay model, and click Open.
6. In Location by, select one of the following options:
**Model origin** inserts the model relative to 0,0,0.

**Work plane** inserts the model relative to the current work plane coordinate system.

**Base point:** `<name of base point>` inserts the model relative to the base point by using coordinate system values **East coordinate**, **North coordinate**, **Elevation**, and **Angle to North** from the base point definition in **Project properties**.

7. Select where you want to place the overlay model. You can enter coordinates in the **Offset** boxes, or pick a position for the overlay model origin.

8. Set the **Scale** of the overlay model if it is different from the one in the Tekla Structures model.

   Note that you need to set the scale for a **DWG** or a file already in AutoCAD. When you define the measurement unit for a **DWG** or a **DXF** file and save the file in AutoCAD, the unit is recognized in Tekla Structures, and the overlay model is scaled correctly.

9. You can rotate the model around model Z axis by picking a location in the model or entering the desired value in the **Rotation** box.

   The maximum number of decimals for the rotation value is 7.

10. Click **Attach model**.

    The model version is added to the selected folder.

11. To show the new overlay model in the model view, click next to the overlay model.

**Create sub-folders for overlay models**

You can create sub-folders within the Trimble Connect project to categorize your overlay models. For example, you can create different sub-folders for overlay models according to their file format, their type, or their position in the project.

1. Select the folder under which you want to add a sub-folder.

2. Click on the right side of the folder.

3. Select **Create new folder**.

4. Name the sub-folder and click **Create**.

**Adjust the scale and position of overlay models**

A change in the model position or scale is applied to both Tekla Structures and Trimble Connect.

1. Select the overlay model whose position you want to adjust.
2. To show the model properties, click **Properties** at the bottom of the **Trimble Connector - Models** dialog box.

   Note that the properties are relative to the project base point.

3. Type new values for the scale, position, or rotation of the model.

4. To apply the changes to the Tekla Structures model view, click **Modify**.

   To return to the initial scale and position of the model, click **Reset**.

### Inquire overlay model objects

You can view the properties of objects and assemblies in overlay models by using the **Inquire** command.

1. Select an object or assembly in an overlay model.
2. Right-click the object or assembly.
3. Select **Inquire**.

   The **Inquire object** dialog box shows the properties of the selected object or assembly. The shown properties can differ depending on the overlay model and the model format. The name and the GUID of the overlay model are displayed at the top.

### Remove an overlay model from currently used models

1. Ensure that you have the **Used in the model** list open.
2. Select the overlay model that you want to remove.
3. Click ![Remove](image)
4. Select **Remove from used model** tree.

   The overlay model is removed from the **Used in the model** list.

   If you want to show the overlay model again, switch to the **Everything in project** list and click ![Show](image). The overlay model appears in the **Used in the model** list again.

### Should I use reference models or overlay models in Trimble Connector?

In the following tables, see the pros and cons of reference models and overlay models, and the operations that you can perform in these model types in the linked Trimble Connect project.

<table>
<thead>
<tr>
<th>Reference models</th>
<th>Overlay models</th>
</tr>
</thead>
<tbody>
<tr>
<td>+ Parts of the Tekla Structures model, so more operations are available</td>
<td>+ Fast to load and display</td>
</tr>
<tr>
<td>- Increase the size of the .db1 files</td>
<td>+ Allow each user to view the model versions that they need</td>
</tr>
<tr>
<td>Operation</td>
<td>Can you do it with reference models?</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------</td>
<td>--------------------------------------</td>
</tr>
<tr>
<td>View the model on top of a model (page 168)</td>
<td>Yes</td>
</tr>
<tr>
<td>View the model in a drawing</td>
<td>Yes</td>
</tr>
<tr>
<td>Inquire objects in the model</td>
<td>Yes</td>
</tr>
<tr>
<td>Filter objects in the model</td>
<td>Yes</td>
</tr>
<tr>
<td>Manage changes between model versions (page 130)</td>
<td>No</td>
</tr>
<tr>
<td>Detect clashes</td>
<td>Yes</td>
</tr>
<tr>
<td>Convert objects to native objects (page 196)</td>
<td>Yes</td>
</tr>
<tr>
<td>Add user-defined attributes</td>
<td>Yes</td>
</tr>
<tr>
<td>Use layers (page 168)</td>
<td>Yes</td>
</tr>
<tr>
<td>Create tasks</td>
<td>Yes</td>
</tr>
<tr>
<td>Create views from objects</td>
<td>Yes</td>
</tr>
<tr>
<td>Fit work area</td>
<td>Yes</td>
</tr>
<tr>
<td>Hide objects</td>
<td>Yes</td>
</tr>
<tr>
<td>Hide all objects from the view with display settings</td>
<td>Yes</td>
</tr>
<tr>
<td>Manage categories in</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**Manage overlay model versions in Trimble Connect**

You can have several versions of the same overlay models in your Trimble Connect projects, and view the differences between these versions in your Tekla Structures models. This way, you can see the progress of the project.

**NOTE** You need to save the new model versions with the same name and in the same folder as previous model versions.
Create overlay model versions

1. Create a new version of the overlay model.
   You can use external software to create overlay model versions, such as ArchiCad or Autodesk Revit, to create IFC model versions, or upload the Tekla Structures model to the Trimble Connect project as a .tekla file.

2. Do any of the following:

<table>
<thead>
<tr>
<th>To upload</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>A new model version in the .ifc format</td>
<td>Do any of the following:</td>
</tr>
<tr>
<td></td>
<td>• In the Trimble Connector - Models dialog box, open the folder where the previous model version is stored, and click next to the previous model version.</td>
</tr>
<tr>
<td></td>
<td>• In Trimble Connect for Browser, open the folder where the original model is stored, and drag and drop the new version of the model to the folder.</td>
</tr>
<tr>
<td>A new model version in another format</td>
<td>a. In the Trimble Connector - Models dialog box, select the folder where the original model version was saved.</td>
</tr>
<tr>
<td></td>
<td>b. Click and select Attach model.</td>
</tr>
<tr>
<td></td>
<td>c. Browse to the folder where you saved the new model version, and select the model version. The model version is added to the selected folder.</td>
</tr>
</tbody>
</table>

3. To see the overlay model versions, select the overlay model, and click Versions to expand the Versions section.

4. Select which version of the model you want to show:

<table>
<thead>
<tr>
<th>To show</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>The newest version of the model</td>
<td>Whenever the latest version of an overlay model is not shown, the symbol appears. The symbol is shown next to models whose old versions are shown, and folders in which you have saved the models whose old versions are shown.</td>
</tr>
<tr>
<td></td>
<td>Click next to the model or the folder in which the model is saved.</td>
</tr>
</tbody>
</table>
## To show

<table>
<thead>
<tr>
<th>An older version of the model</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click 🔄 next to the version that you want to see.</td>
</tr>
</tbody>
</table>

## Compare the differences between .tekla or .ifc overlay model versions

1. In the overlay model list, select an overlay model that has at least two versions in the attached Trimble Connect project.
2. At the bottom of the **Overlay models** tab, click **Versions**.
3. In the **Versions** section, do any of the following according to your needs:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| Define the properties to be compared | a. Click ... in the **Versions** section.  
b. In the **Comparison sets** dialog box that opens, select check boxes next to the properties that you want to compare.  
Only the selected properties will be used for comparing the model objects in the **Changes list**.  
c. To add new properties, click + and type the property name.  
d. To delete properties, click next to the properties.  
e. To save the currently selected properties as a comparison set for future use, select a settings file in the list at the top of the **Comparison sets** dialog box, or create a new settings file by typing a new name.  
f. Click 🖼.  
g. Close the **Comparison sets** dialog box. |

| Define how precisely properties are compared | a. Click 🛠 in the **Versions** section.  
b. In the **Property Set Comparison Tolerances** dialog box, set the minimum units and values which will be considered as changes in properties.  
c. To save the current tolerances for future use, select a settings file in the list at the top of the **Comparison sets** dialog box, or create a new settings file by typing a new name. |

*Working collaboratively within a Tekla Structures model*
<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>d.</td>
<td>Click <img src="" alt="save icon" />.</td>
</tr>
<tr>
<td>e.</td>
<td>Close the <strong>Property Set Comparison Tolerances</strong> dialog box.</td>
</tr>
</tbody>
</table>

4. In the **Versions** section, show two versions of the model by clicking ![next icon] next to the model versions.

Note that you can compare only two versions of an overlay model at a time. If you set a third model version visible, the oldest visible version is hidden automatically, and the comparison is updated to show the differences between the two visible versions.

The changes between the versions are shown with the following colors in the model:

- Added objects = green
- Modified objects = yellow
- Deleted objects = red
- Existing objects that have not been modified = gray

5. To show which properties of modified objects have changed, click the corresponding row in the **Changes list**.

The changed properties are shown in the **Property details** side pane. Note that the side pane may not show changes in object rotation or location.
**Compare the differences between overlay model versions in other formats**

When you compare overlay model versions in formats such as .dgn or .dwg, the changes are shown by color-coding the objects in the overlay model.

1. In the overlay model list, select an overlay model that has at least two versions in the attached Trimble Connect project.

2. At the bottom of the **Overlay models** tab, click **Versions**.

3. In the **Versions** section, show two versions of the model by clicking next to the model versions.

   Note that you can compare only two versions of an overlay model at a time. If you set a third model version visible, the oldest visible version is hidden automatically, and the comparison is updated to show the differences between the two visible versions.

The model objects are color-coded according to the changes that have been made. The newest version of an object is shown in green, while the previous version is shown in red. If the object is the same in both versions, the object is shown in yellow or orange, depending on the rendering option.

![Model comparison with green and red color-coding](image)

You can switch between different rendering options on the to better see the changes and overlapping objects. The same structure is shown below with two different rendering options.

With the **Components wireframe** option:
With the **Components rendered** option:
Match views and selections between Tekla Structures and Trimble Connect for Windows

If you are working in Tekla Structures and Trimble Connect for Windows at the same time, you can collaborate with the two applications. In practice, this means that you can match the zoom and projection of the 3D model views, and select the same objects in both applications.

Before collaborating, you need to do the following:

- Have a project open in Trimble Connect for Windows and a model open in Tekla Structures.
- Export the Tekla Structures model to Trimble Connect in the IFC format. For more information, see Manage reference models in a Trimble Connector (page 126).
- Download and show the model in Trimble Connect for Windows.

**Match the camera position, zoom level, and projection of model views**

You can adjust the model views in Tekla Structures and in Trimble Connect for Windows to match each other as well as possible. When you do so, the camera position, zoom level, and view projection of the views are synchronized. You can select which model view is the principal model view to which you want to match the other model view.

- Do either of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjust the Tekla Structures model view to match the Trimble Connect for Windows view</td>
<td>On the Trimble Connect tab, click <img src="image.jpg" alt="Match with Trimble Connect for Windows view" />.</td>
</tr>
<tr>
<td>Adjust the Trimble Connect for Windows model view to match the Tekla Structures view</td>
<td>On the Trimble Connect tab, click <img src="image.jpg" alt="Match with Tekla Structures view" />.</td>
</tr>
</tbody>
</table>

**Select the same objects**

- Do either of the following:
<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the currently selected Trimble Connect objects also in the Tekla Structures model</td>
<td>On the <strong>Trimble Connect</strong> tab, click <strong>Select in Trimble Connect for Windows</strong>.</td>
</tr>
<tr>
<td>Select the currently selected Tekla Structures model objects also in Trimble Connect for Windows</td>
<td>On the <strong>Trimble Connect</strong> tab, click <strong>Select in Tekla Structures</strong>.</td>
</tr>
</tbody>
</table>
2 Get started with import and export formats

Tekla Structures is highly interoperable. If you need to exchange model information with users of other software or systems, you can import and export information in many standard file formats or even establish a direct link with several other products.

- In most cases, the format used for the exchange is a general industry standard format (page 142) supported by many different tools.
- Formats may be supported for import, export or both. See Tekla Structures data exchange formats (page 143) for a listing. There you can also find tables of supported software listing the options you have for sharing data with many commonly used tools.
- When you are ready to exchange data, see Import to and export from Tekla Structures (page 162)
- You can install new capabilities such as new import and export formats or direct links to other software from the Tekla Warehouse.
- If your organization has a capable programmer, you can even add your own customized import and export formats or direct links to other software and systems using Tekla Open API.

2.1 Industry standards

There are many industry standard file transfer formats. The principle ones supported by Tekla Structures are IFC, DSTV, SDNF, DGN, DXF, DWG, IGES, and STEP. Older formats are also included. For a tighter integration, you can link to Tekla Structures using the Tekla Open API technology.

The file name extension normally informs the user which format it is based upon. If you do not know what format it is, or the file does not import, then you will need to open the file in a text editor to look at the header information,
where the file type and the authoring application is usually noted. With CIS/2 files the authoring application and version number is sometimes written at the end of the file.

See also
Tekla Structures data exchange formats (page 143)

### 2.2 Tekla Structures data exchange formats

The following tables list the interoperability possibilities of Tekla Structures.

The **Compatible file formats** list includes the possible file formats for import and export in Tekla Structures.

The **Simplified Trimble to Trimble data exchange**, **Compatible software with direct links**, and **Compatible software (file-based workflows)** lists include software that are compatible with Tekla Structures.

Some of the listed software have a direct link with Tekla Structures. Many direct links are available in Tekla Warehouse. When you have a direct link to an application, and you export the model from Tekla Structures using that particular application, the model is opened in the application. Tekla Structures and the particular application need to be installed on the same computer.

**NOTE** If you have a format or software that is not listed, please contact your local support.

### Compatible file formats

The following table lists many of the different formats you can use in Tekla Structures to import and export data (page 162). ✓ in a column means that you can import or export the format.

To use some of the formats, you may need to download an extension from Tekla Warehouse.

<table>
<thead>
<tr>
<th>Format</th>
<th>Import</th>
<th>Export</th>
<th>More information</th>
</tr>
</thead>
<tbody>
<tr>
<td>3D geometry definition file format (.obj)</td>
<td>✓</td>
<td>✓</td>
<td>Download Multi converter from Tekla Warehouse.</td>
</tr>
<tr>
<td>Format</td>
<td>Import</td>
<td>Export</td>
<td>More information</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>--------</td>
<td>--------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>aSa (.TEK)</td>
<td></td>
<td>✔</td>
<td>Download Rebar Export from Tekla Warehouse. Rebar quantities and production geometry for cut &amp; bend</td>
</tr>
<tr>
<td>Adobe PDF (.pdf)</td>
<td>✔️*</td>
<td>✔️**</td>
<td>*Reference files in model **Standard reporting, documentation needs including 3D PDF capability.</td>
</tr>
<tr>
<td>Autodesk 3DS Max format (.3ds)</td>
<td>✔</td>
<td></td>
<td>Reference files only. Note that a unity-based renderer Trimble Connect Visualizer is available in Tekla Structures and Trimble Connect products.</td>
</tr>
<tr>
<td>AutoCAD (page 233) .dwg</td>
<td>✔</td>
<td>✔</td>
<td>3D geometry, 2D CAD drawings</td>
</tr>
<tr>
<td>AutoCAD (page 233) .dxf</td>
<td>✔</td>
<td>✔</td>
<td>Limited CAD data file for 3D geometry, 2D CAD geometry</td>
</tr>
<tr>
<td>BIM Collaboration format (page 113) (.bcf)</td>
<td>✔</td>
<td>✔</td>
<td>From Tekla Structures 2024 onwards, BCF Topics is supported in Tekla Structures as a Trimble Connect web-service. Alternatively, you can download a non-server functionality called BCF Comment tool, from Tekla Warehouse. External software houses such as Revizto, Kubus (BIM Collaboration) also offer functionality for Tekla Structures.</td>
</tr>
<tr>
<td>Blender files (.blend)</td>
<td>✔</td>
<td></td>
<td>Reference files only.</td>
</tr>
<tr>
<td>BVBS (page 483) (.abs)</td>
<td>✔</td>
<td></td>
<td>Available in Tekla Structures. Rebar quantities and production geometry for cut &amp; bend, mesh, lattice girder.</td>
</tr>
<tr>
<td>Collada (.dae)</td>
<td>✔</td>
<td>✔</td>
<td>Download Multi converter from Tekla Warehouse.</td>
</tr>
<tr>
<td>Conversion files (.cnv)</td>
<td>✔</td>
<td>✔</td>
<td>Text-based mapping file for Tekla Structures profile, twin profile, and material names with names used in other</td>
</tr>
<tr>
<td>Format</td>
<td>Import</td>
<td>Export</td>
<td>More information</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>--------</td>
<td>--------</td>
<td>---------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Comma separated value files (.csv)</td>
<td>✔️</td>
<td>✔️</td>
<td>You can import and export hardware layout points in CSV files.</td>
</tr>
<tr>
<td>DSTV (page 345) (.nc, .stp, .mis)</td>
<td>✔️*</td>
<td>✔️**</td>
<td>*3D analytical geometry **Part data for manufacturing systems</td>
</tr>
<tr>
<td>EJE (page 384)</td>
<td>✔️</td>
<td></td>
<td>US environment, Imperial role only</td>
</tr>
<tr>
<td>Element Bplan, ELiPOS, Plant Control, FloorMES, WallMES (.eli)</td>
<td>✔️*</td>
<td>✔️**</td>
<td>*Production status and dates **Element and material quantities, production geometry for casting, plotting and cutting, design status and notes</td>
</tr>
<tr>
<td>FabTrol Kiss (.kss)</td>
<td></td>
<td>✔️</td>
<td>Model data, attributes</td>
</tr>
<tr>
<td>FabTrol MIS Xml (.xml)</td>
<td>✔️</td>
<td>✔️</td>
<td>Status information</td>
</tr>
<tr>
<td>Filmbox (.fbx)</td>
<td>✔️</td>
<td></td>
<td>Files can be referenced for 3D collaboration (page 163).</td>
</tr>
<tr>
<td>GL Transmission Format (.glft)</td>
<td>✔️</td>
<td></td>
<td>Files can be referenced for 3D collaboration (page 163).</td>
</tr>
<tr>
<td>HMS (page 524) (.sot)</td>
<td></td>
<td>✔️</td>
<td>Element and material quantities, production geometry for casting, plotting, design status and notes</td>
</tr>
<tr>
<td>IBB Betsy (.fa, .f, .ev)</td>
<td>✔️</td>
<td>✔️</td>
<td>Element and material quantities</td>
</tr>
<tr>
<td>IFC2x3 (.ifc)</td>
<td>✔️*</td>
<td>✔️**</td>
<td>*BIM model, 3D geometry, 2D geometry, attributes. The IFC2X3 format (extrusion) can also be used in IFC object conversion (page 196) to get native Tekla Structures members. **BIM model, 3D geometry, 2D geometry, attributes For a list of IFC applications certified by buildingSMART</td>
</tr>
<tr>
<td>Format</td>
<td>Import</td>
<td>Export</td>
<td>More information</td>
</tr>
<tr>
<td>------------------------------</td>
<td>--------</td>
<td>--------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>IFC4 (.ifc)</td>
<td>✓</td>
<td>✓</td>
<td>For a list of IFC applications certified by buildingSMART international, see Certified Software.</td>
</tr>
<tr>
<td>IFC4.3 (.ifc)</td>
<td>✓</td>
<td>✓</td>
<td>For a list of IFC applications certified by buildingSMART international, see Certified Software.</td>
</tr>
<tr>
<td>IFCXML 2x3 (.ifcXML)</td>
<td>✓</td>
<td>✓</td>
<td>For a list of IFC applications certified by buildingSMART international, see Certified Software.</td>
</tr>
<tr>
<td>IFCZIP 2x3 (.ifcZIP)</td>
<td>✓</td>
<td>✓</td>
<td>For a list of IFC applications certified by buildingSMART international, see Certified Software.</td>
</tr>
<tr>
<td>Initial Graphics Exchange Specification (IGES) (.iges, .igs)</td>
<td>✓</td>
<td>✓*</td>
<td>*Download Multi converter from Tekla Warehouse.</td>
</tr>
<tr>
<td>LandXML (page 270) (.xml)</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microsoft Project (.xml)</td>
<td>✓*</td>
<td>✓**</td>
<td>*Schedule information for Task manager **Schedule information to external project management software</td>
</tr>
<tr>
<td>Microstation (page 239).dgn</td>
<td>✓*</td>
<td>✓**</td>
<td>*3D geometry **3D geometry, drawings</td>
</tr>
<tr>
<td>Oracle Primavera P6 (.xml)</td>
<td>✓*</td>
<td>✓**</td>
<td>*Schedule information for Task manager **Schedule information to external project management software</td>
</tr>
<tr>
<td>Plant Design Management System (.pdms)</td>
<td>✓*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Point cloud (page 279)</td>
<td>✓*</td>
<td></td>
<td>*classification is supported</td>
</tr>
<tr>
<td>Format</td>
<td>Import</td>
<td>Export</td>
<td>More information</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>--------</td>
<td>--------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>(.e57, .las, .laz, .pts, .ptx, .js, .tzf, .tdx)</td>
<td>✔</td>
<td></td>
<td>Files can be referenced for 3D collaboration (page 163).</td>
</tr>
<tr>
<td>Polygon File Format (.ply)</td>
<td>✔</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Potree (page 279) (.js)</td>
<td>✔</td>
<td>✔</td>
<td>Potree file structure is created when reading in other point cloud formats and can then be copied to a new location.</td>
</tr>
<tr>
<td>RIB iTWO-Export (.cpixml)</td>
<td>✔</td>
<td>✔</td>
<td>Quantities, material data, status data</td>
</tr>
<tr>
<td>SketchUp (page 278) (.skp)</td>
<td>✔</td>
<td>✔</td>
<td>Popular 3d geometry file format</td>
</tr>
<tr>
<td>Steel Detailing Neutral Format (.sdf, .sdnf, .dat)</td>
<td>✔</td>
<td>✔</td>
<td>3D geometry Used in getting data to another software where native links do not exist.</td>
</tr>
<tr>
<td>Steel 2000 (page 384)</td>
<td></td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>STEP AP203 (.stp, .step)</td>
<td>✔</td>
<td></td>
<td>Files can be referenced for 3D collaboration (page 163).</td>
</tr>
<tr>
<td>STEP AP214 (.stp, .step)</td>
<td>✔</td>
<td></td>
<td>Files can be referenced for 3D collaboration (page 163).</td>
</tr>
<tr>
<td>.tekla (page 110)</td>
<td>✔</td>
<td>✔</td>
<td>Tekla internal format using TrimBIM, which is based on IFC file schema</td>
</tr>
<tr>
<td>Tekla Collaboration (.tczip)</td>
<td>✔</td>
<td>✔</td>
<td>Format used to zip IFC data, TrimBIM data, and metadata for some workflows, such as with Aveva E3D. Format can be read by Trimble Connect.</td>
</tr>
<tr>
<td>Tekla PowerFab (page 387) (.pftx, .zip)</td>
<td>✔*</td>
<td>✔**</td>
<td>*Status data **Model data, attributes, drawings, NC files, TrimBIM, also IFC files for combining and estimating</td>
</tr>
<tr>
<td>Tekla-FabTrol Report (.xsr)</td>
<td></td>
<td>✔</td>
<td></td>
</tr>
</tbody>
</table>
### Simplified Trimble to Trimble data exchange

Work smarter, easier, and more collaboratively with connected data, solutions, and workflows. Tekla Structures can be purchased as part of a **cost effective bundle of Trimble solutions**. Below the workflow file formats are given in more detail. Note that it is possible to purchase bundles of software under a single license.

<table>
<thead>
<tr>
<th>Trimble product</th>
<th>Import to Tekla Structures</th>
<th>Export from Tekla Structures</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plancal</td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td></td>
<td>AutoCAD (.dwg, .dxf)</td>
<td>AutoCAD (.dwg, .dxf)</td>
</tr>
<tr>
<td>Projectsight</td>
<td>PDF</td>
<td>PDF</td>
</tr>
<tr>
<td>Realworks</td>
<td>.dwg, .dx, .dgn, .las, laz, .pts, .tdx, .xml, .e57</td>
<td>.dwg, .trb, .dgn, .dx, .ascii</td>
</tr>
<tr>
<td>Quadri</td>
<td></td>
<td>.ifc, LANDXML (.xml), .skp</td>
</tr>
<tr>
<td>Trimble product</td>
<td>Import to Tekla Structures</td>
<td>Export from Tekla Structures</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SketchUp</td>
<td>SketchUp (.skp)</td>
<td>SketchUp (.skp)</td>
</tr>
<tr>
<td></td>
<td>AutoCAD (.dwg, .dxf)</td>
<td>AutoCAD (.dwg, .dxf)</td>
</tr>
<tr>
<td>Tekla PowerFab</td>
<td>Direct link via Trimble Connect: Issue management service (.bcf)</td>
<td>Export available in Tekla Structures</td>
</tr>
<tr>
<td></td>
<td>Production management: Fabrication Status information (via Status Share)</td>
<td>Direct link via Trimble Connect: Issue management service (.bcf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Production release (.pftx, .zip)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PDF</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD formats (.dwg, .dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>BIM formats (.ifc, .trb)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NC files (.nc1)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Preliminary/Advanced Bill of Material (ABM) release (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Estimating release (.ifc)</td>
</tr>
<tr>
<td>Tekla Structural Designer</td>
<td><strong>Direct link</strong> (.tsmd) or .cxl format neutral file</td>
<td><strong>Direct link</strong> (.tsmd) or .cxl format neutral file</td>
</tr>
<tr>
<td>Tekla Tedds</td>
<td>Direct data link: <strong>Tekla Tedds Integrator (page 324)</strong></td>
<td>Direct data link: <strong>Tekla Tedds Integrator (page 324)</strong></td>
</tr>
<tr>
<td>Trimble Business Centre</td>
<td>LandXML (.xml)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Point clouds (.las, .laz, .js, .e57, .tdx, .tjf)</td>
<td></td>
</tr>
<tr>
<td>Trimble Connect</td>
<td>Collaboration workflows: Project &amp; Team information</td>
<td>Collaboration workflows: Project controls: BCF Topics</td>
</tr>
<tr>
<td></td>
<td>Project controls: BCF Topics</td>
<td>Digital construction information: .ifc</td>
</tr>
<tr>
<td></td>
<td>Digital construction information: 3D models: .ifc, .skp, .swg</td>
<td>2D AutoCAD formats (.dwg, .dgn )</td>
</tr>
<tr>
<td></td>
<td>AutoCAD formats (.dwg, .dgn )</td>
<td>PDF</td>
</tr>
</tbody>
</table>
Compatible software with direct links

The following tables list the software that have a direct link with Tekla Structures to import and export data (page 162).

Many direct links are available in Tekla Warehouse.

The tables also list the file formats that can be used if the direct link is not available.

Fabrication and production workflow support

<table>
<thead>
<tr>
<th>Product</th>
<th>Company</th>
<th>Import to Tekla Structures</th>
<th>Export from Tekla Structures</th>
</tr>
</thead>
<tbody>
<tr>
<td>BeamMaster</td>
<td>AGT</td>
<td>Direct Link</td>
<td></td>
</tr>
<tr>
<td>PEMA</td>
<td>WeldControl</td>
<td>Pemamek</td>
<td>Direct Link</td>
</tr>
<tr>
<td>Pipelabo</td>
<td>Maruhide</td>
<td></td>
<td>Direct Link</td>
</tr>
<tr>
<td>ProCAM</td>
<td>HGG</td>
<td>Direct Link</td>
<td>Direct Link</td>
</tr>
<tr>
<td>Pro-Fit</td>
<td>Zeman</td>
<td>Direct Link</td>
<td></td>
</tr>
<tr>
<td>Raptor</td>
<td>Peddinghaus</td>
<td>Direct Link</td>
<td></td>
</tr>
<tr>
<td>Sicam</td>
<td>Controlled Automation</td>
<td>Direct Link</td>
<td></td>
</tr>
<tr>
<td>Steel Projects</td>
<td>Steel Projects PLM</td>
<td>Direct Link</td>
<td>Direct Link</td>
</tr>
<tr>
<td>StruM.I.S</td>
<td>StruM.I.S</td>
<td>Direct Link</td>
<td>BSWX (.bswx)</td>
</tr>
<tr>
<td>Vacam</td>
<td>Voortman</td>
<td>Direct Link</td>
<td></td>
</tr>
</tbody>
</table>

Design phase workflow support

<table>
<thead>
<tr>
<th>Product</th>
<th>Company</th>
<th>Import to Tekla Structures</th>
<th>Export from Tekla Structures</th>
</tr>
</thead>
<tbody>
<tr>
<td>AxisVM</td>
<td>Inter-CAD Kft.</td>
<td>Direct Link</td>
<td>Direct Link or .ifc</td>
</tr>
<tr>
<td>Microstation</td>
<td>Bentley</td>
<td>AutoCAD (.dwg, .dxf)</td>
<td>AutoCAD (.dwg, .dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 design (.stp, .p21, .step)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td>Product</td>
<td>Company</td>
<td>Import to Tekla Structures</td>
<td>Export from Tekla Structures</td>
</tr>
<tr>
<td>-----------------</td>
<td>---------</td>
<td>----------------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
<td>STEP AP214 (.stp,.step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Steel Detailing</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Neutral Format (.sdf,.sdnf)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP203/AP214 (.stp,.step)</td>
<td></td>
</tr>
<tr>
<td>ProjectWise</td>
<td>Bentley</td>
<td>Projectwise Drive</td>
<td>Projectwise Drive</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dwg,.dxf)</td>
<td>AutoCAD (.dwg,.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 design (.stp,.p21,.step)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td>Diamonds</td>
<td>Buildsoft</td>
<td>Direct Link</td>
<td>Direct Link</td>
</tr>
<tr>
<td></td>
<td></td>
<td>KISS (.kss)</td>
<td>KISS (.kss)</td>
</tr>
<tr>
<td>StruXML</td>
<td>StruSoft</td>
<td>Direct Link</td>
<td>Direct Link</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td>IDEA StatiCa</td>
<td>IDEA StatiCa</td>
<td>PDF,.ifc</td>
<td>Direct Link</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Requires IDEA StatiCa on the same machine. Link is installed through the IDEA software. IDEA StatiCa can also export .ifc models from designed connections. The reference connection model can be inserted as a reference model in Tekla Structures. Use the Export to IDEA StatiCa extension in Tekla Warehouse to export Tekla Structures connections directly</td>
</tr>
</tbody>
</table>

Get started with import and export formats 151 Tekla Structures data exchange formats
<table>
<thead>
<tr>
<th>Product</th>
<th>Company</th>
<th>Import to Tekla Structures</th>
<th>Export from Tekla Structures</th>
</tr>
</thead>
<tbody>
<tr>
<td>Joints For Tekla</td>
<td>Progetto Archimede</td>
<td></td>
<td>to IDEA StatiCa connection (bypassing Checkbot).</td>
</tr>
<tr>
<td>BIM Connector</td>
<td>Lantek</td>
<td>Direct Link</td>
<td>Direct Link</td>
</tr>
<tr>
<td>LIRA-SAPR</td>
<td>LIRA-SAPR</td>
<td>Direct Link (Default, Russia)</td>
<td>Direct Link (Default, Russia)</td>
</tr>
<tr>
<td>LIRA 10</td>
<td>LIRA SOFT</td>
<td>Direct Link (Russia)</td>
<td>Direct Link (Russia)</td>
</tr>
<tr>
<td>Midas Gen</td>
<td>MIDAS</td>
<td>Direct Link</td>
<td>Direct Link</td>
</tr>
<tr>
<td>ModeSt</td>
<td>Tecnisoft</td>
<td>Direct Link</td>
<td>Direct Link</td>
</tr>
<tr>
<td>PowerConnect</td>
<td>Buildsoft</td>
<td>Direct Link</td>
<td>Direct Link</td>
</tr>
<tr>
<td>BIM Expert</td>
<td>Buildsoft</td>
<td>Direct Link</td>
<td>Direct Link</td>
</tr>
<tr>
<td>Qnect</td>
<td>Qnect</td>
<td>Direct Link</td>
<td>Direct Link</td>
</tr>
<tr>
<td>RFEM</td>
<td>Dlubal</td>
<td>Direct Link</td>
<td>Direct Link</td>
</tr>
<tr>
<td>RISA 3D (Suite)</td>
<td>Risa Technology</td>
<td>Direct Link (US market)</td>
<td>Direct Link (US market)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf)</td>
<td></td>
</tr>
<tr>
<td>RisaConnection</td>
<td>Risa Technology</td>
<td>Direct Link (certain markets)</td>
<td>Direct Link (certain markets)</td>
</tr>
<tr>
<td>Robot Structural</td>
<td>Autodesk</td>
<td>Direct Link</td>
<td>Direct Link</td>
</tr>
<tr>
<td>Analysis Professional</td>
<td></td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 design (.stp, .p21, .step)</td>
<td></td>
</tr>
</tbody>
</table>

Get started with import and export formats 152 Tekla Structures data exchange formats
<table>
<thead>
<tr>
<th>Product</th>
<th>Company</th>
<th>Import to Tekla Structures</th>
<th>Export from Tekla Structures</th>
</tr>
</thead>
<tbody>
<tr>
<td>RSTAB</td>
<td>Dlubal</td>
<td>Direct Link&lt;br&gt;CIS/2 LPM6 analytical (.stp, .p21, .step)&lt;br&gt;IFC2X3 (.ifc)</td>
<td>Direct Link&lt;br&gt;CIS/2 LPM6 analytical (.stp, .p21, .step)&lt;br&gt;IFC2X3 (.ifc)</td>
</tr>
<tr>
<td>SAP2000</td>
<td>Computers &amp; Structures, Inc.</td>
<td>Direct Link</td>
<td>Direct Link</td>
</tr>
<tr>
<td>ETABS</td>
<td>Computers &amp; Structures, Inc.</td>
<td>Direct Link&lt;br&gt;AutoCAD (.dwg, .dxf)&lt;br&gt;CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
<td>Direct Link&lt;br&gt;AutoCAD (.dwg, .dxf)&lt;br&gt;CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
</tr>
<tr>
<td>SCIA</td>
<td>Nemetschek</td>
<td>Direct Link&lt;br&gt;AutoCAD (.dwg, .dxf)&lt;br&gt;IFC2X3 (.ifc)&lt;br&gt;Steel Detailing Neutral Format (.sdf, .sdnf)</td>
<td>Direct Link&lt;br&gt;AutoCAD (.dwg, .dxf)&lt;br&gt;IFC2X3 (.ifc)&lt;br&gt;Steel Detailing Neutral Format (.sdf, .sdnf)</td>
</tr>
<tr>
<td>S-FRAME</td>
<td>S-FRAME Software Inc.</td>
<td>Direct Link Autodesk (.dxf)</td>
<td>Direct Link Autodesk (.dxf)</td>
</tr>
<tr>
<td>STAAD.Pro</td>
<td>Bentley</td>
<td>Direct Link (only geometry started in Tekla Structures can be round tripped)&lt;br&gt;AutoCAD (.dwg, .dxf)&lt;br&gt;CIS/2 LPM6 analytical (.stp, .p21, .step)&lt;br&gt;Steel Detailing Neutral Format (.sdf, .sdnf)&lt;br&gt;ISM</td>
<td>Direct Link&lt;br&gt;AutoCAD (.dwg, .dxf)&lt;br&gt;CIS/2 LPM6 analytical (.stp, .p21, .step)&lt;br&gt;Staad ASCII file (.std)&lt;br&gt;ISM</td>
</tr>
</tbody>
</table>

Compatible software (file-based workflows)

The following table lists Tekla Structures compatible software and the formats that you can import to and export from (page 162) Tekla Structures.

For a list of IFC applications certified by buildingSMART international, see Certified Software.
To find out more about the various import and export tools, see Import to and export from Tekla Structures (page 162).

<table>
<thead>
<tr>
<th>Product</th>
<th>Company</th>
<th>Import to Tekla Structures</th>
<th>Export from Tekla Structures</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adapt</td>
<td>Nemetschek</td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td>Advanced Steel</td>
<td>Autodesk</td>
<td>CIS/2 LPM5 analytical (.stp, .p21, .step) IFC2X3 (.ifc) Steel Detailing Neutral Format (.sdf, .sdnf)</td>
<td>CIS/2 LPM5 analytical (.stp, .p21, .step) IFC2X3 (.ifc) Steel Detailing Neutral Format (.sdf, .sdnf)</td>
</tr>
<tr>
<td>Allplan/Planbar</td>
<td>Nemetschek</td>
<td>AutoCAD (.dwg, .dxf)</td>
<td>AutoCAD (.dwg, .dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc) Microstation (.dgn)</td>
<td>IFC2X3 (.ifc) Microstation (.dgn)</td>
</tr>
<tr>
<td>ANSYS</td>
<td>ANSYS</td>
<td>IGES (.iges, .igs)</td>
<td>IGES (.iges, .igs)</td>
</tr>
<tr>
<td>ArchiCAD</td>
<td>Graphisoft / Nemetschek</td>
<td>AutoCAD (.dwg) IFC2X3 (.ifc) IFC4 (.ifc)</td>
<td>AutoCAD (.dwg) IFC2X3 (.ifc) IFC4 (.ifc)</td>
</tr>
<tr>
<td>Armaor</td>
<td>Ariadis</td>
<td></td>
<td>BVBS (.abs)</td>
</tr>
<tr>
<td>Artube</td>
<td>Adige</td>
<td></td>
<td>STEP (.stp, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>IFC (.ifc)</td>
</tr>
<tr>
<td>aSa Rebar</td>
<td>Applied Systems Associates Inc</td>
<td></td>
<td>aSa Rebar file (.TEK)</td>
</tr>
<tr>
<td>ASI analysis</td>
<td>Applied Science International LLC</td>
<td></td>
<td>Staad ASCII file (.std)</td>
</tr>
<tr>
<td>AutoCAD</td>
<td>Autodesk</td>
<td>AutoCAD (.dwg, .dxf)</td>
<td>AutoCAD (.dwg, .dxf)</td>
</tr>
<tr>
<td>AutoCAD Civil 3D</td>
<td>Autodesk</td>
<td>AutoCAD (.dwg, .dxf)</td>
<td>AutoCAD (.dwg, .dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Microstation (.dgn) LandXML files (.xml)</td>
<td></td>
</tr>
<tr>
<td>AutoPLANT</td>
<td>Bentley</td>
<td>AutoCAD (.dwg, .dxf)</td>
<td>AutoCAD (.dwg, .dxf)</td>
</tr>
<tr>
<td>AutoVue</td>
<td>Oracle</td>
<td>AutoCAD (.dwg, .dxf)</td>
<td>AutoCAD (.dwg, .dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc) STEP AP214 (.stp, .step)</td>
<td></td>
</tr>
<tr>
<td>Product</td>
<td>Company</td>
<td>Import to Tekla Structures</td>
<td>Export from Tekla Structures</td>
</tr>
<tr>
<td>---------</td>
<td>-----------------------------</td>
<td>-------------------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Aveva E3D | AVEVA                       | Workflow installer for Tekla Structures  
Microstation (.dgn)  
Steel Detailing Neutral Format (.sdf, .sdnf, .dat)  
.ifc based Tekla Collaboration files (.tczip) | Installer for Import/ export Aveva E3D/ PDMS from/to Tekla Structures  
Microstation (.dgn)  
Steel Detailing Neutral Format (.sdf, .sdnf, .dat)  
.ifc based Tekla Collaboration files (.tczip) |
| AviCAD | Progress/ EBAWE             |                                                                                           | Unitechnik (.cam)  
BVBS (.abs)                                                                                      |
| Bentley Building Systems | Bentley                    | AutoCAD (.dwg, .dxf)  
IFC2X3 (.ifc)  
Microstation (.dgn)  
STEP AP203/AP214 (.stp, .step) | AutoCAD (.dwg, .dxf)  
IFC2X3 (.ifc)  
Microstation (.dgn)  
STEP AP214 (.stp, .step) |
| Bentley OpenRoads Designer | Bentley                    | LandXML files (.xml)                                                                     |                                                                                                 |
| Betsy   | IBB – Consultants & Engineers |                                                                                         | Betsy (.fa, .f, .ev)  
RIB iTWO (.cpixml)                                                                                   |
| Cadmatic | Cadmatic                    | AutoCAD (.dwg, .dxf)  
IFC2X3 (.ifc)                                                                                       | AutoCAD (.dwg, .dxf)  
IFC2X3 (.ifc)                                                                                       |
| CADWorx Plant | Intergraph / Hexagon       | AutoCAD (.dwg, .dxf)  
CIS/2 LPM6 analytical (.stp,.p21, .step)  
CIS/2 LPM6 design (.stp,.p21, .step) | AutoCAD (.dwg, .dxf)  
CIS/2 LPM6 analytical (.stp,.p21, .step)  
CIS/2 LPM6 design (.stp,.p21, .step) |
<p>| CAESAR II | Intergraph / Hexagon       | AutoCAD (.dwg)                                                                           | AutoCAD (.dwg)                                                                                     |
| ConSteel | ConSteel Solutions Limited  |                                                                                         | ASCII                                                                                             |
| Corobs  | Müller Opladen              |                                                                                         | TubeNC (.xml)                                                                                       |</p>
<table>
<thead>
<tr>
<th>Product</th>
<th>Company</th>
<th>Import to Tekla Structures</th>
<th>Export from Tekla Structures</th>
</tr>
</thead>
<tbody>
<tr>
<td>DDScad</td>
<td>Graphisoft</td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dwg, .dxf)</td>
<td>AutoCAD (.dwg, .dxf)</td>
</tr>
<tr>
<td>Digital Project</td>
<td>Gehry Technologies</td>
<td>AutoCAD (.dwg, .dxf)</td>
<td>AutoCAD (.dwg, .dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf)</td>
<td>STEP AP203/AP214 (.stp, .step)</td>
</tr>
<tr>
<td>ebos</td>
<td>Progress Software Developments</td>
<td></td>
<td>Unitechnik (.cam)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ProgressXML (.pxml)</td>
</tr>
<tr>
<td>ELiPLAN, Plant Control, FloorMES, WallMES</td>
<td>Elematic</td>
<td>ELiPLAN (.eli)</td>
<td>ELiPLAN (.eli)</td>
</tr>
<tr>
<td>ELiPOS</td>
<td>Elematic</td>
<td></td>
<td>ELiPLAN (.eli)</td>
</tr>
<tr>
<td>ETABS</td>
<td>Computers &amp; Structures, Inc.</td>
<td>AutoCAD (.dwg, .dxf)</td>
<td>AutoCAD (.dwg, .dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf)</td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>STEP AP214 (.stp, .step)</td>
</tr>
<tr>
<td>FabTrol MRP</td>
<td>FabTrol</td>
<td>FabTrol MIS XML (.xml)</td>
<td>FabTrol MIS XML (.xml)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>FabTrol KISS File (.kss)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Tekla-FabTrol Report (.xsr)</td>
</tr>
<tr>
<td>FabTrol MRP</td>
<td>FabTrol</td>
<td>FabTrol MIS XML (.xml)</td>
<td>FabTrol MIS XML (.xml)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>FabTrol KISS File (.kss)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Tekla-FabTrol Report (.xsr)</td>
</tr>
<tr>
<td>FXTube</td>
<td>Mazak</td>
<td>STEP (.stp, .step)</td>
<td>STEP (.stp, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
<td>IGES (.iges, .igs)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC (.ifc)</td>
<td>IFC (.ifc)</td>
</tr>
<tr>
<td>GSA</td>
<td>Oasys</td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Rhino/Grasshopper</td>
<td>Rhino/Grasshopper</td>
</tr>
</tbody>
</table>

Get started with import and export formats  
156  
Tekla Structures data exchange formats
<table>
<thead>
<tr>
<th>Product</th>
<th>Company</th>
<th>Import to Tekla Structures</th>
<th>Export from Tekla Structures</th>
</tr>
</thead>
<tbody>
<tr>
<td>GT Strudl</td>
<td>Hexagon</td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
<td></td>
</tr>
<tr>
<td>HMS</td>
<td>HMS</td>
<td></td>
<td>HMS (.sot)</td>
</tr>
<tr>
<td>HOOPS</td>
<td>Tech Soft 3D</td>
<td>AutoCAD (.dwg, .dxf)</td>
<td>AutoCAD (.dwg, .dxf)</td>
</tr>
<tr>
<td>Inventor</td>
<td>Autodesk</td>
<td>AutoCAD (.dwg, .dxf)</td>
<td>AutoCAD (.dwg, .dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
<td>STEP AP214 (.stp, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP203/AP214 (.stp, .step)</td>
<td></td>
</tr>
<tr>
<td>iTWO</td>
<td>RIB Software AG</td>
<td></td>
<td>CPIxml (.xml)</td>
</tr>
<tr>
<td>LEIT2000,</td>
<td>RIB SAA</td>
<td>Unitechnik (.cam)</td>
<td></td>
</tr>
<tr>
<td>iTWO-MES</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LP-System</td>
<td>Lennerts &amp;</td>
<td>BVBS (.abs)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Partner</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MagiCAD</td>
<td>Progman</td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Hole Reservation Manager</td>
</tr>
<tr>
<td>MasterFrame</td>
<td>MasterSeries</td>
<td>DSTV96 (.nc, .stp, .mis)</td>
<td>DSTV96 (.nc, .stp, .mis)</td>
</tr>
<tr>
<td>Mesh Welding</td>
<td>EVG (Filzmoser)</td>
<td>Unitechnik (.cam)</td>
<td>BVBS (.abs)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mesh Welding</td>
<td>A.W.M.</td>
<td>Unitechnik (.cam)</td>
<td></td>
</tr>
<tr>
<td>Mesh Welding</td>
<td>Progress /</td>
<td>Unitechnik (.cam)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>EBAWE</td>
<td></td>
<td>ProgressXML (.pxml)</td>
</tr>
<tr>
<td>Microstation</td>
<td>Bentley</td>
<td>AutoCAD (.dwg, .dxf)</td>
<td>AutoCAD (.dwg, .dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
<td>IGES (.iges, .igs)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP203/AP214 (.stp, .step)</td>
<td>STEP AP214 (.stp, .step)</td>
</tr>
<tr>
<td>Multiframe</td>
<td>Daystar</td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td></td>
<td>Software Inc.</td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf)</td>
<td>Steel Detailing Neutral</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Format (.sdf, .sdnf)</td>
</tr>
<tr>
<td>Nastran</td>
<td>Hexagon</td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
<td>IGES (.iges, .igs)</td>
</tr>
</tbody>
</table>

Get started with import and export formats 157 Tekla Structures data exchange formats
<table>
<thead>
<tr>
<th>Product</th>
<th>Company</th>
<th>Import to Tekla Structures</th>
<th>Export from Tekla Structures</th>
</tr>
</thead>
<tbody>
<tr>
<td>NavisWorks</td>
<td>Autodesk</td>
<td>NWS</td>
<td>Autodesk Data Exchanger, Autodesk Desktop Connector AutoCAD (.dwg, .dxf) CIS/2 LPM6 analytical (.stp, .p21, .step) IFC2X3 (.ifc) IFC4 (.ifc) Microstation (.dgn)</td>
</tr>
<tr>
<td>NX (Unigraph)</td>
<td>Siemens</td>
<td>AutoCAD (.dwg, .dxf) IGES (.iges, .igs) STEP AP203/AP214 (.stp, .step)</td>
<td>AutoCAD (.dwg, .dxf) STEP AP214 (.stp, .step)</td>
</tr>
<tr>
<td>PDS</td>
<td>Intergraph / Hexagon</td>
<td>Microstation (.dgn) Steel Detailing Neutral Format (.dat)</td>
<td>Microstation (.dgn) Steel Detailing Neutral Format (.dat)</td>
</tr>
<tr>
<td>PDS</td>
<td>Peikko Group Corporation</td>
<td>Plug-ins</td>
<td>Plug-ins</td>
</tr>
<tr>
<td>PRIAMOS</td>
<td>GTSdata</td>
<td>CPIxml (.xml) Unitechnik (.cam)</td>
<td></td>
</tr>
</tbody>
</table>

Get started with import and export formats 158 Tekla Structures data exchange formats
<table>
<thead>
<tr>
<th>Product</th>
<th>Company</th>
<th>Import to Tekla Structures</th>
<th>Export from Tekla Structures</th>
</tr>
</thead>
<tbody>
<tr>
<td>ProStructures</td>
<td>Bentley</td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf)</td>
<td>AutoCAD (.dwg, .dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf)</td>
</tr>
<tr>
<td>Pro/Engineer</td>
<td>PTC</td>
<td>IGES (.iges, .igs)</td>
<td>STEP AP214 (.stp, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP203/AP214 (.stp, .step)</td>
<td></td>
</tr>
<tr>
<td>ProFit</td>
<td>Progress/EBAWE</td>
<td></td>
<td>BVBS (.abs)</td>
</tr>
<tr>
<td>Prokon</td>
<td>Prokon</td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
</tr>
<tr>
<td>PythonX</td>
<td>Lincoln Electric</td>
<td></td>
<td>DSTV</td>
</tr>
<tr>
<td>RAM Structural</td>
<td>Bentley</td>
<td>AutoCAD (.dwg, .dxf)</td>
<td>AutoCAD (.dwg, .dxf)</td>
</tr>
<tr>
<td>System</td>
<td></td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 design (.stp, .p21, .step)</td>
<td>CIS/2 LPM6 design (.stp, .p21, .step)</td>
</tr>
<tr>
<td>Revit</td>
<td>Autodesk</td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dwg, .dxf)</td>
<td>Revit (.rvt) - extension in Tekla Warehouse</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk Desktop Connector</td>
<td>Autodesk Desktop Connector</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk Data Exchanger</td>
<td>Autodesk Data Exchanger</td>
</tr>
<tr>
<td></td>
<td></td>
<td>McNeel North America</td>
<td></td>
</tr>
<tr>
<td>Rhinoceros /</td>
<td>McNeel North</td>
<td>Tekla Rhino / Grasshopper live link</td>
<td>Tekla Rhino / Grasshopper live link</td>
</tr>
<tr>
<td>Grasshopper</td>
<td>America</td>
<td>Geometry Gym link</td>
<td>Geometry Gym link</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
<td>STEP AP203/AP214 (.stp, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP203/AP214 (.stp, .step)</td>
<td></td>
</tr>
<tr>
<td>RinasWeld</td>
<td>Kranendonk</td>
<td></td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td>SACS</td>
<td>Bentley</td>
<td>AutoCAD (.dxf)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Steel Detailing Neutral Format (.sdnf)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf)</td>
<td></td>
</tr>
<tr>
<td>Product</td>
<td>Company</td>
<td>Import to Tekla Structures</td>
<td>Export from Tekla Structures</td>
</tr>
<tr>
<td>-----------</td>
<td>----------------------------------</td>
<td>---------------------------------------------------------------------</td>
<td>------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| SAFE      | Computers & Structures, Inc.     | AutoCAD (.dwg, .dxf)  
          CIS/2 LPM6 analytical (.stp, .p21, .step)  
          IGES (.iges, .igs)                                   | AutoCAD (.dwg, .dxf)  
          CIS/2 LPM6 analytical (.stp, .p21, .step) |
| Schnell Software | Schnell Software         |                                                                      | BVBS (.abs)  
          Unitechnik (.cam)                                   |
| SDS/2     | Nemetschek                        | AutoCAD (.dwg, .dxf)  
          CIS/2 LPM6 analytical (.stp, .p21, .step)  
          CIS/2 LPM6 design (.stp, .p21, .step)              | AutoCAD (.dwg, .dxf)  
          CIS/2 LPM6 analytical (.stp, .p21, .step)  
          CIS/2 LPM6 design (.stp, .p21, .step)  
          CIS/2 LPM6 manufacturing (.stp, .p21, .step)  
          Microstation (.dgn)                                |
| Smart 3D  | Intergraph / Hexagon             | Smart 3D Interoperability extension  
          CIS/2 LPM6 design (.stp, .p21, .step)  
          Microstation (.dgn)  
          IFC2X3 (.ifc), with SmartPlant 3D                | CIS/2 LPM6 analytical (.stp, .p21, .step)  
          CIS/2 LPM6 design (.stp, .p21, .step)  
          Microstation (.dgn)                                |
| SOFiSTiK | SOFiSTiK                         | Tekla Rhino/Grasshopper live link  
          AutoCAD (.dwg, .dxf)  
          IFC 2x3 (.ifc)                                       | Tekla Rhino/Grasshopper live link  
          AutoCAD (.dwg, .dxf)                                |
| Solibri   | Solibri                          |                                                                      | IFC2X3 (.ifc)                                                   |
| SolidEdge | Siemens                          | AutoCAD (.dxf)  
          Microstation (.dgn)  
          IGES (.iges, .igs)  
          STEP AP203/AP214 (.stp, .step)                     | AutoCAD (.dxf)  
          Microstation (.dgn)  
          STEP AP214 (.stp, .step)                           |

Get started with import and export formats  

160  

Tekla Structures data exchange formats
<table>
<thead>
<tr>
<th>Product</th>
<th>Company</th>
<th>Import to Tekla Structures</th>
<th>Export from Tekla Structures</th>
</tr>
</thead>
<tbody>
<tr>
<td>SolidWorks</td>
<td>Dassault</td>
<td>AutoCAD (.dwg, .dxf)</td>
<td>AutoCAD (.dwg, .dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
<td>IFC2X3, IFC4 (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3, IFC4 (.ifc)</td>
<td>STEP AP214 (.stp, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP203/AP214 (.stp, .step)</td>
<td></td>
</tr>
<tr>
<td>Soulé</td>
<td>Soulé Software Inc.</td>
<td>.xml</td>
<td>BVBS (.abs)</td>
</tr>
<tr>
<td>SPACE GASS</td>
<td>SPACE GASS</td>
<td>Rhino / Grasshopper</td>
<td>Rhino / Grasshopper</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 analytical</td>
<td>CIS/2 LPM6 analytical</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(.stp, .p21, .step)</td>
<td>(.stp, .p21, .step)</td>
</tr>
<tr>
<td>TurboCAD</td>
<td>IMSI Design</td>
<td>AutoCAD (.dwg, .dxf)</td>
<td>AutoCAD (.dwg, .dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP203/AP214 (.stp, .step)</td>
<td>STEP AP214 (.stp, .step)</td>
</tr>
<tr>
<td>UniCAM</td>
<td>Unitechnik</td>
<td>Unitechnik (.cam, .uni, .uxml)</td>
<td></td>
</tr>
<tr>
<td>Vernon</td>
<td>Lincoln Electric</td>
<td>TubeNC (.xml)</td>
<td></td>
</tr>
<tr>
<td>VectorWorks</td>
<td>Nemetschek</td>
<td>IFC2X3, IFC4 (.ifc)</td>
<td>AutoCAD (.dwg, .dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
<td>IFC2X3, IFC4 (.ifc)</td>
</tr>
</tbody>
</table>
Tekla Structures has several tools you can use to import and export physical and reference models and the information they contain.

For details about compatible software in import and export, see Compatible file formats and software with Tekla Structures (page 143).

Conversion files (.cnv) map Tekla Structures profile, twin profile, and material names with names used in other software. For more information, see "Conversion files" in the Manage Tekla Structures product guide.

NOTE The import and export functionality is not available in all Tekla Structures configurations.

You can use import and export in Tekla Structures for several purposes:

- You can import reference models to Tekla Structures. For example, you can import an architectural model, a plant design model, or a heating, ventilating and air-conditioning (HVAC) model as a reference model. Reference models can also be simple 2D drawings that are imported and then used as a layout to directly build the model on.

- You can import 2D or 3D models created by other software, then detail or modify the structural objects using Tekla Structures. Once the model is complete, you can export it, and return it to the architect or engineer for review.

- You can create reports from the imported models from most of the formats.

- You can export Tekla Structures models for use in Analysis & Design (several formats). Then you can import the Analysis & Design results back to the Tekla Structures model.

- Various model transfers can be completed for the engineering and contractor phase of the project.
• You can import shapes from many formats. Shapes are used in defining items.

• You can export data for use in manufacturing information systems and in the fabrication phase:
  • You can export Computer Numerical Control (CNC) data for use by automated cutting, drilling and welding CNC machinery.
  • You can export Manufacturing Information Systems (MIS) data so that fabricators can track project progress, for example.

Click the links below to find out more about the various types of import and export:

Reference models and compatible formats (page 163)
Trimble Connector (page 124)
IFC (page 192)
DWG and DXF (page 233)
DGN (page 265)
LandXML (page 270)
PDF (page 272)
SketchUp (page 278)
Point clouds (page 279)
Layout manager (page 292)
Analysis and design systems (page 313)
Steel fabrication (page 344)
Automated precast fabrication (page 402)
CAD (page 530)
Import user-defined attribute values (page 540)

In addition to these built-in import and export tools, you have a variety of links to other applications available in Tekla Warehouse that you can download.

Multi Converter: Export to IFC, STEP, IGES, OBJ, STL, DGN, DWG, DXF, or SKP files
Export into AutoDesk Revit format (RVT)

3.1 Reference models and compatible formats

A reference model is a file that helps you to build a Tekla Structures model. A reference model may be created in Tekla Structures or another software or modeling tool and then inserted to Tekla Structures.
For example, an architectural model, a plant design model, or a heating, ventilating and air-conditioning (HVAC) model can be used as a reference model. Reference models can also be simple 2D drawings that are inserted and then used as a layout to directly build the model on. You can snap to reference model geometry.

Reference models of different formats, such as IFC, IFC4, IFCzip, IFCxml, tcZIP, 3DD, DXF, DWG, DGN, XML, LandXML, STP, IGS, SKP and PDF, are converted by the TrimBimConverter to the TrimBIM (.trb) format at reference model insert. The .trb file is saved in the current model folder. The reference cache is created in the cache folder based on the advanced option XS_REFERENCE_CACHE when the reference model is set visible, which happens automatically at insert and update.

Examples of supported file types:

- **AutoCAD files** .dwg, .dxf (supported version ACAD2023 and earlier)
- **IFC files** .ifc, .ifczip, .ifcxml.
  - You can convert IFC reference objects (page 196) into native Tekla Structures objects.
- **IGES files** .igs, .iges
- **LandXML files** .xml
- **MicroStation files** .dgn, .prp
- **PDF files** .pdf
- **Tekla Collaboration files** .tczip
- **SketchUp files** .skp (supported version SketchUp 2021 and earlier)
- **STEP files** .stp, .STEP
- **Filmbox files** .fbx
- **COLLADA files** .dae
- **Autodesk 3DS Max format files** .3ds
- **Geometry definition file format** .obj
- **Blender files** .blend
- **GL Transmission Format files** .glft
- **Polygon File Format files** .ply
- **Tekla files** (page 110) .tep
- **TrimBIM files** .trb

The Add model dialog box lists the extensions of all formats that are currently supported by Tekla Structures.

Some reference models are automatically subdivided or split into reference model objects.
TIP  You can disable the roll-over highlight, which can speed up zooming.

Reference model plug-ins in Tekla Warehouse

Reference model plug-ins are available as .tsep plug-ins in Tekla Warehouse. Tekla Structures installation contains the plug-ins, but you can get newer ones from Tekla Warehouse, and then import it to the Applications & components catalog.

One example of the plug-ins is the Teigha reference model import plug-in for Revit.

Reference models in drawings

You can show reference models in drawings and adjust their visibility settings.

See also

Insert a reference model (page 165)
Modify reference model details (page 173)
Lock reference models (page 174)
View reference models (page 168)
Detect changes between reference model versions (page 175)
Define a comparison set for reference model change detection (page 181)
Export reference model change detection results to Excel (page 185)
Reference model objects (page 189)
Inquire reference model contents (page 188)
Examine reference model hierarchy (page 190)

Insert a reference model

You can insert reference models in a Tekla Structures model. You can use the reference models to overlay different discipline models with your own model. These disciplines can be architect, plant engineer, services engineer, or other structural disciplines.

Note the following:

• All characters below 256 are allowed in a reference model file name: both ASCII (0 - 127) and extended ASCII (128 - 255). If the file name contains unsupported characters, you will get a warning message.

• Reference models should not be inserted very far from the Tekla Structures model origin.

1. Open a Tekla Structures model where you want to insert a reference model.
2. To insert the reference model, go to the File menu, and select Import --> Insert reference model.

Selecting this command opens both the Reference Models pane and the Add model dialog box.

You can also open the Reference Models pane first by clicking the Reference Models button in the side pane , and then click the Add model button.

3. In the Add model dialog box, if you have any previously created reference model properties files, load the desired file by selecting the file from the properties file list at the top.

4. In the Add model dialog box, browse for the reference model file by clicking Browse....

You can also drag reference models from Windows Explorer, and insert several models at a time.

For a list of compatible formats, see Reference models and compatible formats (page 163).

5. Select a group for the model or enter the name of a new group.

If you do not enter a name for the group, the reference model is inserted in the Default group.

You can also drag models to an existing group and create new groups. If you create a new group, and do not add any reference models in the group immediately, the group is saved for future use.

6. In Location by, select one of the following options:

Model origin inserts the model relative to 0,0,0.

Work plane inserts the model relative to the current work plane coordinate system.

Base point:<name of base point> inserts the model relative to the base point by using coordinate system values East coordinate, North coordinate, Elevation, and Angle to North from the base point definition in Project properties.

If you are inserting a IFC2x3 reference model that has a project location available, you can enable the project location by setting the new model-specific advanced option XS_USE_PROJECT_LOCATION_IN_IFC2X3_IMPORT to TRUE, and the reference model is inserted in the project location, away from the Tekla Structures model origin.

7. Select where you want to place the reference model. You can enter coordinates in the Offset boxes or pick a position for the reference model origin.
The maximum number of decimals for coordinates is 13.

Do not insert reference models very far from the Tekla Structures model origin. When there is a big offset, we recommend that you use **Base point**.

8. Set the **Scale** of the reference model if it is different from the one in the Tekla Structures model.

Note that you need to set the scale for a DWG or a DXF file already in AutoCAD. When you define the measurement unit for a DWG or a DXF file and save the file in AutoCAD, the unit is recognized in Tekla Structures, and the reference model is scaled correctly.

The maximum number of decimals for scale is 13.

9. You can rotate the model around model Z axis by picking a location in the model or entering the desired value in the **Rotation** box.

The maximum number of decimals for the rotation value is 7.

10. Click **More** to show more details, and add the **Code**, **Title**, **Phase** and **Description** of the reference model.

By default, the title is the same as the name of the inserted reference model. You may want to use the name of the discipline or the company instead, for example. The code could be a site number, project number, or accounting number. Write the description according to the company conventions. The phase is the design phase of the reference model (not the phase in the Tekla Structures model).

Below is an example of these details when you inquire the reference model.

<table>
<thead>
<tr>
<th>Group</th>
<th>Basement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code</td>
<td>123456</td>
</tr>
<tr>
<td>ref_description</td>
<td>Basement</td>
</tr>
<tr>
<td>Title</td>
<td>First phase</td>
</tr>
<tr>
<td>revisionPhase</td>
<td>1a</td>
</tr>
</tbody>
</table>

You can also modify all the details after you have inserted the model.

11. Click **Add model**.

12. If the inserted reference model lies outside the work area and is not fully or at all visible in the model view, Tekla Structures displays a warning message. Click **Expand** to extend the work area to see the reference model in the model view.

The reference model is inserted in the current phase of the Tekla Structures model.

Note that for IFC reference models, the elevation offset value is not read from the inserted reference model.

When a reference model is inserted or updated, reference model data is copied to Tekla Structures model internal data storage located in the
<current model>\datastorage\ref folder. The reference model is visible even if the original file is removed from its original location. The reference model data in this folder should not be touched.

You can convert inserted IFC reference objects (page 196) into native Tekla Structures objects.

If you cannot see the DWG reference model that you inserted, see "DWG reference file not visible" for more information.

**NOTE** Do not insert the same reference model to the Tekla Structures model several times. One person only should update the reference model (click **Refresh**) to avoid duplicate object data.

When you want to update the reference model, do not delete the old reference model from an open Tekla Structures model and replace it with a new one, because then you would lose the work done on reference objects in the old model. Use the change detection (page 175) functionality instead.

**TIP** To only clip reference models and point clouds with the clip plane tool, set the advanced option XS_DO_NOT_CLIP_NATIVE_OBJECTS_WITH_CLIP_PLANE to **TRUE**. If you do this, the native objects are not clipped.

**See also**

*Modify reference model details (page 173)*

**View reference models**

There are many ways you can select what you want to show about the reference models and how.

For details about inserting reference models, see *Insert a reference model (page 165)*.

<table>
<thead>
<tr>
<th>To:</th>
<th>Do this:</th>
</tr>
</thead>
</table>
| Open the **Reference Models** list | Do either of the following:  
  • Go to the **File** menu, and select **Import -- > Insert reference model**.  
  • Click the **Reference Models** button in the side pane on the right side of the Tekla Structures main window. |
<p>| Hide and show reference models | * Click the eye button next to the model you want to hide. |</p>
<table>
<thead>
<tr>
<th><strong>To:</strong></th>
<th><strong>Do this:</strong></th>
</tr>
</thead>
</table>
| | The button changes to [ ] and the reference model is hidden in the 3D view.  
  • Click the eye button again to show the model. |
| Hide and show a group of reference models |  
  • Click the eye button [ ] next to the group you want to hide. The group eye button and the reference model eye buttons all change to [ ], and all the reference models included in the group are hidden in the Tekla Structures model.  
  • Click the eye button again to show all the models in the group.  
  • If a group contains both hidden and visible models, the eye button for the group looks like this [ ].  
  • If there are no reference models in a group, the eye button looks like this [ ]. |
| Hide or show all reference models | Click the eye button [ ] All. The eye buttons for all groups and reference models change to [ ], and all reference models are hidden in the Tekla Structures model. |
| Highlight the reference model in the 3D view |  
  • Click the reference model in the Reference Models list. |
| Show reference model details |  
  • Double-click the reference model in the Reference Models list. |
<table>
<thead>
<tr>
<th>To:</th>
<th>Do this:</th>
</tr>
</thead>
</table>
2. Ensure that the Select assemblies selection switch (for assemblies) or Select objects in assemblies selection switch (for parts) is active.  
3. Point the reference model in the model view, hold down Shift and scroll to the hierarchy level where the desired reference model object is located.  
4. Point the object and double-click it to open the reference model object details. |
| Rotate the reference model around model Z axis. | • In the reference model details, enter the desired value in the Rotation box. You can also pick the rotation. |
| Hide and show reference model layers | 1. Double-click the reference model in the Reference Models list to open the details.  
2. Click the small arrow on the Layers row to show the list of layers.  
3. You can show and hide individual layers or all layers:  
   • To hide all layers, click the eye button on the Layers row.  
   • To hide individual layers, click the eye buttons of the individual layers.  
   • To hide several layers, holding down Ctrl, click the desired layers and then click the eye button of one of the selected layers.  
   • If the Layers list contains both hidden and visible layers, the eye button for the Layers row looks like this.  
   • If you hide all layers, the eye button for the Layers row changes to . |
<table>
<thead>
<tr>
<th>To:</th>
<th>Do this:</th>
</tr>
</thead>
</table>
| • If you hide individual layers, the eye button for the hidden layers changes to 🎨.  
Note that layer visibilities do not affect model visibility, which means that the model eye icon is visible even though all layers are hidden. | |
| Detect changes between different versions of reference models | For details about change detection, see Detect changes between reference model versions (page 175).  
For details about comparison sets, see Define a comparison set for reference model change detection (page 181). |
| Refresh all reference models | • If the file name or path has not changed, open the Reference Models list and click the 🔄 Refresh button.  
All models that are not up to date are reloaded. If a reference model is not found, a warning sign 🔄 is displayed, and missing reference models are listed.  
• If the file name or path has not changed, open reference model details, browse for the new file and click Modify.  
You can also refresh locked reference models, if you have set the advanced option XS_REFRESH_ALSO_LOCKED_REFERENCE_MODELS to TRUE in File --> Settings --> Advanced options --> Import. |
| Refresh a single reference model | Do one of the following:  
1. Select the reference model in the Reference Models and click the Refresh button.  
2. In the displayed message box, select Selected.  
1. Double-click the reference model in the Reference Models list to open the details.  
2. Click the Refresh button. |
<table>
<thead>
<tr>
<th>To:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>If the original model path model is found, and the model has changed, the model is reloaded. A warning sign ⚠️ is displayed if the reference model is not found and data needed to draw the model is missing.</td>
<td></td>
</tr>
<tr>
<td>Refresh the reference model when settings have changed</td>
<td>Hold down Ctrl and click the Refresh button. You need to do this when you have changed the LargeTessellationPerCircle setting in the TrimBimPlugin.config, for example. The default value is 192, and if you have problems with the performance, you can decrease the value in TrimBimPlugin.config, which is located in the .bin\plugins \referenceplugins\trimbim folder. Changing this setting affects all new inserted and updated reference models.</td>
</tr>
<tr>
<td>View user-defined attributes</td>
<td>1. Double-click the reference model in the Reference Models list to open the details. 2. Click the small arrow on the User-defined attributes row to show the list of user-defined attributes. 3. The user-defined attributes that are specified for reference models in the objects.inp file are listed in the User-defined attributes list. Enter or select a value from the list. By default, the objects.inp is located in ..\ProgramData\Trimble\Tekla Structures&lt;version&gt; \environments\common\inp. You may also have some objects.inp files that you modify and keep in firm or project folders. These files are read in certain order. To use user-defined attributes in your reference models, you must add the UDAs to the objects.inp file if your</td>
</tr>
</tbody>
</table>
To: environment does not contain the necessary reference model UDAs.

Do this:

Clip reference models only with clip plane tool

Set the advanced option XS_DO_NOT_CLIP_NATIVE_OBJECTS_WITH_CLIP_PLANE to TRUE to only clip reference models and point clouds with the clip plane tool. If you do this, the native objects are not clipped.

Redraw the model views after changing the value.

This advanced option is located in the Model views category in the Advanced options dialog box.

See also

Modify reference model details (page 173)
Reference model objects (page 189)
Examine reference model hierarchy (page 190)
Lock reference models (page 174)

Modify reference model details

After you have inserted a reference model, you can modify its details.

Limitation: Coordinates given in the Details section are always relative to model coordinates. You can modify the coordinate system only if model coordinate system is used in the reference model.

1. Click the Reference Models button in the side pane on the right side of the Tekla Structures main window. You can also go to the File menu, and select Import --> Insert reference model. Close the Add model dialog box.

2. In the Reference Models list, double-click the reference model that you want to modify.

3. Click the arrow on the Details row, and change the desired details:
   - Change Code, Title, Phase and Description of the reference model.
     The code could be a site number, project number, or accounting number. By default, the title is the same as the name of the inserted reference model. You may want to use the name of the discipline or the company instead, for example. Write the description according to
the company conventions. The phase is the design phase of the reference model (not the phase in the Tekla Structures model).

- You can insert another version of the reference model using the File box. For more information about version handling, see Detect changes between reference model versions (page 175).

- In the Group box, you can select a new group for the reference model.

- You can also change the Location by selection.

  By default, the Location by change does not keep the reference model location. When you click Modify, the model position changes according to East coordinate, North coordinate and Elevation setting differences. If you want to calculate new offsets and keep the current reference model location, select the check box next to the Location by setting.

- You can change the Offset by entering new coordinates or by picking a new offset.

- You can change the Rotation by entering a new value or picking a new location.

  There may be additional rotation boxes available for rotation around X and Y axis. If the reference model already contains X or Y rotations, the additional X and Y boxes are not active.

- Change the Scale, if necessary.

- Click the arrow on the User-defined attributes row, and enter values for the user-defined attributes.

  You may enter strings (texts), select dates or enter numeric information depending on the type of the user-defined attribute. The reference model user-defined attributes are defined in their own section in the objects.inp file. If you have several objects.inp files, they are read in a specific reading order.

4. Click Modify. The changes that you made are implemented in the reference model.

See also

Insert a reference model (page 165)

Lock reference models

You can prevent reference models from moving and from detail updates by locking the reference models.
1. Click the **Reference Models** button in the side pane on the right side of the Tekla Structures main window.

   You can also go to the **File** menu, and select **Import --> Insert reference model**. Close the **Add model** dialog box.

2. Move your mouse over the desired reference model in the **Reference Models** list.

   The **Lock/Unlock** button is displayed.

3. Click the **Lock/Unlock** button.

   Now the reference model is locked. You can only add values for user-defined attributes and work with layers, but you cannot modify the details in any other way or move the model.

   ![Lock/Unlock button](image)

   To lock multiple reference models, select the models from the list and click the **Lock/Unlock** button of one of the reference models.

   To unlock the reference model, click the **Lock/Unlock** button again.

**See also**

- Reference models and compatible formats (page 163)
- Modify reference model details (page 173)

**Detect changes between reference model versions**

You can check the changes between different IFC reference model versions in Tekla Structures using change detection (change management). You can use change detection to detect changes between reference models from different disciplines, such as engineer or detailer. Changes are detected on object level. You can also compare Tekla Structures models if you have exported a Tekla Structures model into IFC format at least twice.

Tekla Structures stores versions of the reference models for change detection. Versioning is also needed for visualizing sharing changes and object conversion change management.

**Limitations**

- Property comparison works only for IFC or IFC-based reference models.

  The following formats are supported:

  - .ifc
• .ifcxml
• .ifczip
• .tczip

• Deleted objects are not highlighted and cannot be selected.

Change detection

You can show changes between two stored reference model versions or between stored version and browsed reference model file version. In both of these cases you need to activate change detection:

1. Click the Reference Models button in the side pane on the right side of the Tekla Structures main window.
   You can also go to the File menu, and select Import --&gt; Insert reference model. Close the Add model dialog box.
2. Open a reference model by double-clicking the model in the Reference Models list.
3. Open the Change detection list by clicking the arrow on the Change detection row.

Change detection between stored version and browsed model file version

The file path box has automatically the full file path to the current reference model original file. If a reference model file with the same name has changed, you can run the change detection and skip steps 1 and 3 below.
1. Click ... and browse for an earlier version of the reference model.
2. Select the This model is newer check box next to the file path if you want to define that the file shown in the box is newer.
3. Ensure that you have both the original reference model and the browsed reference model version visible by setting the eye buttons active in the Change detection section.
4. To change the comparison set if needed, click the ... button and define the set you want to use. Then click Update view. The comparison set contains the properties that you want to use in version comparison.
5. To change property set comparison tolerances, click the Property set comparison tolerances button .
You can do any of the following in the changes list and in the property details list:

- **Export change detection results to Excel by clicking **Export to Excel.** The exported Excel file contains all or changed properties that are visible in the changes list. The information is exported in the current language.
- Click a row in the changes list to open the related property details list in the side pane. The content of the property details list depends on the comparison rules that you are using. The details list also indicates how the individual properties have changed in the **Old value** and **New value** columns.

Note that in the property details list, if you by accident remove one of the columns, you can bring it back by right-clicking the column title and selecting the column from the context menu. You can then drag the column to the desired location.

- To show the object in the model, select the **Select objects in the model** check box, and then click a row in the changes list. Note that you cannot select deleted objects.
- The older state of an object is drawn to the model view when you select the corresponding object in the changes list.
- To highlight the object in the changes list, select the **Get selected objects from model** check box, and then click an object in the model.
• To zoom to the selected object in the model, select the **Zoom to selected** check box, and then click a row in the changes list. You can also zoom to deleted objects.

• The older state of a reference model object is drawn to the 3D view in orange color when you select the corresponding object.

• To show only changes in the property details list, select the **Show only changes** check box, and then click a row in the changes list.

• You can search for specific items using the search box at the bottom.

• If the changes list disappears, you can bring it back by clicking the **Changes list** button in the side pane. If the details list disappears, you can bring it back by clicking the **Property details** button in the side pane. These two buttons are only visible when **Change detection** is active.

---

**Update reference model and detect changes between versions**

You can update a reference model with another version of the model, and detect the changes between these two reference model versions.

1. Open another version of the reference model by browsing to it in the **File** box in reference model details and clicking **Modify**.

   This updates the original reference model with the changed information in the other reference model version.

   You can open several versions, but you can only compare two versions at a time.

   You do not need to copy the reference models to the model folder.

2. On the **Change detection** row, click the arrow on the row to open the **Change detection** list.

   In the **Change detection** list, the current version is bolded. The newest version is at the top and the oldest at the bottom.

3. Ensure that both models are visible by setting the eye buttons active in the **Change detection** list.

   Comparison is active only when two eye buttons are active. You cannot have more than two eye buttons active at the same time. If you activate a third reference model in the list, the older version from previously visible model is automatically set inactive, and the comparison is done between the two models that have the active eye.

4. Set another version as the current version in the **Change detection** list by right-clicking the version in the list and selecting **Set as current**.

5. To change the comparison set, click the **...** button and define the set you want to use. Then click **Update view**. The comparison set contains the properties that you want to use in version comparison.
6. To delete a version, right-click the version in the Change detection list, and select Remove.

The current model version is modified, and this modification is shared in multiuser mode or Tekla Model Sharing.

When you remove a version, you are asked if you want to set the model as current and save changes.

You need to pay special attention to versioning and updating in a project. For example, if you remove a version, the current model is updated and you may end up with conflicts.

7. Select any or all of the check boxes for the following options: Changed, Unchanged, Inserted and/or Deleted, and then click the Update view button, which is displayed when you select an option.

For example, select Inserted to show with green color the objects that were inserted between the two versions.

The changes list and the property details list are displayed. The changes list content is based on the IFC content and has all physical object types. The colors are the same as the ones in Change detection.

8. You can do any of the following in the changes list and in the details list:

- Click a row in the changes list to open the related property details list in the side pane. The property details list contains at least the name, location as origin and property set properties, basically the content is the same as in the reference object inquiry report. The details list also indicates how the individual properties have changed in the Old value and New value columns.

- To highlight the object in the model, select the Select objects in the model check box, and then click a row in the changes list. Note that you cannot select deleted objects.

- To highlight the model object in the changes list, select the Get selected objects from model check box, and then click an object in the model.

- To zoom to the selected object in the model, select the Zoom to selected check box, and then click a row in the changes list. You can also zoom to deleted objects.
• To show only changes in the property details list, select the **Show only changes** check box, and then click a row in the changes list.

• The older state of a reference model object is drawn to the 3D view in orange color when you select the corresponding object.

• You can search for specific items using the search box at the bottom.

• If the changes list disappears, you can bring it back by clicking the **Changes list** button in the side pane. If the details list disappears, you can bring it back by clicking the **Property details** button in the side pane. These two buttons are only visible when **Change detection** is active.

**Change comparison order**

• Select the **This model is newer** check box to define that the file shown in the file path box is newer than the other compared file. If the file has been updated, it appears in the box automatically and the check box is selected.

• It is possible to compare as newer (default) or older.

Select the **This model is newer** check box next to the file path box if you want to define that the file shown in the box is newer.

**Macro for selecting Tekla Structures native objects**

The **Select Corresponding Objects Based On Ifc Objects Selection** macro is useful for cases where you exported native objects to IFC, inserted the IFC model back to the same native model, and then you want to select the corresponding Tekla Structures objects. You may need to select the corresponding objects when you want to add your own UDAs to all updated and selected native objects, for example.

**Remove old reference model versions automatically**

You can remove old reference model versions automatically with the advanced option **XS_REFERENCE_MODEL_KEEP_VERSIONS_COUNT**.
See also
Insert a reference model (page 165)
Convert IFC objects into native Tekla Structures objects (page 196)

Define a comparison set for reference model change detection
Change detection in Tekla Structures compares different versions of the reference model based on a comparison set, which tells you whether Tekla Structures considers a change in a property a change or not. You can use the standard property comparison set, or define a comparison set of your own.

In the reference model, when change detection is active, the changes list shows all deleted, changed, new and not changed objects. The property details list only contains those properties that are defined by the current comparison set rules to be compared.

When you save a comparison file, both the standard file and a customized comparison set file are saved to the \attributes folder under model folder. The standard file can only be removed from model folder if it exists in another location. If saving or removing the standard file is not successful, you will get an error message.

Create a new comparison set
1. Open two versions of the same reference model.
2. In Change detection, click the Comparison sets button ... to open the Comparison sets dialog box.
3. Enter a name for the comparison set.
4. Add a new comparison rule by clicking the Add row button and typing or copying and pasting the property name.
   • You can copy and paste property names directly from the property details list in change detection.
   • To include more properties within one rule, use asterisk (*), for example:
     X* (all that starts with X)
     *X (all that ends with X)
   • If you want to compare only one property set property, clear the Property sets check box and create a separate rule for that property.
If you want to compare all property sets but not one property, select the **Property sets** check box and create rule for that property and leave its check box empty.

- Note that comparison rules are case insensitive.
- All rules in comparison set affect the comparison if the reference model version has a corresponding property.

5. Add more rules in the same way as in step 2 and 3.

6. To delete a rule, select the rule and click the **Delete row** button. You cannot delete fixed comparison rules, like **Geometry**, **Location**, **Rotation**, **Materials**, **Profiles**, **Products**, **Common attributes** or **Property sets**, but you can exclude those from comparison by leaving the check boxes next to them empty.

7. Ensure that you have the check box selected next to all the comparison rules you want to include in the comparison set. If you do not want to include a rule, clear the check box.

8. Click the **Save** button.

9. Close the comparison set dialog box by clicking the **Close** button. If you have not saved your changes, you will be asked if you want to keep the changes when you close the dialog box.

10. Click the **Update view** button.
**Properties in comparison set**

A comparison set may contain the following types of properties:

- Free property set properties, such as `BaseQuantities.NetVolume`
- Fixed properties that always exist in the comparison set file, but can be excluded from the comparison

The fixed properties are listed below:

<table>
<thead>
<tr>
<th>Property type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Geometry</td>
<td>Object dimensions</td>
</tr>
<tr>
<td>Location</td>
<td>The coordinates of the object in the model</td>
</tr>
<tr>
<td>Rotation</td>
<td>The rotation coordinates of the object</td>
</tr>
<tr>
<td>Material</td>
<td>Material name and grade</td>
</tr>
<tr>
<td>Profile</td>
<td>Profile name</td>
</tr>
<tr>
<td>Product</td>
<td>IfcProduct parameters that vary object type by type. Some properties are optional. Below examples of product properties for IfcColumn: Application full name, Application identifier, Change action, Creation date, Description, Family name, Given name, Is set last modified date, Last modified date, Middle names, Name, Object type, Organization description, Organization names, Organization roles, Roles</td>
</tr>
</tbody>
</table>

Import to and export from Tekla Structures 183 Reference models and compatible formats
<table>
<thead>
<tr>
<th>Property type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Common attributes</td>
<td>Below examples of common attributes for IfcColumn:</td>
</tr>
<tr>
<td></td>
<td>External Use</td>
</tr>
<tr>
<td></td>
<td>Fire Rating</td>
</tr>
<tr>
<td></td>
<td>Load bearing</td>
</tr>
<tr>
<td></td>
<td>Reference</td>
</tr>
<tr>
<td></td>
<td>COLUMNTYPE-&gt;GUID</td>
</tr>
<tr>
<td></td>
<td>GUID</td>
</tr>
<tr>
<td>Property sets</td>
<td>Whatever has been added to IFC properties.</td>
</tr>
<tr>
<td></td>
<td>Below examples of property set properties for IfcColumn:</td>
</tr>
<tr>
<td></td>
<td>BaseQuantities.Length [mm]</td>
</tr>
<tr>
<td></td>
<td>BaseQuantities.NetWeight [kg]</td>
</tr>
<tr>
<td></td>
<td>BaseQuantities.NetVolume [mm³]</td>
</tr>
<tr>
<td></td>
<td>BaseQuantities.OuterSurfaceArea [m²]</td>
</tr>
<tr>
<td></td>
<td>Tekla Common.Bottom elevation</td>
</tr>
<tr>
<td></td>
<td>Tekla Common.Class</td>
</tr>
<tr>
<td></td>
<td>Tekla Common.Phase</td>
</tr>
<tr>
<td></td>
<td>Tekla Common.Preliminary mark</td>
</tr>
<tr>
<td></td>
<td>Tekla Common.Top elevation</td>
</tr>
<tr>
<td></td>
<td>Tekla Quantity.Area per tons [m²]</td>
</tr>
<tr>
<td></td>
<td>Tekla Quantity.Gross footprint area [m²]</td>
</tr>
<tr>
<td></td>
<td>Tekla Quantity.Height [mm]</td>
</tr>
<tr>
<td></td>
<td>Tekla Quantity.Length [mm]</td>
</tr>
<tr>
<td></td>
<td>Tekla Quantity.Net surface area [m²]</td>
</tr>
<tr>
<td></td>
<td>Tekla Quantity.Weight [kg]</td>
</tr>
<tr>
<td></td>
<td>Tekla Quantity.Width [mm]</td>
</tr>
<tr>
<td></td>
<td>Tekla Quantity.Volume [mm³]</td>
</tr>
</tbody>
</table>
**Define property comparison tolerances**

In reference model version comparison, you can modify the property comparison tolerance settings to get relevant changes more easily. You need two versions from the same IFC model.

The changed row appears as light yellow if the tolerance is bigger than the difference.

1. Open two versions of the same reference model.
2. In the **Reference Models** pane, open the **Change detection** section and activate the change detection.
3. Click the **Property set comparison tolerances** button.
4. Change the tolerances by modifying the values.
5. Apply the changes by closing the dialog box and clicking **Update view**. The changed row appears as light yellow.

You can also save the tolerances in the **Property set comparison tolerances** dialog box.

**Export reference model change detection results to Excel**

The exported Excel file contains all or changed properties that are visible in the reference model changes list. The information is exported in the current language.

Objects that are filtered out using **comparison set (page 181)** filtering are not exported.

Columns in export:
1. When the reference model change management (page 175) is active and the changes list is displayed, click Export to Excel.

2. Filter which properties are shown in the property changes list and exported to the Excel file by using the comparison set (page 181) filtering.

3. In the Export to Excel dialog box, define the needed settings:

   - **Template**: Select a new Excel template for the export.
   - **Export without column headers**: If you do not want to show the column headers in the Excel sheet, select this option.
   - **Export details**: Exports all property details. Property details are shown collapsed by default. When you open the collapsed details by clicking the plus (+) button, all details are listed under titles Name, Old value and New value.
   - **Changed details only**: Only exports those property details that have changed between reference model versions.

4. If you want to save the settings in a properties file to be loaded and used in other exports, enter a name and click Save.

5. When you are ready, click Export.
   
   The changes list is exported to an Excel spreadsheet.
   
   If you want, you can save the Excel where ever you want.
Example of the exported Excel when the **Export details** option has not been selected.

<table>
<thead>
<tr>
<th>Status</th>
<th>Name</th>
<th>GUID</th>
<th>Material</th>
<th>Type</th>
<th>Profile</th>
</tr>
</thead>
<tbody>
<tr>
<td>Changed</td>
<td>1k54BEQ2z0FaZ0F06W61h</td>
<td>14u171x892gYaUJ1</td>
<td>STEEL/35JR</td>
<td>IFCCOLUMN</td>
<td>HEA400</td>
</tr>
<tr>
<td>Changed</td>
<td>39B34K2OPQ552S21L6W8</td>
<td>3Qko09y5bNidWmdDg</td>
<td>STEEL/35JR</td>
<td>IFCDISCRETEACCESSORY</td>
<td></td>
</tr>
<tr>
<td>Changed</td>
<td>3uQ8XZIXJTPm512IUvl</td>
<td>STEEL/35JR</td>
<td>IFCDISCRETEACCESSORY</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Changed</td>
<td>180F2Xz19149BpmLg</td>
<td>Undefined</td>
<td>IFCDISCRETEACCESSORY</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Changed</td>
<td>3Q81C0F6607TgB8h1U</td>
<td>Undefined</td>
<td>IFCDISCRETEACCESSORY</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Example of the exported Excel when the **Export details** option has been selected. If you include details in the export, all property details are listed, and the detail rows are by default collapsed. You can open the details by clicking the plus (+) button.

Example of the exported Excel when the **Export details** and **Changed details only** options have been selected.
Inquire reference model contents
You can inquire the contents of a reference model. This is something you might want to do after importing a reference model into Tekla Structures.

1. On the ribbon, click **Object**.
2. In your Tekla Structures model, click the reference model you want to examine.
   The contents of the reference model are listed in the **Inquire object** dialog box.
See also
Insert a reference model (page 165)

Reference model objects

Some types of reference models are automatically subdivided into *reference model objects*, which is an individual part of an imported reference model. You can define user-defined attributes separately for each reference model object and use them for reports and the view and selection filters. They can also be
moved to a Tekla Structures model that is currently being worked on. Information included in a reference model object can be saved in the model database.

The reference model objects are read-only.

Whether the reference model supports splitting depends on the file format and file structure. .ifc models are always automatically subdivided, and .dwg files that include any of the following objects, are also automatically subdivided:

- block table
- polyface mesh
- polygon mesh
- proxy object (for example, ADT)
- ACIS objects (3DSolid, Body, Region)

The file formats .dgn, .prp, .skp, .step, and .iges are not subdivided.

**TIP** To report a needed reference object attribute you can inquire a reference object in the model to see the property name and then in Template Editor, add that property name to be reported in a Reference* row.

**See also**
Reference models and compatible formats (page 163)

**Examine reference model hierarchy**
You can view the reference model hierarchy and check the hierarchy level of different objects. You can also add user-defined attributes to the reference model objects. The added attributes can be used for filtering, for example. Additionally, you can view the native reference object attributes and properties.

1. Ensure that the **Select assemblies** selection switch (for assemblies) or **Select objects in assemblies** selection switch (for parts) is active.
2. Point the reference model, hold down **Shift** and scroll using the middle mouse button to the hierarchy level were the reference object is. Notice that if the cursor is too close to a grid, the hierarchy is not scrolled.
3. Do any of the following:
   - To inquire the native reference object properties and attributes, right-click the object and select **Inquire**.
   - To view or modify the user-defined attributes of a reference object, double-click the object to open the reference model object details.
TIP There are many more commands available for the selected reference model objects. Check rest of the commands on the context menu.

Below is an example of a reference model. When you want to scroll the hierarchy, the Select assemblies selection switch or the Select objects in assemblies selection switch must be active. The 0 level IfcProject in the example is the upmost level.

In the image below you can see one of the reference objects on the third level, IfcBuildingStorey, of the same reference model.

As you can see, the level 4, IfcWall, shows an individual part. In this case, it is a wall.

In the example below, one of the reference objects on the lowest level has been inquired.
Reference model assemblies

Imported IFC reference models can contain assemblies. You can select reference model assemblies in the model view and view assembly level information in Tekla Structures.

- You can add user-defined attributes to reference model assemblies.
- You can use the Inquire command to view information on reference model assemblies. For example, you can view GUIDs of child objects.
- You can create reports to view information on reference model assemblies.

3.2 IFC

IFC stands for Industry Foundation Classes, the set of internationally standardized object definitions for use in the construction industry. IFC is developed as an open standard by buildingSMART.

IFC offers a high-level common language for the sharing of intelligent objects, such as building elements, between disciplines across the building life cycle. The principal benefit of IFC is the object description – not only does the IFC protocol preserve the full geometric description in 3D, but it also knows its location and relationships, as well as all the properties (or parameters) of each object.

For a list of IFC applications certified by buildingSMART international, see Certified software.

See also

IFC interoperability concepts (page 193)
Insert IFC models as reference models (page 195)
IFC interoperability concepts

Some common terms and concepts used in IFC import, export, and conversion are explained below.

B-rep

*B-rep* or *boundary representation* is a method for representing shapes using the limits. A solid is represented as a collection of connected surface elements, showing the boundary between solid and non-solid.

CSG

*CSG* or *Constructive Solid Geometry* is a technique used in solid modeling. CSG allows a modeler to create a complex surface or object by using Boolean operations to combine simpler objects.

Boolean operations on sets

Union:
Intersection:

Difference:
Extrusion
Sweeping is allowing a two-dimensional planar cross section to sweep through space.

Revolved extrusion
A revolved extrusion or a solid of revolution is a solid object that is obtained by rotating a plane cross section around a straight line (the axis) that lies on the same plane.

Arbitrary profiles
In addition to parameterized profiles, there is a free profile shape type called arbitrary profiles. These profiles are defined by an ifcCurve, which may have linear and curved segments. Thin wall profiles can be defined by a centerline and a thickness. Other profiles are defined by a closed shape. Closed profile shape may or may not have inner voids.

Parameterized profiles
There are several parameterized profiles available in the IFC specification. Those include standard hot-rolled steel I, L, T, U, and Z profiles, cold formed C profiles, and generic rectangle and circle profiles with or without a hollow. These profiles are defined with their parameters, such as width, height, web thickness and flange thickness.

Insert IFC models as reference models
You can insert IFC models as reference models to Tekla Structures, and optionally convert the inserted IFC objects into native Tekla Structures objects directly by using the direct conversion, or convert the selected IFC reference objects using conversion change management. You can use inserted IFC reference models, for example, in clash checking, reporting and scheduling.

Insert a reference model
1. Open a Tekla Structures model where you want to insert the IFC reference model.
2. Go to the File menu, and select Import --> Insert reference model.
   This opens the Reference Models list and the Add model dialog box.
   You can also open the Reference Models list by clicking the Reference Models button in the side pane and the click the Add model button.
3. Click the following link and follow the instructions for inserting the reference model: Insert a reference model (page 165).
   You can check the changes between different IFC reference model versions in Tekla Structures using change detection (page 175). You can convert the inserted IFC objects into native objects (page 196).
Supported IFC schemas and IFC applications

• Tekla Structures supports the following IFC schemas:
  • IFC2X3 (recommended)
  • IFC4

• For a list of applications/utilities that are purported, by their developers, to provide IFC insert and/or export functionality, see List of all IFC applications.

Certification

• The IFC insert IFC2X3 functionality has the IFC certification granted by buildingSMART international. For a list of IFC-certified applications, see Certified Software.

Supported entities
The IFC reference model insert in Tekla Structures supports all the sub-objects of the IfcBuildingElement class and sub-objects of the IfcProduct class including:

• Architectural entities
• Structural entities
• Building services entities

Supported formats

• IFC (.ifc) and ifcXML (.ifcXML) formats are supported.
• You can use compressed (.ifcZIP) or uncompressed insert files.
• IFC4 does not support ifcXML.
  IFC4.3 format files are supported in Tekla Structures 2023.

See also
Convert IFC objects into native Tekla Structures objects (page 196)

Convert IFC objects into native Tekla Structures objects
You can convert most linear IFC reference objects such as beams, columns, braces, plates, slabs, footings and walls into native Tekla Structures objects. Conversion also supports polybeams that have curved sections, and have originally been exported from Tekla Structures, and string, int and double type UDAs. The purpose of converting IFC objects in Tekla Structures is to help in the creation of the structural model and to avoid rework in an early modeling phase.

In IFC object conversion, IFC objects are converted either as items or as extrusions. Conversion as item means that an IFC object is converted as a Tekla
Structures item, where the 3D shape defines the geometry of the item.
Conversion as extrusion (page 193) means that an IFC object is converted as a part (column, beam, plate, etc.) that has a profile extruded to create the length of the part.

In IFC object conversion you need to do the following:

1. Before converting, check that the profiles and units in the IFC reference model are compatible with your environment.
2. Check the object conversion settings in the IFC object conversion settings dialog box and change them, if needed.
3. Convert the IFC objects to native Tekla Structures objects. There are two alternative ways available in object conversion:
   • Converting all selected reference model objects at one go using the Convert IFC objects command on the Manage tab.
   • Converting using the IFC object conversion change management. You can also perform an update conversion with a new reference model revision using the change management.

For more information about the profile conversion logic, see section "Profile conversion logic" below. Limitations are listed in section "Limitations in IFC object conversion" below.

Is object conversion always necessary?

In Tekla Structures, reference model objects can be used in a way similar to the native objects, for example, in clash detection, reporting and scheduling. There is no need to have everything as native, because the reference model objects can also be used in many ways. For example, reference model objects can be shown in drawings and they can be listed in reports.

The reference files have the benefit compared to the copied files that the content of the files is automatically updated by the designer of that design discipline.

Check and change the IFC object conversion settings

Before you start converting, check the conversion settings and change them if necessary.

1. On the File menu, click Settings --> IFC object conversion settings.
2. In the IFC object conversion settings dialog box, check and change the conversion settings:

| Create report after conversion | Not used any longer. The changes list replaces the report. |
**Set handles to top flange**

Set the reference lines of beams to top flange.

If **Set handles to top flange** is not selected, the reference lines of beams are located in the middle of the beams.

This setting is not used for polybeams for better conversion results.

**Convert B-rep object**

Convert B-rep objects into Tekla Structures objects.

You can select conversion to item and conversion to extrusion separately for concrete material and other material, for example, steel. The selected options are applied to direct conversion and in conversion change management.

B-rep objects are converted to items, and the items are added to the shape catalog. The items belong to class 996.

**Primary profile mapping**

**Profile name** Map profiles primarily by comparing the profile names between the IFC model and Tekla Structures profile catalog.

**Dimensions**: Map profiles primarily by comparing the object dimensions.

If the IFC object converter cannot map profiles with the method you select as primary, it applies the secondary (unselected) method.

**Tolerance**

Enter values for dimension comparison. The unit of measurement is based on the environment.

The value in **Tolerance** affects only rectangular hollow profiles. It is used to distinguish hot rolled profiles from cold rolled profiles.

3. Copy properties from the IFC object property sets to be used as user-defined attributes of converted Tekla Structures objects:

   a. Click **Add** to add a row and enter the name of the IFC property in the **Property** box.

      Write the IFC property as it is shown in the **Inquire** dialog box (without the prefix EXTERNAL).

      Dots (.), underscores (_), and spaces are allowed in the property set name.

   b. Enter the name of the user-defined attribute in the **UDA** box.

      The maximum length of the user-defined attribute name is 20 characters. The user-defined attribute that you add here must also be included in the **objects.inp** file. Ensure that the attribute name is unique. Enter the original name of the user-defined attribute. For the
following, also the translated name is supported: Profile name, Description, Ifc type (type), Object type, Phase, Material, Finish, Profile, and Name.

Note that you can copy the Object type property to UDA with ObjectType.

c. Click **Type** to select the format of the attribute.

   The possible formats are string, integer or double. The type specifies the IFC property datatype, not the UDA datatype.

4. Before you convert IFC objects into native Tekla Structures objects, check the profiles and materials to ensure that the conversion will be successful, and map the profiles or material manually in the following way:

   a. Click the **Check** button.

      Tekla Structures displays any missing profiles or materials on the **Missing Profiles** and **Missing Materials** tabs in the **Missing Mapping** dialog box.

   b. Select an appropriate option in the Tekla Structures profile and Tekla Structures material lists to define a mapping for the missing profiles or materials.

      An IFC part profile name can be mapped with a Tekla Structures profile. The mapping of profiles works for IFC data that has a profile name but does not include enough information for conversion. You can change your mappings later if needed. The maps are used in conversion only if the profiles are not found from Tekla Structures catalogs. The profile conversion follows a certain logic described below.

      Material mapping works for both existing and not found materials.
c. Click **Update Mapping Catalogs and Close**.

You can also open and modify the catalog files in a text editor. To do this, click the **Catalog** button. When you are done, reopen the IFC object conversion settings to take the new settings in use. The files are located in the `\attributes` folder under the model folder:

- **TeklaStructuresCatalogMaterials.txt** contains all materials
- **TeklaStructuresCatalogProfiles.txt** contains all profiles
- **MappedMaterials-default.txt** maps the materials
- **MappedProfiles-default.txt** maps the profiles

5. Click **OK** in the **IFC object conversion settings** dialog box. Now you can convert the IFC objects using one of the two available ways.

**Convert selected IFC objects at one go**

You can convert all imported IFC objects at one go using the current object conversion settings. You need to have at least two or more revisions of the same model.

1. Open the **Reference Models** list by clicking the **Reference Models** button in the side pane.

2. Click the **Add model** button, browse for the model in the **Add model** dialog box, and click **Add model** again.

3. In the model, select the objects that you want to convert.

4. Go to the ribbon, and on the **Manage** tab, click **Convert IFC objects**. The selected objects are converted on the basis of IFC conversion settings. Conversion is done automatically for objects that have not been converted earlier. Converted IFC objects are listed in the changes list at the bottom. Each object is on a row of its own, and cuts are listed hierarchically under the related object.
• To select objects in model, activate the **Select objects in the model** check box, and then click an object row. This also selects the related native object.

• To highlight the object in the changes list and show its details, select the **Get selected objects from model** check boxes, and then click an object in the model.

• To zoom to the selected object in the model, select the **Zoom to selected** check box, and then click a row in the changes list. The **Zoom to selected** check box is disabled if the **Select objects in the model** is not selected.

• To show only changes in the property details list, select the **Show only changes** check box, and then click a row in the changes list.

  Note that in the property details list, if you by accident remove one of the columns, you can bring it back by right-clicking the column title and selecting the column from the context menu. You can then drag the column to the desired location.

• The status of an object may be **New** (green) **Changed** (yellow), **Deleted** (red), or **Up-to-date** (blue or gray, when the conversion change management is reopened), or **Error** (lilac).

• The **Conversion status** column shows the resulting conversion status.

• The properties of a converted object are listed in the property details list that appears in the side pane when you click an object in the changes list.
5. You can update an object in the list by changing its conversion status to Conversion and clicking Apply changes.

6. If the lists disappear, click the following buttons that are only visible when the conversion changes list is active:

- The Changes list button brings back the changes list.
- The Property details button brings back the property details list.

**Convert IFC objects using conversion change management - first conversion**

Object conversion change management provides change detection and change management on object level. Conversion change management is needed in the initial data change management to reduce the challenges in construction projects. Objects are not converted automatically but you need to convert the objects using the conversion changes list.

1. Open the Reference Models list by clicking the Reference Models button.

2. Click Add model, browse for the model in the Add model dialog box, and click Add model again.

3. Double-click the model in the Reference Models list to open it, and then click the Start IFC object conversion change management button.

The current conversion status is displayed in the changes list and conversion management is activated. The status is based on reference model object physical changes and IFC conversion settings. The properties of a reference object are listed in the property details list that appears separately for each object when you click an object in the changes list.

Use the Select objects in the model, Get selected objects from model, and Zoom to selected check boxes to review the model and the changes and details lists.
The reference object status and conversion status logic and colors:

<table>
<thead>
<tr>
<th>Status</th>
<th>Conversion status</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>No conversion</td>
<td>Green</td>
</tr>
<tr>
<td>Changed</td>
<td>Conversion as item or Conversion as extrusion</td>
<td>Yellow</td>
</tr>
<tr>
<td>Deleted</td>
<td>Conversion as item or Conversion as extrusion</td>
<td>Red</td>
</tr>
<tr>
<td>Up-to-date</td>
<td>Conversion as item or Conversion as extrusion</td>
<td>Blue (gray when the conversion change management is reopened)</td>
</tr>
<tr>
<td>Error</td>
<td>No conversion</td>
<td>Lilac</td>
</tr>
</tbody>
</table>

4. Convert objects by selecting the desired object rows, selecting Conversion in the Conversion status column and clicking Apply changes. The conversion is based on conversion settings. You can select multiple objects.
• After conversion, the conversion status is either **Conversion as item** or **Conversion as extrusion** depending on the result of the conversion.

• **B-reps (page 193)** are shown as **Surface geometry**, **parametric** (page 193) profiles as **Parametric** and **arbitrary** (page 193) shapes as **Arbitrary**. Assembly is also **Arbitrary**, and so are the reference objects that are selected with the **Select objects in assemblies** or **Select objects in components** selection switches.

• If **B-rep** (**Surface geometry** in the **Reference type** column) conversion is selected, conversion is done as item, if not error.

• If **object** is **extrusion (page 193)** (**Arbitrary** or **Parametric** in the **Reference type** column), it is converted as extrusion.

• You can force conversion to be item by selecting **Conversion as item**. In this case, an extrusion object is also converted as item. The conversion does not check if same shape is already available, meaning new shape will always be created.

• You can force conversion to be extrusion by selecting **Conversion as extrusion**. In this case, **B-rep** is also converted as extrusion, profile is by mapping, or by bounding box if there is no mapping. This conversion result is not always as preferred.

• If the conversion fails, the result is written to the **Conversion status** column, and the row color is lilac.

5. If the lists disappear, click the following buttons that are only visible when the conversion management is active:

   - The **Changes list** button brings back the changes list.
   - The **Property details** button brings back the property details list.

---

**Convert IFC objects using conversion change management - update conversion**

If a previously converted reference object has changed in a newer reference model revision, you can compare the older and newer revisions of the reference model and update the conversion.

1. Open the **Reference Models** list by clicking the **Reference Models** button in the side pane.

2. Open the older reference model revision by double-clicking it in the **Reference Models** list.

3. Update the reference model with a new revision of the reference model by selecting a new revision file in the **File** list in the **Details** section and clicking **Modify**.
4. Click the **Start IFC object conversion change management** button.

5. Go through the changes:
   - Select the **Select objects in the model** and **Zoom to selected** check boxes to see the changed objects clearly in the model.
   - Click the changed row to see detailed changes in property details in the side pane.

6. You can update previously converted objects partially by selecting the **Update** check box next to a certain property in the property details pane. For example, if you only want to update the profile information, only select the **Update** check box next to the **Profile** row in the property details pane.

7. To convert all objects with changed conversion status, select all rows, change the **Conversion status** to **Conversion** and click **Apply changes**.
   - The objects that have a changed conversion status are converted on the basis of the current IFC object conversion settings.
   - You can update previously converted native model objects based on previous conversion type and settings by selecting **Conversion** in the **Conversion status** column. You cannot change the type from extrusion to item, in this case you need to delete the native objects and force conversion.
   - If the reference object status is **Deleted**, select **Conversion** and click **Apply changes**. This removes the native object and the link to the removed reference objects.

### Macro for selecting converted IFC objects

The **Select Converted Objects BasedOn Ifc Objects Selection** macro selects the objects that have been converted to native Tekla Structures objects. You may want to select the converted objects to check the properties of the native Tekla Structures objects, for example. This macro is located in the **Applications** section of the **Applications & components** catalog.

### Class values

The status of the converted object is reported in the changes list in the **Class** column. Sometimes the input data in the IFC model is not adequate to
successfully create the converted object. The following table explains what the class values mean.

<table>
<thead>
<tr>
<th>Class value</th>
<th>IFC object data</th>
<th>Converted object description</th>
</tr>
</thead>
<tbody>
<tr>
<td>990</td>
<td>Parametric profile with a name</td>
<td>There is enough information in the IFC model to convert the object successfully.</td>
</tr>
<tr>
<td>991</td>
<td>Parametric profile without a name</td>
<td>Tekla Structures determines the name of the object based on the objects profile.</td>
</tr>
<tr>
<td>992</td>
<td>Arbitrary profile with a name</td>
<td>The profile of the converted object may be incorrectly rotated because there is no parametrized profile data in the IFC model.</td>
</tr>
<tr>
<td>993</td>
<td>Arbitrary profile without a name</td>
<td>The profile of the converted object may be incorrectly rotated because there is no parametrized profile data in the IFC model. The profile name is set to UNKNOWN.</td>
</tr>
<tr>
<td>994</td>
<td>B-rep piece with a name</td>
<td>The profile may be an extrema box due to the lack of profile data in the IFC model.</td>
</tr>
<tr>
<td>995</td>
<td>B-rep piece without a name</td>
<td>The profile may be an extrema box due to the lack of profile data in the IFC model.            The profile name is set to UNKNOWN.</td>
</tr>
<tr>
<td>996</td>
<td>B-rep piece</td>
<td>The object is converted using the Convert B-rep object option in converter settings.          The converted B-rep object is either an item or a concrete item and is added to the shape catalog.</td>
</tr>
</tbody>
</table>
Example: Convert IFC objects into Tekla Structures objects at one go

In this example, an IFC model is used as a basis for your structural model. The beams and columns are converted into native Tekla Structures objects.

1. Hide irrelevant IFC layers:
   a. Click the Reference Models button in the side pane.
   b. In the Reference Models list, double-click the reference model to open the details.
   c. Open the Layers list by clicking the down arrow on the right.
   d. Hide the unnecessary layers by clicking the eye button next to the layer.

<table>
<thead>
<tr>
<th>Layers</th>
</tr>
</thead>
<tbody>
<tr>
<td>fans</td>
</tr>
<tr>
<td>M-HVAC-DUCT</td>
</tr>
<tr>
<td>ventilation</td>
</tr>
</tbody>
</table>
2. Select all visible IFC objects.
3. On the Manage tab on the ribbon, click Convert IFC objects. Tekla Structures converts the reference objects.
4. Check the profiles and materials of the IFC objects and map missing material:
   a. On the File menu, click Settings --> IFC object conversion settings.
   b. Click Check. Tekla Structures lists the missing profiles and materials.
   c. View the Missing Profiles and Missing Materials tabs. Tekla Structures lists a missing reference part material Concrete Block.
   d. Select CONCRETE_UNDEFINED from the list.
   e. Click Update Mapping Catalogs and Close.
   f. Select the Create report after conversion check box.
   g. Click OK in the IFC object conversion settings dialog box.
5. On the Manage tab, click Convert IFC objects again.
Tekla Structures converts the objects.

---

**TEKLA STRUCTURES CONVERTED DATA**

<table>
<thead>
<tr>
<th>ID</th>
<th>NAME</th>
<th>Profile</th>
<th>Initial Profile</th>
<th>Class</th>
</tr>
</thead>
<tbody>
<tr>
<td>Id: 124779</td>
<td>BEAM</td>
<td>W610X82</td>
<td>W610X82</td>
<td>992</td>
</tr>
<tr>
<td>Id: 124772</td>
<td>BEAM</td>
<td>W610X82</td>
<td>W610X82</td>
<td>992</td>
</tr>
<tr>
<td>Id: 124765</td>
<td>BEAM</td>
<td>W610X82</td>
<td>W610X82</td>
<td>992</td>
</tr>
<tr>
<td>Id: 124758</td>
<td>BEAM</td>
<td>W610X82</td>
<td>W610X82</td>
<td>992</td>
</tr>
<tr>
<td>Id: 124751</td>
<td>BEAM</td>
<td>W610X82</td>
<td>W610X82</td>
<td>992</td>
</tr>
<tr>
<td>Id: 124744</td>
<td>BEAM</td>
<td>W610X82</td>
<td>W610X82</td>
<td>992</td>
</tr>
<tr>
<td>Id: 124737</td>
<td>BEAM</td>
<td>W610X82</td>
<td>W610X82</td>
<td>992</td>
</tr>
<tr>
<td>Id: 124730</td>
<td>BEAM</td>
<td>W610X82</td>
<td>W610X82</td>
<td>992</td>
</tr>
<tr>
<td>Id: 124723</td>
<td>BEAM</td>
<td>W610X82</td>
<td>W610X82</td>
<td>992</td>
</tr>
<tr>
<td>Id: 124716</td>
<td>BEAM</td>
<td>W610X82</td>
<td>W610X82</td>
<td>992</td>
</tr>
<tr>
<td>Id: 124709</td>
<td>BEAM</td>
<td>W610X82</td>
<td>W610X82</td>
<td>992</td>
</tr>
<tr>
<td>Id: 124702</td>
<td>BEAM</td>
<td>W610X82</td>
<td>W610X82</td>
<td>992</td>
</tr>
<tr>
<td>Id: 124695</td>
<td>BEAM</td>
<td>W610X82</td>
<td>W610X82</td>
<td>992</td>
</tr>
</tbody>
</table>

The **Class** for all the converted objects is 992. That means that the profile of the converted object may be incorrectly rotated because there is no parametrized profile data in the IFC model.

6. Check the conversion changes list:
   - Select objects in the changes list to highlight them in the model: Use the buttons **Select objects in the model** and **Zoom to selected**.
   - Compare the converted objects with the IFC objects.
   - Use the **Inquire object** button on the ribbon to view detailed information on objects.
Below is an image of converted beams and columns.

Profile conversion logic in IFC object conversion
You can map an IFC part profile name with a Tekla Structures profile. If a profile is not mapped, Tekla Structures uses a certain logic in converting profiles in the IFC object conversion.

When a parametric profile (page 193) is used in the IFC model, the I, L, U, C, T, Z, Rectangle and Circular type profiles can be defined parametrically:

1. If the IFC file has been created with Tekla Structures, the original profile name is used.
2. If a profile with the same name is found from the Tekla Structures profile catalog, that profile will be used.
3. Otherwise, Tekla Structures checks the parameter values to find a corresponding profile. If found, that will be used.
4. Otherwise, a default parametric profile is used.

When an arbitrary profile (page 193) used in the IFC model, the profile shape is defined with polygon:

1. If the IFC file has been created with Tekla Structures, the original profile name is used.
2. If the shape is detected and found from Tekla Structures profile catalog, that profile will be used. The shape detection supports the standard types of hot rolled profiles.
3. Otherwise, a new profile is created based on the description of the arbitrary profile.

When B-rep (page 193) geometry used in the IFC model, the object is defined with surfaces, and profile geometry information is not available:

1. If corresponding item exists in Tekla Structures model, it will be used.
2. Otherwise, a new item will be created and used.

If Conversion as item is used for extrusion (page 193) type of part, a new item is always created.

**Limitations in IFC object conversion**

Tekla Structures converts most linear IFC objects to native Tekla Structures objects. However, there are some limitations in the conversion.

Tekla Structures is dependent on the quality of the IFC model, because it uses information available in the model when converting objects.

The following limitations exist in the IFC object conversion:

- The IFC4.0, IFC4.1, and any newer IFC4 formats are not supported in the IFC object conversion.
- If the IFC model does not comply with the IFC standard, it might not be converted as expected.
- Bolts, reinforcement and welds cannot be converted to native Tekla Structures objects.
- The following physical elements are currently supported: IfcBeam, ifcColumn, ifcMember, ifcPile, ifcFooting, ifcPlate, ifcDiscreteAccessory, ifcSlab, ifcWall, ifcWallStandardCase, ifcRailing and ifcBuildingElementPart.
- Only SweptSolid, Brep, CSG and Clipping representations are supported.
- Multiple representations for one object are not supported.
- Profile offset is not supported.
- Sometimes, chamfers may be converted incorrectly.

**IFC export**

You can export Tekla Structures models as IFC models.

You can export all basic parts in the Tekla Structures model such as beams, columns, braces, slabs, panels, plates, reinforcing bars, pours, and bolts with nuts and washers.

Tekla Structures exports the model objects on the basis of the export settings you define, including the property sets.
The IFC export functionality in Tekla Structures supports the IFC2X3, IFC4 and IFC4.3 schemas. The IFC export functionality has the IFC certification granted by buildingSMART international Certified Software.

Certified model view definitions:
- IFC2x3 Coordination view 2.0
- IFC4 Reference view
- IFC4.3 Bridge view

IFC (.ifc) and ifcXML (.ifcXML) formats are supported, ifcXML in IFC2x3 only. You can use compressed (.ifcZIP) or uncompressed import files.

<table>
<thead>
<tr>
<th>To</th>
<th>Click the link to find out more</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define the resulting IFC entities for the exported Tekla Structures model objects and the IFC export settings, and then export the Tekla Structures model or a part of it into an IFC file</td>
<td>Export in IFC format (page 218)</td>
</tr>
<tr>
<td>Modify existing IFC property sets and the bindings between property sets and IFC entities, modify the properties included in property sets, and add buildingSMART property sets</td>
<td>Modify property sets for IFC export (page 212)</td>
</tr>
</tbody>
</table>

**Modify property sets for IFC export**

If the IFC export does not give the results that you expect, you can modify the property set definitions in the current IFC property set configuration files.

When Tekla Structures exports an IFC file, it uses the configuration file you selected in the Property sets list to export property sets with the exported IFC entities. The list of configuration files includes predefined files located in your environment folders and files stored in the \AdditionalPsets folder under the current folder.

You can also create a new property set configuration file. For details about creating a custom IFC property set configuration file, see Create new property sets for IFC export.

The Property set definitions dialog box allows you to add modify the property sets needed in the IFC export. In addition to modifying the current property sets, you can:
- modify properties in a property set
- add buildingSMART property sets
- include or exclude property sets or properties
(1) The name of the selected property set configuration file. In the list, you can see all the available configuration files stored in your environment folders, and select the desired file. The file is loaded automatically after selection.

Use the Save button to save the changes in the configuration file after you have added or modified the property sets. You can also give a new name for the configuration file and save it. New and modified configuration files are saved in the \AdditionalPsets folder under the current model folder. You can also read configuration files from the following folders:

XS_FIRM
XS_PROJECT
XS_SYSTEM

Use the button to clear the contents of the displayed configuration file and create a new configuration file.

(2) To show in the list only the property sets and properties that you have selected using the Include check box, select Show only included.

(3) Property sets in the current configuration file. You can drag property sets up or down in the list.

(4) Search for a specific property set. The list of property sets might be very long, and the search could be very useful when you want to find and select a specific property set.

(5) Show only the property sets for the selected IFC entities.
Show only the property sets for the selected IFC versions.

To export all property sets and all properties in the list, select the Include check box on the title row for the property set or properties section. To export only the needed property sets and properties for different export purposes, select the check box next to a specific property set or property.

Filters allowing you to further limit for which objects to export the property set. For example, specify a filter to further limit which IfcBeam objects to export the property set for, like for steel beams only.

Command buttons for working with property sets:

- Add buildingSMART property sets. The property sets beginning with Pset_ or Qto_ are buildingSMART property sets. The buildingSMART property sets are protected, and you cannot change the IFC entities that they are exported with, or edit the names of the properties they contain. However, you can edit the properties in the buildingSMART property sets, and select to include or exclude them.
- Add a property set.
- Edit the selected property set.
- Delete the selected property set.
- Duplicate the selected property set. You can then modify the property set so that the properties are the same but the filtering criteria are different, for example.

Properties in the selected property set. You can drag properties up or down in the list.

To enlarge the property set section or the property section, drag the dialog box divider up or down.

Command buttons for working with properties:

- Add a property in the selected property set.
- Edit the selected property.
- Delete the selected property from the selected property set.

Modify a property set

You can modify the existing property sets.

The buildingSMART property sets (starting with prefixes Pset_ or Qto_) are protected, and you cannot modify those. However, you can modify the...
properties included in buildingSMART property sets, see section "Modify properties in a property set" below.

1. On the **File** menu, click **Export --> IFC** or **Export --> IFC4**.
2. Select an existing property set from the **Property sets** list and click the **Edit** button.
3. In the **Property set definitions** dialog box, in the property set section, select a property set and click **Modify selected property set** on the right.
4. Modify the property set name and description.
   The property set name may contain any text, including spaces. Do not start
   the name with prefixes Pset_ or Qto_, they are reserved for
   buildingSMART property sets.
5. Modify the included IFC entities: select new entities, or clear the selection
   of the entities that you do not want to include in the property set.
6. You can use a filter to further limit for which objects to export the
   property set.
   For example, you can specify a filter to further limit which IfcBeam objects
   to export the property set for, like for steel beams only.
   Do one of the following:
   • Select an existing filter from the list of filters.
   • To specify a new filter, click the Display filter button. In the Object
     group - IFC property export dialog box, create a filter, set Filter type
     to IFC property export, and save it.
7. To save the modified property set, click Modify.
8. To save changes in the property set configuration file, click Save.
   New and modified configuration files are saved in the
   \AdditionalPsets folder under the current model folder. You can also
   read configuration files from the following folders:
   XS_FIRM
   XS_PROJECT
   XS_SYSTEM
   For details about adding new property sets in a configuration file, see Create
   new property sets for IFC export.

Modify properties in a property set
You can modify the properties in an existing property set. You can also modify
the properties in the buildingSMART property sets.
1. Open a property set configuration file in the Property set definitions
   dialog box.
2. Select a property set from the property set list, and then select a property
   from the property list.
3. Click the Modify selected property button.
4. Modify the property. You can change the name of the property and the
   Type of the property. For more information about the types and other
   properties, see Create new property sets for IFC export.
5. Click **Modify**.

6. To save the changes in property set configuration file, click **Save**.

**Add a buildingSMART property set**

You can add buildingSMART property sets to property set configuration files.

1. In the **Property set definitions** dialog box, open the property set configuration file where you want to add buildingSMART property sets.

2. Click the **Import buildingSMART property sets** button on the right.

3. Select the property sets that you want to add. To do this, select the **Import** check box next to the property set. You can search for property sets using the **Search** box. You can also limit the number of the displayed property sets by selecting the desired property set categories, IFC entities, or IFC versions.

4. Click **Import**. The selected buildingSMART property sets are added in the property set list. The buildingSMART property sets are protected, and you cannot edit those, but you can exclude the unnecessary buildingSMART property sets from the export, and change and edit the mapped Tekla properties.

5. To save the changes in property set configuration file, click **Save**.
Include or exclude property sets or properties

You can keep a property set or a property in the configuration file, but exclude it from the export.

You can also exclude buildingSMART property sets and properties.

1. On the File menu, click Export --> IFC or Export --> IFC4.
2. Select an existing property set from the Property sets list and click the Edit button.
3. Do one of the following:
   • To export all property sets in the list, select the Include check box on the title row of the property set section.
   • To export all properties for the selected property set, select the Include check box on the title row of the properties section.
   • To export only the needed property sets, select the check boxes next to the property sets.
   • To export only the needed properties for the selected property set, select the check boxes next to the properties.

4. To save the changes in property set configuration file, click Save.

Export in IFC format

You can export Tekla Structures model or a part of the model in the IFC format.

Before exporting

• Decide whether you are going to use the export hierarchy from Organizer, export hierarchy defined in the part UDAs, or the export hierarchy defined in project property UDAs. Define the needed export hierarchy. See below for instructions.
• Define the IFC entities for Tekla Structures model objects. See below for instructions.
• **Modify the IFC property sets (page 212)** if necessary. You can also define new property sets.

• If you export the IFC file using the base point, define the base point.

• To have pour objects and pour units (from Tekla Structures 2018 onwards) in your model, set `XS_ENABLE_POUR_MANAGEMENT` to `TRUE` in the **Advanced options** dialog box.

• The advanced option `XS_EXPORT_IFC_REBARSET_INDIVIDUAL_BARS` affects how bars that are created by rebar sets are exported. If the advanced option is set to `FALSE`, bars are exported in groups. If the advanced option is set to `TRUE`, bars are exported as individual bars. The default value is `FALSE`.

**NOTE** In the IFC file 'Total number' always shows 1 for groups created by rebar sets, and 'Total weight' and 'Weight' show one bar weight. Use the `NUMBER_OF_BARS_IN_GROUP` and `WEIGHT_TOTAL_IN_GROUP` attributes to export the values of the group to the IFC file.

• If you want to export B-rep objects as exact solids in the IFC2x3 export, set the advanced option `XS_EXPORT_BREP_AS_EXACT_SOLID` to `TRUE`. The default value is `FALSE`.

  If you export B-reps as exact solids, the IFC file size increases, and the export takes more time.

• To get smooth edges to the export, you may need to set the advanced option `XS_CS_CHAMFER_DIVIDE_ANGLE` to 10.

• Add classification information to assemblies if needed, see instructions below.

• If you are going to export to AutoDesk Revit, see Tekla Structures Base point for coordination with Autodesk Revit.

**NOTE** For the IFC export of rebar assemblies, use the **File** -- > **Export** -- > **IFC4** command. Rebar assemblies do not work in the IFC2x3 export.

---

**Add classification information to assemblies**

In the IFC export you can add classification information to assemblies by entering the name of the classification system in the user-defined attributes in **Project properties**. The classification system is written to the `IFCCLASSIFICATION` field in the export file. You can define the classification values for the assemblies in Organizer or in the UDA dialog box of the assemblies. Note that classification information is written to the assembly level only.
Check and modify user-defined attributes of the exported objects

If you do not select **Spatial hierarchy from Organizer** in the IFC export settings, the export uses the IFC export hierarchy you define in the part UDAs. You also need to modify the part UDAs to define the load bearing information, and select the IFC export type.

1. Double-click an object, for example a column, to open part properties, and click the **User-defined attributes** button.

2. On the **Structural information** tab, set **Load bearing** to **Bearing**, if you want to define the user-defined attribute **LOAD_BEARING** for the exported object.
   
   Set this option to **No** for all non-load bearing objects. **Bearing** is the default value.

3. Go to the **IFC export** tab, and in the **IFC export type** list, select **Auto** or **B-rep**:
   
   - The **Auto** option will automatically select what kind of Swept Solid IFC object a Tekla object becomes in the IFC.
   
   - If **Auto** fails for some reason (such as with a deformation), the export reverts to **B-rep** automatically, and creates a mesh-based IFC object with less intelligence. These objects are data heavy but still geometrically correct.
   
   - **B-rep** will force the IFC object to be always mesh based.

4. If you are going to use the part-level export hierarchy, define the **IFC building name** and the **IFC building storey name**.
5. Click **Modify** in the user-defined attributes dialog box.

**Define IFC entities for Tekla Structures model objects**

Before you export Tekla Structures model objects to IFC, you need to define the resulting IFC entities for the exported model objects in the object properties.

1. Double-click an object in the model, for example a column, to open part properties.

2. In the **IFC export** section in the property pane, select an option in the **IFC entity** list to define the IFC entity for the exported model object.

   The default entity for the object type is selected by default.

   ![IFC export section](image)

3. You can define the IFC entity more precisely by selecting an entity subtype among the predefined subtypes available in the **Subtype (IFC4)** list, or select **USERDEFINED** and then type the desired type in free text in **User-defined type (IFC4)**.

   The subtype and user-defined type are only supported in the IFC4 export. The available subtypes depend on the selected IFC entity.

   For example, if you have a native assembly in your Tekla Structures model, you can define that its entity type is **IfcBridgePart**, and select a subtype.
among the predefined subtypes available, for example, PIER, or select USERDEFINED and then type the desired type in free text, for example, bridge part.

4. Click **Modify** in the property pane.

**Export in IFC2x3 format**

1. Select the model objects to export.
   - If you want to export all model objects, you do not have to select anything.
2. On the **File** menu, click **Export --> IFC**.
3. If there are predefined export settings available, load the predefined export settings from the list at the top and click **Load**.
   - The predefined export settings files are located in the environment folders.
4. Browse to the **Output file** location and replace the name `outcoord` with the desired file name.
   - IFC files are by default exported to the \IFC folder under the current model folder. The length of the file path is limited to 247 characters. You do not need to enter the file name extension, it will be automatically added according to the selected **File format**.
5. Define the export settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Parameters</strong> tab</td>
<td></td>
</tr>
<tr>
<td><strong>File format</strong></td>
<td>The options are IFC, IFC XML, zipped IFC, and zipped IFC XML.</td>
</tr>
<tr>
<td><strong>Export type</strong></td>
<td>Select the desired export type.</td>
</tr>
<tr>
<td></td>
<td><strong>Surface geometry:</strong></td>
</tr>
<tr>
<td></td>
<td>• If the model is used only for viewing purposes, or as a reference model,</td>
</tr>
<tr>
<td></td>
<td><strong>Surface geometry</strong> is your choice.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Surface geometry</strong> is ideal when the need is to view the model without</td>
</tr>
<tr>
<td></td>
<td>any need for re-using or editing:</td>
</tr>
<tr>
<td></td>
<td>• Reinforcing bars are exported as B-rep (page 193).</td>
</tr>
<tr>
<td></td>
<td>• Export does not support CSG (page 193) (Constructive Solid Geometry).</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>• Curved elements are exported as B-rep.</td>
<td></td>
</tr>
<tr>
<td>• Bolts are exported as B-rep.</td>
<td></td>
</tr>
<tr>
<td><strong>Coordination view 2.0:</strong></td>
<td></td>
</tr>
<tr>
<td>• The certified <strong>Coordination view 2.0</strong> should be your default.</td>
<td></td>
</tr>
<tr>
<td>• We recommend that you use this export type when the geometry needs to be edited and modified in the receiving application:</td>
<td></td>
</tr>
<tr>
<td>• Reinforcing bars are exported as <strong>extrusions</strong> <em>(page 193)</em>.</td>
<td></td>
</tr>
<tr>
<td>• The export uses CSG (Constructive Solid Geometry) for presenting cuts and voids.</td>
<td></td>
</tr>
<tr>
<td>• Curved elements are exported as extrusions.</td>
<td></td>
</tr>
<tr>
<td>• Bolts are exported as B-rep.</td>
<td></td>
</tr>
<tr>
<td><strong>Steel fabrication view:</strong></td>
<td></td>
</tr>
<tr>
<td>• This export type is designed for the fabrication workflow, and to be provided for manufacturing.</td>
<td></td>
</tr>
<tr>
<td>• <strong>Steel fabrication view</strong> is recommended for exporting detailed information on steel objects for steel fabrication:</td>
<td></td>
</tr>
<tr>
<td>• Exports assembly presentation and dedicated property sets.</td>
<td></td>
</tr>
<tr>
<td>• Bolt holes are exported as voids.</td>
<td></td>
</tr>
<tr>
<td>• Steel fabrication model view configuration file for property sets and properties <em>(IfcPropertySetConfigurations_AISC.xml)</em> is included in the installation by default.</td>
<td></td>
</tr>
<tr>
<td><strong>Coordination view 1.0:</strong></td>
<td></td>
</tr>
<tr>
<td>• This export type is for those who need to export openings as separate objects.</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| • We recommend that you use Coordination view 1.0 instead of Coordination view 2.0 when you need to have voids and openings presented by using opening elements: | • Reinforcing bars are exported as extrusions.  
• Voids and openings are exported as opening elements (ifcOpeningElements).  
• Curved elements are exported as extrusions.  
• Bolts are exported as B-rep. |
| Property sets    | The property set default selection changes when you change the Export type.  
• To use a default property set from your environment, select the property set from the Property sets list.  
• To modify an existing property set (page 212), select the property set from the list and click Edit.  
• To define a new property set, select <new> and click Edit. |
| Export           | Select either Selected objects or All objects. If you selected Selected objects, you need to select the objects in the model. |
| Location by      | Model origin exports the model relative to 0,0,0.  
Work plane exports the model Elevation relative to the current work plane coordinate system.  
Base point: <name of base point> exports the model relative to the base point using coordinate system values East coordinate, North coordinate, Elevation, Angle to North, Latitude and Longitude from the base point definition. The |
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>base point latitude and longitude values</td>
<td>have a microsecond accuracy. Note that if the base point has not been defined, it is not displayed in the list.</td>
</tr>
</tbody>
</table>

**Advanced tab**

**Object types**

Select the object types to export. The options are:

- **Assemblies**
- **Bolts**
- **Welds**

**Pour objects**: Select this to export pour objects instead of CIP concrete parts. Note that pour unit export is not supported in IFC2x3.

- **Grid**
- **Reinforcing bars**

- **Surface treatments and surfaces**
- **Spaces**

If you select **Assemblies**, you can exclude single part assemblies by selecting **Exclude single part assemblies** in the **Other** area.

Note the following:

- Edge chamfers are omitted from the exported IFC model. This is to enable better interoperability with plant design systems. If the geometry with edge chamfers is needed, you can set the IFC export type to B-rep separately for those objects in the object user-defined attributes dialog box on the **IFC export** tab.

- The export does not export what you select if certain object types are selected. For example, if a concrete part is selected and the **Reinforcing bars** check box is selected, all rebars in the concrete part will be exported. It is not possible to select which rebars to
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>export with the part. The workaround is to generate two IFC export files: one with concrete parts only, and one with selected rebars only. • To export pour objects, the use the selection switch <strong>Select components</strong>, <strong>Select objects in components</strong>, or <strong>Select objects in assemblies</strong>. Do not use the selection switch <strong>Select assemblies</strong>, because it tries to export pour units, which are not supported in the IFC2X3 export.</td>
<td></td>
</tr>
</tbody>
</table>

**Other**

| Layer names as part names uses part names, such as COLUMN and BEAM, as layer names for exported objects. If this option is not selected, then layer name will be the object’s phase number followed by the phase name. To use a predefined UDA as a layer name, define the UDA for the advanced option **XS_IFC_EXPORT_OBJECT_LAYER_FROM_UDA**. This option is not available with **Steel fabrication view**. |

**Export flat wide beams as plates** exports flat and wide beams as plates. Select this option if you have modeled plates as beams or columns with flat profiles. For example, some system components use beams or columns instead of plates. |

**Spatial hierarchy from Organizer** uses the spatial hierarchy (Building-Site-Section-Floors) created in **Organizer** in export. Do the following:  
a. **Select Spatial hierarchy from Organizer.**  
b. Create a project hierarchy in **Organizer.** |
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>c.</td>
<td>In Organizer, right-click the project, and select Use for reporting.</td>
</tr>
<tr>
<td>d.</td>
<td>Before the IFC export, synchronize or write the Organizer data in the Tekla Structures model by right-clicking the project in Organizer, and selecting Write to the model for reporting.</td>
</tr>
<tr>
<td></td>
<td>If you do not select Spatial hierarchy from Organizer, the export uses the IFC export hierarchy defined in the part UDAs. If you have not defined part UDAs, project property UDAs are used.</td>
</tr>
<tr>
<td></td>
<td>Select Exclude single part assemblies when you export assemblies.</td>
</tr>
<tr>
<td></td>
<td>Use current view colors exports the objects using the colors defined in object representation, not the class colors. The defined transparency settings are also exported. This option is not available with Steel fabrication view.</td>
</tr>
</tbody>
</table>

6. If you want to save the modified export settings in a new file, give the settings file a new name and click Save as. The new settings are saved in the \attributes folder under the model folder.

7. Click Export.

The model objects are exported. The export progress is shown in the Tekla Structures progress dialog box, and the export status is indicated on the Tekla Structures status bar.

Export in IFC4 format
You can export a Tekla Structures model or a part of the model in the IFC4 format.

1. Select the model objects to export.
   If you want to export all model objects, you do not have to select any objects.

2. On the File menu, click Export --> IFC.
3. If there are predefined export settings available, load the predefined export settings from the list at the top and click **Load**. The predefined export settings files are located in the environment folders.

4. In the **File name** box, enter the file name without a file name extension. The extension will be automatically added according to the selected **Format**. The length is not limited.

5. Browse for the **Folder** location.
   IFC files are by default exported to the \**IFC** folder under the current model folder.
   Both absolute and relative paths can be defined.

6. In **Selection**, select whether you want to export **All objects** or **Selected objects**. If you choose **Selected objects**, you need to select **Spatial hierarchy from Organizer**.

7. Define other export settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Location by</strong></td>
<td><strong>Model origin</strong> exports the model relative to 0,0,0. <strong>Work plane</strong> exports the model relative to the current work plane coordinate system. <strong>Base point:</strong> &lt;name of base point&gt; exports the model relative to the base point using coordinate system values <strong>East coordinate</strong>, <strong>North coordinate</strong>, <strong>Elevation</strong>, <strong>Angle to North</strong>, <strong>Latitude</strong> and <strong>Longitude</strong> from the base point definition.</td>
</tr>
<tr>
<td><strong>Object color</strong></td>
<td>Select whether you want to export objects using object class colors or object group colors. If you select object group colors, the defined transparency settings are also exported.</td>
</tr>
<tr>
<td><strong>Layer names as</strong></td>
<td>You can use phases, part names, or template attributes as layer names for exported objects. Select <strong>Name</strong> or <strong>Phase</strong> from the list, or type the attribute name in the box. Note that you cannot use user-defined attributes as the layer name.</td>
</tr>
<tr>
<td><strong>Format</strong></td>
<td>The options are <strong>IFC</strong> and <strong>IfcZip</strong>.</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Export type</td>
<td>Select the desired export type.</td>
</tr>
</tbody>
</table>
| **Reference view (IFC4):** | • This export type is intended to support the referencing workflow, and exported files can be used as reference files, and viewed in a viewer.  
• The **Reference view (IFC4)** is not meant to be used for conversion to native objects.  
• The overall goal of the **Reference view (IFC4)** is to provide workflows for various software applications that do not require modifying geometry. Such applications enable viewing, estimating, building, operating, and other downstream analysis. |
| **Design transfer view (IFC4):** | • This export type is intended for the handover workflow, meaning import for further editing.  
• This requires the conversion of the IFC entities into native objects, and the **IFC object conversion (page 196)** can be used to convert the IFC entities to Tekla Structures native objects. Typically import and conversion are only needed a couple of times, or even once only. The result may require some rework to accomplish a proper model.  
• One example is the takeover of the structural engineering model (or part of it) into the basis of the structural detail modeling. |
<p>| <strong>Bridge view (IFC4.3):</strong> | • The main purpose of the <strong>Bridge view</strong> export is to extend Tekla Structures to bridge constructions. |</p>
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• The bridge IFC files are based on the IFC4.3 schema.</td>
<td></td>
</tr>
</tbody>
</table>

**IFC4precast view:**

• This export type supports the fabrication data transfer workflow of precast elements. At this phase it covers the fabrication of precast walls and slabs including all the needed reinforcement and embeds.

• This export type is available only in precast roles.

For more information about IFC4precast, see IFC4precast.

**Base point export**

Select which system to use when you have defined a base point for **Location by** to ensure that the collaboration works with other parties in the project. The options are:

**IfcMapConversion:** Converts model's local coordinate system into the global coordinate system. This option is needed, when the IFC4 format that complies to the IFC4 schema is required.

**IfcSite coordinate system:** Converts coordinates in the IFC model for each object separately. This option can be used to produce an IFC4 file that you can view in most IFC viewers, including Trimble Connect. The same conversion method is also used in the IFC2x3 export.

**Property sets**

The property set selection changes when you change the **Export type**.

• To use a default property set, select the property set from the **Property sets** list.

• To modify an existing property set (page 212), select the property set from the list and click 

---

Import to and export from Tekla Structures

230  IFC
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• To define a new property set, select <code>&lt;new&gt;</code> and click +.</td>
<td></td>
</tr>
<tr>
<td><strong>Cast-in-place export</strong></td>
<td>Allows you to select more precisely what to include in the cast-in-place export. The options are <strong>Pour units or pour objects</strong> and <strong>CIP cast units or parts</strong>.</td>
</tr>
<tr>
<td><strong>Export flat wide beams as plates</strong></td>
<td>Select this option if you want to export flat and wide beams as plates. Select this option if you have modeled plates as beams or columns with flat profiles. For example, some system components use beams or columns instead of plates.</td>
</tr>
<tr>
<td><strong>Spatial hierarchy from Organizer</strong></td>
<td><strong>Spatial hierarchy from Organizer</strong> uses the spatial hierarchy (Building-Site-Section-Floors) created in <strong>Organizer</strong> in export. Do the following: a. Select <strong>Spatial hierarchy from Organizer</strong>. b. Create a project hierarchy in <strong>Organizer</strong>. c. In <strong>Organizer</strong>, right-click the project, and select <strong>Use for reporting</strong>. d. Before the IFC export, synchronize or write the <strong>Organizer</strong> data in the Tekla Structures model by right-clicking the project in <strong>Organizer</strong>, and selecting <strong>Write to the model for reporting</strong>. Note that the selected objects are only exported when <strong>Spatial hierarchy from Organizer</strong> has been selected. If you do not select <strong>Spatial hierarchy from Organizer</strong>, the export uses the IFC export hierarchy defined in the part UDAs. If you have not defined</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>part UDAs, project property UDAs are used. Also note that in bridge models the export always uses the hierarchy defined in project property UDAs.</td>
</tr>
</tbody>
</table>

**Object types**

Select the object types to export:
- Assemblies
- Bolts
- Grids
- Reinforcing bars
- Surface treatments and surfaces
- Spaces

- Edge chamfers are omitted from the exported IFC model. This is to enable better interoperability with plant design systems. If the geometry with edge chamfers is needed, you can set the IFC export type to B-rep separately for those objects in the object user-defined attributes dialog box on the **IFC export** tab.
- The export does not export what you select if certain object types are selected. For example, if a concrete part is selected and the **Reinforcing bars** check box is selected, all rebars in the concrete part will be exported. It is not possible to select which rebars to export with the part. The workaround is to generate two IFC export files: one with concrete parts only, and one with selected rebars only.

8. If you want to save the modified export settings in a new file, give the settings file a new name and click **Save as**. The new settings are saved in the **\attributes** folder under the model folder.

9. Click **Export**.

After a successful export, a message box is displayed. In this message box you can open the folder where the exported IFC model is stored, or view the log.
file in a browser. The log file gives detailed information of the export process, exported entities, and the errors occurred during the export.

**Limitations in IFC4 export**

- The IFC4 export always contains the full assembly. If the part **IFC entity** is set to None in the part properties, the part and its bolts are not included in the export.
- The user interface does not provide all the features included in the IFC2x3 export user interface.
- The **Reference view** is intended to be used for design coordination and for referencing workflow.

**Check the exported IFC model**

We recommend that you test the reference model after creating it.

To check the exported IFC model (page 218), insert the model as reference model to the original Tekla Structures model.

Check the following things:

- Check the IFC model visually. Use different colors for the IFC model and the original model. Use clip planes to check the model thoroughly.
- Compare the number of objects. If there are differences, check the export log.
- Check the modeling of unsuccessfully exported objects. For example, unnecessary cuts may result in unsuccessful export. Consider remodeling the incorrect objects or set **IFC export type** to Brep for the objects.

**TIP** You can also use Trimble Connector (page 124) for viewing and checking the IFC model.

### 3.3 DWG and DXF

DWG is the native file format of AutoCAD and the standard file format for Autodesk products. DWG is used for 2D and 3D CAD data that is supported by Tekla Structures.

Drawing eXchange Format (DXF) was developed by Autodesk for enabling data interoperability between AutoCAD and other programs. As the file format does not contain any form of part ID it is not possible to track changes between different physical objects contained within different versions of a file. Clash checking is not possible with a DXF file in Tekla Structures.

The DWG and DXF files imported with the DWG/DXF tool do not show the surfaces of the imported objects, only the construction lines or lines converted
to part profiles that can be used to create a model. If you want to show surfaces of the objects, insert DWG and DXF files as reference models (page 165).

In DWG/DXF import, Tekla Structures supports ACAD2023 or earlier.

To determine the AutoCAD version of the DWG file, open the file in a text editor. You will find the version code in the first six bytes:

AC1032 = 2018, 2019, 2020, 2021, 2022, 2023
AC1014 = 14
AC1012 = 13
AC1009 = 12, 11
AC1006 = 10
AC1004 = 9
AC1002 = 2

Click the links below to find out more:
Import 2D or 3D DWG or DXF files (page 234)
Export in 3D DWG or DXF format (page 235)
Export a drawing in 2D DWG, DXF, or DGN format (page 239)
Export a drawing to a 2D DWG or DXF file (old export) (page 250)

Link DWG or DXF files in drawings

You can also add links to DWG or DXF files in drawings through the 2D Library or by using the drawing ribbon command DWG/DXF.

Import 2D or 3D DWG or DXF files

In DWG/DXF import, you can convert 2D and 3D objects as parts or reference lines (construction lines).

1. On the File menu, click Import --> DWG/DXF.
2. Enter the name of the import file.
   Click Browse... to browse for the file.
3. Enter the offset from X, Y and Z.
4. Enter the scale.

5. Select how to show the imported parts:
   - **Reference lines** displays parts in the model as construction lines.
   - **Parts** displays the full profile of parts in the original model, based on the profile sizes defined in the **Plate profile** and **Beam profile** boxes. You can only use metric profiles with this option.

6. Select **Use 2D import** to import a two-dimensional representation of the original object.
   This is useful when have selected the **Reference lines** option. Do not select **Use 2D import** if you want to import the model in 3D.

7. Click **Import**.

Tekla Structures imports the file you specified. If you need to delete the imported parts or reference lines, select the parts or lines and press **Delete**.

**Limitations**

When importing DWG profiles, note the following:
- The profile must be the only object in the DWG file. The file should not include any titles, blocks or any other graphics.
- The profile must be a closed polyline.
- Generating the polylines from an ADSK 3D model requires a number of steps to clean the profile.
- The profile needs to be scaled up.
- The DWG/DXF files imported with the DWG/DXF tool do not show the surfaces of the imported objects, only the construction lines or lines converted to part profiles that can be used to create a model. If you want to show surfaces of the objects, insert DWG and DXF files as reference models (page 165).
- The import functionality is not available in all Tekla Structures configurations.

**Export in 3D DWG or DXF format**

You can export selected parts or the whole model as 3D DWG or DXF. You can use either the older export to export as 3D DWG or DXF, or the newer export to export as 3D DWG.

**Export 3D DWG files**
- Tekla Structures uses the Open Design Alliance (ODA) toolkit to export 3D DWG format.
• The surface presentation of the parts is exported. Bolt holes are not included in the export.

• You can export objects relative to the model origin, to the base point you define, or to the work plane.

• You can export in layers by name, phase or any template attribute or user-defined attribute.

• Colors can be exported by class or by stored object group representation.

• You can export all objects or selected objects. You can use the **Select objects in assemblies** and **Select objects in components** selection switches for selecting the objects to export. You can export selected parts in an assembly when you use the **Select objects** option and **Select objects in assemblies** and **Select objects in components** when you select the parts. If you do not select a part but an assembly, the highest level of assembly parts will be included in the export.

• Bolt holes are not exported.

• Grids are not exported.

**Create object group color representations**

If you want to use object group color representations in the export, you need to create the object groups first, set the colors for the object groups and save the representation settings. Note that the transparency setting is also included in the export.

**Create base points**

If you want to export objects relative to a base point, you need to create a base point in your model.

1. Open a Tekla Structures model.
2. On the **File** menu, click **Export --> 3D DWG**.
3. In the **File name** box, enter the name of the export file.

4. In the **Folder** box, enter the export folder path, or browse to the folder.

5. In **Location by**, select one of the following:
   - **Model origin** exports the model relative to 0,0,0.
   - **Work plane** exports the model relative to the current work plane coordinate system.
   - **Base point** `<name of base point>` exports the model relative to the base point using coordinate system values **East coordinate**, **North coordinate**, **Elevation**, **Angle to North**, **Latitude** and **Longitude** from the base point definition.

6. In the **Selection** list, select **All objects**, or **Selected objects**. If you want to export selected objects, select the objects with the appropriate selection switches:
   - If you activate the **Select parts** and **Select objects in components** selection switches, all the selected parts will be exported.
   - If you activate the assembly or component selection, nothing will be exported.

7. In **Object color**, select whether you want to export objects using object class colors or object group colors.

8. In **Layer names as**, select **Name** or **Phase** from the list, or type the template or user-defined attribute name in the box. You can use phases, part names, or template attributes or user-defined attributes as layer names for exported objects.

9. When you are done, click **Export** to export the objects according to the defined settings.

   Tekla Structures creates the `<name>.dwg` file in the specified folder.

**Export 3D DWG or DXF files (old export)**

You can export the whole model or model parts as 3D DWG or 3D DXF files. By default, Tekla Structures creates a `model.dwg` file in the current model folder. You can export parts, items and bolts as 3D DWG or DXF.

**Limitations**

The old 3D DWG and DXF export has the following limitations:

- Bolt holes are not exported.
- Curved beams and polybeams are exported as single, continuous beams.
- The number of segments in the curved beams is as defined for the particular curved beam.
- Reinforcing bars are not exported.
- Grids are not exported.
TIP  You can define the color settings for parts and other model objects. This way you can affect the color that the objects have in the exported DWG/DXF files.

1. Open a Tekla Structures model.
2. On the File menu, click Export --> 3D DWG/DXF.
3. In the Export 3D DWG/DXF dialog box, accept the default export file name, or enter another one.
   To replace an already existing export file, click the ... button and browse for the file.
4. Select whether to export as DWG or DXF.
5. In Export as, select the representation for the exported objects:
   • Faces exports parts as faces.
     Exporting 3D DWG or DXF files as Faces uses more memory and may take longer, but the end result is better.
   • Lines exports parts as lines located in the center of the profile cross sections. This option suits well for exporting to analysis software.
   • Center lines exports parts as part center lines.
   • Reference lines exports parts as reference lines, drawn between the creation points. This option suits well for exporting to analysis software.
     If the model is large, or you have less memory to use, the Reference lines option is faster, and the resulting file size is smaller.
6. Select Part accuracy:
   • The options are High and Normal. High also exports chamfers in profile cross-sections.
7. Select Bolt accuracy:
   • High exports entire bolt assemblies, including washers.
   • Normal only exports the bolt and nut.
   • No bolts exports no bolts.
8. Select whether to include Cuts in the export.
   Yes exports cuts.
9. Select whether to include Inner contours
   Yes includes the inner contours.
10. In the Export list, select what to export:
    • All objects exports the whole model.
• **Selected objects** exports the parts selected from the model.

To only select parts that you want to include in the export, activate the **Select parts** and **Select objects in components** selection switches. You can also create a selection filter that exports all the parts and objects that you want. Components cannot be imported as such, but you need to select the objects in components to export the included parts.

11. Click **Create**.

Tekla Structures creates the export file in the current model folder. The ID of each part is exported as an attribute and written into the export file for each part.

### 3.4 Export a drawing in 2D DWG, DXF, or DGN format

You can export Tekla Structures drawings in the 2D DWG, DXF, and DGN v8 format. You can export several drawings at a time.

The drawing export is object based. For example, if you export a rectangular part that is drawn using hidden line types, the result is a rectangular object drawn with a dashed line. In the old line-based DWG export, the result would be many separate short straight lines. Hatches are also exported as hatch objects in CAD and not separate lines.

In the drawing DWG/DXF/DGN export you can:

- easily set export layers or levels for different objects, and separate mark frames from mark text and leader lines, for example
- use filters to separate parts from other parts
- use export layers or levels that have been predefined by standard CAD layer/level settings
- use base points and model coordinates
- embed images in the export file so that the images are no longer exported as links

The drawing export does not use font conversion, and the resulting fonts match exactly the fonts that you haven defined and see in the Tekla Structures drawing. With the advanced option **XS_DRAWINGS_USE_CAP_HEIGHT_FOR_FONT_HEIGHT** you can control which font height system to use in drawings, CAP font height or em font height.

### Define export settings and export DWG, DXF, or DGN files

1. Start the export in any of the following ways:
• On the File menu, click Export --> Drawings, and select the drawings from the displayed Document manager list.

• Click Drawings & reports --> Document manager, select the drawings that you want to export from the Document manager list, right-click and select Export, or click the Export button at the bottom. The Export command is not available when you open the Document manager in the drawing mode.

• In an open a drawing, on the File menu, click Export drawings.

2. Click Open preview to show the preview window, where you can also change the displayed drawing if you have selected many drawings for export. To get the preview visible for the first time, click Refresh preview.
You can refresh the preview again by clicking **Refresh preview**. The preview does not get refreshed automatically, because this could take a long time.

3. In the **Save** list, load previously saved or predefined export settings. If you want to save the modified settings for future use with another name, enter a name for the new settings file and click **Save**.

4. In **File location**, define the location for the exported files.
   The default location for the exported files is the current model folder. The default folder can also be controlled by the XS_DRAWING_PLOT_FILE_DIRECTORY advanced option. You can define a relative file location by adding `\` in front of the output folder name. The specified output folder is saved in the settings. Selecting **Open folder when finished** opens the export folder after the export.

5. In the **File type** list, select **DWG**, **DXF**, or **DGN (V8)**.

6. For the DWG and DXF exports, select the version to be used in export. There are several versions of AutoCAD or DXF formats available for the DWG or DXF export, and 2010 is the default. You cannot select a specific version for the DGN export.

7. Define other settings on the **Options** tab as necessary:
### File prefix
Enter a specific prefix or suffix to be used in the file name. The preview of the file name will change accordingly.

The drawing export supports the following drawing-type-specific advanced options, which you can use to modify the name of the exported file:

- XS_DRAWING_PLOT_FILE_NAME_A
- XS_DRAWING_PLOT_FILE_NAME_C
- XS_DRAWING_PLOT_FILE_NAME_G
- XS_DRAWING_PLOT_FILE_NAME_M
- XS_DRAWING_PLOT_FILE_NAME_W

### Model space coordinates
The coordinate system determines how the drawing views are exported in the CAD coordinate system. Select one of the following options:

- **Local**: Exports the drawing to the null point in the CAD coordinate system. This option uses the left bottom corner of the 1st view frame to set the local coordinates. If the frame is expanded, the local will move.

- **Model**: Matches Tekla Structures null point with CAD null point and rotates the CAD coordinate system accordingly in X and Y coordinates. Z coordinates are not supported.

- **Base point**: <name_of_base_point>: Matches the selected base point with CAD null point, and rotates the CAD coordinate system accordingly. The base points are defined in the Tekla Structures model through `File --> Project properties --> Base points`. Z coordinates are not supported.

  **NOTE**: Base points work only in plan views in general arrangement drawings.

### Update Tekla Structures linework only
Update the Tekla Structures drawing content and keep other content that is created in a CAD software intact in the same file. Blocks (groups or cells), created by Tekla Structures will be updated.

This setting is only shown if you have set the advanced option `XS_DWG_EXPORT_UPDATE_TS_LINEWORK_OPTION` to `TRUE`.

To use this setting, you need to have the same drawing exported already, and the layer/level setup and the template must be the same as during the export process.
previous export. All CAD lines that were added previously will stay in the file and only Tekla Structures content will get updated, unless editing was done in a CAD blocks editor.

If you edit the content of a block (CAD object), and then select the **Update Tekla Structures linework only** option, the whole block will be re-written, and the changes made in CAD will not be kept. To keep the changes in CAD, you need to explode a block before editing it.

For example, you may want to use this setting if you have added drawing title blocks in the CAD file after the first export of the drawing from Tekla Structures, and want to keep these title blocks as they are, and update only the objects that exported from Tekla Structures.

<table>
<thead>
<tr>
<th>Embed images inside the file</th>
<th>Embed all images inside the export file. No separate image files are created in the export.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ungroup objects in blocks (DWG, DXF)</td>
<td>Export graphical objects as individual objects instead of blocks or shared cells. For example, a line, hatch and rectangle will be exported as a line object, hatch object and rectangle object, rather than blocks or shared cells. When this option is selected, the option <strong>Update Tekla Structures linework only</strong> is disabled.</td>
</tr>
<tr>
<td>Ungroup objects in shared cells (DGN)</td>
<td>Export graphical objects as individual objects instead of blocks or shared cells. For example, a line, hatch and rectangle will be exported as a line object, hatch object and rectangle object, rather than blocks or shared cells. When this option is selected, the option <strong>Update Tekla Structures linework only</strong> is disabled.</td>
</tr>
<tr>
<td>Include views outside the drawing frame</td>
<td>Select whether to include in the export the drawing views that are located outside the drawing area. If you select this check box, the views that are outside the drawing area are included in the export. If you do not select this check box, the export excludes the drawing views that are outside the drawing area. By default, the check box is not selected. The views that are partially inside the drawing area are always exported by default. When the <strong>Include views outside the drawing frame</strong> check box is selected, the export preview is enlarged to show all included views.</td>
</tr>
<tr>
<td>Drawing as snapshot to CAD model space</td>
<td>Export the Tekla Structures drawing in scale to model space to a CAD file. Model and global coordinates and paper space/coordinate space switch in the layer/level settings will be ignored. If the drawing has linked or copied views, and you have not selected <strong>Drawing as snapshot to CAD</strong></td>
</tr>
</tbody>
</table>
**model space**, the drawing views may be placed on top of each other, and the view limits may not be accurate in the resulting file. This is because drawing views are not conceptually the same as paper space viewports in the DWG, DXF or DGN format.

If you have shortened views in the drawing, and the objects are placed in 1:1 scale, the ends will be stretched to match the actual size of the part. Select **Drawing as snapshot to CAD model space** to avoid stretching of the shortened view in a CAD model space. The drawing space in a CAD software will keep the view shortening.

**Scale**

Define the scale for the exported DWG, DXF, or DGN. This option is only available if you have selected the **Drawing as snapshot to CAD model space** check box.

For example, if you have a drawing between the coordinates 0,0 and 800, and you define a scale value 5, the resulting DWG is 5 times bigger, and the DWG is located between the coordinates 0,0 and 4000.

In another example, if you have set the drawing view scale in Tekla Structures to 1:50, and wish to export the drawing in 1:1 scale, using 50 as the scale value will produce the desired result.

If you have set the advanced option `XS_EXPORT_DRAWING_TRY_TO_KEEP_LOCATION` to `TRUE`, Tekla Structures tries to keep the DWG, DXF, or DGN origin in the same position as the drawing view origin. This can only be done in plan views and elevation views. If the drawing has more than one plan view or elevation view, Tekla Structures places the DWG, DXF, or DGN origin in the bottom-left corner of the drawing frame.

For more information about defining the export scale, see "Drawing export scale factor for DWG/DXF".

8. On the **Layer rules** (DWG, DXF) or **Level rules** (DGN) tab, you can define explicitly the layers or levels where different model and drawing objects, or parts of objects are exported to. For example, you can export outlines to a different layer or level than fills and hatches.

You can also define whether the line color, style, and weight will be used from Tekla Structures settings or from the target layer or level settings specified in a DWG, DXF, or DGN file. If you select Tekla Structures settings,
Tekla Structures line color, style, and weight stay exactly as you see them in the Tekla Structures drawing, and there is no functionality to modify them just for the drawing export.

9. To use a template, use the **Target layers from DWG** (DWG, DXF) or **Target levels from DGN** (DGN) list to browse for the template file. If specified, the template is used for layer or level definition. The template should not contain any CAD objects, just layer or level settings, unless it contains objects that are intended to appear on drawings exported using this template. For example, for the DWG export, you could use your standard DWG file with all the predefined layers. The DGN export uses seed files as templates in the export. A seed file is a blank design file with the appropriate settings.

You can enter \ and then the file name, in which case Tekla Structures searches for the file first in the model, project and firm folders, then in the folder indicated by the advanced option XS_DRIVER, then in the system folder, and finally in the user settings folder.

An error message is displayed next to the **Browse...** button until the template is found and loaded.

The target layer or level boxes are briefly colored in yellow when a new template file is loaded. When there are no layers or levels available in the template file, the boxes are colored in red.

10. Add the rules:

   • To add a new rule, click the **Add** button on the right, or copy the selected rule by clicking the **Copy** button.

   • To move the rules upwards or downwards in the set, click the **Move up** and **Move down** buttons. You can select multiple rules.

   • To delete a rule, select it and click **Delete**. You can delete multiple rules at a time.

11. Define the rule contents:
| **Objects** | Select the objects that you want to export.  
Some objects, like neighbor part marks, are currently under marks and not listed separately. To have them separated in the export, you need to use **Object filtering**, and create several mark rules for parts and neighbor parts.  
To include everything else that is missing from the **Objects** list, add an **All** object rule at the end of the rules list, because rules are read in the order they are listed.  
To export pours, you need to enable the pours in the model by setting the advanced option **XS_ENABLE_POUR_MANAGEMENT** to **TRUE**. |
| **Presentation filtering** | Define which part of the objects should follow the rule. You can also select **All**.  
The **Presentation filtering** options are different for different object types.  
You cannot add more than one filter per rule. For example, to have mark frames separated from mark text, you need to create two rules for marks, and in the first one, set the **Presentation filtering** to **Text**, and in the other one to **Frames**. See the section "DWG layer rule example" below for an example. |
| **Object filtering** | Read the selection filter attribute files that have been defined in the current model.  
The filter attribute files are only read from the current model folder, not from the firm or project folders. |
| **Target layer** (DWG, DXF)  
**Target level** (DGN) | If you have no templates, or want to create layers or levels of your own, type a new layer or level name in the **Target layer** or **Target level** box, or |
select a previously used layer or level from the list.

After you have added a template, its layers or levels will appear in the **Target layer** or **Target level** list.

The target layer or level boxes are briefly colored in yellow when a new template file is loaded. When there are no layers or levels available in the template, the boxes are colored in red.

<table>
<thead>
<tr>
<th><strong>Color</strong></th>
<th>Define whether the linework is taken from Tekla Structures settings or from the template.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Line style</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Line weight</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Paper space (DWG, DXF)</strong></td>
<td>To draw drawing objects correctly in the paper space (DWG, DXF) or coordinate space (DGN) in the exported file (and not through the view portal), select the <strong>Paper space</strong> or <strong>Coordinate space</strong> check box.</td>
</tr>
<tr>
<td><strong>Coordinate space (DGN)</strong></td>
<td>If this check box is not selected, there will only be a portal from the model space in the paper space or coordinate space. We recommend that you put drawing annotations, such as marks, dimensions, and texts to the paper space or coordinate space only. That way they will appear correctly, for example, when a part is cut in a Tekla Structures drawing view.</td>
</tr>
<tr>
<td><strong>Include</strong></td>
<td>To include a rule in the export, select the <strong>Include</strong> check box next to the rule on the left. If you do not want to export some objects, just clear the <strong>Include</strong> check box.</td>
</tr>
</tbody>
</table>

12. To open the preview to check the result before exporting, click **Open preview**. To update the preview after changes, click **Refresh preview**.

13. Click **Export**.
The drawings are exported on the basis of the defined settings and rules. The rules are read in the order that they are listed. If you have selected **Open folder when finished**, the export folder will open.

The error message **Drawing cannot be read** is displayed if the exported drawing is missing, the drawing is not up to date, or the drawing has some other problems.

When you click the **Export** button, Tekla Structures first checks if the files can be written to before the export starts, and asks you to close the necessary applications. It also checks if the files already exist and asks if you want to overwrite the existing files.

**DWG layer rule example**

In the example below, three separate mark rules have been created that will be exported on layers 1, 2, and 3. Lines are exported on the layer 1, texts on the layer 2, and frames on the layer 3.

After exporting, you can show the marks in the CAD model in the following three ways depending on the layers displayed in the CAD viewer:

All layers are shown:

![Layer 1 containing the lines is hidden:](image)

![Layer 2 containing the texts is hidden:](image)
Layer 3 containing the frames is hidden:

Tips

- If you use the **Output file version** 2013 in the export, a wipeout frame will be visible on the layout side in the CAD model due to the limitations in CAD, see below:

To avoid this, either use a DWG file layer template created in AutoCAD, or use the output file version 2010 (default) or earlier.

- Another reason for the visible wipeout frame is that you are using a DWG template where wipeout frames have been set visible. Hide the wipeout frames in the CAD template. For more information, see "Remove unwanted text frames from DWG exports".
To use old DWG or DXF drawing export

If you want to use the old DWG or DXF drawing export, set the advanced option \texttt{XS\_USE\_OLD\_DRAWING\_EXPORT} to \texttt{TRUE} in an \texttt{.ini} file. This advanced option is by default set to \texttt{FALSE}. For instructions on using the old export, see Export a drawing to a 2D DWG or DXF file (old export) (page 250).

Export a drawing in 2D DWG or DXF format (old export)

You can also export drawings as 2D DWG or DXF using the old DWG/DXF drawing export.

If you want to use the old DWG or DXF drawing export, set the advanced option \texttt{XS\_USE\_OLD\_DRAWING\_EXPORT} to \texttt{TRUE} in an \texttt{.ini} file. This advanced option is by default set to \texttt{FALSE}. For instructions on using the newer DWG/DXF drawing export, see Export a drawing in 2D DWG, DXF, or DGN format (page 239).

For an example of setting up the layers and exporting to 2D DWG or DXF, see Example: Set up layers and export in DWG format (old export) (page 258).

Export a drawing in 2D DWG or DXF format

2. Select from the list the drawings that you want to export.
3. Right-click and select Export.
4. In the Export Drawings dialog box, on the Export file tab, enter the export file name.
   
   If you are exporting several drawings, leave the file name box empty.
   
   The drawings are exported by default to the \texttt{\PlotFiles} folder under the current model folder. If you want to use another folder, enter the full path.
   
   Tekla Structures uses one of the following advanced options to define the names for the export files. The advanced option that is used depends on the drawing type:
   
   \texttt{XS\_DRAWING\_PLOT\_FILE\_NAME\_A}
   
   \texttt{XS\_DRAWING\_PLOT\_FILE\_NAME\_C}
   
   \texttt{XS\_DRAWING\_PLOT\_FILE\_NAME\_G}
   
   \texttt{XS\_DRAWING\_PLOT\_FILE\_NAME\_W}
   
   \texttt{XS\_DRAWING\_PLOT\_FILE\_NAME\_M}.
5. Select the file type: DXF or DWG.
6. If you want to include a revision mark in the file name, select Include revision mark to file name.

7. Set the layer options on the Layer options tab:
   • Select the layer rules file.
     To add or modify layers, and to assign object groups to different layers, click Setup...
   • If you want to use advanced conversion to convert the type, color and weight of lines and layers, select Use advanced line type and layer conversion.
   • In the Conversion file box, enter the name of the file to be used in the conversion.
     By default, Tekla Structures uses the LineTypeMapping.xml file in the ..\Tekla Structures\<version>\environments\common \inp folder.
     If you need to define your own line type mappings, you can use the file LineTypeMapping.xml as a template when you create a conversion file of your own.
   • Select Include empty layers if you want to include empty layers in the export.
   • Select Object color by layer to have different colors on different layers.

8. Set the other drawing export options on the Options tab:
   • Set Drawing scale and Line type scale.
     • If you want to export the drawings so that the DWG/DXF content is grouped by object, select Export objects as groups. When you do this, Tekla Structures makes a new group for each object (part, mark, dimension line, etc.).
   • Select Cut lines with text if you do not want to display continuous lines in exported drawings, for example, to run the line through text or drawing marks.
   • Select Export custom lines as split lines to ensure that custom line types have the same appearance in the software you are exporting to and when printed. If Export custom lines as split lines is selected, custom line types are exported as solid lines that are split to several short lines. If Export custom lines as split lines is not selected, custom line types are exported as defined in TeklaStructures.lin.
   • Select Use paper space to export to both model space and paper space. The unscaled contents of the drawing views are exported into model space. The drawing layout is exported into paper space. The
layout contains scaled viewports showing appropriate areas of the model space.

When exporting to paper space, ensure that all objects in the view are inside the view frame. Objects that are partially outside the drawing view frame are not exported.

9. Click **Export**.

**Create layers in DWG/DXF files for export**

You need to define the layers that are included in the exported DWG and DXF files.

**NOTE** To keep track on the layers that you have, create all the layers that you need for the final DWG/DXF drawings at the same time.

1. On the **File** menu, click **Export -> Drawings**.
2. In the **Export Drawings** dialog box, go to the **Layer options** tab and click **Setup** next to the **Layer rules** box.
3. In the **Drawing Export Layers** dialog box, click **Modify layers**.
4. To add a layer, click **Add**.
   
   You can add as many layers as you need.
5. Click the row of the new layer in the **Name** column and enter a name for the layer.
6. Click the row of the new layer in the **Color** column and select a color for the new layer.

![Layer selection example]

7. Click **OK**.

Next you can assign objects to the new layer.

**Assign objects to layers in export**

You need to define which objects to export to certain layers in the exported DWG/DXF file. You can do this by using a selection filter for identifying the
desired objects among all objects, and by creating a rule to export these objects to a certain layer.

Before creating the rule, first create the selection filter.

1. Create a selection filter.
2. On the File menu, click Export --> Drawings.
3. In the Export Drawings dialog box, go to the Layer options tab, and click Setup.
4. Open an object group by clicking the plus sign next to the group name. For example, click the plus sign next to Model Object.
5. Right-click a rule in the list and select Add Next Level Rule. For example, right-click Part.

6. Enter a name for the rule and select the selection filter that you created.
7. Click OK.
8. Double-click the row under the rule you just created and select the desired layer for it in the Select Layer dialog box.
9. Click OK.
Tekla Structures maps the selected layer to the rule.

10. Save the created layer rule settings for later use by entering a name next to the **Save as** button and clicking **Save as**.

**NOTE** The order of rules is important. Organize the rules by right-clicking the rule, and selecting **Move up** or **Move down**. The objects are exported to the first matching layer. If there is no matching layer, the objects are exported as **Other object type**.

**Example: Create a rule for exporting beam marks to their own layer in drawing export**

You can export all kinds of drawing objects to layers of their own.

This example shows how you can do that for beam marks. All kinds of marks can be exported separately to their own layers: bolt marks, part marks, connection marks, neighbor part marks, reinforcement marks and component marks.

First you need to create a selection filter selecting the beams and then you can define the layer rule. Name the beam selection filter **Beams**.

1. On the **File** menu, click **Export --> Drawings**.
2. Go to the **Layer options** tab of the **Export Drawings** dialog box and click **Setup** next to the **Layer rules** box.
3. Under **Mark** in the **Drawing Export Layers** dialog box, select the layer rule of the mark you want to define to its own layer (part, bolt, connection, neighbor part, or reinforcement mark).
   Select **Part mark**.
4. Right-click **Part mark** and select **Add Next Level Rule** from the pop-up menu.
   This opens the **Layer manager rules** dialog box.
5. Enter a rule name (for example, **BeamMark**) and select a filter that you have created (Beam).
6. Click **OK**.

   Tekla Structures creates a new rule **BeamMark**. Now you can connect the new rule to a layer you have created for beam marks and use when exporting drawings.

### Copying export layer settings to another project
If you want your layer settings to also be available in other projects, you can copy them to a firm or project folder.

1. On the **File** menu, click **Export --> Drawings**.
2. Go to the **Layer options** tab and click **Setup**.
3. Define the required rule and layer settings.
4. Enter a name for the layer rule settings file next to the **Save as** button and click **Save as**.
5. Copy the file `<your_layer_rule>.ldb` from the `\attributes` folder under the current model folder to the firm or project folder.

### Define customized line type mappings in drawing export
You can use advanced conversion to convert the type, color and weight of lines and layers. This way you will get the line types that you want to use in the target software, for example, AutoCAD.

By default, Tekla Structures uses the file `LineTypeMapping.xml` in the folder `..\Tekla Structures\<version>\environments\common\inp` for the conversion.

If you need to define your own line type mappings, you can use the file `LineTypeMapping.xml` as a template.

---

**NOTE** When modifying the line type mappings file, use an editor that is capable of validating XML in order to maintain a valid document structure.

To define your own line type mappings, do one of the following:
<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| Map according to line types only | 1. Open the mapping file in an XML editor.  
2. Enter only the line type information.  
   For example, all lines in all layers with line type XKITLINE01 will be exported to DASHED.  
3. Save the mapping file to the model folder. |
| Map according to line types and layers | 1. Open the mapping file in an XML editor.  
2. Enter the line type and layer name.  
   Define the layers that the mapping will apply to in the LayerName attribute.  
   If you leave out the attribute LayerName, Tekla Structures uses the line type mapping for any layer. If you include the attribute LayerName, Tekla Structures uses the line type mapping for that layer only.  
   For example, all lines on the layer BEAM with line type XKITLINE01 will be exported to DASHED. Tekla Structures first searches for these kinds of mappings by default.  
3. Define the color of the line in the Color attribute. Enter the color values in AutoCAD Color Index (ACI) codes (numbers from 0 to 255).  
4. Define the thickness of the line in the Weight attribute. Enter the values in hundredths of millimeters.  
5. Save the mapping file to the model folder. |

This is how the file LineTypeMapping.xml is composed:
The first section consists of XML and document type definition. Do not change or remove this section.

The mappings that are available are defined here. You can use these mappings as a template for your own mappings.

Examples:

In the first example, a new Mapping element is added, where XKITLINE00 lines in the Beam layer are converted to BORDER line type, color is converted to 10 and weight to 1.00 mm:

```
<Mapping LayerName="Part">
  <From LineType="XKITLINED0"/>
  <To LineType="BORDER" Color="4" Weight="100"/>
</Mapping>
```

1. The first section consists of XML and document type definition. Do not change or remove this section.

2. The mappings that are available are defined here. You can use these mappings as a template for your own mappings.

Examples:

In the first example, a new Mapping element is added, where XKITLINE00 lines in the Beam layer are converted to BORDER line type, color is converted to 10 and weight to 1.00 mm:
In the second example, a new Mapping element is added, where XKITLINE02 lines in the Part layer are converted to HIDDEN2 line type, the layer name is converted to Part_Hidden, the color is converted to 8 and weight to 1.00 mm.

You can use the LineTypeMapping.xml file for exporting hidden lines to separate layers. The hidden lines must then be defined to their own layers (here Part_Hidden).

```xml
<Mapping LayerName="Part">
  <From LineType="XKITLINE02"/>
  <To LineType="HIDDEN2" LayerName='Part_Hidden' Color='8' Weight='1.00'/>
</Mapping>
```

**NOTE** For the export to succeed, ensure that the layer (here Part_Hidden) exists on the list of available layers in the Modify Layers dialog box.

**Default line types in drawings**

Default line types are available in Tekla Structures drawings. You can map default line types to customized line types, which are defined in TeklaStructures.lin and further exported to DWG/DXF files.

The table below lists the default line types and shows what they look like.

<table>
<thead>
<tr>
<th>Line type name</th>
<th>Line type appearance</th>
</tr>
</thead>
<tbody>
<tr>
<td>XKITLINE00</td>
<td>-----</td>
</tr>
<tr>
<td>XKITLINE01</td>
<td>-----</td>
</tr>
<tr>
<td>XKITLINE02</td>
<td>---</td>
</tr>
<tr>
<td>XKITLINE03</td>
<td>-----</td>
</tr>
<tr>
<td>XKITLINE04</td>
<td>........</td>
</tr>
<tr>
<td>XKITLINE05</td>
<td>-----</td>
</tr>
<tr>
<td>XKITLINE06</td>
<td>-----</td>
</tr>
</tbody>
</table>

**Example: Set up layers and export in DWG format (old export)**

This example shows how to define layers and export line types on a certain layer to their own sublayers in the DWG export.
Example: Create a selection filter for DWG export

To create a selection filter:

1. In the model, click the **Selection filter** switch.
2. In the **Object Group - Selection Filter** dialog box, click **New filter**.
3. Add new filter rules.
   a. Create a filter rule that select parts according to the name **BEAM**.
   b. Create a filter rule that selects parts according to the material **S*** (as in steel).
4. Save the filter as **steel-beam**.

Example: Create layers for DWG export

After creating a selection filter, you can continue by creating layers that you want to have in the exported DWG.

To create the layers you want to have in the exported DWG:

1. On the **File** menu, click **Export --> Drawings**.
2. Go to the **Layer options** tab.
3. Click **Setup** and then click **Modify layers**.
4. Click **Add** to add a new layer.

   Create separate layers for solid lines (**steel-beam-layer**) and hidden lines (**steel-beam-layer-H**) within steel beams.

5. Set the color for the layers.

   Set the solid lines to red and hidden lines to blue.

   - **steel-beam-layer-H**
   - **steel-beam-layer**

6. Click **OK** to accept the changes.

**Example: Create a rule for drawing DWG export and assign a layer to the rule**

After creating layers, you can continue by creating a rule to export an object group into a layer, and assign the layer to the created rule.

To create a rule to export an object group into a layer, and assign the layer to the created rule:

1. Right-click a model object part rule and select **Add Next Level Rule**.

2. Enter a name for the rule (**steel-beam-rule**) and select the selection filter you created for steel beams (**steel-beam**).

3. Click **OK**.

4. To assign a layer to a rule, double-click the row under the **steel-beam-rule** and select a layer, in this case **steel-beam-layer**.

5. Click **OK**.

6. Save the layer rule settings with the name **example1** using **Save as**.

---

Import to and export from Tekla Structures 260

Export a drawing in 2D DWG, DXF, or DGN format
7. Close the dialog box by clicking OK.

Example: Define a custom line type for DWG export

After creating a rule, you can continue by defining a custom line type for continuous lines in the exported DWG. In this example, you will add some line type definitions.

To define a custom line type:

1. Open the TeklaStructures.lin file in a text editor (.\ProgramData \Trimble\Tekla Structures\<version>\environments\common \inp).
2. Add the following line type definition in the file:

   ```
   *HIDDEN, Hidden __ __ __ __ __ __ __ __ __ __
   A, 1.5875, -0.79375
   *HIDDEN2, Hidden (.5x) __ __ __ __ __ __ __ __ __ __
   A, 0.79375, -0.396875
   *HIDDENX2, Hidden (2X) __ __ __ __ __ __ __ __ __ __
   A, 3.175, -1.5875
   *PHANTOM, Phantom __ __ __ __ __ __ __ __ __ __
   A, 7.9375, -1.5875, 1.5875, -1.5875, 1.5875, -1.5875
   *PHANTOM2, Phantom (.5x) __ __ __ __ __ __ __ __ __ __
   A, 3.96875, -0.79375, 0.79375, -0.79375, 0.79375, -0.79375
   *PHANTOMX2, Phantom (2X) __ __ __ __ __ __ __ __ __ __
   A, 15.875, -3.175, 3.175, -3.175, 3.175, -3.175
   
   *CONTINUOUS, Continuous ________________________________
   A, 1]
   ```

3. Save the file. Ensure that the file name extension does not change.

Example: Define line types and weights for layers in DWG export

After defining a custom line type, you can continue by modifying the LineTypeMapping.xml file and defining the line types and weights.

To define the line types and weights:
1. Open the LineTypeMapping.xml file (..\ProgramData\Trimble \Tekla Structures\<version>\environments\common\inp) in a text editor.

2. Add the line type mappings for the layers as shown inside the lower blue frame in the image below. Do not touch the lines inside the upper red frame.

3. Save the file. Ensure that the file name extension does not change.

1. The lines are on the steel-beam-layer layer.
2. The lines are drawn with XKITLINE00 (solid lines).
3. The lines are exported to CONTINUOUS lines in DWG. The line color in DWG was already defined in the layer properties (red). The line weight in DWG is 35.
4. The lines are on the steel-beam-layer layer.
5. The lines are drawn with XKITLINE02 (hidden lines).
6. The lines are exported to DASHED lines into a separate layer called `steel-beam-layer-H` in DWG. The line color in DWG was already defined in the layer properties (blue). The line weight in DWG is 35.

**Example: Export the drawing to DWG**

After you have defined all the layer settings, you can continue by exporting the drawing. Before exporting the drawing to DWG, ensure that all the drawing properties are as you wish.

To export the drawing:

1. Open the drawing that you want to export.
2. On the **File** menu, click **Export drawings**.
3. Enter a name for the export file.
4. Set the **Type** to **DWG**.
5. Go to the **Layer options** tab page and load the layer rule settings that you saved earlier with the name `example1`.
6. Select the following check boxes: **Use advanced line type and layer conversion**, **Include empty layers** and **Object color by layer**.
8. Go to the **Options** tab, set the scale for the export and select the **Export objects as groups** check box and, if you want to, **Cut lines with text** and **Export custom lines as split lines**.
9. Click **Export**.

Open the exported DWG with an applicable DWG viewer software. You can see that the solid lines of the steel beam are on one layer and the hidden lines are
on another layer. You can also see that columns do not match with the layer rules you defined, so they are handled according to other rules.

See below for examples on how the selecting and not selecting **Cut lines with text** affects the result.

In the following example, **Cut lines with text** is selected.

In the following example, **Cut lines with text** is not selected.
3.5 DGN

The DGN format has been used especially for data transfer between plant design programs. It was developed by MicroStation. It is similar to DWG in that it is only a graphical data format. It contains unique part IDs in the given model. It is possible to check for clashes between the Tekla Structures model and a DGN reference model.

This format has the following limitations:

- GUID is not supported.
- DGN reference model import does not support change management or UDAs.
- 3D DGN export supports parts only.

See also

Reference models and compatible formats (page 163)
Insert DGN files (page 265)
Insert a reference model (page 165)
Export in 3D DGN format (page 267)

Insert DGN files

You can insert DGN files as reference models to Tekla Structures.

You can view DGN reference model objects on different reference model layers according to the level settings in the DGN file. You can use DGN models for clash checking. Tekla Structures reference model insert supports V7 and V8 DGN formats.

A DGN file may contain one or more DGN models. A DGN model can be one of the following three types: a design model, an extrusion model or a sheet model. Design models are most useful in Tekla Structures as they contain appropriate structural data.
If there are many model types available in a DGN file, Tekla Structures selects the inserted model type in the following order:

1. Active model is inserted if it is a design model.
2. Default model is inserted if it is a design model.
3. If DGN file contains design models, the first one is inserted.
4. If there are no design models in the DGN file, the first model is inserted, regardless of the model type.

DGN reference model insert does not support UDAs or change management.

To insert a DGN file, open the Tekla Structures model where you want to insert the DGN reference model, and click the Reference Models button in the side pane.

To complete the insertion, follow the instructions in Insert a reference model (page 165).

**DGN objects supported in reference models**

Tekla Structures can display the following DGN objects in reference models:

<table>
<thead>
<tr>
<th>Object</th>
<th>Type no.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cell</td>
<td>2</td>
<td>A collection of grouped entities with a common insertion point/origin, scale and orientation in 2D/3D space.</td>
</tr>
<tr>
<td>Line</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>Line string</td>
<td>4</td>
<td>A series of interconnected lines.</td>
</tr>
<tr>
<td>Shape</td>
<td>6</td>
<td>Like a line string, but closed (first point = last point).</td>
</tr>
<tr>
<td>Text node</td>
<td>7</td>
<td>A multi-line paragraph/block of text.</td>
</tr>
<tr>
<td>Curve</td>
<td>11</td>
<td>A parametric spline curve.</td>
</tr>
<tr>
<td>Complex chain</td>
<td>12</td>
<td>A chained collection of other entities (lines, line strings, arcs, curves or b-spline curves).</td>
</tr>
<tr>
<td>Complex shape</td>
<td>14</td>
<td>Like a complex chain, but closed (first point = last point).</td>
</tr>
<tr>
<td>Ellipse</td>
<td>15</td>
<td></td>
</tr>
<tr>
<td>Arc</td>
<td>16</td>
<td></td>
</tr>
<tr>
<td>Text</td>
<td>17</td>
<td>Supports TrueType fonts and text styles (bold, underline, italic, etc).</td>
</tr>
<tr>
<td>3D surface</td>
<td>18</td>
<td>Like a 3D solid, but not capped on the ends.</td>
</tr>
<tr>
<td>Object</td>
<td>Type no.</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>----------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>3D solid</td>
<td>19</td>
<td>The solid created by projecting or rotating from a boundary entity (line, line string, curve, arc or ellipse).</td>
</tr>
<tr>
<td>Cone</td>
<td>23</td>
<td>Actually a truncated cone described by two parallel circles; if the radius of both circles is the same, a cylinder is produced.</td>
</tr>
<tr>
<td>B-spline surface</td>
<td>24</td>
<td>See description of b-spline curves, which also applies here; additional data is provided by surface boundary entities (type 25).</td>
</tr>
<tr>
<td>B-spline curve</td>
<td>27</td>
<td>Can be rational/non-rational, uniform/non-uniform, open/closed; entity type 27 supplies header data and additional data is provided by pole entities (type 21), knot entities (type 26) and weight factor entities (type 28).</td>
</tr>
<tr>
<td>Shared cell definition</td>
<td>34</td>
<td>Similar to a DWG block definition; basically defines a set of grouped entities.</td>
</tr>
<tr>
<td>Shared cell instance</td>
<td>35</td>
<td>Similar to a DWG block instance; given a particular cell 'definition', numerous cell 'instances' can be created at differing locations, scales and orientations.</td>
</tr>
<tr>
<td>Multiline</td>
<td>36</td>
<td>A set of parallel lines, which can be jointed (with or without visible seams at the joints), and have various types of end caps (rounded, square, etc).</td>
</tr>
<tr>
<td>Mesh</td>
<td>105</td>
<td>Supports indexed face loops, quad list, quad grid, triangle grid and triangle list meshes.</td>
</tr>
<tr>
<td>Smart solid</td>
<td>-</td>
<td>Smart solids (solids created from embedded Parasolid/ACIS data) can be imported into Tekla Structures as wireframe outlines.</td>
</tr>
</tbody>
</table>
Export in 3D DGN format
You can export selected parts or the whole model in the 3D DGN format. You can use either the older v7.0 export or the newer v8.0 export.

Export in 3D DGN v8 format
• Tekla Structures uses the Open Design Alliance (ODA) toolkit to export 3D DGN v8 format.
• The surface presentation of the parts is exported. Bolt holes are not included in the export.
• You can export objects relative to the model origin, to the base point you define, or relative to the work plane.
• You can export in layers by name, phase or any template attribute or user-defined attribute.
• Colors can be exported by class or by stored object group representation.
• You can export all objects or selected objects. You can use the Select objects in assemblies and Select objects in components selection switches for selecting the objects to export. You can export selected parts in an assembly when you use the Select objects option and Select objects in assemblies and Select objects in components when you select the parts. If you do not select a part but an assembly, the highest level of assembly parts will be included in the export.

Create object group color representations
If you want to use object group color representations in the export, you need to create the object groups first, set the colors for the object groups and save the representation settings. Note that the transparency setting is not included in the export.

Create base points
If you want to export objects relative to a base point, you need to create a base point in your model.
1. Open a Tekla Structures model.
2. On the File menu, click Export --> 3D DGN v8.
3. In the **File name** box, enter the name of the export file.

4. In the **Folder** box, enter the export folder path, or browse to the folder.

5. In **Location by**, select one of the following:
   - **Model origin** exports the model relative to 0,0,0.
   - **Work plane** exports the model relative to the current work plane coordinate system.
   - **Base point** `<name of base point>` exports the model relative to the base point using coordinate system values **East coordinate**, **North coordinate**, **Elevation**, **Angle to North**, **Latitude** and **Longitude** from the base point definition.

6. In the **Selection** list, select **All objects**, or **Selected objects**. If you want to export selected objects, select the objects with the appropriate selection switches:
   - If you activate the **Select parts** and **Select objects in components** selection switches, all the selected parts will be exported.
   - If you activate the assembly or component selection, nothing will be exported.

7. In **Object color**, select whether you want to export objects using object class colors or object group colors.

8. In **Layer names as**, select **Name** or **Phase** from the list, or type the template or user-defined attribute name in the box. You can use phases, part names, or template attributes or user-defined attributes as layer names for exported objects.

9. When you are done, click **Export** to export the objects according to the defined settings.

   **Tekla Structures creates the <name>.dgn file in the specified folder.**
**Export in 3D DGN v7 format**

- The 3D DGN v7 export supports parts only.
- In the 3D DGN v7 export, you can only use the model origin in the export. Changing the work plane has no effect to the export.
- You can use the following advanced options to control DGN exports:
  - XS_EXPORT_DGN_COORDINATE_SCALE
  - XS_EXPORT_DGN_INCLUDE_CUTS

1. Open a Tekla Structures model.
2. On the **File** menu, click **Export** --> **3D DGN**.
   - The **3D DGN Export** dialog box opens.
3. In the **Output file** box, enter the name of the export file.
   - If you want to replace an already existing file, click the ... button and browse for the file.
4. In the **Export** list, select **All objects**, or **Selected objects** and select the parts to export.
   - It might be a good idea to filter out minor secondary parts, for example, curved parts from railings, if you do not need them in the exported DGN model. This decreases the export file size.
5. Click **Create**.
   - Tekla Structures creates the `<name>.dgn` file in the current model folder.

**Control tubular parts in 3D DGN export**

If you have tubular parts in your model, and you want to reduce the size of the DGN files, or affect the complex display in rendered views, you can use the following advanced options:

- XS_CHORD_TOLERANCE_FOR_SMALL_TUBE_SEGMENTS
- XS_CHORD_TOLERANCE_FOR_TUBE_SEGMENTS

### 3.6 LandXML

You can insert LandXML reference models to Tekla Structures. The supported contents of LandXML files are terrain models, line alignments of roads and railways, and rain water systems.

You can export files in `.xml` format from applications like Bentley InRoads, Autodesk Civil, and Trimble Business Center, and insert the `.xml` files in Tekla Structures as reference models. The LandXML format extends the capabilities...
of Tekla Structures to show merged models, including the infra models. Tekla Structures supports LandXML 1.2 schema and single-precision floating-point format.

A typical example of a building structure where LandXML can be used is the surface of the bedrock to be utilized when pile lengths are to be considered. LandXML can also be used when estimating the need of excavation. The LandXML format is important also for bridge and for civil structures design tasks.

An example of an imported LandXML reference model:

An example of layers in a LandXML reference model:
Limitations

The LandXML feature does not support all the possible data in the format. It supports the subset of the primitives defined in LandXML 1.2 schema, such as alignments, terrain models and pipe networks.

- Surfaces are not shown correctly in drawings.
- Triangle type of surfaces are only supported.
- There is no warning if the LandXML file contains unsupported data.

See also

Insert a reference model (page 165)
3.7 PDF

You can insert a PDF file as a reference model in your Tekla Structures model. During import, Tekla Structures converts the PDF into the DXF format.

**Insert a PDF file in a model**

1. On the File menu, click Import --&gt; Insert PDF.
   
   The Insert PDF Reference Model dialog box opens.
2. Click Browse...
3. Browse for the PDF reference model file and click Open.
4. Set the scale for the PDF reference model.
5. Enter the number of the pages that you want to insert.
6. Click OK.
7. Pick a point to place the PDF reference model.

Tekla Structures converts the PDF file into the DXF format. The conversion creates a DXF file for every inserted PDF page. Tekla Structures saves the DXF files to the same folder where the PDF is.

**Limitations**

Only vector graphics are converted, not raster graphics.

---

**WARNING** The PDF document might be subject to minor scaling adjustments during the printing process to make it fit a standard page size. That means that it may not be 100% accurate in all directions once scaled to full size.

---

3.8 3D PDF

You can export the current model or the selected model objects as a 3D PDF file. The 3D PDF allows you to easily communicate your work to others: all the receiver needs is a PDF reader that supports 3D PDFs.

When you open the resulting 3D PDF file in a PDF reader, the 3D PDF looks exactly like the original 3D design. You can explore the model using the tools available in the PDF reader.

---

**NOTE** We recommend that you use Adobe Acrobat Reader, as all PDF readers do not support the 3D PDF format.

---

**Export a model or selected model objects as 3D PDF**

1. In modeling mode, click File --&gt; Export --&gt; 3D PDF.
2. Enter the desired filename and browse to the folder where you want to save the file. By default, the 3D PDF file is exported to the PDF folder under the current model folder.

3. Check the other options on the File, PDF, and Model content tabs, and adjust the options to suit your needs. For more information about the settings, see section "3D PDF export settings" below.

4. If you want to export some objects only, select the objects in the model, and select Selected objects as the Scope of export. To export the whole model, select All objects.

5. When you are ready, click Publish. The 3D PDF file is exported to the export folder you defined. A message is displayed when the model has been converted.

3D PDF export settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File tab</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Cover page</strong></td>
<td>Browse for a suitable PDF cover page.</td>
</tr>
<tr>
<td><strong>View PDF after export</strong></td>
<td>Open the 3D PDF in a PDF reader after the export.</td>
</tr>
<tr>
<td><strong>Open the folder after export</strong></td>
<td>Open the 3D PDF export folder after the export.</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Create U3D file only</td>
<td>Export as a U3D file. The Universal 3D (U3D) format is a compressed file format standard for 3D computer graphics data.</td>
</tr>
<tr>
<td><strong>PDF tab</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Additional property sets</strong></td>
<td>Select the IFC property set configuration file to include in the export. The properties defined in the property sets are shown in the model tree together with the standard part properties. The property sets can be defined in the IFC Property set definitions dialog box. To show the additional properties in the PDF model tree, you need to select the <strong>Include part attributes</strong> option.</td>
</tr>
<tr>
<td>Include fasteners</td>
<td>Include fasteners in the export.</td>
</tr>
<tr>
<td>Include reinforcement</td>
<td>Include reinforcement in the export.</td>
</tr>
<tr>
<td>Include welds</td>
<td>Include welds in the export.</td>
</tr>
<tr>
<td>Include grids</td>
<td>Include grids in the export</td>
</tr>
<tr>
<td>Include part attributes</td>
<td>Include part properties in the export. When you select this option, and select a part in the model tree or in the PDF, the part properties will be displayed in the model tree.</td>
</tr>
</tbody>
</table>

When you have selected this option, the additional properties are shown in the model tree as well if you have selected a property set configuration file in **Additional property sets**.
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Export as assemblies</strong></td>
<td>Automatically select the corresponding assembly of the objects for the export.</td>
</tr>
<tr>
<td><strong>Use current view colors</strong></td>
<td>Use the colors in the model view in the exported 3D PDF.</td>
</tr>
<tr>
<td><strong>Tree view</strong></td>
<td>Select how to show the model content in the model tree: by model phases (<strong>Per phase</strong>) or by model objects (<strong>Per part name</strong>).</td>
</tr>
<tr>
<td><strong>Solid accuracy</strong></td>
<td>Show the solids with normal or high accuracy.</td>
</tr>
<tr>
<td><strong>Model content tab</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Page size</strong></td>
<td>Select the desire page size.</td>
</tr>
<tr>
<td><strong>Page orientation</strong></td>
<td>Select the desired page orientation (<strong>Landscape</strong> or <strong>Portrait</strong>)</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Background</strong></td>
<td>Define the background color.</td>
</tr>
<tr>
<td><strong>Light definition</strong></td>
<td>Select the desired extra light effects. The options are:</td>
</tr>
<tr>
<td></td>
<td>Artwork</td>
</tr>
<tr>
<td></td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>White</td>
</tr>
<tr>
<td></td>
<td>Day</td>
</tr>
<tr>
<td></td>
<td>Night</td>
</tr>
<tr>
<td></td>
<td>Hard</td>
</tr>
<tr>
<td></td>
<td>Primary</td>
</tr>
<tr>
<td></td>
<td>Red</td>
</tr>
<tr>
<td></td>
<td>Cube</td>
</tr>
<tr>
<td></td>
<td>CAD</td>
</tr>
<tr>
<td></td>
<td>Headlamp</td>
</tr>
<tr>
<td><strong>Rendering mode</strong></td>
<td>Select the desired rendering mode. The options are:</td>
</tr>
<tr>
<td></td>
<td>Solid</td>
</tr>
<tr>
<td></td>
<td>Solid wireframe</td>
</tr>
<tr>
<td></td>
<td>Transparent</td>
</tr>
<tr>
<td></td>
<td>Transparent wireframe</td>
</tr>
<tr>
<td></td>
<td>Bounding box</td>
</tr>
<tr>
<td></td>
<td>Transparent bounding box</td>
</tr>
<tr>
<td></td>
<td>Transparent bounding box outline</td>
</tr>
<tr>
<td></td>
<td>Wireframe</td>
</tr>
<tr>
<td></td>
<td>Shaded wireframe</td>
</tr>
<tr>
<td></td>
<td>Hidden wireframe</td>
</tr>
<tr>
<td></td>
<td>Vertices</td>
</tr>
<tr>
<td></td>
<td>Shaded vertices</td>
</tr>
<tr>
<td></td>
<td>Illustration</td>
</tr>
<tr>
<td></td>
<td>Solid outline</td>
</tr>
<tr>
<td></td>
<td>Shaded illustration</td>
</tr>
<tr>
<td><strong>Title</strong></td>
<td>Enter a title for the PDF. The title is shown in the PDF properties.</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Subject</strong></td>
<td>Enter a subject for the PDF. The subject is shown in the PDF properties.</td>
</tr>
<tr>
<td><strong>Author</strong></td>
<td>Enter the author of the PDF. The author is shown in the PDF properties.</td>
</tr>
</tbody>
</table>

Below is an example of a 3D PDF in Adobe Acrobat Pro. The model content is listed in the model tree by phases.

![3D model PDF example](image)

### 3.9 SketchUp

You can export Tekla Structures models as .skp files to be used in Trimble SketchUp.

Trimble SketchUp is a modeling software used in architecture, construction, engineering, and landscape architecture, for example. [3D Warehouse](https://3dwarehouse.autodesk.com) contains lots of SketchUp models that you can import as reference models to Tekla Structures.

You can insert Sketchup files as reference models to Tekla Structures. For more information about inserting reference models, see [Insert a reference model](page 165).
Tekla Structures supports SketchUp version 2021 and earlier in export and reference model insert.

Export a model to SketchUp
1. Select the model objects to export.
   - If you want to export all objects, you do not have to select anything. We recommend exporting large models in smaller portions.
2. On the **File** menu, click **Export --> SketchUp**.
3. On the **Parameters** tab, browse to the desired **Output file** location and enter the file name. By default, the file is exported to the model folder.
4. In **Version**, select the desired SketchUp version.
5. On the **Advanced** tab, select the objects that you want to export. You can export:
   - **Parts**
   - **Reinforcing bars**
   - **Surface treatment**
   - **Pour objects**
   - **Bolts**
   - **Welds**
6. Click **Create selected**.
   - If have not selected any model objects, and want to export everything, click **Create all**.
   The export file is created in the specified folder.

### 3.10 Point clouds

Point clouds are groups of measured points on the surfaces of objects created with 3D laser scanners such as Trimble X9 3D Laser Scanning System. In construction, the point clouds are mainly used in renovation projects to define the building or structure that is to be renovated. They can also be used to get the exact position of existing machinery, pipework or landscape that need to be taken into consideration on the site. You can also use them to check execution by importing them as build points into a model to be compared to the design.

**About point clouds in Tekla Structures**
- When you attach a point cloud to a Tekla Structures model, you can place it either by the model origin or a defined base point.
• The original point cloud file is processed and cache files are created in the potree format. The point cloud conversion occurs as a background process, and you can continue working with Tekla Structures meanwhile.

• Point cloud data is stored in the folder defined by the advanced option XS_POINT_CLOUD_CACHE_FOLDER. By default, the folder is %LocalAppData%\Trimble\Tekla Structures\PointClouds, for example, C:\Users\<user>\AppData\Local\Trimble\Tekla Structures\PointClouds. The XS_POINT_CLOUD_CACHE_FOLDER advanced option is user-specific, and it is located in the **File locations** category in the **Advanced options** dialog box.

• If the point cloud file is in the potree format already, then the original file is used without any conversion or copying to the ..\Pointclouds folder.

• If the same point cloud is used in several models, it will not be converted again or duplicated when you attach it. If point clouds are identical, the existing converted file is used, otherwise the file is converted.

• It may be useful to use a network drive for the potree file in a project. The file will not be copied to the local computer.

• You can also use point clouds through internet. Point cloud web streaming cache is a common cache with Trimble Connect for Windows. You can define the cache folder using the advanced option XS_POINT_CLOUDS_WEB_CACHE in the **File locations** category in the **Advanced options** dialog box. By default, the folder is %LocalAppData%\Trimble\Trimble Connect\Import, for example, C:\Users\<user>\AppData\Local\Trimble\Trimble Connect\Import. The cache usage improves the performance of the web streamed point clouds.

• In Tekla Structures, point clouds have colors if the original file format supports colors.

• Point clouds can be seen in both the OpenGL model view and in the DX model view. The DX model view with perspective projection may give better visual result. Performance with bigger amount of data and/or larger number of views may make DX usage impossible.

**Compatible file formats**

- ASCII (.asc, .xyz)
- E57 (.e57)
- LAS (.las)
- LAZ (.laz)
- SDB (.sdb)
- PTS (.pts)
- PTX (.ptx)
- Potree (.js, .json)
Trimble scan format (.tzf)
Trimble TDX format (.tdx)

Limitations

- Some basic Tekla Structures model handling functionalities are not available, such as select, undo, move, rotate, copy, and context menu on right-click.
- Point clouds are not autosaved.
- You cannot delete a point cloud from the point clouds list using the keyboard button Delete.
- Point clouds are not visible in drawings.
- Point clouds are not shared in Tekla Model Sharing or in multi-user mode.
- For the file formats ASCII, PTS: On each text line, the first three fields must be: x y z. For colored point data, the last three fields must be: r g b

Attach a point cloud to the model

1. Click the Point clouds button in the side pane.
2. If you want to place the point cloud inside the work area, select the Show inside work area only check box.
3. Click Attach.
4. Browse for the point cloud file, or enter the URL address of the point cloud.

You can also drag point clouds from Windows Explorer, and insert several point clouds at a time.

Note that when you are using a URL, you need to create the HTTP directory structure potree that you can create with Point Cloud Manager.
5. Change the point cloud scale, if needed.

6. In Location by, select Model origin to place the point cloud in the model origin, or select a base point to place the point cloud in the real world coordinates.

**NOTE** If you do not know the coordinate system of the point cloud, select Auto-created base point to get the point cloud near the model origin. Automatic base point with point cloud bounding box min x, min y, and min z coordinates will be created in Tekla Structures origin.

7. Click Attach point cloud.
8. To show the point cloud in the model, select the model view where you want to show it, and click the eye button next to the point cloud in the list.

Note that when you select a model view, it has a yellow frame.

When the point cloud is set visible in the model view, you can see the min x, min y, and min z coordinates of the point cloud bounding box on the status bar.

To hide the point cloud, click .

When you are modeling, you can snap to points for modeling and measuring distances. You can use clip planes in point clouds to exactly show what you want, for example, clip off the roof and some of the floors so that you can see the bottom floor of the building, and everything there that needs your attention in the planning phase. You can also use the Clipper tool in Tekla Warehouse for handling several clip planes at a time, and split the model to smaller pieces for visualization and modeling.

Modify point cloud properties and visualization settings

You can modify the point cloud properties and visualization settings when you have attached a point cloud, and DirectX rendering is active.

Note that the point cloud Visualization settings are view specific and settings are enabled for one view only, the name of which can be seen at the top of the Point clouds side pane (if you have not selected multiple views). The Properties settings are enabled only if the point cloud is selected from the list.

1. When you have attached the point cloud, select it from the point clouds list in the side pane, otherwise you cannot modify its properties.
2. In **Display name**, define the desired display name for the point cloud. In addition to the display name, the point cloud has the actual point cloud file name, which you cannot change.

3. **URL** shows the point cloud URL address. You can change the URL if necessary.

4. **File** shows the folder path of the point cloud file. You can change the path if necessary.

5. Adjust the point cloud location, scale and rotation.
   
   Use the **Reset** button to return the values that we saved for the point cloud the last time.

6. Click **Modify**.

7. In **Visualization settings**, use the EDL (Eye-dome lighting) effect to improve the depth perception of the point cloud. Drag the sliders to increase or decrease the outline thickness and strength of the point cloud. You can deactivate the EDL effect by clicking the **EDL** button.
8. In **Visualization settings**, adjust the size and density of the points by dragging the sliders.

9. In **Visualization settings**, change the point cloud colors. Normally, the default color values are in use. The visualization settings are view specific and therefore you can use different settings in different views.
   - You can color the point cloud by elevation by dragging the sliders.
• If the point cloud contains classifications, you can change the color of the classification category points or hide them.

• Check clashes and deviations by using different colors for different tolerances. You can detect points that are inside or within a distance from the selected parts and selected reference model objects based on the settings you define. Clash check between point clouds and pour objects is also supported. Note that rendered objects coloring may cause confusing results. It is recommended to use Ctrl+1 and Shift+1 visibility modes to get unambiguous results.

10. Save the properties and visualization settings for future needs.
Detach a point cloud from a model

- To detach a point cloud, click Detach next to the point cloud name in the Point clouds list. Then reopen the model or save the model.

  Note that you cannot detach the point cloud by pressing Delete on the keyboard.

  The point clouds are cached to the default location or to the location specified by the user. When a point cloud is no longer used in any Tekla Structures model, it is cleaned from cache.

Set the default maximum point count in a view

You can use the advanced option XS_SET_MAX_POINT_CLOUD_POINT_COUNT to set the default maximum value for the points in a view. The default value is 10 000 000 (10 million).

This advanced option is system specific, and it is located in the Model views category of the Advanced options dialog box. Restart Tekla Structures if you change the value.

Clip point clouds and reference models only

Set the user-specific advanced option XS_DO_NOT_CLIP_NATIVE_OBJECTS_WITH_CLIP_PLANE to TRUE to only clip point clouds and reference models with the Clip plane command. Native Tekla Structures objects are not clipped. FALSE is the default value. This advanced option is located in the Model views category in the Advanced options dialog box.

Redraw the model views after changing the value.

Point cloud example

In the first image below, a point cloud has been attached to a model in a plan view. Remember to select a model view and click the eye button, otherwise the point cloud will not be shown.
In the next image, the clip plane tool has been used to cut off floors and other structures:
In the next image, a section has been cut to be used in a section view:
The last image shows the section view:
Share point clouds with other users

Point clouds are normally so large in file size that it is not sensible to share the point cloud as a part of the model data. Point cloud is not structural domain data but project data that is not a part of the model, and therefore it is not dependent on the model save. However, there is need for multiple persons to use the same point cloud model efficiently. You can use the potree file for sharing the point cloud. The best practices in sharing the point cloud potree file among model users are explained below. You first need to create the potree file and copy the potree file to a shared location, and then other users can attach it to their Tekla Structures model.

Create a potree file

Option 1: With Tekla Structures

1. Create a potree file by attaching a point cloud model to a Tekla Structures model.

   The potree file is created in the folder defined by the advanced option XS_POINT_CLOUD_CACHE_FOLDER. The potree file is named as <potree_name>.db, and it has a folder with the same name. For example:
2. Copy both the `<potree_name>.db` file and the related folder to a shared location. You can rename the model if you want, in which case you also need to rename the folder.

**NOTE** Do not replace existing potree data, especially if it is used by other users.

**Option 2: With Point cloud manager**

For detailed instructions for creating a potree file with Point cloud manager, see section "Create a potree file with Point cloud manager" in "Hosting your own potree point cloud data".

**Attach a potree from a shared location**

1. Open Tekla Structures and the **Point clouds** pane from the side pane.
2. Browse to the point cloud folder (`mypotree` in the example above) and select the point cloud `.js` file. Then follow the instructions above for attaching the point cloud.

### 3.11 Layout manager

Use **Layout manager** to import and export layout data between Tekla Structures and a field layout device, such as Trimble® LM80. **Layout manager** enables you to use accurate model data on the construction site.

When you wish to import and export layout data, we recommend that you first set up groups in **Layout manager**, then model the layout points, layout lines, and layout arcs, and organize them in the groups. The points, lines, and arcs are used in a layout device on the construction site to position parts correctly.

Once you have defined and organized the layout data, you can export the data from **Layout manager** to a field layout device in different export formats: point file (.txt), CSV file (.csv), job file (.cnx), and Trimble FieldLink file (.tfl) and (.tflx).

You can check and measure the positions of the exported layout points (design points) on the site using a field layout device. The layout device helps you to position the parts correctly on the site, because then the points along the part
boundaries can be placed to the correct locations. To place the part boundaries correctly, measure the as-built positions of the parts on the site and create measured points along the part boundaries.

When you have measured the as-built positions and created measured points, you can import the points to Tekla Structures. You can first preview the points in Layout manager. Finally, you can view the measured points in the model.

To import and export directly with a handheld mobile device, such as Trimble® LM80, you need to connect your computer to the device. Your computer needs to have software that enables it to communicate with a mobile device. For information on how to connect your computer to Trimble layout devices, see the Trimble website.

See also
Set up groups in Layout manager (page 293)
Create a layout point (page 298)
Create a layout line (page 299)
Export layout data from Layout manager (page 301)
Import layout data to Layout manager (page 304)
Example: Base point use in Layout manager (page 310)

Set up groups in Layout manager
You can create groups in Layout manager to organize layout points, layout lines, and layout arcs suitably.

Base points in Layout manager
You can use base points in Layout manager when defining the location of layout points. You can use the base points that have already been defined in the model, and you can define new base points in File --> Project properties --> Base points. Layout manager uses the Location in the model...
coordinates that you define for base points, and the **East coordinate**, **North coordinate**, and **Elevation** coordinates.

When you add, modify, or delete base points in **File --> Project properties --> Base points**, reopen or refresh **Layout manager** to ensure that the base point data is up to date in **Layout manager**.

- The base points that you add are shown in the **Group local coordinate system** list for the groups in **Layout manager**.
- If you delete a base point that is linked to a group in **Layout manager**, Tekla Structures recreates that base point so that it can still be used in **Layout manager**.
- If you modify a base point that is used in **Layout manager**, Tekla Structures shows a message about the base point use in **Layout manager**. You can either use the modified coordinates in **Layout manager**, or you can select not to use them. If you select not to use them, the coordinates of the base point will then be different in Tekla Structures and in **Layout manager**.

When you open an existing model in a Tekla Structures version where **Layout manager** uses the base point functionality, **Layout manager** creates base
points based on the group local coordinate systems that are not in the model origin [(0,0,0) & no rotation]. The created base points are added to the groups in **Layout manager** and shown in the **Group local coordinate system** list. The base points are also shown in the list of base points in **File --> Project properties --> Base points**. The description text in the **Base point** dialog box shows that the base point has been created by **Layout manager**.

**Define a default coordinate system for groups**

You can define a default base point to set the default coordinate system for all the new groups that you create in **Layout manager**. You can use the groups in **Layout manager** to organize layout points, layout lines, and layout arcs.

1. On the **Manage** tab, click **Layout manager**.
2. In **Layout manager**, select **Layout Manager Object Group** to show the available **Group local coordinate system for new groups** list.
3. Select from the list the base point that you want to use, the model origin, or the current work plane.

![Layout Manager](image)

The base points that have been defined in the model are available in the list. If you have added new base points to the model since you opened **Layout manager**, reopen or refresh **Layout manager** to make the new base points available in the list.

You can change the group default coordinate system at any time by selecting another option from the list. Note that the default coordinate system only applies to new groups. The existing groups are not changed.

**Define numbering settings for groups**

You can define that all groups in **Layout manager** have the same numbering settings. When you change the settings, the changed settings are used in all the groups that you create after the change. The settings in the existing groups are not changed.

1. On the **Manage** tab, click **Layout manager**.
2. Click **Group** to open the settings and then click **Group**.
3. Define the numbering settings.
a. Enter the prefix in the **Prefix** box.

You can also leave the prefix empty to create the layout point, layout line, and layout arc names without a prefix.

b. Enter the starting number in the **Starting number** box.

c. Enter the maximum length of the number in the **Number max length** box.

d. Enter a delimiter to separate the prefix and the number in the **Delimiter** box: a hyphen or an empty space.

e. Select from the **Fill leading space** list whether the leading space in front of the number is filled with zeroes or not, for example, PFX 00001 or PFX 1.

4. Click **OK**.

5. To apply the numbering settings to the points and lines in a group, right-click the group and select **Auto Naming**.

---

**NOTE** You can modify the numbering settings of an individual group if you do not want to use the default settings. Select the group and change the settings. To restore the default settings, click **Reset**.

---

**Create a group in Layout manager**

1. On the **Manage** tab, click **Layout manager**.

2. Right-click **Layout Manager Object Group** and select **Add Group**.

   You may want to set up several groups so that you can organize the points, lines, and arcs into groups as they are modeled. You can have a maximum of 255 groups in **Layout manager**.

3. If needed, click the group to rename it.

   A group name can have 18 characters.

4. Define the numbering settings for the group.

5. Select the **Group local coordinate system**.

   The coordinates are immediately applied when selected.

   If you do not want to use the default base point, you can select some other suitable base point, the model origin, or the current work plane.
When you have selected a coordinate system for the group and added layout points to it, you can view the location coordinates of the points in **Layout manager**. Select the point in **Layout manager** to show the coordinates of the point in **Layout manager**.

- **Location in the model** shows the point location compared to the model origin.
- **Location in the group** shows the point location compared to the group local coordinate system.
- **East, North, Elevation** shows the coordinates that represent the corresponding X, Y and Z coordinates.

**TIP** Set `XS_IMPERIAL` to `TRUE` to display imperial units in **Layout manager**, otherwise metric units are used. You can modify the distance accuracy setting for imperial units in the **Layout manager** settings dialog box when `XS_IMPERIAL` is set to `TRUE`. 
NOTE  Layout manager may show an Unassigned group in the tree structure. The Unassigned group shows layout points and layout lines that have inadequate group information. Such points and lines have usually been created in an earlier Layout manager version.

Create a layout point

Use the Layout Point tool in the Applications & components catalog to create layout points. The layout points that you create in the model are design points that you can export to use in a layout device, such as Trimble® LM80.

Before you start, ensure that the Select components selection switch is activated.

1. In the Applications & components catalog, double-click the Layout Point tool.

2. Define the layout point properties on the Parameters tab:
   a. Enter a name and a description for the layout point.
      You can use the following special characters in layout point names: _ ~ % ! @ # $ & . = + – and space.
      Note that the maximum length of the name is 16 characters if you export layout data to .cnx, .tfl, and .tflx formats. When exporting to a text file (.txt) or a CSV file (.csv), there is no limitation in the number of characters in the name. The maximum length of the description is 24 characters.
      If you do not enter a name, Layout manager adds a number as the name.
   b. Enter the diameter of the layout point in the Size box.
      Layout manager uses the XS_IMPERIAL advanced option to determine the units. Set XS_IMPERIAL to TRUE to show imperial units.
   c. Select whether the layout point is a reference point or not.
      A reference point is a mapping point to another coordinate system, such as a geo-spatial coordinate system or a municipal monument.
   d. Select a color for the layout point.
   e. Select a shape for the layout point.
   f. Select a group from the list or create a new group by entering a name.

For imported points, Is Stakeout Point shows if the point is a measured point as staked in the Trimble® LM80 device if it deviates from the corresponding layout point created in the model. Is Field Point shows if a
point is a field point that has been measured on the construction site and imported to Tekla Structures.

3. Select a location for the layout point in the model. The layout point is created when you select the location.

4. On the Manage tab, click Layout manager.

5. Click Refresh to show the added point.

**TIP** You can also add a layout point to a group in Layout manager. First select a group, then select the point in the model. Right-click the group and select Add Selected. Click Refresh to show the point.

**TIP** To zoom to a layout point in the model, right-click the point in Layout manager and select Zoom selected.

To highlight a layout point in Layout manager, click in Layout manager and select Highlight selected model point. Select Redraw to remove the highlighting.

**See also**
Set up groups in Layout manager (page 293)

### Create a layout line

Use the Layout Line tool in the Applications & components catalog to create layout lines. Layout lines are created between layout points.

Before you start, ensure that the Select components selection switch is activated. Create layout points in your model.

1. In the Applications & components catalog, double-click the Layout Line tool.

2. Define the properties of the layout line:
   a. Enter a name and a description for the layout line. If you do not enter a name, Layout manager adds a number as the name.
   b. Enter the diameter of the layout line in the Size box. Layout manager uses the XS_IMPERIAL advanced option to determine the units. Set XS_IMPERIAL to TRUE to show imperial units.
   c. Select a color for the layout line.
d. Select a group from the list or create a new group by entering a name.

**Is Field Line** shows if a line is a field line that has been measured on the construction site and imported to Tekla Structures.

3. Pick the first layout point.

4. Pick the second layout point.
   The start point and the end point cannot be in the same location.
   The layout line is created.

5. On the **Manage** tab, click **Layout manager**.

6. Click **Refresh** to show the added line.

**TIP** You can also add a layout line to a group in **Layout manager**. First select a group, then select the line in the model. Right-click the group and select **Add Selected**. Click **Refresh** to show the line.

**TIP** To zoom to a layout line in the model, right-click the line in **Layout manager** and select **Zoom selected**.

To highlight a layout line in **Layout manager**, click 🎨 in **Layout manager** and select **Highlight selected model point**. Select **Redraw** to remove the highlighting.

**See also**

- Set up groups in Layout manager (page 293)
- Create a layout point (page 298)

**Create a layout arc**

Use the **Layout arc** tool in the **Applications & components** catalog to create layout arcs. Layout arcs are created between layout points.

Before you start, ensure that the **Select components** selection switch is activated.

1. In the **Applications & components** catalog, double-click the **Layout arc** tool.

2. Define the layout arc properties on the **Parameters** tab:
   a. Enter a name and a description for the layout arc.
      If you do not enter a name, **Layout manager** adds a number as the name.
b. Enter the diameter of the layout arc in the **Size** box.  
   **Layout manager** uses the **XS_IMPERIAL** advanced option to determine the units. Set **XS_IMPERIAL** to **TRUE** to show imperial units.

c. Select a color for the layout arc.

d. Select a group from the list or create a new group by entering a name.

e. In **Is circle**, select how the arc is shown in the model. To show the arc as a complete circle, select **Yes**. This property is exported to and imported from .tflx files.

3. Select the start layout point for the arc in the model.
4. Select the end layout point for the arc in the model.
5. Select a layout point on the arc.
   Tekla Structures creates the arc when you select the point on the arc. The created layout arc is listed in **Layout manager**.

### Export layout data from Layout manager

You can use **Layout manager** to export layout data from your model to a layout device, such as Trimble® LM80.

**Export layout data**

You have two options when exporting:

- Export the layout data from **Layout manager** to a file and move the file later to a layout device.
- Export a file directly to a layout device. You can do this if you connect the layout device to your computer using a USB, or with a Bluetooth connection.

Before you export, you can define the default export settings in **Layout manager** settings 🗯.

1. On the **Manage** tab, click **Layout manager**.
2. Check from the settings 🗯 that the default export settings are as intended.
3. Select the **group (page 293)** that you want to export.
   The points in the group are exported according to the group local coordinate system. The local coordinates of the points are shown in the export dialog box.
4. Click 🍀 and select the appropriate file type for the export.
• **Export point file (.txt)** to export layout points (page 298).

• **Export CSV file (.csv)** to export layout points.

• **Export job file (.cnx)** to export all layout data in the model to Trimble® LM80.

• **Export Field Link file (.tfl)** to export all layout data in the model to Trimble FieldLink.

• **Export Field Link file (.tflx)** to export all layout data in the model to Trimble FieldLink (from version 6.3 onward).

Note that in addition to Trimble devices, other layout devices can also read in the .txt, .csv, and .cnx file types.

**NOTE** The layout points that you create in the model are design points that you can export to use in a layout device.

The maximum length of the layout point name is 16 characters if you export layout data to .cnx, .tfl, and .tflx formats. When exporting to a text file (.txt) or a CSV file (.csv), there is no limitation in the number of characters in the name. The maximum length of the description is 24 characters.

5. Select the destination folder and enter a name for the export file.

6. Select the coordinate system for the export from the **Export local coordinate system** list.

   • If you are exporting one group, the Export local coordinate system list shows the base point of the group. You can change the coordinates by selecting another option from the list.

   • If you are exporting more than one group and the groups do not have the same local coordinate system, the Export local coordinate system list shows the text: **Local coordinate systems of groups**. If you use this option in the export, each group uses the base point that has been defined for it.

   You can also use one base point for all the groups in the export by selecting the coordinate system from the Export local coordinate system list.

7. If needed, select a drawing in **Map file (.dxf)**.

   You can attach a layout drawing when exporting a job file (.cnx) and a Trimble FieldLink file (.tfl). You can use the layout drawing with the layout point data in the layout device. To ensure that the drawing is exported correctly, you need to define the drawing scale.

8. Click **Export** to export.
**Define default export settings**

You can define the default export settings for each export file type: point file (.txt), CSV file (.csv), Trimble LM80 job file (.cnx), and Trimble FieldLink (.tfl, .tflx). The units depend on the settings in File menu \(\rightarrow\) Settings \(\rightarrow\) Options \(\rightarrow\) Units and decimals.

1. On the Manage tab, click Layout manager.
2. Click \(\text{(Network icon)}\) to open the settings.
3. Click Point File to define the export settings for point files (.txt):
   a. Select the unit.
   b. Select the delimiter.
   c. Define the order of column headers in point files. Right-click a header in the list and select Move Up or Move Down.
4. Click CSV File to define the export settings for CSV files (.csv):
   a. Select the unit.
   b. Define the order of column headers in point files. Right-click a header in the list and select Move Up or Move Down.
5. Click Trimble LM80 to define the export settings for Trimble® LM80 job files (.cnx):
   a. Select the Default directory.
   b. Select the default Length unit.
      You can select to export as meters, feet-inches, or survey feet.
   c. Select the plane Angle unit.
      The default angle unit is Degree.
   d. Select the Version of the Trimble® LM80 device.
      The default version is V4. Ensure that the setting matches the version of your layout device.
6. Click Trimble Field Link to define the Trimble FieldLink file default directory (.tfl, .tflx).
7. Click OK.

**Define the drawing scale**

You can include a drawing when exporting all layout data in a job file or a field link file from Layout manager by adding the drawing to the Map file (.dxf) box in the export dialog box. The drawing is exported in the .dxf or .dwg
To ensure that the drawing is exported correctly, you need to define the drawing scale.

1. Create a general arrangement (GA) drawing of your model.
   We recommend that you make the drawing as simple as possible, only include parts and grids to show the drawing correctly in a layout device. You might want to create a drawing layout especially intended to be used in Layout manager export.

2. Open the drawing that you are going to use as a drawing layout.

3. Double-click the drawing view frame to open View Properties.

4. Copy the drawing scale.

5. Close the drawing.

6. On the Manage tab in the model view, click Layout manager.

7. Click Drawing Scale Calculator.

8. Enter the drawing scale in the Scale Denominator (e.g. 48, 128) box.

9. Click Calculate.
   The drawing scale is shown in the Scale box.

10. Copy the drawing scale from the Scale box and close the Drawing Scale Calculator dialog box.

    Tekla Structures opens the Document manager dialog box and the Export drawings as DWG/DXF dialog box.

12. In the Document manager dialog box, select the drawing that you want to export.

13. In the Export drawings as DWG/DXF, do the following:
    a. In File location, select the export folder.
    b. Select the Drawing as snapshot to CAD model space check box.
       The Scale box is shown.
    c. Enter the drawing scale in the Scale box.

14. Click Export.

**Import layout data to Layout manager**
You can use Layout manager to import layout data to your model from a layout device, such as Trimble® LM80, to verify the as-built conditions.
**Import layout data**

You have two options when importing:

- Copy the file that contains the layout data from the layout device to your computer and import the file later to **Layout manager**.
- Import the file directly to **Layout manager**. You can do this if you connect the layout device to your computer using a USB, or with a Bluetooth connection.

1. On the **Manage** tab, click **Layout manager**.
2. In **Layout manager**, click **Import**.
3. Select the appropriate import file option.
   - **Import point file (.txt)** to import layout points (page 298).
     Point files (.txt) are always imported to the **Design Points** tab, regardless of whether they have been measured on the site.
   - **Import CSV file (.csv)** to import layout points.
     CSV files (.csv) are always imported to the **Design Points** tab, regardless of whether they have been measured on the site.
   - **Import job file (.cnx)** to import all layout data in a Trimble® LM80 job file.
     Job files (.cnx) are imported to the **Measured Points** tab.
   - **Import Field Link file (.tfl) or Import Field Link file (.tflx)** to import all layout data in a Trimble FieldLink file. The .tflx files are used for Trimble FieldLink from version 6.3 onwards.
     Design points imported from Trimble FieldLink files (.tflx) are shown in the **Layout manager** dialog box using different colors and symbols, depending on the visual classification type of the point. The imported points are shown in the model by the class color that most closely matches the color of the symbol.

<table>
<thead>
<tr>
<th>Trimble FieldLink color</th>
<th>Tekla Structures color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Control point</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Tolerance status - low</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Tolerance status - in tolerance</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Tolerance status - high</td>
</tr>
<tr>
<td>Trimble FieldLink color</td>
<td>Tekla Structures color</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Design point</td>
</tr>
<tr>
<td></td>
<td></td>
<td>April tag</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Plane level in tolerance</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Plane level high tolerance</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Plane level low tolerance</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Stake in tolerance</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Stake out tolerance</td>
</tr>
</tbody>
</table>

4. Select the file to import.
   When you select a file, a new group that is named with the file name is created. You can have a maximum of 255 groups in **Layout manager**.

5. Select the **group (page 293)** to which the layout data is imported, or click **New** to create a new group.
   Job files (.cnx) and Trimble FieldLink files (.tfl, .tflx) may contain layout point groups. If there are groups in these files, the groups are shown in the list of groups that you can select in the **Group** list.

6. Check the group coordinate system.
   The **Group local coordinate system** shows the group coordinate option that you have selected. You can change the coordinates by selecting another option from the list.
   If you select the group that has the import file name, the default coordinate system for groups defined in **Layout Manager Object Group** is used.

7. Click **Show** to show the contents of the import file.

8. If needed, define the point file columns in the **Text File Import - Column Headers Mapping** dialog box, and save the changes.

9. Click **OK** to close the **Text File Import - Column Headers Mapping** dialog box.
   The points are now shown in the import dialog box.
10. Click **Import**.

   The imported points are created in the model and displayed in the **Layout manager** dialog box in the group that you selected in the import dialog box.

**NOTE**  Design points are layout points that have been created in the Tekla Structures model. Measured points are layout points that have been measured on the construction site.

**Define point file columns**

You can import layout points to your model in a point file that lists the layout point names and the point coordinates. If the point file does not have a header, or if **Layout manager** does not recognize the header, the **Text File Import - Column Headers Mapping** dialog box is displayed when you click **Show** to show the file contents in the import dialog box.

Example of a point file without a header:

```
Layout point 6, 0, 13.12336, , 0
Layout point 5, 0, 6.56168, , 0
Layout point 4, 4.92126, 0, , 0
Layout point 3, 9.84252, 6.56168, , 0
Layout point 2, 4.92126, 13.12336, , 0
Layout point 1, 9.84252, 13.12336, , 0
Layout point, 9.84252, 0, , 0
```

In the **Text File Import - Column Headers Mapping** dialog box, the content of the point file is shown at the bottom and the column headings are shown at the top.

1. Check that the point file content is shown under the correct column headings:
   - **Name Column** shows the layout point name.
   - **X Column** shows the x coordinates.
   - **Y Column** shows the y coordinates.
   - **Z Column** shows the z coordinates.
2. If needed, change the columns at the top of the dialog box by selecting the correct column from the list.

3. Select a measuring unit.

4. Select in the **Process first line** setting whether the first line in the point file is a header row.
   - **Yes** means that the first line has layout point data and that it is not a header line.
   - **No** means that the first line is a header line.

5. Click **OK**.

**Measured points in Layout manager**
Measured points are points that are measured on the construction site using a layout device and imported to Tekla Structures. You can view the properties of
measured points in Layout manager or in the Layout Point tool dialog box. In addition to the general point properties, such as name, diameter, and shape, the measured points have measured point properties that cannot be modified in Tekla Structures.

To view the measured point properties, select the point in Layout manager or double-click the point in the model.

The measured point properties are as follows:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is Stakeout Point</td>
<td>You can label a measured point as staked in the Trimble® LM80 device if it deviates from the corresponding layout point created in the model. The property is shown in the Layout Point tool dialog box.</td>
</tr>
<tr>
<td>Is Field Point</td>
<td>A field point has been measured on the construction site and imported to Tekla Structures. Is Field Line is the corresponding property for layout lines. The property is shown in the Layout Point tool dialog box.</td>
</tr>
<tr>
<td>HR</td>
<td>Height of rod is the height of the prism on the pole. It is used to determine instrument height, and therefore the actual elevation of the measured point.</td>
</tr>
<tr>
<td>HA</td>
<td>Horizontal angle is the angle that was measured from the back sight, or 0 angle.</td>
</tr>
<tr>
<td>VA</td>
<td>Vertical angle is the difference in angle measurement from the horizontal position of the instrument scope.</td>
</tr>
<tr>
<td>SD</td>
<td>Slope distance is the actual distance regardless of elevation change. Horizontal angle is the distance along a horizontal plane.</td>
</tr>
<tr>
<td>PPM</td>
<td>Parts per million is a factor used to determine measurements that take into account the air conditions and how they affect the ability of light to travel through the air. This property is</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Benchmark offset</td>
<td>Benchmark offset is a measurement that defines a benchmark that elevation measurements are calculated from.</td>
</tr>
</tbody>
</table>

**Example: Base point use in Layout manager**

This example shows different model views that contain a layout point, control point, and civil origin in the model. The civil origin is the datum point, or the fundamental benchmark point of the national land survey network.

1. Create a control point in **File --> Project properties --> Base points.**

![Base point dialog box](image)

2. Create a layout point (page 298) by using the **Layout Point** tool, and add the layout point to the model.
The image below shows the point locations in a 3D model view.

- The green point in the bottom-left corner is the civil origin.
  Note that the **East coordinate** and **North coordinate** are not in scale here.

- The blue point is the control point, that is, the base point that you created.

- The red cone is the layout point, in the image framed with a yellow square.

- The green box is the model origin at the grid intersection A-1.

3. In **Layout manager**, add the layout point to a **group (page 293)**. Select the base point that you created, **Control point 1**, to be used as the **Group local coordinate system** of the group.

4. Check the coordinates of the layout point.
   - **Location in the model**: the distance to the model origin.
   - **Location in the group**: the distance to the base point selected for the layout point group.
   - **East, North, Elevation**: the distance to the civil origin.
The images below show different views and measurements of the points in the model.

**Elevation view**

**Plan view**
5. **Export the layout point (page 301).**

The X, Y and Z coordinates in the export dialog box are the **East, North, Elevation** (X, Y, Z) coordinates that you can view in **Layout manager** point properties. These coordinates are exported.
3.12 Analysis and design systems

Analysis and design systems are used to design and analyze the frame or components within a structure. These applications calculate the loading, stresses and strains on the elements. They also calculate the moments, shears and deflections on objects under various loading conditions.

These types of applications make use of various forms of analysis from the traditional first order static, second order p-delta, geometric non-linear or buckling analysis. They can also make use of various forms of dynamic analysis from modal extraction to time history and response spectrum analysis along with the sizing of steel, concrete and timber elements to the relevant national and international design codes.

Some examples of these systems are Tekla Structural Designer, ETABS, STAAD.Pro, SAP2000, Robot, ISM, S-Frame, MIDAS, Dlubal, SCIA, Powerframe, GTStrudl, Strusoft, and AxisVM.

See also
Analysis and design direct links (page 314)
Tekla Structural Designer (page 315)
STAAD.Pro (page 336)
SAP2000 (page 335)
Robot (page 335)
ISM (page 336)
S-Frame (page 337)
FEM (page 338)

Analysis and design direct links

When you have a direct link to an analysis and design application, and you export the analysis model from Tekla Structures using that particular analysis application, the model is opened in the application. Tekla Structures and the analysis and design application need to be installed on the same computer.

The analysis and design direct links are created either using the Tekla Open API or the older COM link (Common Object Model transfer technology). A number of direct links are available including AxisVM, Diamonds, Dlubal, ETABS, GTStrudl, ModeSt, MIDAS, NISA, Powerframe, ISM, Robot, SAP2000, SCIA, S-Frame, STAAD.Pro, STRUDS, and Strusoft.

Many of the direct links are available for downloading in Tekla Warehouse. For the applications that are not available in Tekla Warehouse, the links can be downloaded from the vendor web sites or by contacting the vendor.
**Tekla Structural Designer**

Tekla Structural Designer is a software that allows you to design reinforced concrete buildings and steel buildings. It works with real physical objects such as beams, columns and slabs. The information transferred is the physical information such as geometry, section sizes and grade as well as attributed data. In Tekla Structures, you can import from and export to Tekla Structural Designer.

Tekla Structural Designer is a code-based modeling tool, which enables structural engineers to establish a code compliance design of the structure, and perform calculations and schema design, for example. All the design/code data is held within Tekla Structural Designer at all times.

Tekla Structural Designer will analyze and design structures to a range of International codes of practice.

The initial model can be started in either Tekla Structures or Tekla Structural Designer, depending on the project needs. You can import and export many times, and make use of the effective change management functionality.

The integration process allows you to pass models between Tekla Structural Designer and Tekla Structures, allowing the updates in the model at both ends. As the model is integrated between software applications, the changes are updated, and modifications performed since the last integration operation are maintained within the model.

For the full integration process, including importing reinforcement, you need to have compatible versions of Tekla Structures and Tekla Structural Designer installed on the same computer and access to the original Tekla Structures Designer file (.tsmd). Otherwise Tekla Structural Designer and Tekla Structures accept and produce files in the .cxl neutral file format. The .cxl file format is an XML based neutral file format that allows applications to link Tekla Structural Designer.

Tekla Structures supports files created in Tekla Structural Designer 2016 or later.

This section only contains instructions regarding import (page 317) and re-import (page 320) from Tekla Structural Designer, and export (page 322) to Tekla Structural Designer. For more information about Tekla Structural Designer and the integration between Tekla Structural Designer and Tekla Structures, see Guidance notes for Integration between Tekla Structural Designer and Tekla Structures. This page contains a link to “Integration with Tekla Structures” guide in .pdf format.

Also take a look at other related information in Tekla User Assistance for Tekla Structural Designer:

- Getting started with Tekla Structural Designer
- First steps with Tekla Structural Designer
Example workflow of integration between Tekla Structures and Tekla Structural Designer

Integration between Tekla Structures and Tekla Structural Designer has been developed to ensure that the initial model can be started in either tool without any detriment to the design process. This added flexibility enables companies to align their software solutions closely to their own workflows. (i.e. The initial model can be created in Tekla Structural Designer by the engineer or in Tekla Structures by the technician.)

It is recommended that Tekla Structures model is used as the "master model" for geometrical changes as this model also is linked to the BIM documentation. Alterations made to the model geometry are best handled by altering the Tekla Structures model and transferring the changes through to Tekla Structural Designer for redesign.

A typical workflow and the decision making process through the different stages of a project could be as follows:

**Initial scheme stage**

- The initial model may be started in Tekla Structures or Tekla Structural Designer without any detriment to the process.
- A number of factors may determine which software is used for starting the modeling process, such as availability of staff, or deliverable requirements.
- Unless there are external drivers, Tekla Structures may prove to be the best starting point for the model as it can provide most of the deliverable items at the initial stage.
- The model does not need to cover the complete building, it might be a typical bay or floor, for example.
- The generated structure can be designed in Tekla Structural Designer for initial section sizing at the initial stage and synchronized back to Tekla Structures for initial drawings or material list creation.
- Simple drawings can be created at this stage, this can be done in Tekla Structures or Tekla Structural Designer.
- Initial material lists for cost estimates can be generated at this stage.

**Detailed design stage**

- It is not always appropriate to carry models forward from the Initial scheme stage to the Detailed design stage as changes to the overall scheme may have been made, which will not be reflected in the initial scheme model. It is sometimes better to begin the model again.
• Models can be started in Tekla Structures or Tekla Structural Designer to suit the user. The models can then be transferred to the other modeling system.
• Importantly, the two models can be worked on at the same time, with synchronization of the two models taking place to suit the workflow.
• Tekla Structural Designer can be used for a full gravity and lateral design of the structure.
• Within Tekla Structures, drawings can be generated to a tender stage level and general arrangements submitted to building control for approval.

Construction stage
• Using the model from the Detailed design stage, much of the Construction stage process will take place in Tekla Structures so that the integration with other disciplines can be accounted for.
• The design is not revisited unless the client drives the requirement for change.
• If a re-design of the structure is required, the same synchronization of Tekla Structures or Tekla Structural Designer models can be carried out to suit the user.
• The model will be completed within Tekla Structures and fully detailed drawings for parts can be created along with construction level arrangement drawings of the structure.
• Detail integration checks with other disciplines (e.g. mechanical and electrical engineers) can be carried out at this stage.

Import from Tekla Structural Designer
Import from Tekla Structural Designer creates Tekla Structures parts, such as beams, columns, slabs, and shear walls based on the contents of the imported Tekla Structural Designer file (.tsmd) or neutral file (.cxl). To import rebars, you need to have compatible versions of Tekla Structures and Tekla Structural Designer installed on the same computer and access to the original Tekla Structures Designer file (.tsmd).

1. Open the Tekla Structures model to which you want to import.
2. On the File menu, click Import --> Tekla Structural Designer.
3. In the Tekla Structural Designer Import dialog box, enter the path of the import .cxl file or the original .tsmd file in the Import file box, or click the ... button next to the box to browse for the file.
   Once you have selected a valid file, the import settings and the Import button will be enabled.
4. If updating the positions of objects is not required, select the Only consider profile and material changes check box.
5. Select among the following grid options:
   - **Import grids from import file**: The grid lines from the import file will be imported into the Tekla Structures model. A grid line pattern will be created, and all the imported grid lines will be attached as individual grid planes to this pattern.
   - **Delete existing Tekla Structures grids**: Import will remove all grid lines/planes from the current Tekla Structures model.

6. If you want to remove slab and wall openings in the Tekla Structures model that were previously imported from Tekla Structural Designer, select the **Remove previously imported openings** check box.

7. Open the **Location** section and define to which location you want to import the model. Do one of the following:
   - In the **X**, **Y**, and **Z** boxes, enter offsets for the imported model from the global origin of the Tekla Structures model.
   - Click **Pick** and then pick a location for the import model datum point in the Tekla Structures model.
     You can also define a rotation.

8. In the **Rebars** section, define whether the reinforcing bars are imported, and how they are imported. Note that the **Rebars** section will become available only when you have selected a .tsmd file as the import file.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import rebars</td>
<td>Enable or disable rebar import.</td>
</tr>
<tr>
<td>Delete old rebars</td>
<td>Delete any reinforcement previously imported using Tekla Structural Designer import.</td>
</tr>
<tr>
<td>Create rebars as</td>
<td><strong>Native bars</strong>: Create the rebars as standard Tekla Structures bars.</td>
</tr>
<tr>
<td></td>
<td>Rebar sets are created for loose bars in cast-in-place concrete pad footings, strip footings, beams, columns, and walls. Meshes are not transferred.</td>
</tr>
<tr>
<td></td>
<td><strong>Reference bars</strong>: Create the rebars as a reference model that will be saved in the model folder.</td>
</tr>
<tr>
<td>Creation options</td>
<td><strong>Simplify bars</strong>: The rebars will be imported without any hooks or curtailments, and longitudinal bars in beams will be cut off before they enter the columns at the end points.</td>
</tr>
<tr>
<td></td>
<td><strong>Once per design group</strong>: Rebars in parts belonging to the same design</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>group (for example, beam, column, or pad footing) will be added only to one part in the group.</td>
</tr>
<tr>
<td>Import rebars for</td>
<td>Select the objects for which you want to import rebars: Beams, Columns, Walls, Slabs, or Foundations.</td>
</tr>
</tbody>
</table>

9. To read the import file and display all the proposed profile, material grade, and rebar grade conversions to be used, open the Conversions section and click the preview buttons.

The import uses an internal conversion list containing the standard profiles and grades. If the profile or grade of any object cannot be converted using the internal conversion, the Tekla Structures name will be replaced with the text --- NO MATCH --- in the Conversions tables.

10. If the text --- NO MATCH --- is displayed, you can convert the profiles, materials, and rebar grades manually in the following way:

   a. Create a profile, material, and/or rebar grade conversion file in a text editor using the file name extension .cnv.

      The conversion files can also be used to override the standard conversion.

   b. In the text file, enter the .cxl/.tsmd profile, material, or rebar grade name, for profiles the # symbol and the profile code, then the equal sign (=), and the corresponding Tekla Structures name.

      You may need help from your local Tekla support with this.

      In the rebar grade conversion file, list the size mappings for the grade on the rows underneath the grade name in the same way, indented by a tab.

```plaintext
Gr. 60=A615-60
TsdSize1=TsSize1
#3=#14
#6=#18
TSDgrade=T5Grade
[...]```
c. In the **Profile conversion file, Material conversion file, and/or Rebar conversion file** boxes, specify the conversion files that you want to use for mapping profiles and grades.

The **Rebar conversion file** box is only available if you have a compatible version of Tekla Structural Designer installed and a .tsmd import file selected.

If the conversion files are not used, the members with profiles or materials that cannot be converted will still be created but they will use the import file profile or material, which may be invalid in Tekla Structures. In this case, the members may be drawn as lines in the model, but can then be edited manually in Tekla Structures.

11. Click **Import**.

If you are importing a .tsmd file, Tekla Structural Designer starts and opens the model, so that it can be imported into Tekla Structures.

If none of the objects in the import file have previously been imported into the current model, Tekla Structures imports the contents of the selected import file and creates all the required objects in the Tekla Structures model. If the Tekla Structures model is empty, the project properties from the import file will be written into the model's project properties. If the model contains objects, the .cxl/.tsmd model data will be ignored leaving existing project properties intact.

**NOTE** You can find more information on exporting models and objects from Tekla Structural Designer in the [Tekla Structural Designer product guides](#).

### Limitations

- For the best results, ensure that `XS_ENABLE_POUR_MANAGEMENT` in Advanced options --> Concrete detailing is set to `TRUE`.

- Clashes are not resolved.

- Laps cannot be modeled.

- Mapping of sizes and grades only works for standard settings with UK and USA models.

**See also**

[Re-import from Tekla Structural Designer (page 320)](#)

**Re-import from Tekla Structural Designer**

When you import from Tekla Structural Designer, you can control which changes will be made in the Tekla Structures model. If none of the objects in the import file have been previously imported in Tekla Structures, the import will complete after Tekla Structures has created the required objects. If objects
already exist, then the new objects will be listed as new, but if no objects exist, then the import will just take place.

1. Follow the steps in Import from Tekla Structural Designer (page 317). In addition, do the following in the Tekla Structural Designer Import dialog box:
   a. If updating the positions of objects is not required, select the Only consider profile and material changes check box.
      This will only update the object profiles and materials, and ignore other changes.
   b. Select the Show model comparison tool check box at the bottom of the dialog box.
      This will display the Model Comparison Tool dialog box after you have clicked Import.

2. In Model Comparison Tool, go to an appropriate tab: Added, Updated, Deleted, or Unchanged.

3. To display the properties of an object, select the object from the list on the left.
   If the selected object has been updated or deleted, or has not been changed, the object is also highlighted in the model.

4. To append the Tekla Structures object ID to the object name in the comparison tool list, select the Display part IDs check box.

5. To import objects that do not exist in the Tekla Structures model:
   a. On the Added tab, ensure that the check box after the object name is selected for each object (or object type) that you want to import.
   b. At the bottom of the Model Comparison Tool dialog box, select the Add new objects check box.
      If you clear this check box, the objects that did not previously exist in the Tekla Structures model but that are in the import file are excluded from the import.

6. To update the properties of the previously imported objects, go to the Updated tab and do the following:
   a. Ensure that the check box after the object name is selected for each object (or object type) that you want to update.
   b. To reduce the amount of information displayed about the objects that have been updated, select the Only display changed fields check box.
      Only the values that have been changed are displayed instead of all the object properties.
c. For each object to update, select the object from the list on the left, and then in the list of properties, select the **Apply updates** check box for each object property whose value you want to update.

7. To delete objects that currently exist in the Tekla Structures model but that are not in the import file:
   a. On the **Deleted** tab, ensure that the check box after the object name is selected for each object (or object type) that you want to delete.
   b. At the bottom of the **Model Comparison Tool** dialog box, select the **Delete current objects** check box.
      If you clear this check box, no objects will be deleted.

8. Click **Accept changes** to use the current settings and complete the import.

**Export to Tekla Structural Designer**
Export to Tekla Structural Designer allows you to export the entire Tekla Structures model or a selected subset of the model. The exported .cxl file can be uploaded to Tekla Structural Designer to update the model, or to create a new Tekla Structural Designer model based on the Tekla Structures model.

If you have compatible versions of Tekla Structures and Tekla Structural Designer installed on your computer, also the corresponding Tekla Structural Designer model (.tsmd file) can be created or updated during the export, and it then automatically opens in Tekla Structural Designer.

**NOTE** To export to Tekla Structural Designer using a Tekla Structures analysis model, see Export an analysis model to Tekla Structural Designer.

1. Open the Tekla Structures model from which you want to export.
2. On the **File** menu, click **Export --> Tekla Structural Designer**.
3. In the **Export to Tekla Structural Designer** dialog box, either enter the path of the export file in the **Export file** box or click the **...** button at the end to browse to a folder and enter a name for the file.
   If you have a compatible version of Tekla Structural Designer installed, the .tsmd file type is automatically selected.
   Once you have selected a valid file, the **Export** button and the **Conversions** section will be enabled.
4. In the **Grids** list, specify which of the Tekla Structures grids you want to export: **All**, **Selected**, or **None**.
   With **Selected**, select the grids in the model.
5. In the **Model objects** list, specify which objects you want to export.
To only export certain objects, select **Selected**, and then select the objects in the model.

The use of selection and view filters is recommended to ensure that only the structural part of the model or objects requiring design are exported.

6. To process the model and display all the proposed profile and material grade conversions to be used, open the **Conversions** section and click the preview buttons.

The export uses an internal conversion list containing the standard profiles and grades. If the profile or material of any object cannot be converted using the internal conversion, the export name will be replaced with the text **--- NO MATCH ---** in the **Conversions** tables.

7. If the text **--- NO MATCH ---** is displayed, you can convert the profiles and materials in the following way:
   a. Create a profile and/or material conversion file in a text editor using the file name extension `.cnv`.
      The conversion files can also be used to override the standard conversion.
   b. In the text file, enter the `.cxl/.tsmd` profile or material name, for profiles the # symbol and the profile code, then the equal sign (=), and the corresponding Tekla Structures name.
      You may need help from your local Tekla support with this.
   c. In the **Export to Tekla Structural Designer** dialog box, in the **Profile conversion file** and **Material conversion file** boxes, specify the conversion files that you want to use for mapping profiles and material grades.
      If the conversion files are not used, the objects with profiles or materials that cannot be converted will still be created but they will use the export file profile or material that may be invalid.

8. Click **Export**.

The **Process log** section will show you the result of the export.

A `.cxl` file is created in the folder you specified using the file name you specified. Also with the `.tsmd` export file type, a `.cxl` file is created first and a timestamp is added after the file name.

9. If you have a compatible version of Tekla Structural Designer installed and `.tsmd` selected as the export file type, Tekla Structural Designer starts and the **BIM Integration : Structural BIM Import** wizard appears. Do the following:
   a. Review and modify the settings in the wizard as needed, and then click **Next** in each step.
For example, you can set the building code, and select whether this is a first-time transfer from Tekla Structures to Tekla Structural Designer, or an update to an existing model.

For more information about the options, see 'Import a project from a Structural BIM Import file' in the Tekla Structural Designer product guides.

b. When you are happy with the settings, click **Finish** in the final step of the wizard.

A Tekla Structural Designer model file (.tsmd) is created in the folder you specified using the file name you specified.

Next you can start working with the model in Tekla Structural Designer.

To import a .cxl file to Tekla Structural Designer on another computer, for example, see 'Import a project from a Structural BIM Import file' in the Tekla Structural Designer product guides.

**Tekla Tedds Integrator**

Tekla Tedds Integrator allows you to link Tekla Tedds calculation documents to your Tekla Structures model. You can link existing documents or create new documents, which you or other Tekla Structures users can then easily modify or review during the BIM workflow. The integration reduces the amount of manual work that the detailer or engineer has to undertake in Tekla Structures.

**NOTE** The Tekla Tedds Integrator ribbon tab is shown only if it has been set visible in your environment or role by your administrator. For more information, see Administrator's release notes: Integrated link to Tekla Tedds for simple connections.

For example, using Tekla Tedds Integrator you can check that a simple steel connection in a Tekla Structures model is compliant with Eurocode design. You can quickly modify the design using the Tekla Tedds calculations until all the code-compliant design checks are satisfied. Then you can return the modified design to the Tekla Structures model and automatically update the geometry and configuration of the steel connection to reflect the modified design.

When using Eurocode design, Tekla Tedds Integrator includes built-in automatic data transfer for simple steel connections, structural concrete, and precast concrete elements. For other structural design codes, you can manually select the calculation to use, in which case no data is transferred. You can also add your own integration links, see the Tekla Tedds Integrator Reference Guide for details on how this can be achieved.
Tekla Tedds Integrator supports different levels of design integration. The linking method that is used depends on the structural element selected in the Tekla Structures model.

- **Data linking**: If the integrator is able to identify the structural element you selected in the Tekla Structures model, the appropriate Tekla Tedds calculation will be automatically selected and any appropriate design information available from the model object, such as geometry and material, will be automatically transferred to the Tekla Tedds calculation. When the design is completed, the Tekla Structures model object will be updated as appropriate and the documentation will be linked to the model object. For a list of Tekla Structures object types supporting the data linking method, see the Tekla Tedds Integrator User’s Guide.

- **Document linking**: If the integrator is unable to identify the structural element you selected in the Tekla Structures model, you will be asked to choose which Tekla Tedds calculation to use to create your design documentation. When the design is completed, the documentation will then be linked to the model object.

**Tekla Tedds ribbon tab in Tekla Structures**

The Tekla Tedds ribbon tab in Tekla Structures provides commands for integrating Tekla Structures model objects and Tekla Tedds calculations:

<table>
<thead>
<tr>
<th>TEKLA TEDDS</th>
<th>FORMWORK</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tedds</td>
<td>New</td>
</tr>
<tr>
<td>Add</td>
<td>Update</td>
</tr>
<tr>
<td>Update</td>
<td>Update model</td>
</tr>
<tr>
<td>Open</td>
<td>Remove</td>
</tr>
<tr>
<td>Project</td>
<td>Tools</td>
</tr>
</tbody>
</table>

**Tekla Tedds application**

Tekla Tedds is an easy to use application that engineers can rely on for accurate calculations. With Tekla Tedds, engineers can streamline engineering design, avoid errors, and present output professionally. Tekla Tedds includes a built-in library of structural engineering calculations, which can be used to produce high quality calculation documentation for a wide variety of structural building elements. The calculations are compliant with a range of regional design codes. For more information about Tekla Tedds, see Tekla User Assistance for Tekla Tedds.

To use Tekla Tedds Integrator, you need to have the Tekla Tedds application installed on your computer. You do not need to start the Tekla Tedds application to use the integrator commands, the commands will launch Tekla Tedds automatically when it is needed. For more information about the Tekla Tedds installation, see Tekla Tedds installation and licensing workflow.

Tekla Tedds needs to be purchased separately, it is not included in the Tekla Structures license.

To launch the Tekla Tedds application to do some manual work with Tekla Tedds:
Create a new document for a model object

You can create a new Tekla Tedds calculation document for the selected Tekla Structures object.

1. Select an object in the Tekla Structures model.
2. On the Tekla Tedds ribbon tab, click New.

Depending on the selected structural element, either the data linking method or the document linking method is used:

Data linking method

If the structural identity of the object can be determined, the data linking method will be used, and the appropriate calculation will start automatically. Geometric information related to the section shape, governing dimensions, member length and material will be automatically populated.

Some information is not transferred from Tekla Structures to the Tekla Tedds calculation, such as loads and bending moments (where applicable), slenderness information, or the national annex to be used. Where values are not transferred from Tekla Structures, the default values applicable for the Tekla Tedds calculation will be populated.
To complete the design once the Tekla Tedds calculation has been completed, click the Finish button. This creates a new Tekla Tedds calculation document (.ted) and links it to the selected model object.

In the displayed dialog, save the documented results of the calculation. We recommend that you save the document in a subfolder under the Tekla Structures model folder, which will ensure that the documents are transferred with the model, for example, when using Tekla Model Sharing.

**Document linking method**

If the integrator is unable to identify the structural element, the document linking method will be used, and you will be asked to choose which calculation to use.

In the Select calculation dialog box, select the required calculation and click the Calculate button.
The calculation dialog box is displayed.

For document linking, no information is transferred from Tekla Structures to Tekla Tedds. Instead of information transfer, the default values applicable for the Tekla Tedds calculation will be populated.
b. Once the Tekla Tedds design calculation has been completed, click the **Finish** button to complete the design.

This creates a new Tekla Tedds calculation document (\*.ted) and links it to the selected model object.

c. In the displayed dialog, save the documented results of the calculation.

We recommend that you save the document in a subfolder under the Tekla Structures model folder, which will ensure that the documents are transferred with the model, for example, when using Tekla Model Sharing.

**Link an existing document to a model object**

You can link an existing Tekla Tedds document (\*.ted) to the selected model object.

1. Select an object in the Tekla Structures model.

2. On the **Tekla Tedds** ribbon tab, click **Add**.

3. In the **Select Tedds document** dialog box, browse for and select a previously saved Tekla Tedds document (\*.ted).

The selected Tekla Tedds document is linked to the model object that you selected.

**Update document and model**

You can update the Tekla Tedds calculation document linked to the selected model object with the current data from the Tekla Structures model, recalculate the document, and update the model from the completed Tekla Tedds design.

1. Select an object in the Tekla Structures model.

2. On the **Tekla Tedds** ribbon tab, click **Update**. The calculation is started. The current data from the Tekla Structures model will be transferred to the existing Tekla Tedds design and the calculations will be shown so that any other data can be modified before completing the design.

3. In the calculation dialog box, click **Finish**.

The Tekla Tedds document linked to the selected model object is updated with the current data from the Tekla Structures model and the document is recalculated. The document will be saved, and finally, the completed Tekla Tedds design data will be transferred back to the Tekla Structures model to update the model object.
**Update document**

You can update the Tekla Tedds calculation document linked to the selected model object with the current data from the Tekla Structures model and recalculate the document.

1. Select an object in the Tekla Structures model.

2. On the **Tekla Tedds** ribbon tab, click **Update document**. The calculation is started. The current data from the Tekla Structures model will be transferred to the existing Tekla Tedds design and the calculations will be shown so that any other data can be modified before completing the design.

3. In the calculation dialog box, click **Finish**.

The Tekla Tedds document linked to the selected model object is updated with the current data from the Tekla Structures model and the document is recalculated and saved. No data will be transferred back to the Tekla Structures model object.

**Update model**

You can recalculate the Tekla Tedds calculation document linked to the selected model object using the existing design data and update the Tekla Structures model from the completed Tekla Tedds design.

1. Select an object in the Tekla Structures model.

2. On the **Tekla Tedds** ribbon tab, click **Update model**. The calculation is started. The calculations will be shown so that any other data can be modified before completing the design.

3. In the calculation dialog box, click **Finish**.

The Tekla Tedds document linked to the selected model object is recalculated using the existing design data. The document will be saved, and finally, the Tekla Tedds design data will be transferred back to the Tekla Structures model to update the model object.

**View and modify document**

You can view and modify the Tekla Tedds calculation document linked to the selected Tekla Structures model object.

1. Select an object in the Tekla Structures model.

2. On the **Tekla Tedds** ribbon tab, click **Open**. The Tekla Tedds document will be opened and you can modify the data.
3. To save the changes in the document, click \(\text{Save}\).

**Create a new project for calculations linked to current model**

You can create a new project in the Tekla Tedds application and transfer all Tekla Tedds calculation documents linked to the model to the created project.

1. On the **Tekla Tedds** ribbon tab, click \(\text{Project}\). The Tekla Tedds application will be opened and you can see the new project there. The new project contains all of the Tekla Tedds calculations associated with the currently open Tekla Structures model. You can use the commands within Tekla Tedds to modify various aspects of the project. You can change the documentation order and modify the calculation headers, for example.

2. To save the changes to the project, click **Save project**. The saved project data will be available in the future sessions of the Tekla Tedds application.

**Remove a document**

You can remove the Tekla Tedds calculation document linked to the selected Tekla Structures object.

1. Select an object in the Tekla Structures model.

2. On the **Tekla Tedds** ribbon tab, click \(\text{Remove}\).

   The association between the Tekla Structures object and the saved Tekla Tedds document is removed. The document is still retained in the saved location so that it may be added again if required using the **Add** command.

   If you remove the document, the **Tedds document** UDA in the model object properties will be set to **No**.

**View model object properties**

You can view the properties of the selected model object in a separate dialog box. This is particularly useful when you are writing your own integrations.

1. Select an object in the Tekla Structures model.

2. On the **Tekla Tedds** ribbon tab, click **Tools \(\rightarrow\) Object browser**.
The object properties are displayed in **Object browser**.

![Object Browser](image)

3. To update the list, click **Refresh**
4. You can limit the number of properties by selecting the desired object property sources.

**View and modify Tekla Tedds integrator settings**
You can view and modify Tekla Tedds Integrator settings.
1. On the **Tekla Tedds** ribbon tab, click **Tools --> Options**.
2. Modify the settings if required.
Enable logging: A record of actions taken by Tekla Tedds Integrator will be recorded to the log file. The log file will be created in C:\Users \<username>\AppData\Local\Trimble\Tekla Structures \<version>\TeklaTeddsIntegrator.

Delete log file on close (requires restart): Delete the log file when you close the integrator.

Timestamp log entries: Add a time stamp at the start of each line in the log to indicate when it was recorded.

Display log when mapping errors are encountered: When errors are encountered during property mappings, the log file will be shown automatically.

Open log folder: Open the folder storing the log data.

Reload all data files before performing each integration: Every time you use a command that uses the information in the IdentityProviders, DataProviders and TypeConverters folders, the data files will be reloaded. Enable this setting when modifying data files so that your changes will be reflected the next time you use a command in Tekla Tedds Integrator.

Open system provider files folder, Open user provider files folder: Open the system data or user data folder. Each part of the system is configured using data files that are stored in one of two locations, the system data location, which contains the files for the calculations already supported by the integrator, and the user data location, where you can save your own integrations. Each location has a hierarchy of folders for
storing the various data files used to configure the different parts of the system. Within each folder files can be stored at either the root level for the default configuration or within subfolders for either design code specific data or Tekla Structures specific data.

Default system data location: ..\Tekla Structures\<version>\Environments\common\system\Analysis

Default user data location: C:\Users\<username>\AppData\Local\Trimble\Tekla Structures\<version>\TeklaTeddsIntegrator.

3. To save your changes and close the dialog box, click Close. The changed settings are saved in the TeklaIntegrator.dll.config configuration file in the C:\Users\<username>\AppData\Local\Trimble\Tekla Structures\<version>\TeklaTeddsIntegrator folder.

**Tekla Tedds user-defined attributes**

Once a Tekla Tedds calculation document has been linked to an object in the Tekla Structures model, the object will get two user-defined attributes.
**Tedds document:** This attribute indicates whether a Tekla Tedds document is associated with an object or not. The name of the user-defined attribute is TEDDS_DOCUMENT, and the value is either **Yes** or **No**.

**Tedds identity:** This Tekla Tedds Integrator attribute is only populated when you use the **New** or **Update** commands for an object which is supported by data linking. The attribute identifies which Tekla Tedds calculation should be used by the integrator. The name of the user-defined attribute is TEDDS_IDENTITY, and the value is a structural identity name as defined by Tekla Tedds Integrator identity provider feature.

**Robot**

The Robot Millennium A&D application is owned by Autodesk Inc. Full product details can be found on the Robot Millennium web site.

- This application is suitable for basic interoperability, and it can export and import cis/2 files.

- If you install Tekla Structures and Robot Millennium on the same computer, then a direct link can be used.

- Currently only the EC3, LRFD, CM66, E32 and ANS design codes are available in Robot when using the direct link.

- If you are upgrading to Robot 2012, you will need to uninstall Robot 2011 along with the Autodesk Robot Structural Analysis link. Then install Robot 2012 and the link again. This way you make Tekla Structures point to the Robot 2012 application.

  To get more information and to download, go to [Tekla Warehouse](http://www.tekla.com)

**See also**

[Linking Tekla Structures with Robot](http://www.tekla.com)

[Analysis and design direct links (page 314)](http://www.tekla.com)

**SAP2000**

The SAP2000 analysis & design application is written by Computers & Structures, Inc. Full product details can be found on their website.

- The SAP2000 analysis & design application can export and import cis/2 and ifc files, and export SDNF files.

- If Tekla Structures and SAP2000 are installed on the same computer, then a direct link can be used.

- It is important that you run SAP2000 for the first time as a standalone application before you load the link. Just start SAP2000 and create a new
model, save it and close SAP2000. This will then update your registry which
is needed by the link.

To get more information and to download, go to Tekla Warehouse.

See also
Linking Tekla Structures with SAP2000
Analysis and design direct links (page 314)

STAAD.Pro
The STAAD.Pro analysis and design application is owned by Bentley Systems,
Incorporated. Full product details can be found on their website.

• STAAD.Pro can export and import CIS/2 files, along with their .std format.
  It has become a semi-industrial standard especially in the plant and heavy
  engineering segments.

• If Tekla Structures and STAAD.Pro are installed on the same computer, then
  a direct link can be used.

• Profile mapping for different installation environments is achieved by
  mapping the profiles used by Tekla Structures and Bentley in files called
  ProfileExportMapping.cnv and ProfileImportMapping.cnv located
  in the TeklaStructures\TS_STAAD folder. Currently these files are only
  used in import.

To get more information and to download, go to Tekla Warehouse.

See also
Linking Tekla Structures with STAAD.Pro
Analysis and design direct links (page 314)

ISM
Bentley's Integrated Structural Modeling (ISM) is a technology for sharing
structural engineering project information among structural modeling,
analysis, design, drafting and detailing applications.

ISM is similar to Building Information Modeling (BIM), but focuses on the
information that is important in the design, construction and modification of
the load bearing components of buildings, bridges and other structures. Full
product details can be found on their website.

The ISM link is different form the other analysis and design links in that the
physical model is also transferred at the same time as the analysis and design
model and the ISM model can be imported into an empty Tekla Structures
model. The round-trip of model information is also controlled by a synchronizer.

If Tekla Structures and an ISM enabled Analysis & Design application or Bentley Viewer v8i are installed on the same computer then a direct link can be used.

In order to use the link, the ISM Structural Synchronizer version 3.0 needs to be loaded before the link.

For more information and to download, go to Tekla Warehouse.

See also
Analysis and design direct links (page 314)

S-Frame

S-Frame Analysis is owned and developed by S-FRAME Software Inc. It is a complete 4D structural modeling, analysis and design solution for steel, concrete, linear and non-linear structural models.

- The Tekla API link allows you to write code to connect to an open model in Tekla and query or manipulate the model. The link was established by using both the S-Frame and Tekla APIs. It uses a library database to manage items between Tekla Structures and S-Frame.

- S-Frame can export and import .dxf files. If Tekla Structures and S-Frame are installed on the same computer, then a direct link can be used. A copy of the link and instructions on using the link can be requested from https://s-frame.com. Descriptions regarding the link can be found here: Building information modeling (BIM) links.

- In some areas S-Frame used to be distributed by CSC, in which case the installation points to different folders. The model name must not include spaces as this currently is an issue as the analysis and design frame is not created if spaces are included.

The whole process involves the following steps: importing to S-Frame, displaying imported items, and exporting from S-Frame. This process is described below.

Importing objects to S-Frame and displaying the objects

1. The S-Frame software checks to see if there is an open model in Tekla Structures using the Tekla API.

2. If a connection can be established, the Tekla Structures model is queried for a list of model objects, such as modeled members or panels.

3. The returned objects are iterated through, recognized types are processed, and equivalent S-Frame objects are added or updated to a library database.
4. The IDs from Tekla Structures are stored so that items can be mapped back and forth between Tekla Structures and S-Frame.

5. Once the objects have been iterated through, the library database is queried, and the updated or created objects referenced in the library are displayed in S-Frame display window.

**Exporting from S-Frame**

1. The S-Frame is queried for objects that are displayed in the S-Frame display window.

2. The library is iterated through for types of known objects (members and panels) that can be mapped back and forth between Tekla Structures and S-Frame.

3. Using the unique IDs stored in the import, the Tekla Structures model is queried to see if items exist. If they do not, they will need to be created, and the library will be updated.

4. Items can then be added or updated to Tekla Structures to match what is in S-Frame.

**FEM**

Tekla Structures FEM import and export tool support several formats and provide several options for importing and exporting models.

FEM (Finite Element Method) is an analysis and calculation method used in structural engineering. In this element method, the target is divided into appropriate finite elements interconnected at points called nodes.

You can import the following formats into Tekla Structures using the FEM import tool.

<table>
<thead>
<tr>
<th>Option</th>
<th>Software</th>
</tr>
</thead>
<tbody>
<tr>
<td>DSTV</td>
<td>DSTV format data (Deutsche Stahlbau-Verband). Several different systems, for example, RSTAB static software and Masterseries Analysis &amp; Design system. DSTV manufacturing format is the standard format used for manufacturing steel components on numerically controlled (NC) machines. It also has an Analysis &amp; Design format that is used for transferring Analysis &amp; Design models to the physical 3D model. Different programs produce different DSTV files. For example, the DSTV file produced by RSTAB static software only contains a static model. Tekla Structures exports either the static model (CROSS_SECTION), or the CAD model (MEMBER_LOCATION).</td>
</tr>
<tr>
<td>SACS</td>
<td>SACS modeling and analysis software</td>
</tr>
<tr>
<td>Option</td>
<td>Software</td>
</tr>
<tr>
<td>---------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>S-Frame</td>
<td>Analysis software, for example, FASTSOLVE</td>
</tr>
<tr>
<td>Monorail</td>
<td>Monorail system</td>
</tr>
<tr>
<td>STAAD</td>
<td>STAAD format data (Structural Analysis And Design). STAAD modeling and analysis system. FEM import is an old way to import STAAD data. We recommend that you use a direct link to ISM or STAAD.Pro, which are available in Tekla Warehouse. If Tekla Structures and STAAD.Pro or ISM are loaded onto the same machine then direct links can be used. To make a STAAD input file compatible with the Tekla Structures STAAD import, use the option <strong>Joint coordinate format (Single)</strong> to save the input file in STAAD. This creates a line for each coordinate in the input file.</td>
</tr>
<tr>
<td>Stan 3d</td>
<td>Stan 3d analysis software</td>
</tr>
<tr>
<td>Bus</td>
<td>BUS 2.5 analysis software</td>
</tr>
</tbody>
</table>

**Import FEM**

1. On the **File** menu, click **Import --&gt; FEM**.
2. In the **New Import Model** dialog box, select **Import FEM**.
3. Select **import model (default)** from the list or enter a new name.
4. Click **OK**.
5. Click **Properties...** to open a dialog box where you can define the settings for the import file:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Conversion</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Profile conversion file</strong></td>
<td>Define the conversion files you want to use. The maximum conversion file path length is 255 characters. Conversion files map Tekla Structures profile and material names with names used in other software. For more information about conversion files, see .</td>
</tr>
<tr>
<td><strong>Material conversion file</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Twin profile conversion file</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Parts</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Part Pos_No</strong></td>
<td>Enter a prefix and a start position number.</td>
</tr>
<tr>
<td><strong>Assembly Pos_No</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Parameters</strong></td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Input file</strong></td>
<td>The name of the file you want to import. You can also browse for the file. The maximum folder path length is 255 characters.</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>Select the input file type: DSTV, SACS, Monorail, Staad, Stan 3d, Bus</td>
</tr>
<tr>
<td><strong>Origin X, Origin Y, Origin Z</strong></td>
<td>Define the origin coordinates to place the file in a specific location.</td>
</tr>
<tr>
<td><strong>Default yield stress limit</strong></td>
<td>The <em>Default material when yield stress &lt; limit</em> setting is used for SACS import file. Define the material to use if yield stress is less than the limit.</td>
</tr>
<tr>
<td><strong>Default material when yield stress &gt;= limit</strong></td>
<td>The setting <em>Default material when yield stress &gt;= limit</em> is used for SACS or DSTV import files. For SACS, this field defines the material to use if yield stress is greater than or equal to the limit. For DSTV you can enter the material grade here, if it is not included in the import file.</td>
</tr>
<tr>
<td><strong>Combine members</strong></td>
<td>To combine several elements in the FEM model into one part in Tekla Structures, set <strong>Combine members</strong> to <strong>Yes</strong>.</td>
</tr>
<tr>
<td><strong>Max length for combining</strong></td>
<td>For example, if a beam in a file consist of more than one element, and you select <strong>Yes</strong>, the elements are combined to form one beam in the Tekla Structures model.</td>
</tr>
<tr>
<td></td>
<td>If you use the value <strong>No</strong>, Tekla Structures creates a beam for each element in the FEM model.</td>
</tr>
<tr>
<td></td>
<td><strong>Max length for combining</strong> is only applied if you set <strong>Combine members</strong> to <strong>Yes</strong>. Use this setting to define the maximum length for combining parts. Tekla Structures combines elements into one part only if their combined length is less than the value you enter here.</td>
</tr>
<tr>
<td><strong>Staad tab</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Material</strong></td>
<td>Select the material grade.</td>
</tr>
<tr>
<td><strong>Report tab</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Create report</strong></td>
<td>Set to <strong>Yes</strong> to create a report.</td>
</tr>
<tr>
<td><strong>Display report</strong></td>
<td>Set to <strong>Yes</strong> to display the report.</td>
</tr>
<tr>
<td><strong>Report template</strong></td>
<td>Select the report template. You can also browse for the template.</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Report file name</strong></td>
<td>Enter the report file name or browse for a report file. If you do not give the report any other name, the report is saved with the name <code>import_revision_report.rpt</code> in the model folder.</td>
</tr>
<tr>
<td><strong>DSTV tab</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Version</strong></td>
<td>Select the DSTV version.</td>
</tr>
<tr>
<td><strong>Import static elements</strong></td>
<td>If the DSTV file to be imported contains a static and a CAD model, you can choose which one to import. Answering <strong>Yes</strong> to <strong>Import static elements</strong> imports the static model. Answering <strong>Yes</strong> to <strong>Import other elements</strong> imports the CAD model.</td>
</tr>
<tr>
<td><strong>Import other elements</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Stan 3d tab</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Scale</strong></td>
<td>Specify the scale of the import model. You can import Stan 3d without specifying the scale as long as both the Tekla Structures model and the import model are in millimeters. If the Stan 3d file is in millimeters, use the scale 1. If the Stan 3d file is in meters, use the scale 1000.</td>
</tr>
<tr>
<td><strong>Material</strong></td>
<td>Enter the material for the parts to import.</td>
</tr>
<tr>
<td><strong>Bus tab</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Pos_No</strong></td>
<td>Indicate the <strong>Pos_No</strong> of the girders, columns, braces and cantilevers you import.</td>
</tr>
<tr>
<td><strong>Material</strong></td>
<td>Enter the material for the parts to import.</td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td>Enter the name of the parts to import.</td>
</tr>
<tr>
<td><strong>Class</strong></td>
<td>Enter the class of the parts to import.</td>
</tr>
<tr>
<td><strong>Beams behind plane</strong></td>
<td>The value <strong>Yes</strong> aligns the tops of all beams at the floor level.</td>
</tr>
<tr>
<td><strong>Advanced tab</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Action when objects status is (compared to)</strong></td>
<td><strong>Previous plan</strong> lists the objects in your model, compared with the objects in the file to be imported. They can be <strong>New</strong>, <strong>Modified</strong>, <strong>Deleted</strong>, or <strong>Same</strong>. Tekla Structures compares the state of imported objects with those in your model. They can be <strong>Not in model</strong>, <strong>Different</strong>, or <strong>Same</strong>. Use the options under <strong>Not in model</strong>, <strong>Different</strong>, and <strong>Same</strong> to specify the actions when importing</td>
</tr>
</tbody>
</table>

Import to and export from Tekla Structures 341 Analysis and design systems
6. Click OK to go to the **Import Models** dialog box.
7. Select the model to import.
8. Click **Import**.
   Tekla Structures displays the **Import model info** dialog box.
9. Select which version of parts to import.
10. Click **Accept all**.
    If you have changed the model and want to re-import it, you can also reject all changes by clicking **Reject all**, or accept or reject individual changes by clicking **Select individual...**
11. Tekla Structures displays the message **Do you want to save the import model for subsequent imports?** Click **Yes**.
    Tekla Structures displays the import model in a model view.
12. Right-click the model view and select **Fit work area to entire model** to ensure that the imported model is completely visible.
13. If parts are missing, check the **Depth up** and **Depth down** values in the **View Properties** dialog box and change them if necessary.

**Export FEM**
1. Open a Tekla Structures model.
2. On the **File** menu, click **Export --> FEM**.
   The **Export FEM** dialog box opens.
3. Go to the **Conversion** tab and enter the names of the conversion files, or browse for the files.
4. Go to the **Parameters** tab, and enter the name of the output file, or browse for the file.
5. Select the output file type: DSTV, **MicroSAS** or Staad.
6. Set **Split members** to **Yes** to split a part in the Tekla Structures model into several elements in the exported model.
7. If you are exporting to MicroSAS, set **Combine segmented members (MicroSAS)** to **Yes** to combine multiple parts to form one part in the exported model.
   For example, if you have divided a beam into several elements and select the Yes option, Tekla Structures combines the elements so that they form
one beam in the exported model. With the option No every element of the beam in the model forms individual beams.

8. If you are exporting to Staad, go to the Staad tab:
   • Select an option from **Profile table** list.
   • Use the setting **Parametric shapes when possible** to define how Tekla Structures exports the profiles PL, P, D, PD, SPD to Staad. **Yes** exports the profiles as parametric shapes so that STAAD can identify them correctly. **No** exports all profiles as standard STAAD shapes.

Example of a plate PL10*200 when exported as parametric shape (**Yes**):

13 PRI YD 200.000000 ZD 10.000000.

Example of the same plate exported as a standard shape (**No**):

13 TABLE ST PL10*200

9. If you are exporting to DSTV, go to the DSTV tab:
   • Select the DSTV version from the version list.
   • In **Element reference with**, select whether you want to export into a static model (**CROSS_SECTION**), or into a CAD model (**MEMBER_LOCATION**).

10. Select the parts in the model to export.
11. Click **Apply** and **Create**.

Tekla Structures creates the export file in the current model folder.

**Supported DSTV entities**

The DSTV entities are listed below. Tekla Structures supports those marked with an asterisk (*). See the DSTV standard “Stahlbau - Teil 1. März 2000” for more information.

**Static data:**
vertex (*)
polyline
substructure (*)
node (*)
element (*)
element_eccentricity (*)
raster
boundary_condition
elastic_support
nodal_reaction
element_reaction

**General data:**
material (*)
cross_section (*)

**CAD data:**
member (*)
member_location (*)
construction-data
cutout
hole

**STAAD table type specifications**
Tekla Structures supports the following STAAD table type specifications:

- ST (single section from the standard built-in tables)
- ST PIPE (parametric)
- ST TUBE (parametric)
- RA (single angle with reverse Y_Z axes)
- D (double channel)
- LD (long leg, double angle)
- SD (short leg, double angle)
- TC (beams with top cover plates)
- BC (beams with bottom cover plates)
- TB (beams with top and bottom cover plates)

You can import the types CM and T, user-provided steel table types (UPT), and other non-standard profiles, if you have defined them in the profile conversion file. You must use the underscore character in the STAAD name, for example, UPT_1_W10X49. Tekla Structures automatically converts twin profiles in this import routine.

### 3.13 Steel fabrication

Fabrication applies to the building of structures by cutting, shaping and assembling components made from steel. Steel fabrication shops generally
concentrate on the preparation, welding and assembly aspect with a much greater use of the multi functioning machines.

Fabrication (cutting and drilling features) of structural steel elements has always been performed using manually operated techniques, and these remain today as fabrication methods. The emergence of CNC (computer numerical control) technology brought automation and greater accuracy to these techniques, resulting in families of special purpose machines dedicated to performing individual fabrication tasks.

The following tools are included for steel fabrication purposes in Tekla Structures installation:

**NC/DSTV (page 345)**
**MIS (page 384)**
**CIS/2 (page 385)**
**ASCII (page 386)**
**PDMS/E3D (page 386)**

There are also some steel tools that you can download from Tekla Warehouse, for example:

**STP/STEP files export for CNC cutting**

---

**NC files**

Tekla Structures produces NC files in DSTV format. You can select the information to be included in NC files and NC file headers, and define the desired pop-mark and contour mark settings. You can also produce MIS (Manufacturing Information System) list files according to the DSTV standard.

**NC** (Numerical Control) refers to a method where machine tool operations are controlled with a computer. The NC data controls the motion of **CNC** (computer numerical control) machine tools. During the manufacturing process a machine tool or machining center drills, cuts, punches or shapes the piece of material.

After you have finished detailing a Tekla Structures model, you can export the NC data as NC files from Tekla Structures to be used by CNC machine tools. Tekla Structures transforms the part length, hole positions, bevels, notches, and cuts into sets of coordinates that the machine tools can use to create the part in a shop. In addition to the CNC machine tools, the NC files can also be used by MIS and ERP software solutions.

The data for the NC files comes from the Tekla Structures model. We recommend that you complete detailing and create drawings before producing the NC files.

Tekla Structures produces NC files in **DSTV** format (Deutscher Stahlbau-Verband) in the current model folder. In most cases each part has its own NC
file. You can also produce NC files in DXF format by converting DSTV files to DXF files.

DSTV is a standard interface for geometrical description of steel structure pieces for the post-processors with numerical control. The essential aim of this interface is to be neutral, which means that with only one standard description you can manage several different NC machines. The interface standardizes the link between a CAD-program or a graphical system via a CAM file for the NC machines. The geometry of the piece is introduced completely neutrally, and after knowing the parameters of the NC machine, the post-processor is able to translate this neutral language to the NC machine language. For more information, visit https://dstv.deutscherstahlbau.de/.

Notes and limitations:

• Duplicate bolts on a part (bolts in the same location as another bolt) are by default ignored in DSTV NC export. The tolerated distance for bolts to be considered duplicates can be adjusted with the XS_BOLT_DUPLICATE_TOLERANCE advanced option.

• The DSTV standard does not support curved beams, and therefore Tekla Structures does not create NC files for curved beams. Use polybeams instead of curved beams.

• Contour mark and pop-mark settings should be fixed before numbering and drawing creation, because both affect numbering. For more information, see the following support article: "How scribing affects DSTV and drawing workflow".

Create NC files in DSTV format

DSTV format is an industrial standard defined by the German Steel Construction Association (Deutsche Stahlbau-Verband). A DSTV file is a text file in ASCII format. In most cases each part has its own DSTV file.

1. On the File menu, click Export --> NC files.

2. If you have some predefined settings that you want to use, select the settings from the settings file list at the top and click Load.

3. In the NC files dialog box, select the check box in the Create column next to DSTV for plates and/or DSTV for profiles.

4. To modify the NC file settings, select an NC file settings row, and click Edit...

   In the NC file settings dialog box, modify the settings on the Files and part selection, Holes and cuts, Hard stamp and Advanced options tabs. Click OK to save your NC file settings and to close the NC file settings dialog box.

   Hard stamps can be created for both the main part and the secondary parts. By default, Tekla Structures creates hard stamps only for the main
part. Set the advanced option XS_SECONDARY_PART_HARDSTAMP to **TRUE** to also create hard stamps for secondary parts.

You can select to create only DSTV files, MIS files, both, or DSTV files embedded in MIS files.

If you want to add new NC file settings, click **Add...** This will add a new row in the **NC file settings** list, and the **NC file settings** dialog box is displayed, where you can give the settings a new name.

You can enter a unique name for the settings using **Save as**. Tekla Structures saves the settings in the ```\attributes``` folder under the current model folder.

For more information about the NC file settings, see the "NC file settings" section below.

5. You can customize the order in which information is displayed in an NC file, and add additional information on individual parts in the NC file header. To select the information to be included in the NC file header, click **Header...**, modify the information, and click **OK**:

- In the **NC File Header Information** dialog box, include in the **Selected elements** list the header information options that you want, and arrange the options in the desired order by selecting the option and using the **Move up** and **Move down** buttons.

- If needed, add additional information on individual parts.

  You can enter text in the **Text info on piece 1 - Text info on piece 4** boxes, and enter desired template attributes in double angle brackets, for example `<<WEIGHT>>` to display the weight of the part.

- If you want to restore the default file header information, click the **Default** button in the **NC File Header Information** dialog box.
6. To create pop-marks and modify the pop-mark settings, click Pop-marks...

For more information about creating pop-marks and about the pop-mark settings, see the section "Create pop-marks in NC files" below.

7. To create contour marks, and modify contour marking settings, click Contour marking.

For more information about creating contour marking and about the contour marking settings, see the section "Create contour marking in NC files" below.

For more information on contour marking, see the support article How to create contour marking for steel beams.

8. To save the settings that you have modified with another name for later use, click enter a new name next to Save as and click Save as.

9. In the NC files dialog box, use the All parts or Selected parts options to select whether to create the NC files for all parts or only for the selected parts.

If you use the Selected parts option, you need to select the parts in the model.

10. Click Create.

Tekla Structures creates .nc1 files for the parts using the defined NC file settings. By default, the NC files are created in the current model folder. The filename consists of a position number and the extension .nc1.

11. Click Show NC log to create and show the log file dstv_nc.log that lists the exported parts and the parts that were not exported.

If all expected parts are not exported, check that the parts which were not exported pass all the profile type, size, hole and other limits set in the NC file settings.

Sometimes the NC file is not created, and a message is displayed on the status bar telling that NC files have not been written. For details about the possible causes, see "Troubleshooting when NC file is not created".

For a DSTV file description, see "DSTV file description" in Manage Tekla Structures.

To learn more about the DTSV syntax, see Standard Description for Steel Structure Pieces for the Numerical Controls.

**NC file settings**

**Files and part selection tab**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File format</td>
<td>DSTV is the only available value.</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>File location</td>
<td>The default folder is \DSTV_Profiles or DSTV_Plates under the current model folder. You can define another destination folder for NC files in one of the following ways:</td>
</tr>
<tr>
<td></td>
<td>• You can enter the folder path in the <strong>File location</strong> box. You can also browse for the path. For example, enter C:\NC.</td>
</tr>
<tr>
<td></td>
<td>• If you leave the field empty, the NC files will be created in the current model folder.</td>
</tr>
<tr>
<td></td>
<td>• To create the NC file in a specific folder under the current model folder, enter .&lt;folder_name&gt;. For example, enter .\MyNCFiles.</td>
</tr>
<tr>
<td></td>
<td>• You can use the model-specific advanced option XS_MIS_FILE_DIRECTORY to define the destination folder for NC and MIS files. Go to the <strong>CNC</strong> category in the <strong>Advanced options</strong> dialog box, and enter the desired folder path for the advanced option XS_MIS_FILE_DIRECTORY. The NC files will be created in the specified folder under a folder that has the name of the current model.</td>
</tr>
<tr>
<td></td>
<td>For example, if you define C:\NC, and the name of the current model is MyModel, the NC files will be created in the folder C:\NC\MyModel.</td>
</tr>
<tr>
<td>File extension</td>
<td>.nc1 is the default value.</td>
</tr>
<tr>
<td>Include revision mark to file name</td>
<td>Add a revision mark to the NC file name. The file name then includes a number indicating the revision of the file, P176.nc1 becomes P176_1.nc1, for example.</td>
</tr>
<tr>
<td>Create what</td>
<td>Select the type of files to create:</td>
</tr>
<tr>
<td></td>
<td><strong>NC files</strong> creates only DSTV files.</td>
</tr>
<tr>
<td></td>
<td><strong>Part list</strong> creates only a MIS list file (.xsr).</td>
</tr>
<tr>
<td></td>
<td>If you create an MIS list file, enter a name for the list in the <strong>Part list file name</strong> box. Also, you need to click the <strong>Browse...</strong> button next to the <strong>Part list file location</strong> box and browse for the location where you want to save the list.</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>NC files and part list</strong></td>
<td>creates both the DSTV files and an MIS list file.</td>
</tr>
<tr>
<td><strong>Combined NC files and part list</strong></td>
<td>embeds DSTV files in an MIS list file (*.xsr).</td>
</tr>
<tr>
<td>Maximum size</td>
<td>The options define the maximum length, width, and height of the parts the machine tool can handle. Larger parts are sent to other machines.</td>
</tr>
<tr>
<td>Profile type</td>
<td>All profiles that are set to <strong>Yes</strong> in the <strong>Profile type</strong> list can be handled by the machine tool. Profile types are named according to the DSTV standard.</td>
</tr>
<tr>
<td>I:</td>
<td>I profiles</td>
</tr>
<tr>
<td>U:</td>
<td>U and C profiles</td>
</tr>
<tr>
<td>L:</td>
<td>L profiles</td>
</tr>
<tr>
<td>M:</td>
<td>Rectangular tubes</td>
</tr>
<tr>
<td>R:</td>
<td>Round bars and tubes</td>
</tr>
<tr>
<td>B:</td>
<td>Plate profiles</td>
</tr>
<tr>
<td>CC:</td>
<td>CC profiles</td>
</tr>
<tr>
<td>T:</td>
<td>T profiles</td>
</tr>
<tr>
<td>S:</td>
<td>Z profiles and all the other types of profiles</td>
</tr>
<tr>
<td>By default, Tekla Structures unwraps round tubes as plate profiles and uses the plate profile type B in the NC file header data. To change this, use the advanced option XS_TUBE_UNWRAP_USE_PLATE_PROFILE_TYPE_IN_NC.</td>
<td></td>
</tr>
<tr>
<td>Maximum size of holes</td>
<td>The <strong>Maximum size of holes</strong> options define how large holes the machine tool is able to drill. The NC file is not created if a part contains larger holes or its material is thicker than the specified values. The hole size is connected to material thickness or plate thickness.</td>
</tr>
<tr>
<td>Each row contains the maximum hole diameter and the material thickness. Both conditions have to be met for the NC file to be created. For example, a row with the values 60 45 means that when the material thickness is 45 mm or smaller, and the hole diameter is 60 mm or smaller, the NC file is created. You can add as many rows as needed.</td>
<td></td>
</tr>
<tr>
<td>The following example shows how the <strong>Maximum size of holes</strong> can be defined. In this example, we have the following situation:</td>
<td></td>
</tr>
</tbody>
</table>
### Setting | Description
---|---
| Three plates of different thickness. | Two bolt groups with equal sizes, and one bolt group with a larger size.

#### Maximum size of holes
- Test1 creates a folder under the model folder for the plates that meet the following criteria:
  - **Hole diameter**: 22
  - **Plate thickness**: 10
- Test2 creates a folder under the model folder for the plates that meet the following criteria:
  - **Hole diameter**: 22
  - **Plate thickness**: 20

When you create NC files for the plates, the folder Test1 includes the plate PL350*10 and the folder Test2 includes the plate PL350*20. The plate PL350*15 is not included in any folder, because the hole size criterion is not met.

The order in which you enter the criteria is important: enter the most exclusive criteria first. If you define the criteria in a different order, the results will also be different.

#### Holes and cuts tab
See also XS_DSTV_CREATE_NOTCH_ONLY_ON_BEAM_CORNERS.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Inner corners shape</strong></td>
<td>The <strong>Inner corners shape</strong> option defines the shape of, for example,</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>web notches or flange cuts at the beam end.</td>
</tr>
</tbody>
</table>

![Diagram](image1)

The **Inner corners shape** option also affects cuts on the flange:

![Diagram](image2)

The **Inner corners shape** option does not apply to rectangular openings that are located in the middle of a part:

![Diagram](image3)

The **Inner corners shape** option does not apply to those inner contours that are already rounded in the model. The model values remain intact.

The examples in the below show how the different inner corner shape options affect the part in the NC file. The original part in the model has flanges cut entirely and the web is notched.

Option 0: Radius
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The inner corners are shaped like holes with a given radius. A separate BO block is not written to the NC file.</td>
</tr>
<tr>
<td><strong>Option 1: Tangential</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>The inner corner is rounded according to the value in the <strong>Radius</strong> box.</td>
</tr>
<tr>
<td><strong>Option 2: Square</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>The corner is as it is in the model.</td>
</tr>
<tr>
<td><strong>Option 3: Drilled hole</strong></td>
<td>A drilled hole is added to the inner corner. The hole radius is the same as</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| | the value in the **Radius** box. Holes are written as a separate BO block to the NC file.  

Option **4**: Tangential drilled hole

A drilled hole is added tangentially to the inner corner. The hole radius is the same as the value in the **Radius** box. Holes are written as a separate BO block to the NC file.  

If the inner corner **Radius** is set to be too large, an NC file is not created to avoid manufacturing errors. The `dstv_nc.log` file in the model folder shows the error messages, and indicates the parts that have failed and the maximum allowed inner corner radius.  

For the radius to be valid, the hole (including angles) must be equal to or greater than radius $x$ 2. For example, a hole with angles needs to be even smaller than radius $x$ 2, so that it would not hit the weld preparation area. |

| **Distance from flange within which web is not cut** | **The Distance from flange within which web is not cut** option defines the height of the flange clearance area. The clearance check only affects the I, U, C, and L DSTV profile types.  

If a cut in a part is located closer to the flange than the clearance in the model, the cut points inside that clearance are moved to the border of the clearance area when the NC file is written. |
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>The part how it is modeled. The cut goes closer to the top flange than the defined flange clearance in the NC file settings:</td>
<td></td>
</tr>
<tr>
<td>The part how it is written in the NC files. The dimension shows the clearance. The top of the original cut is moved so that the clearance area is left free. The bottom of the cut is not moved.</td>
<td></td>
</tr>
<tr>
<td>Machine slots as</td>
<td>The <strong>Machine slots as</strong> option defines how slotted holes are created:</td>
</tr>
<tr>
<td><strong>Ignore slots</strong>: Slotted holes are not created in the NC file.</td>
<td></td>
</tr>
<tr>
<td><strong>A single hole in the center of the slot</strong>: Drills a single hole in the center of the slotted hole.</td>
<td></td>
</tr>
<tr>
<td><strong>Four small holes, one at each corner</strong>: Drills four smaller holes, one at each corner.</td>
<td></td>
</tr>
<tr>
<td><strong>Internal contours</strong>: Flame-cuts the slots as internal contours.</td>
<td></td>
</tr>
<tr>
<td><strong>Slots</strong>: Leaves slots as they are.</td>
<td></td>
</tr>
<tr>
<td>Maximum diameter for holes to be drilled</td>
<td>The <strong>Maximum diameter for holes to be drilled</strong> option defines the maximum hole diameter. Holes and</td>
</tr>
</tbody>
</table>

Import to and export from Tekla Structures 355 Steel fabrication
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>slotted holes that are larger than the</td>
<td>maximum hole diameter are manufactured as internal contours.</td>
</tr>
<tr>
<td>Maximum diameter for circular</td>
<td>Maximum diameter for circular cuts to be drilled defines the maximum circular part cuts. They are written as holes if the diameter of the cut is less than the value defined for the setting. Smaller internal circular cuts are converted to holes.</td>
</tr>
<tr>
<td>cuts to be drilled</td>
<td></td>
</tr>
</tbody>
</table>

**Hard stamp tab**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create hard stamp</td>
<td>When selected, creates hard stamps.</td>
</tr>
<tr>
<td>Hard stamp content</td>
<td>The <strong>Elements</strong> list defines which elements are included in hard stamps and the order in which the elements appear in the hard stamp. You can also define the <strong>Text height</strong> and <strong>Case</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>Project number</strong>: Adds the project number to the hard stamp.</td>
</tr>
<tr>
<td></td>
<td><strong>Lot number</strong>: Adds the lot number to the hard stamp.</td>
</tr>
<tr>
<td></td>
<td><strong>Phase</strong>: Adds the phase number to the hard stamp.</td>
</tr>
<tr>
<td></td>
<td><strong>Part position</strong>: Prefix and position number of the part.</td>
</tr>
<tr>
<td></td>
<td><strong>Assembly position</strong>: Prefix and position number of the assembly.</td>
</tr>
<tr>
<td></td>
<td><strong>Material</strong>: The material of the part.</td>
</tr>
<tr>
<td></td>
<td><strong>Finish</strong>: The type of finish.</td>
</tr>
<tr>
<td></td>
<td><strong>User-defined attribute</strong>: Adds a user-defined attribute (user fields 1-4) to the mark.</td>
</tr>
<tr>
<td></td>
<td><strong>Text</strong>: Opens a dialog box where you can add user-defined text to the hard stamp.</td>
</tr>
<tr>
<td></td>
<td>Including part position and/or assembly position in the hard stamp affects the NC filename:</td>
</tr>
<tr>
<td></td>
<td>• Part position: P1.nc1, P2.nc1</td>
</tr>
</tbody>
</table>

Import to and export from Tekla Structures 356 Steel fabrication
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| • Assembly position: A1.nc1, A2.nc1  
• Assembly and part position: A1-P1.nc1, A2-P2.nc1 | The following example shows a hard stamp that contains the elements Phase, Part position, Material, and Text. |

**Hard stamp placing**  
If you set the option **By orientation mark** to **Yes**, the default face is changed from bottom (u) to top (o) for L profiles, rectangular tubes and round bars.

The **Side** option defines the side of the part on which the hard stamp is placed.

The **Position along the part** and **Position in depth of part** options define the position of hard stamps on parts.

These options move the hard stamp on the same face it is created, but they cannot move the stamp to a different face. If the face is, for example, the bottom flange, you can move the stamp to a different place on bottom flange, but not to the top flange.

Default faces for different profiles:  
I profile: Bottom flange (u)  
U and C profiles: Back side of web (h)  
L profiles: Back (h) or Bottom (u)  
Rectangular tubes: Bottom flange (u)  
Round bars: Bottom flange (u)  
Circular tubes: Front (v)  
T profiles: Back side of web (h)
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plate profiles: Front (v)</td>
<td>See also XS_SECONDARY_PART_HARDSTAMP.</td>
</tr>
</tbody>
</table>

**Advanced Options tab**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of decimals</td>
<td>Define the number of decimals shown in NC files.</td>
</tr>
<tr>
<td>Change external contour (AK block) radius sign</td>
<td>Change the AK block curve radius signs on top (o) and back (h) faces. This change only affects on top (o) and back (h) faces.</td>
</tr>
</tbody>
</table>

Below is an example, where the **Change external contour (AK block) radius sign** is not selected.

<table>
<thead>
<tr>
<th>AK</th>
<th>0.00</th>
<th>0.00</th>
<th>0.00</th>
<th>0.00</th>
<th>0.00</th>
<th>0.00</th>
<th>0.00</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>0.00</td>
<td>300.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td>300.00</td>
<td>300.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td>300.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td>1356.75</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td>1356.75</td>
<td>115.98</td>
<td>-40.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td>1356.75</td>
<td>155.99</td>
<td>-40.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td>1316.75</td>
<td>155.99</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td>1086.75</td>
<td>155.99</td>
<td>40.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td>1046.75</td>
<td>115.98</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td>1046.75</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

Below is an example, where the **Change external contour (AK block) radius sign** is selected.

<table>
<thead>
<tr>
<th>AK</th>
<th>0.00</th>
<th>0.00</th>
<th>0.00</th>
<th>0.00</th>
<th>0.00</th>
<th>0.00</th>
<th>0.00</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>0.00</td>
<td>300.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td>300.00</td>
<td>300.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td>300.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td>1356.75</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td>1356.75</td>
<td>115.98</td>
<td>40.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td>1356.75</td>
<td>155.99</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td>1316.75</td>
<td>155.99</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td>1086.75</td>
<td>155.99</td>
<td>40.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td>1046.75</td>
<td>155.99</td>
<td>40.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td>1046.75</td>
<td>115.98</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td>1046.75</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

**Change internal contour (IK block) radius sign** | Change the IK block curve radius signs for top (o) and back (h) faces. This change only affects top (o) and back (h) faces. |
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Curve detection</td>
<td><strong>Curve detection</strong> controls whether three points should be read as a curve instead of two straight lines. When <strong>Curve detection</strong> is set to <strong>Yes</strong>, Tekla Structures checks the edges of a solid against a virtual curve described by the edges to see if the edges are curved or straight based on the <strong>Chord tolerance</strong> value. Enter the <strong>Chord tolerance</strong> value in millimeters. <strong>Curve detection</strong> is on by default. The image below describes the chord tolerance.</td>
</tr>
<tr>
<td>Chord tolerance</td>
<td></td>
</tr>
<tr>
<td>Convert I profile to T profile when flange is missing</td>
<td>Select whether to convert I profiles to T profiles when a flange is missing. You can select either <strong>Yes</strong> or <strong>No</strong>.</td>
</tr>
<tr>
<td>Skip unnecessary points</td>
<td>Select whether to keep or skip the points that are almost collinear. If the creation points of a contour plate differ less than 0.3 mm from a straight line, they are skipped in the NC file when this setting is selected. When the setting is not selected, every creation point of a plate is written to the NC file. <strong>Skip unnecessary points</strong> not selected:</td>
</tr>
</tbody>
</table>
### Setting

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Skip unnecessary points</strong> selected:</td>
<td><img src="image1" alt="Diagram" /></td>
</tr>
</tbody>
</table>
| **Create KA block for**  | Select the following options to show bent line information for bent plates and polybeam plates in the NC file KA block: *Unfolded bent plates* and *Unfolded polybeam plates*.  
  See also XS_DSTV_DO_NOT_UNFOLD_POLYBEAM_PLATES. |

---

**Create pop-marks in NC files**

Pop-marks are small holes that help the shop assemble individual parts to form an assembly. Tekla Structures is able to write the pop-mark information in NC files to help position parts that will be manually welded to the assembly main part. Pop-marks are usually made using a drilling machine that drills a small hole in the surface of the material.

**Limitation:** Tekla Structures pop-marking does not work with polybeams.

Tekla Structures only creates pop-marks for parts for which you have defined pop-mark settings. You can save the pop-mark settings in a .ncp file, which Tekla Structures saves by default in the ..\attributes folder under the current model folder.
NOTE  Pop-marking affects numbering. For example, if two parts have different pop-marks, or one part has pop-marks and the other one does not, Tekla Structures gives the parts different numbers.

1. In the **NC files** dialog box, select the parts for which you want to create the pop-marks by selecting the corresponding check boxes in the **Pop-marks** column.

2. Click the **Pop-marks...** button.

3. In the **Pop-Mark Settings**, click **Add** to add a new row.

4. To define which parts are pop-marked and where the pop-marks are created, enter or select information for each item on a row.

   The order of the rows in the **Pop-Mark Settings** dialog box is important. Enter the most limiting definition first, and the most generic one last.

   First define the pop-mark settings on the **Parts to pop-mark** tab:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Main part profile type</strong></td>
<td>Select the main part profile type that is pop-marked. The list contains profiles according to the DSTV standard.</td>
</tr>
<tr>
<td><strong>Main part name</strong></td>
<td>Enter the names of the main part profiles. You can enter several part names separated by commas, for example, <strong>COLUMN, BEAM</strong>. You can use wildcards (* ? [ ]). For example, *<em>HE</em> matches all parts with a profile name that begins with the characters &quot;HE&quot;. Part name can contain more names separated by comma.</td>
</tr>
<tr>
<td><strong>Sec part profile type</strong></td>
<td>Select the secondary part profile type.</td>
</tr>
<tr>
<td><strong>Secondary part name</strong></td>
<td>Enter the names of the secondary part profiles. You can enter several part names separated by commas. You can use wildcards (* ? [ ]). Part name can contain more names separated by comma</td>
</tr>
<tr>
<td><strong>Pop-mark location</strong></td>
<td>Select how the secondary part is projected onto the main part.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Left side</strong>: The left side of the secondary part is marked on the main part. The left side is the side</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>of the secondary part that is closest to the start point of the main part.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Right side</strong>: The right side of the secondary part is marked on the main part.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Both sides</strong>: Combines <strong>Left side</strong> and <strong>Right side</strong>.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Center</strong>: Center of the secondary part.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Left side holes</strong>: Marks the main part with the position of holes in the secondary part, on the left side of the secondary part.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Right side holes</strong>: Marks the main part with the position of holes in the secondary part, on the right side of the secondary part.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Both side holes</strong>: Combines <strong>Left side holes</strong> and <strong>Right side holes</strong>.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Middle line</strong>: Marks two points on the middle line of the secondary part x axis.</td>
</tr>
</tbody>
</table>

**Move to flange**
Select to which part of the main part flange the pop-marks are moved. The options are **None**, **Both flanges**, **Top flange**, and **Bottom flange**.

**Edge distance**
Enter the minimum distance from a pop-mark to the edge of the main part. Tekla Structures does not create pop-marks inside this distance.

If a pop-mark is inside the defined edge distance, Tekla Structures moves it, unless you have set **Pop-mark location** to **Center**.

**Secondary pop-marks**
Select whether pop-marks are created to the secondary parts.

**Add pop-mark to parts welded on site**
Select whether pop-marks are created for parts that are welded on site.

Then define the pop-mark settings on the **Pop-marking options** tab:
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Pop-marks on the back**                           | Select one of the options:  
|                                                      | Rotate part if pop-marks or other items only on the back                     |
|                                                      | Rotate part and drill through pop-marks on the back if other items or more pop-marks only on the back. Also set the Hole diameter. |
|                                                      | Drill through pop-marks on the back if no other items on the back. Also set the Hole diameter. |
| **No pop-marks on overlapping holes**               | Select if you do not want to have pop-marks on overlapping holes.           |
| **Add pop-marks to centers of studs**               | Select to have pop-marks in the stud centers.                              |
| **Show pop-marks in the model**                     | Select to show pop-marks in the model.                                     |
| **Consider zero diameter holes as pop-marks**       | Write zero diameter bolt holes as a pop-marks.                             |

5. Click **OK**.

6. Select the parts in the model and create the NC files.

Pop-marks are written in the **BO** block in the DSTV file as 0 mm diameter holes. If needed, pop-marks can also be displayed in drawings. In drawings, select the **Pop-marks: on/off** check box in the part properties to display the pop-marks.

The default symbol for pop-marks is **xsteel@0**. You can change the symbol with the advanced option **XS_POP_MARK_SYMBOL**.

Tekla Structures displays thick red lines for each pop-mark pair in the model view which was last updated.
Examples

Tekla Structures marks the center point of all round secondary profiles on a main part, and does not create pop-marks closer than 10 mm to the main part edge.

Tekla Structures projects the hole location in the secondary plates onto a main part.

Create contour marking in NC files

Tekla Structures is able to generate contour marking in NC files. This means that information on the layout and the parts that are welded together can be added to the NC files and passed on to the machine tool.

Limitation: Tekla Structures contour marking on polybeams does not work in all cases. The visual placement of contour marking on polybeams has been improved.

Tekla Structures only creates contour markings for parts for which you have defined contour marking settings. You can save the contour marking settings in a .ncs file, which Tekla Structures saves by default in the ..\attributes folder under the current model folder.

You can add contour marking to both the main and the secondary parts.
Contour marking affects numbering. For example, if two parts have different contour markings, or one part has contour markings and the other one does not, Tekla Structures gives the parts different numbers.

For more information on contour marking, see the support article How to create contour marking for steel beams.

1. In the NC files dialog box, select the parts for which you want to create the contour marks by selecting the corresponding check boxes in the Contour marking column.
2. Click the Contour marking... button in the NC files dialog box.
3. In the Contour marking settings dialog box, click Add to add a new row.
4. To define which parts are contour marked and how they are contour marked, enter or select information for each item on a row:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Main part profile type</td>
<td>Select the main part profile type that is contour marked. The list contains profiles according to the DSTV standard.</td>
</tr>
<tr>
<td>Main part name</td>
<td>Enter the name for the main part profiles. You can enter several part names separated by commas, for example, COLUMN, BEAM. You can use wildcards (* ? []). For example, HE* matches all parts with a profile name that begins with the characters &quot;HE&quot;. Part name can contain more names separated by comma.</td>
</tr>
<tr>
<td>Sec part profile type</td>
<td>Select the secondary part profile type. The list contains profiles according to the DSTV standard.</td>
</tr>
<tr>
<td>Secondary part name</td>
<td>Enter the name for the secondary part profiles. You can enter several part names separated by commas. You can use wildcards (* ? []). Part name can contain more names separated by comma.</td>
</tr>
<tr>
<td>Secondary contour marking</td>
<td>Select whether the secondary parts are contour marked.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Punch or powder</td>
<td>In the list, select how the part is contour marked:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Punch</strong>: The part is punched.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Powder</strong>: The part is marked with powder.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Both</strong>: Both techniques are used.</td>
</tr>
<tr>
<td>Hard stamp</td>
<td>Select whether hard stamps are created.</td>
</tr>
<tr>
<td>Mark parts welded on site</td>
<td>Select whether you want to mark parts that are welded on site.</td>
</tr>
<tr>
<td>Edge distance</td>
<td>Define the minimum distance from a contour mark to the edge of the main part. Tekla Structures not create contour marks inside this distance.</td>
</tr>
</tbody>
</table>

5. Click **OK** and create the NC files.

Contour marking is written in the **PU** and **KO** blocks in the DSTV file.

Tekla Structures displays contour marking as thin magenta lines in the model view.

![Contour marking in Tekla Structures](image)

**Fittings and line cuts in NC files**

When creating NC files in DSTV format, the method you use to cut the end of the beam affects the beam length in the NC file.

- **Fittings** affect the length of the beam in the NC file.
• **Line cuts** do not affect the length of the beam in the NC file.

When you cut the beam end, use the fitting method to make sure that the beam length is correct in the NC file.

The overall length of a beam will be the fitted net length of the beam. This means that Tekla Structures always takes the fitting into account when calculating the beam length.

For lines, polygons, or part cuts, the cut does not affect beam length, but the overall length in the NC file will be the gross (initially modeled) length of the beam.

1. Fitting
2. Line cut
3. Polygon or line cut
4. Fitting

**Shortest length**

If you want to use the shortest possible length in an NC file, use the advanced option XS_DSTV_NET_LENGTH.

**Net and gross length**

If you want to include both net and gross length into NC file header data, use the advanced option XS_DSTV_PRINT_NET_AND_GROSS_LENGTH.

**Create round tube NC files**

You can create NC files for tubular hollow sections. You first need to use specific tube components to create the connections.

Create the following tube-to-tube and tube-to-plate connections:

• Tube-Chamfer
• Tube-CrossingSaddle
• Tube-MitreSaddle+Hole
• Tube-Saddle+Hole
• Tube-SlottedHole

After using the components, you can create an NC file for data export. The tube NC file creation results in an XML file that contains the model data.

Limitations:
To get correct tube NC export results, note the following limitations:

• Line cuts and fittings created manually or by other components will be exported as simple chamfers.
• Part cuts are not supported in the XML export to HGG tube NC files.
• Holes created by bolts are not supported, and they will not be exported.
• Curved beams are not supported.
• For square or rectangular tubes, use File --> Export --> NC files to create DSTV files.

1. On the File menu, click Export --> Tube NC files.
2. In the Create Tube NC Files dialog box, enter a name for the export file, and browse for the location where you want to save the file.

By default, the file is saved in the model folder.
3. Select whether you want to create the file for selected parts or for all parts.
4. Click Create.

Tekla Structures creates an XML file and a log file in the location you defined.

Convert DSTV to DXF
Use the DSTV to DXF converter to convert DSTV files to DXF format files to be used in fabrication production solutions, such as plate nesting or production management. Many production automation solutions, especially some plate nesting solutions, only support the import of DXF files, not DSTV NC files.

The DSTV to DXF converter provides key layer and quantity information in the format expected by the production solutions. The converter also supports the automation of the conversion processes through the command prompt and macro templates, which allow you to set up and customize your automation routines.

Convert using the DSTV to DXF Converter

1. To open the DSTV to DXF Converter, in the side pane, click the Applications & components button, search for the DSTV to DXF Converter, and double-click the DSTV to DXF Converter button.
The **DSTV to DXF Converter** dialog box is displayed.

2. Define the desired settings on the various tabs, and use the **Add** button to add the `.nc` files.

   The settings are described in the "Conversion settings" section below.

3. Click the **Convert** button.

   The DXF files are created in the specified folder:
Convert DSTV to DXF using a converter template

You can use a converter template to automate the conversion process. All you need to do is to fill in the necessary information in the template file in a text editor. Once you have it set up, you do not need open and load the settings in the DSTV to DXF Converter dialog box, and you can do the conversion just by double-clicking one button.

1. In Applications & components, right-click the DSTV to DXF Converter Template button, click Edit, and select a suitable text editor.

   This opens the DSTVtoDXFConverterTemplate.cs template located in the ..\TeklaStructures\<version>\bin\<Env>\Common\macros\modeling folder.

2. Scroll down to modify the strings to suit local environment and user preferences:

   /**** Modify these strings to suit local environment and user preferences. ****/
   
   private static string attributeFile = @"standard";
   private static string inputFolder = @"./DSTV_Profiles";
   private static string outputFolder = @"./NC_dxf";
   private static string files = @"PL*.nc1, BPL*.nc1, FLT*.nc1";
   
   private static bool overwrite = true;

   • standard: attribute file name you want to use for conversion
   • ./DSTV_Profiles: input folder in which single and batch files are searched for
• ./NC_dxf: output folder where to create the *.dxf files
• PL*.ncl, BPL*.ncl, FLT*.ncl: list of file names each enclosed in quotes or wild card
• true: option to overwrite or not the existing *.dxf files.

3. Save the template file.

4. To run the conversion using the template, in Applications & components, double-click the DSTV to DXF Converter Template button.
   After the process ends, a message will give you information about the conversion.

### DSTV to DXF conversion settings

<table>
<thead>
<tr>
<th>General tab</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Output folder, DSTV files</strong></td>
</tr>
<tr>
<td>• Select the desired settings file. You can use the Import .def button to import a settings file.</td>
</tr>
<tr>
<td>• Define the Output folder. By default, the output folder is \NC_dxf under the model folder.</td>
</tr>
<tr>
<td>• Use the Add button to add the .nc files.</td>
</tr>
<tr>
<td>• You can remove files by clicking the Remove button. To remove all files at one go, use the Clear all button.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Environment tab</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Include shop data section</strong></td>
</tr>
<tr>
<td>Specify whether to include a special data section in the DXF file to allow the DXF file to be better imported into CNC software written by Shop Data Systems. Including this special data section in the DXF file makes the DXF file unreadable by AutoCAD. No is the default value.</td>
</tr>
</tbody>
</table>

| No input file extension in output file |
| Specify whether to use the input file extension in the output file.  |
| • Yes: p1001.dxf. Yes is the default value.  |
| • No: p1001.ncl.dxf  |
| **Draw crosshairs** | Select whether to draw crosshair for holes and slotted holes.  
**Holes** (default):  
- **Long holes:**  
- **Both:**  
- **None:** |
|---------------------|----------------------------------------------------------------------------------------------------------------------------------|
| **Side to convert** | Define the part face that is shown in the DXF file: **Front** (default), **Top**, **Back**, or **Below**.  
For plates, if you select **Back**, you need to set the advanced option **XS_DSTV_WRITE_BEHIND_FACE_FOR_PATE** to **TRUE** for the NC file creation. This will include the back side data of a plate in the NC file. |
| **Output contours as** | Convert contours as **Polylines** (default) or **Lines and arcs**. |
| **Contour direction** | Define the contour direction. This option changes the coordinates of the |
vertices, and their order in the DXF file. The options are:
- **Reverse** (clockwise, default)
- **Forward** (counter-clockwise)

**Convert holes to polylines**
Convert holes to polylines. **Yes** is the default value.

**Maximum diameter for holes converted to points**
Convert holes with a diameter smaller than the defined value to points and follow the **Hole point style** and **Hole point size** settings. The default value is 10.00 mm.

**Hole point style**
Set the style for hole points. Enter one of the following values:

<table>
<thead>
<tr>
<th>Number</th>
<th>Style</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>![Image]</td>
</tr>
<tr>
<td>3</td>
<td>![Image]</td>
</tr>
<tr>
<td>4</td>
<td>![Image]</td>
</tr>
<tr>
<td>33</td>
<td>![Image]</td>
</tr>
<tr>
<td>34</td>
<td>![Image]</td>
</tr>
<tr>
<td>35</td>
<td>![Image]</td>
</tr>
<tr>
<td><strong>Hole point size</strong></td>
<td>Enter the hole point size. 1.00 mm is the default value.</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Scale DSTV by</strong></td>
<td>Scale the values from the DSTV file.</td>
</tr>
<tr>
<td></td>
<td>• 1.00000 for metric units (default)</td>
</tr>
<tr>
<td></td>
<td>• 0.03937 for imperial units</td>
</tr>
<tr>
<td><strong>NOTE:</strong> Sometimes, the elements are not properly converted in the <code>.dxf</code> file due to the small <strong>Scale DSTV by</strong> value (less than 1.00). In this case, you can increase the <strong>Number of decimals</strong> value and/or the <strong>Scale DSTV by</strong> value, which will create the elements in the <code>.dxf</code> file properly.</td>
<td></td>
</tr>
<tr>
<td><strong>Add outer contour roundings</strong></td>
<td>Add holes to roundings. <strong>No</strong> is the default value.</td>
</tr>
<tr>
<td></td>
<td>This setting only affects the roundings if at the NC file creation, the <strong>Inner corners shape</strong> setting was set to 1 on the <strong>Holes and cuts</strong> tab in the <strong>NC file settings</strong> dialog box.</td>
</tr>
<tr>
<td></td>
<td>The hole size information is comes to the DSTV file from the <strong>Radius</strong> value in the <strong>NC file settings</strong> dialog box, and it cannot be adjusted in the DSTV to DXF converter.</td>
</tr>
<tr>
<td></td>
<td><strong>Yes</strong></td>
</tr>
<tr>
<td><strong>Minimum material between holes</strong></td>
<td>Define how close the holes can be to each other in the slotted hole conversion. 2.00 mm is the default value.</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Hardstamp for contour marking</strong></td>
<td>Enable the conversion of the hard stamp created at the NC file creation. In the <strong>Contour marking settings</strong> in <strong>NC file settings</strong>, you need to have set the <strong>Hard stamp</strong> option to <strong>Yes</strong>. <strong>No</strong> is the default value.</td>
</tr>
<tr>
<td><strong>Number of decimals</strong></td>
<td>Set the number of decimals for values in the DXF file. 3 is the default value.</td>
</tr>
</tbody>
</table>
| **Read part mark from NC file header line** | Set the line number of the NC file header for reading the part mark information. The options are:  
• 3 - Read the part mark information from the 3rd line of the NC file header. This is the default value.  
• 4 - Read the part mark information from the 4th line of the NC file header. |
| **Draw blind holes** | Include or exclude the blind holes in the NC files. **No** is the default. |
| **Text specifications tab, Text properties** |  |
| **Add text** | Select whether to use the manual text properties or the hardstamp from the NC file:  
• **Manual**: Define the text settings. This is the default value.  
• **From NC file**: All text settings will be disabled and the information defined in the DSTV file will be used. |
| **Text placing** | Place the text manually or let the application find out a suitable place for it. The options are:  
• **Fixed**: Set the X and Y coordinates of the point that represents the lower-left corner of the last line of text from the origin point 0,0 of the DXF file.  
• **Automatic**: The text will be placed automatically taking into consideration the collision with outer and internal contours, holes, and contour marking. If no suitable position is found, the default value (X 30.00, Y 30.00) will be used. |
<p>| <strong>Text height</strong> | Specify the text height. 10.00 is the default value. |
| <strong>Text line alignment</strong> | Write the text options on separate or combined lines. |</p>
<table>
<thead>
<tr>
<th><strong>Separator symbol</strong></th>
<th>Enter the separator used for the Text options if you are using one of the combined text alignment options. You can specify more than one character. Plus (+) is the default separator.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Enable/Disable items from the converted text options</strong></td>
<td>Enable or disable options from the converted text options. If you disable an option, the related Prefix box is also disabled. Note that whitespaces will be considered in the prefixes. <strong>Project number</strong>: Enter the prefix for the project number. <strong>Project number</strong>: is the default. This option is disabled by default. <strong>Part mark</strong>: Enter the prefix for the part mark. <strong>Part</strong>: is the default. This option is enabled by default. <strong>Side mark</strong>: Enter the prefix for the side mark. <strong>Side</strong>: is the default. This option is disabled by default. <strong>Material</strong>: Enter the prefix for the material. <strong>Material</strong>: is the default. This option is enabled by default. <strong>Quantity</strong>: Enter the prefix for the quantity. <strong>Quantity</strong>: is the default. This option is enabled by default.</td>
</tr>
</tbody>
</table>

- **Separate lines**: Each text option is written on a separate line. This is the default value.
- **Project number and part mark separate, others combined**
- **All into one line**: All text options are concatenated on one line.

When selecting one of the last two options the prefixes will be automatically removed but they can be added back and work as for the first option.
**Thickness**: Enter the prefix for the thickness. **Thickness**: is the default. This option is disabled by default.

**Profile description**: Enter the prefix for the profile description (Desc: is the default). This option is enabled by default.

### Misc layers
The maximum length of a layer name is 100 characters.
If you use special characters in layer names, such as <, >, /, \, ?, !, *, |, ;, and space " ", the extension will replace them with the "_" underscore character.

**Part mark**
Define a name and a color for the part mark layer. SCRIBE is the default name.

**Phantom**
Define a name and a color for the phantom layer. LAYOUT is the default name.

**NS pop-mark**
Define a name and a color for the near side pop-mark layer.
NS_POP_MARK is the default name.
You can also define whether to use pop circle (default) or pop point as the pop mark type. Also define the DXF diameter (default 2.00 mm).

**FS pop-mark**
Define a name and a color for the far side pop-mark layer.
FS_POP_MARK is the default name.
You can also define the diameter (default 1.00 mm), and whether to use pop circle (default) or pop point as the pop-mark type. Also define the DXF diameter (default 2.00 mm).

**Text**
Define a name and a color for the text layer. TEXT is the default name.

**Outer contour**
Define a name and a color for the outer contour layer. CUT is the default name.

**Inner contour**
Define a name and a color for the inner contour layer. CUTOUT is the default name.

**Punch contour marking**
Define a name and a color for the punch contour marking layer.
<table>
<thead>
<tr>
<th><strong>PUNCH CONTOUR MARKING</strong> is the default name.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Powder contour marking</strong></td>
</tr>
<tr>
<td><strong>Bends</strong></td>
</tr>
<tr>
<td><strong>Color</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Color</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td></td>
</tr>
<tr>
<td>0</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
</tr>
</tbody>
</table>

**Hole layers** tab:
- For the hole layers, to modify the hole layer name, hole minimum diameter, hole maximum diameter, and the layer color, double-click the cell and enter a new value, or select a new value from the list.
- To add a new row, right-click and select **Add new row**.
- To delete a row, select a row, right-click, and select **Delete selected row**, or press **Delete** on the keyboard.
- To clear all rows, right-click and select **Clear all rows**.

**Slotted hole layers** tab:
- For the slotted hole layers, to modify the hole layer name, hole minimum diameter, hole maximum diameter, minimum width, maximum width, minimum height, maximum height, type, layer color, and phantom type, double-click the cell and enter a new value, or select a new value from the list.
• To add a new row, right-click and select **Add new row**.
• To delete a row, select a row, right-click, and select **Delete selected row**, or press **Delete** on the keyboard.
• To clear all rows, right-click and select **Clear all rows**.

### Phantom type examples

Below there are some examples with different phantom types. The other settings used are **Slot type** = 1, **Hole point style** = 33 and **Hole point size** = 1.

<table>
<thead>
<tr>
<th>Phantom type</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phantom arrow</td>
<td><img src="image1.png" alt="Phantom Arrow" /></td>
</tr>
<tr>
<td>Phantom outline</td>
<td><img src="image2.png" alt="Phantom Outline" /></td>
</tr>
<tr>
<td>Phantom arrow + outline</td>
<td><img src="image3.png" alt="Phantom Arrow + Outline" /></td>
</tr>
<tr>
<td>Phantom none</td>
<td><img src="image4.png" alt="Phantom None" /></td>
</tr>
</tbody>
</table>

**Convert DSTV to DXF through command prompt**

1. Open a Tekla Structures model.
2. Open the Command Prompt window.
3. To run the DSTV to DXF converter, at the command prompt, enter the path to the `DSTVtoDXFConverter.exe` command and the desired parameters.
   
   **The command is located in the ..\Tekla Structures\<version>\bin \applications\Tekla\Tools\DSTVtoDXFConverter folder by default.**

**Command syntax:**

```
DSTVtoDXFConverter.exe [-cfg attributeFile] [-out outputFolder] [-in inputFolder] [-overwrite] [-f files]
```

**Parameters:**

- `-cfg attributeFile`
  
  - Defines the attribute file used in the conversion.
  - The standard attribute file is used if nothing else is specified.
• You can use both full and relative paths.
• Relative paths are relative to the model folder.
• If no path is specified, the configuration file is read from the standard attribute file locations.
• If there are no attribute files, a warning message will appear asking you to specify a configuration file, and create an attribute file in the DSTV to DXF converter dialog box.

-out outputFolder
• Defines the output folder.
• You can use both full and relative paths.
• Relative paths are relative to the model folder.
• If the folder is not specified, the output folder is read from the attribute file.
• If the folder is not specified in the attribute file, the output folder is the same as the input folder.
• The output folder is created if it does not exist.
• If the output folder name contains spaces, enclose the name in quotation marks (" ").

-in inputFolder
• The folder from which single and batch files are searched for.
• You can use both full and relative paths.
• The default is the model folder if the input folder is not specified.
• If the input folder name contains spaces, enclose the name in quotation marks (" ").

-no_over_write
• When included, existing files are not overwritten.
• When not specified, existing files are overwritten.

-f files
• A list of 1 to n file names each enclosed in quotes, separated by commas
• You can also use wild card *
• If not specified, "*.nc1" is used as default
• Examples:
  1. -f "P1.nc1"
  2. -f "*.nc1"
  3. -f "P1.nc1, F2.nc1, P3.nc1, P5.nc1, P7.nc1"
  4. -f "PL*.nc1, BPL*.nc1, FLT*.nc1"
Examples of DSTV to DXT converter command

DSTVtoDXFConverter.exe

• opens the **DSTV to DXF converter** dialog box.

DSTVtoDXFConverter.exe -in “./NC Plates”

• standard attribute file is used

• the input folder is [modelFolder]\NC Plates

• the output folder is read from standard attribute file

• all files with .nc1 extension are converted

• existing *.dxf files for selected *.nc1 files will be overwritten

DSTVtoDXFConverter.exe -cfg myPlateSettings -out “./Plate DXF” -in “./NC Plates” -f “P1.nc1”

• attribute file with the name myPlateSettings is used

• the input folder is [modelFolder]\NC Plates

• the output folder is [modelFolder]\Plate DXF

• the file P1.nc1 is converted

• existing *.dxf files for selected *.nc1 files will be overwritten

DSTVtoDXFConverter.exe -cfg myPlateSettings -out “./Plate DXF” -in “./NC Plates” -f “P1.nc1, F 2.nc1, P3.nc1, P5.nc1, P7.nc1”

• attribute file with the name myPlateSettings is used

• the input folder is [modelFolder]\NC Plates

• the output folder is [modelFolder]\Plate DXF

• the files P1.nc1, F2.nc1, P3.nc1, P5.nc1, and P7.nc1 are converted

• existing *.dxf files for selected *.nc1 files will be overwritten

DSTVtoDXFConverter.exe -cfg myPlateSettings -in “./NC Plates” -no_over_write -out “./Plate DXF” -f “*.nc1”

• attribute file with the name myPlateSettings is used

• the input folder is [modelFolder]\NC Plates

• the output folder is [modelFolder]\Plate DXF

• all files with .nc1 extension are converted

• existing *.dxf files for selected *.nc1 files will not be overwritten

DSTVtoDXFConverter.exe -cfg myPlateSettings -in “./NC Plates” -no_over_write -out “./Plate DXF” -f “PL*.nc1, BPL*.nc1, FLT*.nc1”

• attribute file with the name myPlateSettings is used

• the input folder is [modelFolder]\NC Plates

Import to and export from Tekla Structures
• the output folder is [modelFolder]\Plate DXF
• all the files that have PL, BPL, FLT as a prefix and .nc1 extension are converted
• existing *.dxf files for selected *.nc1 files will not be overwritten

You can also use the following parameters with DSTVtoDXFConverter.exe:
• To find out the version of the converter: DSTVtoDXFConverter.exe -!
• To see all the options and commands: DSTVtoDXFConverter.exe -?
• To list examples that use correct templates: DSTVtoDXFConverter.exe examples

Convert DSTV to DXF (old conversion tool)
You can create NC/DSTV files in DXF format by converting DSTV files to DXF files. Before running a DXF conversion, you must first create the NC files in DSTV format. The old conversion tool is available in Tekla Warehouse.

Install the DSTV to DXF converter
The old DSTV to DXF converter tool is available as an extension and can be installed as a TSEP package from Tekla Warehouse.
1. Download the DSTV to DXF converter installer package from Tekla Warehouse.
2. Install the TSEP package.

Convert DSTV files to DXF
You can convert the created DSTV files in DXF format by using the Convert DSTV files to DXF macro.

Limitation: The macro has been designed for simple plates. Therefore it may not give correct conversion results for beams, columns, and bent polybeams.
1. Create the NC files (page 345) in the DSTV format.

2. Click the Applications & components button in the side pane to open the Applications & components catalog.
3. Click the arrow next to Applications to open the applications list.
4. If Convert DSTV files to DXF is not visible in the Applications list, select the Show hidden items check box at the bottom of the Applications & components catalog.
5. Double-click Convert DSTV files to DXF to open the Convert DSTV files to DXF dialog box.
6. Browse for the folder that contains the DSTV files you want to convert to DXF files.
7. Select the DSTV files and click Open.

Tekla Structures automatically creates an NC_dxf folder under the model folder and creates the DXF files there.

**Convert DSTV files to DXF using tekla_dstv2dxf.exe**

You can use a separate Tekla Structures program tekla_dstv2dxf.exe to convert the DSTV files to DXF format. Only one side of a part (front, top, back or bottom) is written to the file, and therefore this export format is most suited to plates.

The program is located in the `..\Tekla Structures\<version>\bin \applications\Tekla\Tools\dstv2dxf` folder.

1. Create a folder for the DSTV files, for example `c:\dstv2dxf`.

   Do not use spaces in the folder path. You should not save the files, for example, in the Tekla Structures folder under the `\Program Files` folder, because the folder path contains spaces.

2. Copy all files from `..\Tekla Structures\<version>\bin \applications\Tekla\Tools\dstv2dxf` to the folder you created (`C:\dstv2dxf`).

3. Create DSTV files (page 345) and save the files in the folder you created (`C:\dstv2dxf`).


   The program converts the files to DXF format in the same folder.

   If you need to adjust the conversion settings, modify the settings in an appropriate `tekla_dstv2dxf_<env>.def` file and restart the conversion. A conversion file description in the PDF format can be found in the same folder as the `tekla_dstv2dxf.exe` program.

**MIS lists**

You can export an MIS list to a file.

You can export model data to use in Manufacturing Information Systems (MIS). The MIS export supports the following formats:

- **DSTV** - The exported file contains the MIS information written in the DSTV format.

- **KISS** - We recommend using the FabTrol reports instead of the MIS export for exporting FabTrol data. The FabTrol reports are available for the Steel Detailing role in the US environment. If you do not use a suitable environment you may also contact your local support for the FabTrol files.

  Note that plates will not export in the KISS format correctly.
• EJE - US environment, Imperial role only. Structural Material Manager internally stores all dimensions in sixteenths. Its External Data Interface writes all dimensions, such as widths and lengths, except for Beam and Channel descriptions, in sixteenths of an inch. As an example the length 12'-8 7/8 is equivalent to 2446 sixteenths, which is calculated as (feet * 192) + (inches * 16) + (eighths * 2) = (12 * 192 + 8 * 16 + 7 *2).

Tekla Warehouse also provides additional EJE report templates used to pass data from Tekla Structures into EJE's Structural Material Manager. Download the templates and save the templates in a folder defined for the templates by the advanced option XS_SYSTEM. You can modify these report templates if you wish.

• EPC - The EPC (Estimating and Production Control) module of SDS/2 requires multumbering to be active.

• Steel 2000

Export a MIS list

1. On the File menu, click Export --> MIS.
   The Export MIS dialog box opens.
2. Select the file type from the MIS type list.
3. If you selected KISS or Steel 2000, define the additional options:
   • KISS
     Enter the customer name in the Customer name box.
     Select the Full material list check box to add labor-related information to the list (for example, holes, welds, cambers, preliminary marks).
   • Steel 2000
     Select the Export only shop bolts check box to include only workshop bolts in the list file.
4. Enter a name for the list file in the MIS list file box.
   By default, the list file is saved in the model folder.
   You can select the folder where you want to save the list file by clicking Browse....
5. Ensure that you have the selection switch Select objects in components selected. If you have the switch Select assemblies selected, Tekla Structures will create empty files.
6. Click Create all or Create selected to export the MIS list file.
**CIS/2**
In order to use CIS/2 you need to download interoperability with Smart3D (S3D) from Tekla Warehouse.

You have the following S3D tool available for downloading in Tekla Warehouse:
- **Smart3D Interoperability**

Tekla User Assistance contains the following article about S3D:
- **Smart3D Interoperability**

**PDMS/E3D**
You have the following tools available for download in Tekla Warehouse:
- **PDMS/E3D and Tekla Structures Interoperability: Export to PDMS/E3D**
- **PDMS/E3D and Tekla Structures Interoperability: PDMS/E3D extension**
- **BIM Publisher**

Tekla User Assistance contains the following articles about PDMS/E3D:
- **PDMS/E3D and Tekla Structures Interoperability: Q&A, collected 7th March 2017**
- **AVEVA PDMS/E3D and Tekla Structures Interoperability: PDMS/E3D extension**
- **PDMS**

**ASCII files**
ASCII stands for American Standard Code for Information Interchange. Some plant design systems export ASCII files, for example, ModelDraft, PDS and PDMS.

You can import and export profiles and plates created as beams using the ASCII format. Contour plates cannot be imported.

**Import a model in ASCII format**
2. Create a new 3D view.
3. Copy the ASCII file to the model folder.
4. Name the file `import.asc`.
5. On the **File** menu, click **Import --> ASCII**.

   Tekla Structures displays the main parts created from the ASCII file in the model.
Export a model in ASCII format

1. Open the Tekla Structures model you want to export.
2. Select the parts in the model you want to export.
3. On the File menu, click Export --> ASCII.
   Tekla Structures creates a model.asc file in the current model folder.

ASCII file description

For a file description, see "ASCII file description" in Manage Tekla Structures.

Tekla PowerFab

You can export your Tekla Structures model data to Tekla PowerFab as a compressed package in the .pfxt or .zip format. The package contains an XML file with drawing revisions, bills of materials, and user-defined attributes, as well as directories with CNC files and drawing files.

Combining and estimating

You can export a preliminary list or an advanced bill of materials (ABM) from Tekla Structures to Tekla PowerFab for combining and estimating in Tekla PowerFab.

We recommend that before exporting an ABM from the modeling software, you create and apply preliminary marks (PRELIM_MARK) to all parts that are included in the export. This provides a way for Tekla PowerFab to link and compare the advanced bill of materials to the subsequent production bill of materials, allowing any changes to be identified.

You can use Tekla Structures IFC export to produce the IFC files needed for combining and estimating in Tekla PowerFab. For more information about the IFC export, see Export in IFC format.

For details on importing IFC files to Tekla PowerFab, see Import files to Tekla PowerFab, Import an IFC file to a combining job, and Import files to the Estimating module.

Fabrication

In the fabrication phase, you can export your Tekla Structures model data to Tekla PowerFab as a compressed package in the .pfxt or .zip format. The package contains an XML file with drawing revisions, bills of materials, and user-defined attributes, as well as folders with CNC files and drawing files.

This export is specific to importing to Tekla PowerFab Production Control.

For details about importing Tekla PowerFab files into Tekla Structures, see section "Import Tekla PowerFab XML into Tekla Structures" in the Tekla PowerFab Exchange support article.
**Export model to Tekla PowerFab**

1. In Tekla Structures, ensure the **Select objects in components** or **Select objects in assemblies** selection switch is enabled.

2. In the Tekla Structures model, select the objects that you wish to include in the fabrication package.

3. Select the drawings for the selected parts:
   a. To open **Document manager**, on the **Drawings & reports** ribbon tab, click **Document manager**.
   b. In the category list on the left, select **All drawings**.
   c. Click the **Select and show only drawings containing parts currently selected in the model**.

4. In the **File** menu, select **Export --> Tekla PowerFab**. The **Export to Tekla PowerFab** dialog box is displayed.

5. On the **Export to Tekla PowerFab** tab, to load predefined export settings, select the export settings from the list, and select **Load**.

6. On the **Export to Tekla PowerFab** tab, either select **Auto-generate file name**, or type the path and the name of the export file in the **Tekla PowerFab file name** box. Select the export file format **.pfxt** or **.zip**. The **.pfxt** file is a Tekla PowerFab Exchange File format file.

   **NOTE**  
   Commas are not allowed in the file path.

7. In the **Export settings** section, select which information you want to include in the export file.

   **Include BOM**: Select to include the production bill of materials in the export.

   When creating the fabrication package, we can also select to include the physical assembly, part, general arrangement and multidrawings. To do this, the drawings must be printed, typically to PDF, prior to the export being made.

8. In the **Drawing files** section, select which drawing files are exported, and where different types of drawings are stored.

9. In the **CNC files** section, select if and how you want to export CNC files.

   Whilst it is not mandatory, it is recommended to include the NC files in the fabrication package, as there are a number of workflows in the Tekla PowerFab desktop application that rely on them.

10. Select whether you want to embed the model file, upload the model file into Trimble Connect, or skip the generation of the model file.

11. Click **Export to Tekla PowerFab**. You can save the modified export settings for future use by selecting **Save**, or save the modified export
settings with another name by defining a new name and selecting Save as.

The standard settings file is saved with the name standard.TeklaPowerFabPluginSettings.xml in the \attributes folder under the model folder. If you save the settings with another name, the settings file will be saved as <name>.TeklaPowerFabPluginSettings.xml.

12. If any files are out of date or not found in the export, you get warning messages that notify you of these files. Do one of the following in the message box:
   • To continue despite the missing files, click Yes.
   • To cancel the export, click No.

Below are the most common validation issues.

<table>
<thead>
<tr>
<th>No CNC files found</th>
<th>An NC file for one or more parts cannot be found in the specified folder. The part numbers are listed in the log area.</th>
</tr>
</thead>
<tbody>
<tr>
<td>No drawing files found</td>
<td>A drawing file for one or more assembly or part cannot be found in the specified folder. The part numbers are listed in the log area</td>
</tr>
<tr>
<td>Out of date drawings</td>
<td>One or more drawings is out of date. Such drawings will not be included in the export.</td>
</tr>
<tr>
<td>Numbering not up to date</td>
<td>The export has detected that the numbering may be out of date. If you are confident that the numbering is up to date, often running the Repair model tool can resolve this.</td>
</tr>
</tbody>
</table>

Any warnings and error messages are shown in the white text box at the bottom of the Export to Tekla PowerFab dialog box. When the export is complete, the path to the exported file is shown in this text box.

Once the export is finished, the log will display “Export completed“ and a Windows Explorer window will open showing the exported fabrication package, as a .zip file. The .zip file can be opened to view its contents, which includes the bill of materials (in XML format), the PDF drawings organized by type, and the NC files.

Next, the export file can be imported into Tekla PowerFab. For more information, see Import files to Tekla PowerFab.
Import files to a production control job

For more information on the export settings, see the table below.

**Export settings for Tekla PowerFab**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tekla PowerFab file name</td>
<td>When the <strong>Auto-generate file name</strong> option is <strong>not</strong> selected, you can type a file name, select .pfxt or .zip, and click ... to browse to and select the folder where the file is saved.</td>
</tr>
<tr>
<td>Auto-generate file name</td>
<td>When the <strong>Auto-generate file name</strong> option is selected, the export file is saved in the Tekla PowerFab folder under the model folder. You can select the file extension .pfxt or .zip. The file name format is &lt;project number&gt;_&lt;number of the export&gt;. For example, if a model has the project number PROJ-NUM, the first export is saved to TeklaStructuresModels\PowerFab-01\Tekla PowerFab \PROJ-NUM_1.pfxt. The next export will have the same path except for the number, which will be 2.</td>
</tr>
</tbody>
</table>
| Export assembly drawings     | Select which assembly drawing information you want to include in the export:  
  - **All** exports information of all assembly drawings in the model.  
  - **Selected from Drawing list** only exports information of the assembly drawings that are currently selected in **Document manager**.  
  - **Selected from model** only exports information for assembly drawings currently selected in the model.  
Drawing files are not included if you have selected the **Do not export drawing files** option. |
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include BOM</td>
<td>When this option is selected, bill of material (BOM) information is included in the export. The export package (either a .zip or .pfxt file) will include the bill of materials in the form of an XML file. This is required for populating the assemblies and parts in the Production Control job in Tekla PowerFab. This needed in many downstream processes, such as purchasing, production tracking and shipping. You would usually select this option, because a BOM is an integral element of the issuing process. However, an example of when you may not want to select the option is if you only want to export the drawings into Tekla PowerFab to be sent for approval before the final fabrication package is issued.</td>
</tr>
<tr>
<td>Include single-part drawings</td>
<td>When this option is selected, single-part drawing information is included in the export. Drawing files are also included if you have not selected the <strong>Do not export drawing files</strong> option.</td>
</tr>
<tr>
<td>Include general arrangement</td>
<td>When this option is selected, general arrangement drawing information is included in the export. Drawing files are also included if you have not selected the <strong>Do not export drawing files</strong> option.</td>
</tr>
<tr>
<td>drawings</td>
<td></td>
</tr>
<tr>
<td>Include multidrawings</td>
<td>When this option is selected, multidrawing information is included in the export. Drawing files are also included if you have not selected the <strong>Do not export drawing files</strong> option.</td>
</tr>
<tr>
<td>Include drawing UDAs</td>
<td>When this option is selected, user-defined attributes for drawings are included in the export. In the list on the right, select which information is included:</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>From report</td>
<td>includes information from your 450 TeklaPowerFab_Drawing_UserDefined_v1.rpt report. By default, the Drawn by, Checked by, and Checked date values are included.</td>
</tr>
<tr>
<td>From drawing (slow)</td>
<td>includes all user-defined attributes in drawings. Note that this might take some time.</td>
</tr>
<tr>
<td>From both (slow)</td>
<td>includes information from both the 450 TeklaPowerFab_Part_UserDefined_v1.rpt report and the drawing. Note that this might take some time.</td>
</tr>
</tbody>
</table>

To customize the user-defined attributes in the export file, see the Customize user-defined export information instructions.

<table>
<thead>
<tr>
<th>Include part UDAs</th>
<th>When this option is selected, user-defined attributes for parts are included in the export.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>In the list on the right, select which information is included:</td>
</tr>
<tr>
<td>From report</td>
<td>includes information from your 450 TeklaPowerFab_Part_UserDefined_v1.rpt report. By default, user-defined fields 1-4 and comment are included.</td>
</tr>
<tr>
<td>From model</td>
<td>generates part information directly from the model.</td>
</tr>
<tr>
<td>From both</td>
<td>includes information from both the 450 TeklaPowerFab_Part_UserDefined_v1.rpt report and the model.</td>
</tr>
</tbody>
</table>

To customize the user-defined attributes in the export file, see the...
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include bolts-nuts-washers</td>
<td>When this option is selected, bolt, nut, and washer information is included in the export.</td>
</tr>
<tr>
<td>Include bolt-nut-washer UDAs</td>
<td>When this option is selected, user-defined attributes for bolts, nuts, and washers are included in the export. In the list on the right, select which information is included:</td>
</tr>
<tr>
<td></td>
<td>• From report includes information from your 450 TeklaPowerFab_BoltNutWasher_UserDefined_v1.rpt report. By default, the GUID, IsBoltNutWasher value, and comment are included.</td>
</tr>
<tr>
<td></td>
<td>• From model generates nut, bolt, and washer information directly from the model.</td>
</tr>
<tr>
<td></td>
<td>• From both includes information from both the 450 TeklaPowerFab_BoltNutWasher_UserDefined_v1.rpt report and the model.</td>
</tr>
<tr>
<td></td>
<td>To customize the user-defined attributes in the export file, see the Customize user-defined export information instructions.</td>
</tr>
<tr>
<td>Include studs</td>
<td>When this option is selected, stud information is included in the export.</td>
</tr>
<tr>
<td>Include stud UDAs</td>
<td>When this option is selected, user-defined attributes for studs are included in the export.</td>
</tr>
<tr>
<td></td>
<td>In the list on the right, select which information is included:</td>
</tr>
<tr>
<td></td>
<td>• From report includes information from your 450 TeklaPowerFab_Stud_UserDefined_v1.rpt report. By default, the stud GUID and comment are included.</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>From model</td>
<td>• From model generates stud information directly from the model.</td>
</tr>
<tr>
<td>From both</td>
<td>• From both includes stud information both from the 450 TeklaPowerFab_Stud_UserDefined_v1.rpt report and the model. To customize the user-defined attributes in the export file, see the Customize user-defined export information instructions.</td>
</tr>
<tr>
<td>Embed the model file</td>
<td>When the model file is made available for Tekla PowerFab, either by embedding it into the export file or by having it uploaded to Trimble Connect, then the Tekla PowerFab import is able to use Trimble Connect for Windows to generate a comparison model between the new version of the model and the one provided by the previous import. This allows you to not only see in Tekla PowerFab the details of the data that has changed, but to visualize those changes in Trimble Connect for Windows to understand the full context of the change.</td>
</tr>
<tr>
<td>Upload the model file to Trimble Connect</td>
<td></td>
</tr>
<tr>
<td>Do not generate a model file</td>
<td></td>
</tr>
<tr>
<td>Do not export drawing files</td>
<td>When this option is selected, no drawing files are included in the export.</td>
</tr>
<tr>
<td>Use drawing files from folder</td>
<td>When this option is selected, drawing files from the folder defined below are included in the export. The default folder is .\PlotFiles. To change the folder, click ... next to the text box. Then, browse to and select the folder. Note that the drawing file names must match the drawing number, excluding the file extension. For example, the right file name for drawing 200 would be 200.</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Assembly drawing sub-folder</td>
<td>Saving drawing types in different folders is optional. We recommend that you do so if you have drawings of different types with the same name. Having different drawing types in different folders also makes it easy for Tekla PowerFab to place the drawings in the right drawing logs. To select the folders, click ... next to each text box. Then, browse to and select the folder where the current drawing type should be saved.</td>
</tr>
<tr>
<td>Single-part drawing sub-folder</td>
<td></td>
</tr>
<tr>
<td>GA drawing sub-folder</td>
<td></td>
</tr>
<tr>
<td>Multidrawing sub-folder</td>
<td></td>
</tr>
<tr>
<td>Do not export CNC files</td>
<td>When this option is selected, CNC files will not be included in the export.</td>
</tr>
<tr>
<td>Generate CNC files - settings</td>
<td>When this option is selected, Tekla Structures generates CNC files from the current model. The exported CNC files are UTF-8 encoded. In the list below, select the CNC export settings file that you want to use.</td>
</tr>
<tr>
<td>Use CNC files from folder</td>
<td>When this option is selected, CNC files from the folder set below are included in the export. The default folder is .\NC_Files. To change the folder, click ... and browse to and select the folder. Note that the file names need to match the piece mark, excluding the file extension. For example, the right CNC file name for piece mark w104 would be w104.</td>
</tr>
</tbody>
</table>

For more information about adding drawings to Tekla PowerFab, see Add, modify, and delete drawings.

**Customize user-defined attributes for Tekla PowerFab export**

The user-defined attributes for the export comes from the following reports, which you can customize to adjust which information is included in the export:

- 450 TeklaPowerFab_Drawing_UserDefined_v1.rpt
• 450 TeklaPowerFab_Part_UserDefined_v1.rpt
• 450 TeklaPowerFab_Stud_UserDefined_v1.rpt
• 450 TeklaPowerFab_BoltNutWasher_UserDefined_v1.rpt

**NOTE** • Do not customize any of the other reports related to the Tekla PowerFab export.
  • Always keep extra copies of the customized reports in a separate folder.

1. Open the environment folder where the reports are stored.
   For example, open `C:\ProgramData\Trimble\Tekla Structures \<version> Daily\Environments\Steel\reports`.
2. Create a copy of the desired report and move it to another folder.
3. Open the copy in a text editor, such as Microsoft Notepad.
4. Customize the copy according to your needs.
   Note that:
   • Each field must be separated by a tab character.
   • The report needs to have a single-line header containing the name of each field. These field names are included in the export file, so that the user can decide to which Tekla PowerFab fields the information should be mapped.
   • Each field name can be used only once.
   • Each field in the report needs to consist of a single line.
   • In the 450 TeklaPowerFab_Part_UserDefined_v1.rpt report, the first field needs to be the part GUID, and the name in the report header for the first field needs to be `GUID`.
   • In the 450 TeklaPowerFab_Drawing_UserDefined_v1.rpt report, the first field needs to be the drawing ID, and the name in the report header for the first field needs to be `ID`.
5. Save the copy.
6. Move the copy to the right folder, and overwrite the existing report.

**Exported bolt XML data**

**Default data included in XML file**

<table>
<thead>
<tr>
<th>Data</th>
<th>Description</th>
<th>Example Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>PartId</td>
<td>Globally Unique Identifier (GUID) of the bolt group.</td>
<td>`&lt;PartId&gt;1cd0dbe6-bc01-4dd4-</td>
</tr>
</tbody>
</table>

Import to and export from Tekla Structures  396  Steel fabrication
<table>
<thead>
<tr>
<th>Data</th>
<th>Description</th>
<th>Example Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>PartMark*</td>
<td>This will always be blank because bolts in Tekla Structures do not have part marks.</td>
<td>&lt;PartMark /&gt;</td>
</tr>
<tr>
<td>MainMember*</td>
<td>This will always be false because bolts in Tekla Structures are always attached to a member and never the main member.</td>
<td>&lt;MainMember&gt;false&lt;/MainMember&gt;</td>
</tr>
<tr>
<td>PartQuantity</td>
<td>Number of bolts in the bolt group.</td>
<td>&lt;PartQuantity&gt;3&lt;/PartQuantity&gt;</td>
</tr>
<tr>
<td>Shape</td>
<td>The default values for shape are HS, MB, NU, WA, or STD. *</td>
<td>&lt;Shape&gt;HS&lt;/Shape&gt;</td>
</tr>
<tr>
<td>Dimensions</td>
<td>The <strong>diameter</strong> and <strong>length</strong> of the bolt as defined in the Bolt catalog properties. *</td>
<td>&lt;Dimensions Metric=&quot;0&quot;&gt;HS 0.75&quot; x 2.5&quot;&lt;/Dimensions&gt;</td>
</tr>
<tr>
<td>Grade</td>
<td>For Bolts (HS or MB), the grade is defined by the <strong>Standard</strong> set in Bolt assembly catalog properties.*</td>
<td>&lt;Grade&gt;F1852&lt;/Grade&gt;</td>
</tr>
<tr>
<td></td>
<td>For Nuts, washers, and Studs, the grade is defined by the <strong>Standard</strong> set in the Bolt catalog properties.*</td>
<td></td>
</tr>
<tr>
<td>Length**</td>
<td>The length value will not be populated as it is provided in the Dimensions.</td>
<td>&lt;Length UOM=&quot;in&quot;/&gt;</td>
</tr>
<tr>
<td>Remark</td>
<td>Will report Field or Shop based on bolt group the <strong>Bolt type</strong> property.</td>
<td>&lt;Remark&gt;Field&lt;/Remark&gt;</td>
</tr>
</tbody>
</table>

* The SHAPE and GRADE data may be overridden by the hard-coded translations. See section "Hard-coded translations" below.

** These fields are sections that are required for parts, but are not applicable to bolts. Because the format for bolts is the same, the values will be empty.
Shape
The default values for SHAPE are HS, MB, NU, WA, or STD depending on the type specified in the **Bolt Catalog**.

It is possible to manually override the individual bolt group bolt SHAPE by specifying a user-defined value for the bolt shape. It is not possible to manually override the nut or washer SHAPE values.
**Grade (Material)**

Bolt assembly GRADE data is output differently depending on the component of the assembly. Bolts obtain the GRADE data based on the **Standard** value for the assembly in the *Bolt Assembly Catalog*. 

---

**THE HARD CODED BOLT SHAPES CAN BE OVERRIDDEN WITH THE USER DEFINED VALUE “Bolt Shape”**
All other bolt assembly elements obtain the GRADE data based on the Standard value for the assembly in the Bolt Catalog.

The grade data for bolts (HS or MB) is populated by the bolt assembly Standard value.

The grade data for nuts, washers, and studs is populated by the bolt Standard value.
Hard-coded translations

When Export to Tekla PowerFab compiles the XML file data, there are a few hard-coded translations that are performed. These can affect both the <SHAPE> and <GRADE> data that is exported.

**NOTE** The translations are not applied when you specify a user-defined bolt shape.

Anytime a Grade contains the text "TC", then the shape is set to "HS":

<SHAPE>HS</SHAPE>

If the bolt Grade contains "TC" and "A325", then the grade is set to "A325TC":

<GRADE>A325TC</GRADE>

If the bolt Grade contains "TC" and "A490", then the grade is set to "A490TC":

<GRADE>A490TC</GRADE>

If the bolt Grade does not contain "TC", but does contain "A325", "A490", "F1852", "F2280", or "F3148", then the shape is "HS", and the grade is left as-is:

<SHAPE>HS</SHAPE>

If the bolt Grade does not contain "TC" and is not any of those grades, then the shape is set to "MB":

<SHAPE>MB</SHAPE>

**Example XML data for bolt assembly**

```xml
<AssemblyPart>
  <PartId>1cd0dbe6-bc01-4dd4-a47d-4a78c4766642</PartId>
  <PartMark />
  <MainMember>false</MainMember>
  <PartQuantity>1</PartQuantity>
  <Shape>HS</Shape>
  <Dimensions Metric="0">HS 0.75" x 1.5"</Dimensions>
  <Grade>A325TC</Grade>
  <Length UOM="in"></Length>
  <Remark>Field</Remark>
</AssemblyPart>

<AssemblyPart>
  <PartId>1cd0dbe6-bc01-4dd4-a47d-4a78c4766642</PartId>
  <PartMark />
  <MainMember>false</MainMember>
  <PartQuantity>1</PartQuantity>
  <Shape>NU</Shape>
  <Dimensions Metric="0">NU 0.75"</Dimensions>
  <Grade>HEAVY HEX</Grade>
  <Length UOM="in"></Length>
  <Remark>Field</Remark>
</AssemblyPart>

<AssemblyPart>
  <PartId>1cd0dbe6-bc01-4dd4-a47d-4a78c4766642</PartId>
  <PartMark />
  <MainMember>false</MainMember>
  <PartQuantity>1</PartQuantity>
  <Shape>WA</Shape>
  <Dimensions Metric="0">WA 0.75"</Dimensions>
  <Grade>PLAIN</Grade>
</AssemblyPart>
```

Import to and export from Tekla Structures 401 Steel fabrication
3.14 Automated precast fabrication

With Tekla Structures you can efficiently deliver all types of precast concrete elements at the right time to the right place by integrating design and detailing with manufacturing, project management and efficient information sharing.

For the precast fabricators, the target is to offer functionalities to help to optimize the whole precast construction process from modeling to fabrication to site operations, minimize errors and waste in all stages and improve collaboration between project parties in design, production and site.

The offering consist of several product listed below.

Unitechnik

Unitechnik (from the company Unitechnik) is the most common format for exporting precast and mesh geometry as well as production data. Unitechnik is for precast panels and slabs and other products that are manufactured in a pallet circulation as well as for reinforcement meshes.

The Unitechnik format is not used only by UniCAM but also by other industry solutions such as Leit2000.

Export to Unitechnik (page 404) versions 5.0c - 6.1 are available in Tekla Structures core installation in the most extensive precast-related configurations.

ELiPLAN

ELiPLAN is an ERP software from machinery provider Elematic. The file format .eli also contains production data and geometry for CAM-operated hollow-core slab production.

Both EliPLAN export from and import to (page 499) Tekla Structures are available in the Tekla Structures installation in the most extensive precast-related configurations.

HMS

HMS is a CAM software for hollow-core production.

The export to HMS (page 524) software is included in the Tekla Structures installation in the most extensive precast-related configurations.

BVBS

Reinforcement geometry can be exported to German BVBS (Bundesvereinigung Bausoftware) format. The result is a text file in ASCII format.
You can export cut and bent reinforcing bars, reinforcing bar groups and reinforcement meshes, which can be rectangular, polygonal, non-bent or bent, and may include cuts. The export of hooks is also supported.

The supported version of the BVBS format is 2.0 from year 2000. **BVBS export** (page 483) is available in Tekla Structures installation in the most extensive configurations.

**UXML**

UXML (from the company Unitechnik) is for precast panels and slabs and other products that are manufactured in a pallet circulation as well as for reinforcement meshes.

Tekla Structures supports exporting both to Unitechnik and UXML formats.

Precast Production Export for UXML can be found as an extension in **Tekla Warehouse**. For instruction on how to use the export, see **Precast Production Export**.

**PXML**

The data format of progress XML also known as PXML has been developed by Progress Software Development, which is part of precast solution provider Progress Group. Data format is based on hierarchically structured XML for the generation of data and production control and scheduling at precast or rebar prefabrication factories. PXML contains both the product geometry to be used in production and the attribute data for managing the related processes (ERP data). In particular, there are two different areas of application:

- interface between systems of different manufacturers
- internal (proprietary) storage of data of CAD/CAM systems

PXML is the main data format to bring design geometry between detailer's Tekla Structures and factory's Progress software such as ebos, erpbos, ProFit and AviCAD.

Precast Production Export for PXML can be found as an extension in **Tekla Warehouse**. For instruction on how to use the export, see **Precast Production Export**.

**Precast planning tools**

There are some precast planning tools available in Tekla Warehouse, such as:

- **Palletizer**: Practical, easy-to-use and efficient workflow tool for arranging different types of precast elements on production pallets.
- **Stacker**: Interactive 3D-model-based truck-load planning application helps you to efficiently plan the transportation units for optimal deliveries with less crane time needed at the factory and site.

For other concrete tools in Tekla Warehouse, see **Concrete**.
**Unitechnik**

You can export the 3D geometry of the cast units in the Unitechnik format. The result is a text file in the ASCII format.

Supported versions of the Unitechnik format are:

- 6.1.0 17.9.2009
- 6.0.0 14.6.2005
- 5.2b 11.9.2000
- 5.0c 30.10.1997

The Unitechnik format is intended for the production of the geometry of pallet- or table-produced precast elements such as solid, sandwich or double walls as well as panel slabs and half-slabs. You can export cast units consisting of concrete, steel and surface materials. Exporting of reinforcing bars (bent and not-bent), reinforcing bar groups and meshes with hooks is also supported.

**Example**

Exported cast unit:

1. Hole
2. Steel embed
(3) Reinforcing bars, cages also supported (UT version 6.1.0)
(4) Insulation plate (green)

For details about exporting in the UXML and PXML formats, see Precast Production Export. You can download Precast Production Export from Tekla Warehouse.

To ensure the best possible export result, see Best practices in modeling, validating and exporting for Unitechnik (page 467).

**Limitations in Unitechnik export**

The Unitechnik format is for flat panels and slabs for production in pallet circulation plants. It is an open format used by many different production system master computers, and therefore the specifications are quite strict, and field character lengths are limited, for example. The different master computers from different solution providers also have different interpretations of the Unitechnik data. The original format is from early 2000's, and it is a bit outdated in many aspects. As a result, the Unitechnik format has certain limitations:

- Cast units with cast unit type cast-in-place are not exported.
- All Unitechnik fields have a maximum character length, both for geometry and attribute information.
  - While Tekla Structures supports input of longer strings, the data has to be cut and simplified, or the export may be prevented completely. The log will notify if this happens.
  - Negative values in certain geometry fields (negative pallet X, Y, and Z coordinates, for example) will cause errors in production systems, even though the geometry comes correctly from the model.
  - Also the number of fields per hierarchy object is limited, although each has also unspecified reserve fields for customer-specific cases.
- 3D shapes are not supported.
  - 3D concrete shapes are not supported (except for edge shapes in line attributes)
  - 3D embed shapes are not supported
  - 3D bent rebar shapes are not supported
- When using terminal hook flection forms, the rebars and meshes can be bent only in one direction (hooks up or hooks down, for example).
- One Unitechnik file may only have one HEADER block, but it may have several SLABDATE blocks.
  - Double wall elements are an exception. They should be exported in one file, with each shell having its own HEADER information.
Export in Unitechnik format

1. Go to the part properties of the parts that you plan to export, and edit the user-defined attributes on the **Unitechnik** and **Delivery** tabs (or **Unitechnik Mountpart** tab for steel parts) as required. The user-defined attributes are environment specific, so you may not have all the settings below available:

<table>
<thead>
<tr>
<th>Unitechnik tab:</th>
<th>Product type</th>
<th>User-defined product type</th>
<th>Product group</th>
<th>Product addition</th>
<th>Storey</th>
<th>Surface smoothing</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Parts:</strong></td>
<td>Product type is important for identifying the object type in CAM software. Undefined product type will result in error notification while importing the production data file. You can define the product type by selecting one of the options, or by defining a user-defined text. Product type affects the file structure of the exported element. Certain product types, such as double walls, sandwich walls and thermo walls set custom export logics to ensure that the panel production stages are transferred correctly. With double walls and thermo walls, you can use the user-defined product type setting for the special logic with an alternate product type identifier.</td>
<td>Optional field for product type.</td>
<td>Optional field for product group. The product group is used in the SLABDATE block.</td>
<td>This attribute is exported with Unitechnik export (79) to object’s SLABDATE block as a representative number 00-03. The available options are <strong>Standard element</strong>, <strong>Balcony</strong>, <strong>Roof</strong>, and <strong>Plastered element</strong>.</td>
<td>Optional field used for planning the transport and erection processes.</td>
<td>Select whether to smooth the surfaces or not. The default value is blank.</td>
</tr>
<tr>
<td><strong>Concreting identification (LOT block)</strong></td>
<td>You can select <strong>No special treatment</strong> or <strong>Shovel concrete</strong>, or leave the field empty.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Layer split thickness</strong></td>
<td>Manually define the layers with names and thicknesses.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Layer not to export</strong></td>
<td>Specify the layer that you do not want to export.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Mountpart data from UDA</strong></td>
<td>Select whether you want to export mountpart data from the user-defined attributes.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Exclude from export</strong></td>
<td>Select whether you want to exclude mountparts from export.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| **Identification of installation** | Select one of the following options:  
  - Installed (0)  
  - Only plotted (1)  
  - Only installed (2)  
  - Not installed, not plotted (3)  
  - Installed in reinforcement (4)  
  - Installed automatically (5) |
| **Type of mounting part** | Define the type of mounting part by entering a user-defined attribute. |
| **Reference number** | Define the reference number of a mounting part by entering a user-defined attribute. |
| **Mountpart name** | Enter the mountpart name. |
| **Info 1 text (UT 6.0)** | Specify more information, if necessary. |
| **Info 2 text (UT 6.0)** | Specify more information, if necessary. |
| **Delivery tab:** | Specify the unloading type. |
| **Unloading type** | **Pallets (00)**  
  - A-frame (01)  
  - Inside loader (02) |
| **Transport unit number** | Optional fields used for planning the transport and erection processes. These can be defined in the export settings to be included as part of SLABDATE block.
### Transport pile number
Optional field that specifies the transport pile number.

### Transport pile level number
Optional field that specifies the transport pile level number. If there are elements in the stack that need to be layered on the same level, then the pile level is used if the transport sequence number is the same for the pile. This can be defined in the export settings to be included as part of SLABDATE block.

For example, you may have a pile of 6 slabs, and they each have sequential pile level numbers 1, 2, 3.. 6.

### Surface objects:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Use surface as pallet base</strong></td>
<td>Orient the object without changing the top-in-form face or the rotation in export settings.</td>
</tr>
<tr>
<td><strong>Align pallet direction</strong></td>
<td>If you did not select to use the surface object as the pallet base, you can use <strong>Align pallet direction</strong> to rotate the element in plane so that the selected face is towards the pallet X axis, and aligns towards the X direction. This setting overrides all other rotation settings.</td>
</tr>
<tr>
<td><strong>Line type</strong></td>
<td>Select manual or predefined line type.</td>
</tr>
<tr>
<td><strong>Line attribute code</strong></td>
<td>If you selected manual line type, type the line attribute code.</td>
</tr>
</tbody>
</table>

### Unitechnik reinforcement type
Overrides the automatically assigned Unitechnik reinforcement type, which is used to define the rebar/mesh wire layer within the element or mesh.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Cage group number</strong></td>
<td>Used to group together specific rebars into a cage.</td>
</tr>
<tr>
<td><strong>Cage type</strong></td>
<td>Unitechnik cage type data attribute</td>
</tr>
<tr>
<td><strong>Cage shape</strong></td>
<td>Unitechnik cage shape data attribute</td>
</tr>
<tr>
<td><strong>Mesh type</strong></td>
<td>Overrides the automatically assigned Unitechnik mesh type.</td>
</tr>
</tbody>
</table>

2. Check the settings on the **Unitechnik** tab in user-defined reinforcement attributes and change them as required. Ensure that rebars are not accidentally grouped into mesh or cage.
3. We recommend that you define the top-in-form face. Do this before creating any drawings.

4. Update numbering.
   
   **Export Unitechnik** reads and exports data from the numbering series of parts. It is important that all exported parts are numbered correctly. Incorrectly numbered parts are not exported.

5. On the **File** menu, click **Export --> Unitechnik**.
   
   The **Export Unitechnik** dialog box is displayed.

6. Define the Unitechnik export properties on the various tabs.

7. Select objects using **Select assemblies** (recommended) or **Select objects in assemblies** depending on the option that you selected for **Create from** on the **Main** tab. You can also enter the cast unit positions to be exported manually.

8. Click **Create**.
   
   By default, .uni output files are created in the \UT_Files folder under the current model folder. The number of output files depends on the options selected from the **Create from** list on the **Main** tab, and on the total number of selected parts, cast units, or assemblies.

   During the export, information on the export progress is shown in the export progress window.

   When the export is ready, the export log is displayed. See the **Log files** tab for additional log options.

   ![Image of the Export Unitechnik dialog box]

   The maximum number of exported elements or layers is limited to 99. If the limitation is exceeded, you will be notified by a console and log file message.
**Unitechnik export: Main tab**

**NOTE** When specifying object names: If names consist of several words, enclose those in quotation marks and use spaces between words, for example, "WORD1 WORD2".

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Unitechnik version</strong></td>
<td>Select the Unitechnik version.</td>
</tr>
<tr>
<td><strong>Create from</strong></td>
<td>Select which parts or cast units are exported.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Selected cast units</strong></td>
</tr>
<tr>
<td></td>
<td>Only cast units that have one or more parts selected in the model are exported. Each cast unit has one output file. Select <strong>By cast unit Id</strong> or <strong>By cast unit position</strong>.</td>
</tr>
<tr>
<td></td>
<td>• <strong>All parts</strong></td>
</tr>
<tr>
<td></td>
<td>All cast units are exported. Each cast unit has one output file. Select <strong>By cast unit Id</strong> or <strong>By cast unit position</strong>.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Selected parts (separately)</strong></td>
</tr>
<tr>
<td></td>
<td>Only the selected concrete parts (also embeds and insulation parts belonging to the selected part) are exported. Each part has one output file.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Selected parts (cast united)</strong></td>
</tr>
<tr>
<td></td>
<td>Selected parts belonging to one cast unit are grouped and exported together in one output file. Select <strong>By cast unit Id</strong> or <strong>By cast unit position</strong>.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Selected assemblies</strong></td>
</tr>
<tr>
<td></td>
<td>This option is recommended in most cases. All selected assemblies are exported. One assembly equals one cast unit and has one output file. Selection of subassemblies is also allowed.</td>
</tr>
</tbody>
</table>

In the rebar assembly export, the rebar assembly types **Mesh**, **Bent mesh**, and **Roll mat** are collected and exported as mesh. The rebar assembly type is defined in the rebar assembly properties. If the rebar assembly type is undefined or **Cage**, the rebar assemblies are exported as cages. Rebar assemblies of the type **Braced girder** are exported as braced girders, and the assemblies of the type **Embed**
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>are exported as mountparts. As the cage is not supported in Unitechnik versions below 6.1.0., the cage rebars will be exported as loose.</td>
<td></td>
</tr>
<tr>
<td><strong>Cast units in list</strong></td>
<td>Select the cast units for export from the Cast unit position list you enter.</td>
</tr>
<tr>
<td><strong>By cast unit Id</strong></td>
<td>Each cast unit has its own output file.</td>
</tr>
<tr>
<td><strong>By cast unit position</strong></td>
<td>Identical cast units share an output file.</td>
</tr>
<tr>
<td><strong>Export using filter</strong></td>
<td>Use a selection filter to select the parts for export. You can use the selection filter for including the parts in or excluding the parts from the export.</td>
</tr>
<tr>
<td><strong>Parts excluded from export (class or name)</strong></td>
<td>If you do not want to export some parts, enter the classes or names of these parts. You can also filter out rebars with this setting. Parts with classes in this list will not be exported.</td>
</tr>
<tr>
<td><strong>Directory path</strong></td>
<td>Define where the export files are saved. The default folder is .\UT_Files under the current model folder.</td>
</tr>
<tr>
<td><strong>File name Extension</strong></td>
<td>Select the name of the output file from the lists and specify the file name extension. You can use up to 5 strings to generate the export file names. Select options from the lists, definition values or attributes, and an optional string length limiter. You can leave the box empty if you do not need all 5 strings. You can use the delimiter period (.), dash (-), or underscore (_) between the strings.</td>
</tr>
<tr>
<td>• <strong>Proj. nr</strong> is the number of the project.</td>
<td></td>
</tr>
<tr>
<td>• <strong>Proj. name</strong> is the name of the project.</td>
<td></td>
</tr>
<tr>
<td>• <strong>CU nr</strong> is the assembly position number of the main part of the cast unit.</td>
<td></td>
</tr>
<tr>
<td>• <strong>Phase</strong> is the current phase.</td>
<td></td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>• CU pos</td>
<td>is the assembly position of the main part of the cast unit.</td>
</tr>
<tr>
<td>• ACN</td>
<td>is the assembly control number. To generate the assembly control numbers, go to the <strong>Drawings &amp; reports</strong> tab and click <strong>Numbering --&gt; Assign control numbers</strong>.</td>
</tr>
<tr>
<td>• Part ID</td>
<td>is the ID number, which is 10 characters long. If the ID number is not 10 characters long, zeros are added in front of the ID number to make it 10 characters long. For example, id number <strong>456999</strong> will be <strong>0000456999</strong>.</td>
</tr>
<tr>
<td>• Counter</td>
<td>adds a running number at the end of the file name, if the name already exists.</td>
</tr>
<tr>
<td>• Other options</td>
<td>are <strong>Date</strong>, <strong>Time</strong>, <strong>Date-Time</strong>, <strong>UDA</strong>, <strong>Text</strong>, <strong>Template</strong>, and <strong>Project UDA</strong>. <strong>Date</strong>, <strong>Date-Time</strong> and <strong>Time</strong> use the format <strong>yyyy-mm-dd-hh-mm</strong>. <strong>Template</strong> means a template attribute. <strong>UDA</strong> and <strong>Template</strong> are always read from the main part.</td>
</tr>
<tr>
<td></td>
<td>Also define the file name extension. By default it is <strong>Text</strong> and <strong>uni</strong>. You can select another option from the list.</td>
</tr>
<tr>
<td><strong>File name mask</strong></td>
<td>The format (length) of the output file name and file name extension. Numbers represent the length of the output string. If the name is longer than the selected option, it is cut.</td>
</tr>
<tr>
<td><strong>Open folder after export</strong></td>
<td>Select whether the folder where the output file is saved is opened after the export.</td>
</tr>
<tr>
<td><strong>Blank symbol in exported file</strong></td>
<td>Select the blank symbol to be used in the export file.</td>
</tr>
<tr>
<td></td>
<td>An example with &quot;_&quot; symbol:</td>
</tr>
<tr>
<td></td>
<td>HEADER__ 005 57_____ W1_____ W 57__ Corporation__</td>
</tr>
<tr>
<td></td>
<td>An example with &quot; &quot; symbol:</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Output file structure</strong></td>
<td><strong>Structure of the exported file (slab date and layer part).</strong></td>
</tr>
<tr>
<td></td>
<td>In most cases, you do not need to use this setting.</td>
</tr>
<tr>
<td>• <strong>Multiple layers</strong></td>
<td>One <strong>SLABDATE</strong> block with N layers. Each cast unit has its own <strong>LAYER</strong> block. Embeds, reinforcement and insulations belong to one concrete part, and they are exported to the related <strong>LAYER</strong> block.</td>
</tr>
<tr>
<td></td>
<td>If the layers are not defined correctly, it will result in error.</td>
</tr>
<tr>
<td>HEADER__</td>
<td></td>
</tr>
<tr>
<td>005</td>
<td></td>
</tr>
<tr>
<td>57  W1  W1</td>
<td></td>
</tr>
<tr>
<td>57 Corporation</td>
<td></td>
</tr>
<tr>
<td>SLABDATE</td>
<td></td>
</tr>
<tr>
<td>LAYER__</td>
<td></td>
</tr>
<tr>
<td>END LAYER__</td>
<td></td>
</tr>
<tr>
<td>LAYER__</td>
<td></td>
</tr>
<tr>
<td>END LAYER__</td>
<td></td>
</tr>
<tr>
<td>LAYER__</td>
<td></td>
</tr>
<tr>
<td>END LAYER__</td>
<td></td>
</tr>
<tr>
<td>LAYER__</td>
<td></td>
</tr>
<tr>
<td>END LAYER__</td>
<td></td>
</tr>
<tr>
<td>END SLABDATE</td>
<td></td>
</tr>
<tr>
<td>END HEADER__</td>
<td></td>
</tr>
<tr>
<td>• <strong>Single layer, 1 slabdate, 1 part</strong></td>
<td>Each cast unit has its own <strong>SLABDATE</strong> block, no <strong>LAYER</strong> blocks.</td>
</tr>
<tr>
<td>HEADER__</td>
<td></td>
</tr>
<tr>
<td>SLABDATE</td>
<td></td>
</tr>
<tr>
<td>END SLABDATE</td>
<td></td>
</tr>
<tr>
<td>SLABDATE</td>
<td></td>
</tr>
<tr>
<td>END SLABDATE</td>
<td></td>
</tr>
<tr>
<td>SLABDATE</td>
<td></td>
</tr>
<tr>
<td>END SLABDATE</td>
<td></td>
</tr>
<tr>
<td>END SLABDATE</td>
<td></td>
</tr>
<tr>
<td>END HEADER__</td>
<td></td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>• <strong>Single layer, n slabdate, n parts</strong></td>
<td>Cast units with equal geometry are collected in one <code>SLABDATE</code> block. No <code>LAYER</code> or <code>LOT</code> blocks are defined. Embeds, reinforcement and insulation belonging to a cast unit with the same geometry are collected and exported in one <code>SLABDATE</code> block.</td>
</tr>
<tr>
<td></td>
<td><strong>HEADER</strong></td>
</tr>
<tr>
<td></td>
<td>...</td>
</tr>
<tr>
<td></td>
<td><code>SLABDATE</code></td>
</tr>
<tr>
<td></td>
<td>...</td>
</tr>
<tr>
<td></td>
<td><code>END SLABDATE</code></td>
</tr>
<tr>
<td></td>
<td><code>SLABDATE</code></td>
</tr>
<tr>
<td></td>
<td><code>END SLABDATE</code></td>
</tr>
<tr>
<td></td>
<td><code>END HEADER</code></td>
</tr>
<tr>
<td>• <strong>Single layer, 1 slabdate, n parts</strong></td>
<td>All similar wall shells are defined within one <code>SLABDATE</code> block instead of being defined in a separate <code>SLABDATE</code> block per wall shell. The option is useful when exporting special embeds.</td>
</tr>
<tr>
<td>• <strong>Combined, n slabdate, 1 part</strong></td>
<td>Combined export that can contain more than one cast unit. The exported cast units are placed side by side according to the sequential logic defined on the <code>Pallet</code> tab.</td>
</tr>
<tr>
<td>• <strong>Single layer, 1 slabdate, n steelmats</strong></td>
<td>Only exports the main part of the cast unit as slabdate and meshes and embeds from whole cast unit in one row in export X axis direction with a 1 mm gap between them.</td>
</tr>
<tr>
<td>• <strong>1 slabdate, scanned layers</strong></td>
<td>Export element layers in the same order as they are modeled in the model. Multiple parts on the same depth level are recognized as one layer.</td>
</tr>
<tr>
<td><strong>1st exported layer</strong></td>
<td>Select which part is exported in the first <code>LAYER</code>. This option allows to define which wall shell is positioned on the pallet first.</td>
</tr>
<tr>
<td></td>
<td>The options are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Main part</strong> (of cast unit)</td>
</tr>
<tr>
<td></td>
<td>• <strong>Biggest part</strong></td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Heaviest part</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Consider layer split thicknesses</strong></td>
<td>Select how the layers of the cast unit are exported. These options are available when you have set Output file structure to Multiple layers.</td>
</tr>
<tr>
<td>• No</td>
<td>The cast unit is exported as one volume.</td>
</tr>
<tr>
<td>• Yes</td>
<td>The manual layers set on the Unitechnik tab in the user-defined attributes of a part are used, and the cast unit is exported in two or three layers.</td>
</tr>
</tbody>
</table>

| **Split meshes to individual files**        | Select **Yes** to export meshes into individual files. Each exported file contains one STEELMAT block only.                               |

**Unitechnik export: TS configuration tab**

**NOTE** When specifying object names: If names consist of several words, enclose those in quotation marks and use spaces between words, for example, "WORD1 WORD2".

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Rotation</strong></td>
<td>Select the scanning direction, which defines which main part face is towards the pallet base. Unitechnik export uses scanning layers to obtain the geometry of all parts in a cast unit. The scanning direction depends on the plane of the cast unit main part. A floor panel is scanned from bottom to top side. A wall panel and a column are scanned from one side to the other side. The position and direction of a basic shape of the exported cast unit depends on the rotation. Note that you can use the surface object user-defined attribute <strong>Use surface as pallet base</strong> to orient the object without changing the top-in-form face or the rotation in export settings. You can also use the surface object <strong>Align pallet direction</strong> UDA, which rotates the element in plane so that the selected face is towards the pallet Y axis.</td>
</tr>
</tbody>
</table>

Import to and export from Tekla Structures  415  Automated precast fabrication
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **No**      | Floor: Bottom to top  
Wall: Front to rear side (according to the modeling direction)  
Column: Side to side |
| **180**     | Floor: Top to bottom  
Wall: Rear to front side  
Column: From one side to the opposite side |
| **+90 around X** | Floor: Left to right side  
Wall: Top to bottom  
Column: Side to side |
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| -90 around X    | **Floor:** Right to left side  
                  **Wall:** Bottom to top  
                  **Column:** From one side to the opposite side                       |
| -90 around Y    | **Floor:** Rear to front side  
                  **Wall:** Right to left side  
                  **Column:** Top to bottom                                              |
<p>|                 | With the <strong>Top in form face</strong> option, the scanning direction depends on the defined top-in-form face, so that the opposite face will be towards the pallet. |</p>
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>

Examples of rotation:

- Wrong scanning plane (from the right side to the left side):
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Correct scanning plane</td>
<td>Select the rotation around the z axis, and thereby the rotation of the pallet. The z axis has the same direction, but the x and y directions are changed. To show the actual coordinate system, set Draw pallet axis to Yes on the Pallet tab.</td>
</tr>
<tr>
<td>Extra rotation</td>
<td>Select the rotation around the z axis, and thereby the rotation of the pallet. The z axis has the same direction, but the x and y directions are changed. To show the actual coordinate system, set Draw pallet axis to Yes on the Pallet tab.</td>
</tr>
<tr>
<td>No</td>
<td>No extra rotation.</td>
</tr>
<tr>
<td>Swap X/Y</td>
<td>Swap x and y axis.</td>
</tr>
<tr>
<td>X=max(X_dim,Y_dim)</td>
<td>X axis goes through the longer side of the main part.</td>
</tr>
<tr>
<td>X=min(X_dim,Y_dim)</td>
<td>X axis goes through the shorter side of the main part.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>• $X=\max(X_{\text{dim}},Y_{\text{dim}})$ cast unit</td>
<td>$X$ axis goes through the longer side of the cast unit.</td>
</tr>
<tr>
<td>• $X=\min(X_{\text{dim}},Y_{\text{dim}})$ cast unit</td>
<td>$X$ axis goes through the shorter side of the cast unit.</td>
</tr>
<tr>
<td>• +90 around $Z$</td>
<td>Rotates $x$ and $y$ axis around the $z$ axis by 90 degrees.</td>
</tr>
<tr>
<td>• -90 around $Z$</td>
<td>Rotates $x$ and $y$ axis around the $z$ axis by -90 degrees.</td>
</tr>
<tr>
<td>• 180 around $Z$</td>
<td>Rotates $x$ and $y$ axis around the $z$ axis by 180 degrees.</td>
</tr>
</tbody>
</table>

The following example shows the coordinate system with no rotation and no extra rotation settings. Panel 1 has the $z$ axis set parallel to the shorter side. It is incorrect in the Unitechnik format, so the coordinate system has to be rotated. Panel 2 shows a rotation by 90 degrees around the $z$ axis.

**Auto-rotate on pallet**

Select whether to auto-rotate the coordinate system for export +90° or -90° when the element width exceeds the pallet width, or when the element width exceeds the element length, or to auto-rotate the element on pallet.

With the **Auto-rotate on pallet** option, the element is rotated based on a fixed set of rules defining that the longer edge with no cuts or protruding embeds is at the bottom edge of the
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>pallet. For the <strong>Auto-rotate on pallet</strong> option, you can also select if the default rotation direction is <strong>To long even edge (clockwise)</strong> or <strong>To long even edge (counterclockwise)</strong>.</td>
<td></td>
</tr>
</tbody>
</table>

**Export CONTOUR**

Select how to export the element contour. The options are **Scanned**, **Bounding box**, and **Simplified**.

The **Scanned** option inquires the modeled 3D geometry using 2D scanning planes, see the **Scan position** setting description below.

The **Bounding box** option defines the contour as 4 perpendicular lines between the minimum and maximum values of \((x, y)\) coordinates.

The **Simplified** option exports a simplified contour using 4 \(x\), \(y\) corner points of the element. Similarly as the bounding box, but accounts for diagonal lines at the edges.

**Scan position**

The element contour, cutouts and line attributes are defined by scanning the cast unit in the scan direction defined by rotation settings above. A scanning plane works like a section with no view depth. The export application uses 1 or 2 scanning planes for each part included in the exported cast unit (regardless of the output file structure setting).

The offset is towards the middle of panel from the scanning plane, but can be negative or positive value.

The number of the scanning layers depends on the selected scan position. Each object of the cast unit is scanned in one direction.

Select the position in which all parts are scanned. Each part is scanned separately. Scanning plane is parallel to the basic shape plane.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Bottom and top</td>
<td>Two scanning planes at the top and bottom of the scanned part.</td>
</tr>
<tr>
<td>• Bottom only</td>
<td>One scanning plane at the bottom face.</td>
</tr>
<tr>
<td>• Top only</td>
<td>One scanning plane at the top face.</td>
</tr>
<tr>
<td>• Middle only</td>
<td>One scanning plane at the middle point of the scanned part.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Top, bottom and middle</td>
<td>Three scanning planes: one at the top face, one at the bottom face and one at the middle point of the scanned part.</td>
</tr>
<tr>
<td></td>
<td>To move the position of the exact scanning plane, use the <strong>Scan position offset</strong> boxes below to define start offset and end offset.</td>
</tr>
</tbody>
</table>

### Merge CONTOUR layers

You can export one scanned layer only. With two scanned layers, they have to be merged into one layer.

- **Intersection**
  
  Creates polygon intersection of two contour geometries.

  ![Intersection Example](image)

  1. First scanned layer
  2. Second scanned layer
  3. Layer

- **Union**

  Creates polygon union of two contour geometries.

  ![Union Example](image)
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Export CUTOUTs</strong></td>
<td>To prevent cutout export, select No.</td>
</tr>
<tr>
<td></td>
<td><strong>Exclude selected</strong> excludes from the export the modeled cut parts that you define by class or name.</td>
</tr>
<tr>
<td></td>
<td><strong>Selected only</strong> includes in the export the cut parts that you define by class or name.</td>
</tr>
<tr>
<td><strong>Merge CUTOUT layers</strong></td>
<td>The same as <strong>Contour export</strong>, but for holes only.</td>
</tr>
<tr>
<td><strong>Merge CUTOUTs</strong></td>
<td>Select how to merge overlapping cutouts. You can select to export a big cutout which is created by smaller cuts as separate cutouts. The options are:</td>
</tr>
<tr>
<td></td>
<td>1. Merged as one cutout</td>
</tr>
<tr>
<td></td>
<td><img src="image1" alt="Merged as one cutout" /></td>
</tr>
<tr>
<td></td>
<td>2. Unmerged, overlapping cutouts</td>
</tr>
<tr>
<td></td>
<td><img src="image2" alt="Unmerged, overlapping cutouts" /></td>
</tr>
<tr>
<td></td>
<td>3. Unmerged cutouts with no overlapping</td>
</tr>
<tr>
<td></td>
<td><img src="image3" alt="Unmerged cutouts with no overlapping" /></td>
</tr>
<tr>
<td><strong>Cuts as mountparts</strong></td>
<td>Recognize certain cuts as mountparts automatically. Select the cut type: <strong>Designated only</strong>, <strong>All, Recesses, Within contour</strong>, or <strong>Recesses within</strong>.</td>
</tr>
<tr>
<td></td>
<td>Any embed designated as <strong>Cutpart former</strong> will always be a mountpart, unless excluded. <strong>Within contour</strong> means any cut surrounded by the concrete part at least from three sides.</td>
</tr>
<tr>
<td><strong>Extend contour and add formwork</strong></td>
<td>Select whether to extend the contour according to protruding reinforcement or embeds. This setting extends the contour and adds additional formwork mountparts to the extended area.</td>
</tr>
<tr>
<td></td>
<td>Formwork is not added if there already is an embed with the same geometry.</td>
</tr>
<tr>
<td></td>
<td>The contour is not extended for electric tube embeds.</td>
</tr>
<tr>
<td><strong>Name for additional formwork (embed)</strong></td>
<td>Define a name for the embed.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Geometry export</td>
<td>Select whether the geometry of the exported part (concrete contour, cutout, mountpart) is represented as polygons or lines.</td>
</tr>
<tr>
<td></td>
<td>Polygons exported:</td>
</tr>
</tbody>
</table>

```
SLABDATE
502
00 0 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 400
00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
END
```

Import to and export from Tekla Structures  425  Automated precast fabrication
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Export rounded holes as circle (K)</strong></td>
<td>Select whether you want to export rounded holes as circles (K) or polygons/lines.</td>
</tr>
<tr>
<td><strong>Double wall turned</strong></td>
<td>Select whether the first shell of a double wall on the pallet is turned. This requirement depends on the receiving master computer system. The options are:</td>
</tr>
<tr>
<td></td>
<td><strong>No, one coordinate system</strong>: Exported as in model, shell1 is in front, shell2 in background.</td>
</tr>
<tr>
<td></td>
<td><strong>Yes, turn shell1</strong>: The shell 1 is offset by the pallet width in y direction (defined on the Validation tab) and flipped around x axis</td>
</tr>
<tr>
<td></td>
<td><strong>Yes, turn shell1 - fixed edge up</strong>: This is meant for special machines.</td>
</tr>
<tr>
<td></td>
<td><strong>No, shell-specific coordinate systems</strong>: Use to export the second shell in the Z direction from the bottom of the pallet upwards.</td>
</tr>
<tr>
<td><strong>Allow swapping of shells</strong></td>
<td>Specify whether the double wall shells are swapped.</td>
</tr>
</tbody>
</table>
**Unitechnik export: Embeds tab**

**NOTE** When specifying object names: If names consist of several words, enclose those in quotation marks and use spaces between words, for example, "WORD1 WORD2".

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal embeds</td>
<td>Select which parts are considered as embeds. Embedded parts are exported in the <strong>MOUNPART</strong> block. If the embed block consists of several parts, it is useful to combine all embed parts into one sub-assembly block and then add as sub-assembly to a cast unit or concrete shell sub-assembly. Single part embeds can be simply added to cast unit.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Selected + steel</strong></td>
</tr>
<tr>
<td></td>
<td>All classes listed in the <strong>Embeds classes</strong> box are considered as embeds. All steel parts are also considered as embeds, unless excluded from export.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Selected</strong></td>
</tr>
<tr>
<td></td>
<td>Classes listed in the <strong>Embeds classes</strong> box are only considered as embeds.</td>
</tr>
<tr>
<td></td>
<td>• <strong>No export</strong></td>
</tr>
<tr>
<td></td>
<td>Ignores the <strong>Embeds classes</strong> box and exports all steel parts as standard parts.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Selected (also reinforcement) + steel</strong></td>
</tr>
<tr>
<td></td>
<td>All parts and reinforcing bars listed in the <strong>Embed classes or names</strong> box are considered as embeds and plotted as lines. Also bounding box can be used. All steel parts are also considered as embeds.</td>
</tr>
</tbody>
</table>

<p>| Embed classes or names         | Enter the classes or names of the embeds.                                  |
| Embed filter                  | Enter the name of the filter that specifies the embeds to export.          |
| Export assemblies             | Select how the 2D geometry of embeds and steel blocks are exported.        |</p>
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Diagram 1" /> → <img src="image2.png" alt="Diagram 2" /></td>
<td>Embeds are exported as parts. All embedded welds and assembly relations are ignored.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Diagram 3" /> → <img src="image4.png" alt="Diagram 4" /></td>
<td>Welded embeds and the assembly block are exported as one part with the bounding box geometry of the complete sub-assembly.</td>
</tr>
<tr>
<td><img src="image5.png" alt="Diagram 5" /> → <img src="image6.png" alt="Diagram 6" /></td>
<td>Only the main part of the embedded block or embedded assembly is exported.</td>
</tr>
<tr>
<td><img src="image7.png" alt="Diagram 7" /> → <img src="image8.png" alt="Diagram 8" /></td>
<td>The main part of the embedded block extended in the x direction to cover all the parts of the embedded block is exported.</td>
</tr>
<tr>
<td><img src="image9.png" alt="Diagram 9" /> → <img src="image10.png" alt="Diagram 10" /></td>
<td>Only the bounding box around the main part of the embedded block or embedded assembly is exported.</td>
</tr>
</tbody>
</table>

Import to and export from Tekla Structures 428 Automated precast fabrication
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Image" /> ➔ <img src="image2.png" alt="Image" /></td>
<td>Export the corner symbols of the embed sub-assembly bounding box.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Image" /> ➔ <img src="image4.png" alt="Image" /></td>
<td>Export the corner symbols of the main part bounding box.</td>
</tr>
<tr>
<td><img src="image5.png" alt="Image" /> ➔ <img src="image6.png" alt="Image" /></td>
<td>Export all sub-assembly parts as one object with continuous geometry.</td>
</tr>
<tr>
<td><img src="image7.png" alt="Image" /> ➔ <img src="image8.png" alt="Image" /></td>
<td>Export all sub-assembly parts as one object with distinct geometry of each part.</td>
</tr>
</tbody>
</table>

**Corner symbol width / height**

Enter the width and height of the corner symbol.

**Def export code**

Define how the insertion point and the direction for embeds is calculated. Possible values are 0, 1, 2, 3, 11, 12, 21, 22, 23, 31 and 32, 41, 42, 43.

In most cases, the insertion middle point refers to the center of gravity of the embed sub-assembly or main part depending on the Export assemblies setting.

0 = Ignores the symbol and uses the sub-assembly bounding box setting according to the insertion COG setting (1 - 5), for example, PLATE 0 0 4.

1 = The insertion point is the middle point of embed and the direction is parallel to the longest
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>side of the exported mountpart geometry. 1 is the default. 2 = The insertion point is the middle point of embed and the direction is parallel to the shortest side of the exported mountpart geometry. 3 = The insertion point is the middle point of embed, and if the mainpart is symmetrical, calculate the direction of the mountpart along the line from mainpart COG to sub-assembly COG. 11 = The insertion point is the point of embed in the middle of shorted side and the direction is along the longest side. 12 = The insertion point is the point of embed in the middle of longest side and the direction is along the shortest side. 21 = The insertion point is in the contour’s top edge point closest to the embed and the direction is parallel to the longest side of the exported mountpart geometry. 22 = The insertion point is in the contour’s top edge point closest to the embed and the direction is parallel to the shortest side of the exported mountpart geometry. 23 = The insertion point is in the contour’s top edge point closest to the embed and if the mainpart is symmetrical, calculate the direction of the mountpart along the line from mainpart COG to sub-assembly COG. 31 = The insertion point is the point of the closest vertex on concrete part, between embeds and concrete part side and the direction is along the longest side. 32 = The insertion point is the point of the closest vertex on concrete part, between embeds and concrete part side and the direction is along the shortest side. 41 = Insertion point embed assembly COG and orients towards the start to end point axis. 42 = Insertion point embed part start point and orients towards the end point. 43 = Insertion point embed assembly COG and orients towards the axis of the longest edge.</td>
<td></td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Cut outer assemblies</strong></td>
<td>Select how the embedded parts that are outside the concrete element are exported.</td>
</tr>
<tr>
<td><img src="image1.png" alt="Image" /></td>
<td>All parts in the embed are exported.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Image" /></td>
<td>Only the embedded parts that are inside of the concrete element are exported. Embedded parts that are outside the concrete element are ignored. If an embedded part is partly inside a concrete element, the exported geometry of the embedded part is changed to cut.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Image" /></td>
<td>Same as the previous option, but only embedded parts with class defined in <strong>Cut outer only classes</strong> are taken into account.</td>
</tr>
<tr>
<td><strong>Cut outer only classes</strong></td>
<td>Enter the classes of parts whose geometry is changed to cut when you have selected the last option in the <strong>Cut outer assemblies</strong> list.</td>
</tr>
<tr>
<td><strong>Embed Z position</strong></td>
<td>Select the embed z position. The options are <strong>Minimum to pallet</strong>, <strong>Start point</strong> and <strong>Z=0</strong>. When you select <strong>Z=0</strong>, all exported mountparts will be plotted on the level of the pallet.</td>
</tr>
<tr>
<td><img src="image4.png" alt="Image" /></td>
<td>You can use the <code>spec_assemblies_def.txt</code> file to set the position of the embeds, see above.</td>
</tr>
<tr>
<td><img src="image5.png" alt="Image" /></td>
<td>If unassigned, the setting chosen in the dialog box is used by default.</td>
</tr>
<tr>
<td><img src="image6.png" alt="Image" /></td>
<td>For example:</td>
</tr>
<tr>
<td><img src="image7.png" alt="Image" /></td>
<td>On the first line of the example above you have additional options for positioning the embed symbol:</td>
</tr>
<tr>
<td><img src="image8.png" alt="Image" /></td>
<td><strong>Quicky</strong> is the name of the embed.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| **Special embeds** | **Class or name list**  
When defining special embeds as names, and object names consist of several words, enclose those in quotation marks and use spaces between words, for example, "WORD1 WORD2". |
| **Insulation**    | Define the insulation classes or names. The corresponding parts will be exported as insulation parts. All parts considered insulation are exported in the MOUNPART block. Default mountpart type for insulation is 03 unless overwritten. |
| **Electric tubes**| Define the electric tubes classes or names. The corresponding parts will be exported as MOUNPART with lines geometry. Default mountpart type for electric installation is 07 unless overwritten. |
| **Opening embed** | Define the opening embed classes or names. The corresponding parts will be exported as normal embeds in the MOUNPART block. The geometry will not be considered in the CONTOUR and CUTOUT blocks of the concrete part. |
| **Opening cutout**| Define the opening cutout classes or names. The corresponding parts will be exported only in regard to their geometry in the CUTOUT block of the concrete part. They will not be exported in the MOUNPART block. |
| **Cutpart former**| Export cuts that have been specified with a class or name in the MOUNPART block. Default mountpart type for cutout box is 21 unless overwritten. |
| **Thermal anchors** | Export thermal anchors for thermal walls by specifying names or classes.  
You need to set Export insulation to As embed (mounpart) with thermal anchor to activate the **
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Export insulation</strong></td>
<td>Select how to export insulation:</td>
</tr>
<tr>
<td></td>
<td>• <strong>As embed (mounpart)</strong> exports insulation parts in the MOUNPART block as embeds.</td>
</tr>
<tr>
<td></td>
<td>• <strong>As concrete panel</strong> exports insulation parts in the SLABDATE block as concrete panels.</td>
</tr>
<tr>
<td></td>
<td>• <strong>As layers and embeds</strong> export insulation parts in the SLABDATE block as layers and in the MOUNPART block as embeds.</td>
</tr>
<tr>
<td></td>
<td>• To export thermal anchors as a part of the insulation, select <strong>As embed (mounpart) with thermal anchor</strong>. The thermal anchors will be represented as very small vertical lines within the insulation mountpart geometry.</td>
</tr>
<tr>
<td></td>
<td>Select if the insulation layer affects the contour using the options <strong>Layer cut to contour</strong> and <strong>Extend contour</strong>. These options are only available if the insulation is exported as a layer within the concrete element, and you have set the <strong>Export insulation</strong> setting to <strong>As concrete panel</strong> or <strong>As layers and embeds</strong>.</td>
</tr>
<tr>
<td></td>
<td>When <strong>Layer cut to contour</strong> is used, the shuttering is placed by the determined concrete edge, however any insulation mountpart is allowed to extend outside this contour.</td>
</tr>
<tr>
<td><strong>Export surface</strong></td>
<td>Select whether surface treatment is exported in the MOUNPART block as embeds or in the SLABDATE block as concrete panels. You can also use the option <strong>No</strong>, which does not export surface treatment.</td>
</tr>
<tr>
<td><strong>Export cut edges</strong></td>
<td>Select how to export cut edges as MOUNPART block. The options are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Line cuts</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Chamfers</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Line cuts and chamfers</strong></td>
</tr>
<tr>
<td></td>
<td>The geometry will be a simple line, and the MOUNPARTs have fixed names. Line cuts and fittings are plotted along the cut edge. Chamfers are plotted at the inner line of the chamfered edge.</td>
</tr>
<tr>
<td></td>
<td>You can use this setting for representing sawings on standard slabs, for example.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Sorting embeds by</strong></td>
<td>Select the export order of the embeds. The options are:</td>
</tr>
<tr>
<td></td>
<td><strong>ID, descending</strong> (default)</td>
</tr>
<tr>
<td></td>
<td><strong>ID, ascending</strong></td>
</tr>
<tr>
<td>Distance to zero point:</td>
<td>The first embed in the list is the closest to the cast unit zero point, the shortest distance to zero point.</td>
</tr>
<tr>
<td></td>
<td><strong>Name, descending</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Name, ascending</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Class, descending</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Class, ascending</strong></td>
</tr>
<tr>
<td><strong>Identification of installation</strong></td>
<td>Select the installation identification for the MOUNPART block.</td>
</tr>
<tr>
<td></td>
<td>The options are <strong>Installed (0), Only plotted (1), Only installed (2), Not installed, not plotted (3), Installed in reinforcement (4), Installed automatically (5)</strong></td>
</tr>
</tbody>
</table>

**Unitechnik export: Reinforcement tab**

You can export single reinforcing bars, groups of straight and bent reinforcing bars, and rectangular or polygonal or bent meshes. The reinforcing bar group, or rectangular or polygonal mesh is divided into several single reinforcing bars. All reinforcing bars are exported in the RODSTOCK block.

**NOTE** When specifying object names: If names consist of several words, enclose those in quotation marks and use spaces between words, for example, "WORD1 WORD2".

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Rebars export - Straight</strong></td>
<td>Note that the hooked bars are controlled by the <strong>Straight</strong> setting, not by the <strong>Bent</strong> setting.</td>
</tr>
<tr>
<td>All including <strong>hooked</strong></td>
<td>Straight reinforcing bars are exported. Hooks are supported.</td>
</tr>
<tr>
<td>All without <strong>hooks</strong></td>
<td>Exports straight rebars without hooks only.</td>
</tr>
<tr>
<td><strong>Collected</strong></td>
<td>Uncollected reinforcement is excluded from the export.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Rebars export - Bent          | All - Bent reinforcing bars are exported.  
**Collected** - Uncollected reinforcement is excluded from the export.                                                                                                                                                                                                                                                                                                                                                                                                       |
| Meshes export                 | When set to **Yes**, polygonal or rectangular meshes are exported. Hooks are supported. You can define the setting separately for straight or bent meshes.  
You can also select whether to unfold along longest line or parallel to pallet.                                                                                                                                                                                                                                                                                                                                                                                                     |
| Bent mesh and reinforcement   | When set to **All as unfolded**, bent reinforcement is exported as unfolded.  
When set to **Freely selectable forms**, bent reinforcement is exported as freely selectable forms, which means that they will have the geometry of each leg and bending represented in the additional row.  
Hooks are also supported for unfolded reinforcement, and you can select **Mesh with hook forms 0, 2 and 5**. Hook forms 0, 2 and 5 are detected.  
**Mesh with hook forms 0-5** exports end hook shape L and two types of shapes S and U (flection form 1, 2, 3, 4 and 5) as terminal hooks according to the Unitechnik specification. Other shapes are exported as unknown shape form 999.  
Using the option **Mesh as unfolded**, you can export bent meshes as unfolded, while other bent reinforcement is exported as bent.  
**Mesh forms 0-5 or free** exports end hook shape L and two types of shapes S and U (flection form 1, 2, 3, 4 and 5) as terminal hooks according to the Unitechnik specification. Other shapes are exported using freely selectable forms logic.  
You can select between two reinforcement starting points: **Origin in unfolded rebar** or **Origin in start rebar point**. Origin in unfolded rebar uses the first point of the main leg of rebar or mesh wire depending on the rebar orientation in export. The option also affects the z level of the reinforcement in the resulting Unitechnik file. The start points are unaffected by unfolding options. |
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export meshes as</td>
<td>Set the rotation of the mesh plane in the export file. The options are:</td>
</tr>
<tr>
<td></td>
<td><strong>Standard</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Embeds</strong>: Exported as mountparts.</td>
</tr>
<tr>
<td></td>
<td><strong>Turned to pallet (longest wire on X axis)</strong>: All meshes will be individually rotated in line with the pallet axes.</td>
</tr>
<tr>
<td></td>
<td><strong>Turned to pallet (bent wire on X axis)</strong>: Exports meshes rotated to pallet plane with bent wires parallel with the X axis of the pallet.</td>
</tr>
<tr>
<td>Braced girder classes</td>
<td>We recommend that you model braced girders with braced girder components, which are automatically recognized by the export, making the export faster and consistently precise.</td>
</tr>
<tr>
<td>or names</td>
<td>Enter the class or name of reinforcing bars, steel rods or profiles representing braced girders. For example, 15 17 5 means that parts with class 15, 17, or 5 are considered braced girders.</td>
</tr>
<tr>
<td></td>
<td>You can export braced girders within the STEELMAT block using the option <strong>Within the STEELMAT block</strong>. You can also export braced girders Z coordinate as 0 using the option <strong>Without concrete cover</strong>. By default, the braced girders are exported outside of the STEELMAT block.</td>
</tr>
<tr>
<td></td>
<td>Braced girders are represented as a single line, placed according to your selection:</td>
</tr>
<tr>
<td></td>
<td>• <strong>As braced girder top chord</strong> (default): The geometry of the main chord (top chord) with all information is included in the export.</td>
</tr>
<tr>
<td></td>
<td>• <strong>As braced girder bottom chords</strong>: The braced girder is exported as one object but with the quantity number 2 with the spacing included.</td>
</tr>
<tr>
<td></td>
<td>• <strong>As braced girder all chords</strong>: One object like above but with the quantity number 3.</td>
</tr>
<tr>
<td></td>
<td>• <strong>As top chord with end symbols</strong>: 2 mountpart symbols are placed at the top chord end points towards the braced girder direction, line 20 mm long. In addition, the above-mentioned BRGIRDER information.</td>
</tr>
<tr>
<td></td>
<td>You can adjust the symbol length on the <strong>Symbols</strong> tab, where you can also select if</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>braced girders exported as mountparts should also have width symbols.</td>
</tr>
<tr>
<td>• As bottom chords with end symbols: 4</td>
<td>Mountpart symbols are placed at the bottom chord end points towards the braced girder direction, line 20 mm long. In addition, the above-mentioned BRGIRDER information.</td>
</tr>
<tr>
<td>• Only top chord end symbols: 2</td>
<td>Mountpart symbols are placed at the top chord end points towards the braced girder direction, line 20 mm long. No BRGIRDER.</td>
</tr>
<tr>
<td>• Only bottom chord end symbols: 4</td>
<td>Mountpart symbols are placed at the bottom chord end points towards the braced girder direction, line 20 mm long. No BRGIRDER.</td>
</tr>
</tbody>
</table>

**Reinforcement export type**

Define the structure of the exported file for reinforcement.

**Plant with lying robot only**

All reinforcement including mesh objects will be exported as individual rodstocks within slabdate.

```plaintext
HEADER__
SLABDATE
CONTOUR__
CUTOUT__
MOUNPART
RODSTOCK
BRGIRDER
EXTRON__
END_SLABDATE
END_HEADER__
```

**Fabrication of welded rebars**

If the export type is set to **Fabrication of welded rebars**, bar groups are exported as individual rodstocks, mesh objects are exported as rodstocks within `STEELMAT` blocks.

The structure of the output file (one SLABDATE is shown only):
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Collect reinforcement</strong></td>
<td>The structure of the output file is the same as for Fabrication of welded rebars. This option allows you to collect mesh, single reinforcing bars and reinforcing bar groups into groups exported in one STEELMAT block. The groups are collected based on the Collect based on field. You can also collect meshes which belong to different cast units.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>1 (orange color): The mesh belongs to the bottom panel of the cast unit, mesh name is MESH1.</td>
<td></td>
</tr>
<tr>
<td>2 (blue color): Two single bars, the name is MESH1.</td>
<td></td>
</tr>
<tr>
<td>3 (green color): One reinforcing bar group belongs to the top panel, the name is MESH1.</td>
<td></td>
</tr>
</tbody>
</table>

If **Reinforcement export type** is set to **Collect reinforcement** and **Collect based on** is set to **Name**, all three different reinforcement types are collected into one mesh, which is exported in one **STEELMAT** block.

Other non-designated rebar groups are exported as individual rodstocks. If the collected mesh has only one rebar, it is exported as an individual rodstock without a **STEELMAT**.

**Designated welded bars**

This option works in the same way as **Fabrication of welded rebars**, but you can use it with the **Collect based on** option to designate the rebars that will form main layers with reinforcement type 1 or 2, while the rebars remain as **RODSTOCK** depending on object type.

**Collect based on**

Select how meshes are collected. Meshes with one bar are exported as a single reinforcing bar.

- **Name**
  
  Meshes, single reinforcing bars and reinforcing bar groups with the same name are collected into meshes. Meshes, single reinforcing bars and reinforcing bar groups with the same name equals one mesh in the exported file.

- **Class**
  
  Meshes, single reinforcing bars and reinforcing bar groups with the same class number are collected into meshes. Meshes, single reinforcing bars and reinforcing bar groups with one class number equal one mesh in the exported file.

- **Grade**
  
  Meshes, single reinforcing bars and reinforcing bar groups with the same grade are collected into meshes.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• UDA</td>
<td>Meshes, single reinforcing bars and reinforcing bar groups with the same user-defined attribute are collected into meshes. The value you enter in the box next to this option is the UDA value.</td>
</tr>
<tr>
<td>Collect if distance is lower then</td>
<td>Define the maximum distance between the mesh rebars to be collected together into one STEELMAT.</td>
</tr>
<tr>
<td>Rebar grouping</td>
<td>Group similar rebars with equal spacing. Similar rebars are exported using one RODSTOCK row with correct quantity and spacing. The options are Yes and No (default). The rebar grouping is primarily intended to be used in the production of simple mesh and reinforcement.</td>
</tr>
<tr>
<td>Reinforcing bars length</td>
<td>Select how the reinforcing bar length is calculated.</td>
</tr>
<tr>
<td>• Lines in the middle</td>
<td></td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>• Lines at the edge (total length only)</td>
<td><img src="image" alt="Diagram" /></td>
</tr>
<tr>
<td>• Lines at the edge (all leg lengths)</td>
<td>calculates the lengths of the reinforcing bar legs at the edge of the bars.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Reinforcing bars diameter</strong></td>
<td>Select how the reinforcing bar diameter is exported. The options are:</td>
</tr>
<tr>
<td></td>
<td>• Actual or nominal (XS_USE_ONLY_NOMINAL_REBAR_DIAMETER)</td>
</tr>
<tr>
<td></td>
<td>• Size</td>
</tr>
<tr>
<td></td>
<td>• Actual</td>
</tr>
<tr>
<td></td>
<td>• Nominal</td>
</tr>
<tr>
<td></td>
<td>This selection affects the results of the Rebar length option.</td>
</tr>
</tbody>
</table>

<p>| <strong>Braced girders diameter</strong> | Select how the braced girder diameter is exported. The options are:          |
|                            | • Actual or nominal (XS_USE_ONLY_NOMINAL_REBAR_DIAMETER)                    |
|                            | • Size                                                                      |
|                            | • Actual                                                                   |
|                            | • Nominal                                                                  |</p>
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Rebar direction angle limit</strong></td>
<td>Select whether the reinforcing bars starting direction in XY plane is limited, as required in some production interfaces.</td>
</tr>
<tr>
<td>• <strong>No</strong></td>
<td>The reinforcing bars exported as they're modeled in Tekla Structures.</td>
</tr>
<tr>
<td>• <strong>From 0 to 180</strong></td>
<td>The reinforcing bars are exported so that they have a start angle limit to be under 180 degrees, and therefore always oriented to start in positive pallet y direction. In this case the rebar start point will be always be the rebar end with smallest Y-coordinate</td>
</tr>
<tr>
<td>• <strong>From 0 to 180 ordered</strong></td>
<td>Same as above but the reinforcing bars are sorted according to the direction angle of the reinforcing bar: the reinforcing bars with lower angles are first.</td>
</tr>
<tr>
<td>• <strong>From 180 to 0 ordered</strong></td>
<td>The reinforcing bars are sorted according to the direction angle of the reinforcing bar: the reinforcing bars with higher angles are first.</td>
</tr>
<tr>
<td><strong>First bending angle</strong></td>
<td>Allows setting the first bending angle of free-flection rodstock to be positive or negative (as required by certain interfaces). The options are:</td>
</tr>
<tr>
<td>• Always positive</td>
<td></td>
</tr>
<tr>
<td>• Allow positive or negative</td>
<td></td>
</tr>
<tr>
<td><strong>Reinforcement types</strong></td>
<td>Select the reinforcing bar types in a mesh to be exported. UDA can also be specified for most of the options. The options are:</td>
</tr>
<tr>
<td>• Use 1, 2 and 4</td>
<td></td>
</tr>
<tr>
<td>• Use 1, 2, 4, 5, 6, 8 and UDA (default)</td>
<td></td>
</tr>
<tr>
<td>• Use 1, 2, 8 and UDA</td>
<td></td>
</tr>
<tr>
<td>• Use 1, 2, 4, 8 and UDA</td>
<td></td>
</tr>
<tr>
<td>• Use 1, 2 and UDA</td>
<td>1 and 2 are for the rods in the bottom face longitudinal and cross bars. With the Use 1, 2 and UDA option, the lowest rebar layer, including all...</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>bars in the same direction, is exported with rebar type 1, and all other layers are exported as type 2. <strong>5</strong> and <strong>6</strong> are for the rods in the top face longitudinal and cross bars. <strong>4</strong> is for other rebars placed in the element reinforcement. <strong>8</strong> is for loose bars welded into prefabricated meshes. In addition, you can use the option <strong>Bottom rebar = type 1</strong> to specify that the reinforcement type 1 rebars will always be the lowest rebars of a mesh regardless of the mesh orientation on the pallet. The options <strong>Use 1, 2 and 4</strong> and <strong>Use 1, 2, 4, 5, 6, 8 and UDA</strong> calculate types 1 and 2 for the main reinforcement according to the layer depth position. The options <strong>Use 1, 2, 8 and UDA</strong> and <strong>Use 1, 2, 4, 8 and UDA</strong> are for specific interfaces. By default, they use a logic that has types 1 and 2 assigned by the bar direction in pallet x-/y-axes, not by their depth in z-direction.</td>
<td></td>
</tr>
<tr>
<td>Classes for loose rebars (type 8)</td>
<td>Enter the classes of loose reinforcing bars to be collected. The bars are a part of a mesh and are exported as reinforcing bar type 8.</td>
</tr>
<tr>
<td>Classes for non-automated rebars</td>
<td>Enter the classes of reinforcing bars to be tagged for non-automated production.</td>
</tr>
<tr>
<td>Spacer type</td>
<td>You can add spacer type information to the first layer of the reinforcement (Unitechnik reinforcement type 1). The spacer type is added to the respective spacer type block in the rodstock within the Unitechnik file. The options are: <strong>Automatic, rebar type 1</strong>: Calculates the spacer type automatically according to the cover thickness. When the reinforcement type is 1 and element is thinner that 100 mm, the spacer type is exported. <strong>Automatic, all rebar types</strong>: Spacer type is always calculated for each rebar. <strong>User defined spacer type</strong>: Enter the spacer type to be input in all first layer rebars. <strong>No</strong>: Leaves 0 as spacer type.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Spacer start position</strong></td>
<td>Enter the first spacer start position from the start point of the rebar, for example, 500 (mm).</td>
</tr>
<tr>
<td><strong>Spacer pitch</strong></td>
<td>Enter the spacer pitch information from start point onwards, for example, 1000 (mm).</td>
</tr>
<tr>
<td><strong>Mesh wire layer level</strong></td>
<td>Select how mesh wire levels are calculated. The options are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Actual level</strong>: This is the relative wire level in the model.</td>
</tr>
<tr>
<td></td>
<td>• <strong>By highest level</strong>: All wires in the layer are moved to the level of the wire with the highest z position.</td>
</tr>
<tr>
<td></td>
<td>• <strong>By wire size</strong>: The relative level of the 2nd layer is written according to the wire size.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Manual</strong>: The 2nd layer wire level can be defined manually.</td>
</tr>
<tr>
<td><strong>Add mesh stabilizing wires</strong></td>
<td>Select whether to extend reinforcement mesh wires through openings to stabilize the mesh. Use for meshes with large openings.</td>
</tr>
<tr>
<td><strong>Stabilization wire max spacing</strong></td>
<td>Enter a value to define the maximum spacing of the wires that stabilize the reinforcement mesh. As a result, the minimum amount of extra wires will be extended within this spacing value from the closest full wire near opening.</td>
</tr>
<tr>
<td><strong>Meshes sort</strong></td>
<td>Select whether meshes are sorted.</td>
</tr>
<tr>
<td><strong>Meshes offset</strong></td>
<td>Select whether the mesh has an offset defined in the STEELMAT block. If the option is set to <strong>Yes</strong>, the value for X and Y direction is set to zero. If the option is set to <strong>No</strong>, the X and Y values are exported according to modeled situation.</td>
</tr>
</tbody>
</table>

**Unitechnik export: Validation tab**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Draw scanned geometry</strong></td>
<td>The exported geometry can be shown with <strong>Draw scanned geometry</strong>. Select whether you want to check if the geometry of the exported parts is correct. It shows the lines representing the exported rectangle of the basic shape, the exported geometry of parts, cuts, embeds, and reinforcement. Embeds are projected to the plane of the basic shape. The reinforcement lines are positioned inside each reinforcing bar in</td>
</tr>
</tbody>
</table>
### Option

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Draw pallet axis</strong></td>
<td>Select whether to show the coordinate system. The axes are displayed with dotted lines.</td>
</tr>
<tr>
<td><strong>Wall to pallet checking</strong></td>
<td>Select whether the export checks the wall size against the pallet size. If you select the <em>Yes, if exceeded, do not export</em> option, the <em>Pallet width, Pallet length, and Max. cast unit thickness</em> options cannot be empty.</td>
</tr>
<tr>
<td><strong>Pallet width</strong></td>
<td>Define the pallet width. On the basis of the pallet width and length, the <em>Wall to pallet checking</em> option is able to check if a wall element is too big to fit to a pallet. If the wall is bent or in unfolded state depending on the option selected for the setting <em>Bent reinf. as unfolded</em> on the <em>Reinforcement</em> tab.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Pallet length</td>
<td>Define the pallet length.</td>
</tr>
<tr>
<td>Max. cast unit thickness</td>
<td>Define the maximum cast unit thickness. To avoid collision with the drying chamber, the maximum thickness of a cast unit should be smaller than the maximum opening of the drying chamber.</td>
</tr>
<tr>
<td>Rebar diameter limitation</td>
<td>Minimum and maximum diameter for the reinforcing bars to be exported.</td>
</tr>
<tr>
<td>Rebar length limitation</td>
<td>Minimum and maximum length for the reinforcing bars to be exported.</td>
</tr>
<tr>
<td>Rebar leg length limitation</td>
<td>Minimum and maximum length for individual leg section within a bent rebar to be exported.</td>
</tr>
<tr>
<td>Mesh wire length limitation (Long)</td>
<td>Minimum and maximum diameter for longitudinal reinforcing bars to be exported.</td>
</tr>
<tr>
<td>Mesh wire length limitation (Cross)</td>
<td>Minimum and maximum length for cross reinforcing bars inside a mesh to be exported.</td>
</tr>
<tr>
<td>Mesh wire leg length limitation</td>
<td>Minimum and maximum length for individual leg section within a bent mesh wire to be exported.</td>
</tr>
<tr>
<td>Mesh wire overhang limitation</td>
<td>Minimum and maximum length for mesh wire overhang section before the first cross-wire welding point and after the last cross-wire welding point to be exported.</td>
</tr>
<tr>
<td>Mesh wire spacing limitation</td>
<td>Allowed spacing values for mesh wires separated by blank space to be exported. If no value added, there is no limitation for spacing.</td>
</tr>
<tr>
<td>Export others</td>
<td>These operations are intended for objects that fail the validation:</td>
</tr>
<tr>
<td>· Remove invalid mesh wires</td>
<td>Only exclude invalid mesh wires and not the whole mesh when some of the mesh wires fail the validation.</td>
</tr>
<tr>
<td>· Yes, as loose (type 4 or 8)</td>
<td>Export invalid rebars as loose rebars of type 4 or 8.</td>
</tr>
<tr>
<td>· Yes, ignore limitation</td>
<td>The diameter and length limitations are ignored.</td>
</tr>
<tr>
<td>· Yes, as non-automated</td>
<td>Export non-valid rebars as non-automated.</td>
</tr>
<tr>
<td>· Prevent export</td>
<td></td>
</tr>
</tbody>
</table>
### Option Description

- **Exclude all**: Exclude the whole mesh from the export if any of the wires fail the validation. When a rebar fails the validation, you are notified by a log message.

### Unitechnik export: Reinforcement data tab

In the column on the right, enter the custom or UDA string when applicable. On this tab, you can add data attributes only, no geometric attributes. The information you add controls the reinforcement unit data (single reinforcement, mesh, braced girder, or cage). The attributes are either optional or obligatory. The length of some of the fields may be limited in the UT format, so keep the strings short.

Depending on the setting, the following attributes can be added: **Name**, **Grade**, **Class**, **Rebar ID**, **Mesh ID**, **Mesh position**, **UDA**, **UDA (main part)**, **UDA (rebar)**, **Part UDA**, **Main part UDA**, **Phase**, **User-defined text**, **User-defined text + class**, **Template**, and **Text[Template]#Counter**.

**Text[Template]#Counter**:  
- Text can be any text including punctuation marks.  
- Write templates in brackets []).  
- # adds a running number if the data content is the same in several entries.  
- You can enter several templates and use text delimiters, for example, [ASSEMBLY_POS]-[REBAR_POS].  
- If you start the Text[Template]#Counter with a template, add a space as the first character before the bracket.  
- Template attributes are read from the single reinforcement, mesh, braced girder, or cage.  
- You can also use attributes that refer to another hierarchy level, for example, the assembly UDA of the rebar.  
- You can use <VALUE> to inquire a part UDA and {VALUE} to inquire an assembly UDA. This makes it possible to use a shorter string instead of having to use a template property to designate UDAs.  
- Data field and file name options with #Counter logic keep the counter series separate from each other when necessary. Only objects with the same object type and matching data string as a base are put into the same counter series. For data fields other than HEADER block fields, these counter series are also distinct within each export file and data section.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Rebars: Article number rebar</strong></td>
<td>Select which property you want to export as a reinforcing bar article number for rebars.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Rebars: Article number mesh</td>
<td>Select which property you want to export as a mesh article number for rebars.</td>
</tr>
<tr>
<td>Meshes: Article number rebar</td>
<td>Select which property you want to export as a reinforcing bar article number for meshes.</td>
</tr>
<tr>
<td>Meshes: Article number mesh</td>
<td>Select which property you want to export as a mesh article number for meshes.</td>
</tr>
<tr>
<td>Meshes: Meshes designation</td>
<td>Select the information that you want to export about the meshes.</td>
</tr>
<tr>
<td>Meshes: Info 1 text (UT 6.0)</td>
<td>Information field is filled with the selected data.</td>
</tr>
<tr>
<td>Meshes: Info 2 text (UT 6.0)</td>
<td>Information field is filled with the selected data.</td>
</tr>
<tr>
<td>Welded leg designation</td>
<td>Designate the welded leg in bent mesh bars if there is only one leg that is welded to cross-wires. When you select Yes, information about welded leg designation is exported.</td>
</tr>
<tr>
<td>Strands (UT 6.0): Pull force (KN)</td>
<td>You can now use main part UDA (UDA (main part)) or rebar UDA (UDA (rebar)) to include strand pull force information in the Unitechnik export.</td>
</tr>
<tr>
<td></td>
<td>Selecting Empty does not export the strand pull force information.</td>
</tr>
<tr>
<td></td>
<td>This setting only works for rebars that are set to type 9 in the Unitechnik reinforcement type box on the Unitechnik tab in the user-defined properties of the rebars.</td>
</tr>
<tr>
<td>BRGIRDER block: Braced girder type</td>
<td>Select the string value of girder type field in the BRGIRDER block in the exported file.</td>
</tr>
<tr>
<td></td>
<td>• Empty</td>
</tr>
<tr>
<td></td>
<td>No string is exported.</td>
</tr>
<tr>
<td></td>
<td>• Name</td>
</tr>
<tr>
<td></td>
<td>The name of the braced girder type is exported. If the name of the top part of a braced girder is empty, the names of the rods are checked.</td>
</tr>
<tr>
<td></td>
<td>• UDA</td>
</tr>
<tr>
<td></td>
<td>You can export the user-defined attribute values for a braced girder type (type), braced girder article number (art_number), or braced girder fabricator name (fabricator).</td>
</tr>
<tr>
<td></td>
<td>The UDAs can be added to the braced girder if the parts have been created using the system component Braced girder (88) or Braced.</td>
</tr>
</tbody>
</table>
Option | Description
---|---
girder (89) and you have entered the needed values on the dialog boxes of the components. |
• **User defined text**
  The value you enter in the box next to this option is exported.

| CAGE BLOCK: Cage designation | Select the information that you want to export about the the cage in the CAGE block (UT 6.1). |
| CAGE BLOCK: Base cage shape | Select the information that you want to show as base cage shape. |
| CAGE BLOCK: Info 1 text | Information field is filled with the selected data. |
| CAGE BLOCK: Info 2 text | Information field is filled with the selected data. |
| Definition file | Use an external definition file to overwrite type and designation information, which is usually determined automatically from model objects. The definition file is a .csv file, with a fixed structure. The definition file can also be read from folders defined for XS_FIRM and XS_PROJECT. Example of the definition file: **UT_rebar_info.csv**. |

**Unitechnik export: HEADER block data tab**

In the column on the right, enter the custom or UDA string, when applicable. On this tab, you can add data attributes only, no geometric attributes. The attributes are either optional or obligatory. The length of some of the fields may be limited in the UT format, so keep the strings short.

Depending on the setting, the following attributes can be added: Project number, Project name, Cast unit position, Cast unit position code, Assembly control number (ACN), Cast unit ID, Cast unit prefix (2 digits), Cast unit drawing revision mark, Project properties - name, Project properties - address, File name with extension, File name without extension, Tekla Structures version, Main part ID, Project UDA, Main part UDA, Main part UDA (UT_product_code), Phase, User-defined text, User name, Main part template, Template and Text[Template]#Counter.

**Text[Template]#Counter:**

• Text can be any text including punctuation marks.
• Write templates in brackets [].
• # adds a running number if the data content is the same in several entries.
• You can enter several templates and use text delimiters.
• If you start the Text[Template]#Counter with a template, add a space as the first character before the bracket.
• Template attributes are read from the main part.
• You can also use attributes that refer to another hierarchy level.
• You can use <VALUE> to inquire a part UDA and {VALUE} to inquire an assembly UDA. This makes it possible to use a shorter string instead of having to use a template property to designate UDAs.
• Data field and file name options with #Counter logic keep the counter series separate from each other when necessary. Only objects with the same object type and matching data string as a base are put into the same counter series. For data fields other than HEADER block fields, these counter series are also distinct within each export file and data section.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Name of order               | Order fields in the HEADER block are filled with the selected data. 
**File name sections:** Specify a string consisting of numbers referring to the 6 sections of the exported file name mask that are specified on the Main tab. You can type numbers 1 to 6, and delimiters , , _ and - in the free input field to export any combination of strings used in the file name, in any order. For example, 1-2-3, or 2_5_6. |
| Name of component           | Component fields in the HEADER block are filled with the selected data. |
| Drawing number              | Drawing number fields in the HEADER block are filled with the selected data. 
**File name sections:** Specify a string consisting of numbers referring to the 6 sections of the exported file name mask that are specified on the Main tab. You can type numbers 1 to 6, and delimiters , , _ and - in the free input field to export any combination of strings used in the file name, in any order. For example, 1-2-3, or 2_5_6. |
<p>| Drawing revision            | Drawing revision fields in the HEADER block are filled with the selected data and drawing revision mark is exported. |
| Product code                | Product code fields in the HEADER block are filled with the selected data. |
| Project line1 text - Project line4 text | Project information fields (3rd line) in the HEADER block are filled with the selected data. |
| File creator (UT 6.0)       | You can select to export the Tekla Structures version information, use name or user-defined text in the HEADER block. |</p>
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Free field (UT 5.2)</strong></td>
<td>Only for Unitechnik 5.2. You can select to export the following information to the <strong>HEADER</strong> block: user name, user-defined text, file name with extension, file name without extension, or model name.</td>
</tr>
<tr>
<td><strong>Building site - name</strong></td>
<td>Name of the building site.</td>
</tr>
<tr>
<td><strong>Building site - street</strong></td>
<td>Street address of the building site.</td>
</tr>
<tr>
<td><strong>Building site - post code</strong></td>
<td>Postal code of the building site.</td>
</tr>
<tr>
<td><strong>Building site - place</strong></td>
<td>City or town where the building site is located.</td>
</tr>
<tr>
<td><strong>Building owner - name</strong></td>
<td>Name of the building owner.</td>
</tr>
<tr>
<td><strong>Building owner - street</strong></td>
<td>Street address of the building owner.</td>
</tr>
<tr>
<td><strong>Building owner - post code</strong></td>
<td>Postal code of the building owner.</td>
</tr>
<tr>
<td><strong>Building owner - place</strong></td>
<td>City or town where the building owner street address is located.</td>
</tr>
<tr>
<td><strong>Data field template units: No. of digits after decimal point</strong></td>
<td>Specify the number of decimals after the decimal separator in data field template units.</td>
</tr>
</tbody>
</table>

**Unitechnik export: SLABDATE block data tab**

In the column on the right, enter the custom or UDA string, when applicable. On this tab, you can add data attributes only, no geometric attributes. The attributes are either optional or obligatory. The length of some of the fields may be limited in the UT format, so keep the strings short.

Depending on the setting, the following attributes can be added: **Counter**, **Cast unit number**, **Cast unit position**, **Part position**, **Part number**, **Part name**, **Cast unit position code**, **Cast unit name**, **Cast unit GUID**, **Assembly control number (ACN)**, **Cast unit ID**, **Cast unit prefix**, **Cast unit thickness**, **Concrete part thickness**, **Cast unit width**, **Concrete part width**, **Main part thickness**, **Main part ID**, **Main part GUID**, **Main part UDA**, **Material**, **Name**, **UDA**, **User-defined text**, **Phase**, **Total quantity of part**, **Main part template**, **Part weight**, **Unit weight**, **Cast unit weight**, **Template**, **Template (shell main part)**, and **Text[Template]#Counter**.

**Template (shell main part):** Reads data from the respective double wall shell.

**Main part template:** Reads data from the double wall level 1 main part.

**Text[Template]#Counter:**
- Text can be any text including punctuation marks.
- Write templates in brackets [ ].
- # adds a running number if the data content is the same in several entries.
You can enter several templates and use text delimiters.

If you start the `Text[Template]#Counter` with a template, add a space as the first character before the bracket.

Template attributes are read from the main part.

You can also use attributes that refer to another hierarchy level.

You can use `<VALUE>` to inquire a part UDA and `{VALUE}` to inquire an assembly UDA. This makes it possible to use a shorter string instead of having to use a template property to designate UDAs.

Data field and file name options with #Counter logic keep the counter series separate from each other when necessary. Only objects with the same object type and matching data string as a base are put into the same counter series. For data fields other than HEADER block fields, these counter series are also distinct within each export file and data section.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Slab number</strong></td>
<td>Slab number field in the <code>SLABDATE</code> blocks is filled with the selected data.</td>
</tr>
<tr>
<td><strong>File name sections:</strong></td>
<td>Specify a string consisting of numbers referring to the 6 sections of the exported file name mask that are specified on the Main tab. You can type numbers 1 to 6, and delimiters , , _ and - in the free input field to export any combination of strings used in the file name, in any order. For example, 1-2-3, or 2_5_6.</td>
</tr>
<tr>
<td><strong>Unloading type</strong></td>
<td>Specify the unloading type. The options are:</td>
</tr>
<tr>
<td></td>
<td>• Lying</td>
</tr>
<tr>
<td></td>
<td>• Tilting table</td>
</tr>
<tr>
<td></td>
<td>• Main part UDA</td>
</tr>
<tr>
<td></td>
<td>You can override this setting on the Unitechnik tab for precast concrete parts, which overrides the export dialog box setting.</td>
</tr>
<tr>
<td><strong>Transport type</strong></td>
<td>Export the means of transportation information.</td>
</tr>
<tr>
<td></td>
<td>You can override this setting on the Unitechnik tab for precast concrete parts, which overrides the export dialog box setting.</td>
</tr>
<tr>
<td><strong>Transport unit number, Transport sequence number</strong></td>
<td>Define a value for the transport unit and sequence numbers in the <code>SLABDATE</code> blocks.</td>
</tr>
<tr>
<td></td>
<td>This can be defined in the part UDAs.</td>
</tr>
<tr>
<td><strong>Transport pile level number</strong></td>
<td>Specify the transport pile level number in the <code>SLABDATE</code> blocks. If there are elements in the stack</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>that need to be layered on</td>
<td>that need to be layered on the same level, then the pile level is used.</td>
</tr>
<tr>
<td>the same level, then the</td>
<td>For example, you may have a pile of 6 slabs, and they each have sequential pile level numbers 1, 2, 3.. 6.</td>
</tr>
<tr>
<td>pile level is used.</td>
<td>This can be defined in the part UDAs.</td>
</tr>
<tr>
<td>Exposure class</td>
<td>Export exposition class. You can select to read from part UDAs or use another option.</td>
</tr>
<tr>
<td>Total thickness</td>
<td>Select which value will be exported as total thickness. The options are <strong>Cast unit thickness</strong>, <strong>Concrete part thickness</strong>, <strong>Main part thickness</strong>, <strong>Template</strong>, and <strong>Double wall width</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>Double wall width</strong> is the same as the <strong>Cast unit thickness</strong> but it is always inquired from the main cast unit, regardless of how it is modeled. Then the 2nd shell will also receive total cast unit width.</td>
</tr>
<tr>
<td>Production thickness</td>
<td>Calculates the production thickness in SLABDATE block based on cast unit width, concrete part width or double wall width.</td>
</tr>
<tr>
<td></td>
<td><strong>Double wall width</strong> is the same as the <strong>Cast unit width</strong> but it is always inquired from the main cast unit, regardless of how it is modeled. Then the 2nd shell will also receive total cast unit width.</td>
</tr>
<tr>
<td></td>
<td>When you export double walls: With the option <strong>Cast unit width</strong> the cast unit thickness is exported for both shells.</td>
</tr>
<tr>
<td>Export shell gap width</td>
<td>Controls or disables the export of the gap width value. The options are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>No</strong>: No gap is exported.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Double walls only</strong>: The gap is exported only for double walls. This is the default option, as the value should only be used with double walls in most control systems.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Layered panels</strong>: The gap is exported for all panels with multiple concrete layers, such as double walls and sandwich walls.</td>
</tr>
<tr>
<td>Production weight</td>
<td>Set the type of the SLABDATE weight. The options are <strong>Part weight</strong>, <strong>Unit weight</strong>, <strong>Cast unit weight</strong>, and <strong>Template</strong>.</td>
</tr>
<tr>
<td>Concrete volume</td>
<td>Set the type of the volume. You can select concrete part or specify a user-defined concrete volume template property.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Maximum dimensions</strong></td>
<td>Specify how the SLABDATE maximum part length and width are exported. The options are:</td>
</tr>
</tbody>
</table>
|                                 | • **Main part bounding box** (default): Checks the main part geometry  
|                                 | • **Cast unit bounding box**: Checks the entire cast unit geometry, including all protruding embeds  
|                                 | • **Scanned contour**: Checks all contour polygons  
|                                 | • **Scanned all parts**: Checks all contour and embed polygons  
| **Iron protection**             | Export iron projection data. The values are automatically determined from the reinforcement length that extends outside the element.                                                                                                                                                                                                |
| **Quality of layer**            | Set the quality of the slabdate. The options are name, template, material and UDA.                                                                                                                                                                                                                                                   |
| **Item designation**            | Designate data about the exported element.                                                                                                                                                                                                                                                                                             |
| **Info 1 text (UT 6.0) - Info 4 text (UT 6.0)** | Information fields (1 - 4) in the SLABDATE and MOUNPART blocks are filled with the selected data.                                                                                                                                                                                                                               |
| **Export project coordinates**  | Select how you want to export project coordinates. The options are:                                                                                                                                                                                                                                                                       |
|                                 | • **No**  
|                                 | • **Yes, model origin**: Use model origin.  
|                                 | • **Yes, with swapped X-axis and Y-axis**: Swap X-axis and Y-axis.  
|                                 | • **Yes, special variant A (version 5.2b)**: Export Unitechnik files that are compatible with the IDAT stacker software. This is only available for the 5.2b version of Unitechnik.  
|                                 | • **Yes, project base point**: Use project base point.  
|                                 | • **Yes, current base point**: Use the base point currently selected in the model.  
| **Export quantity**             | You can export element quantity in the SLABDATE block. If the exported sets have multiple cast units, they will have their quantity marked in the SLABDATE reference number field. The export sets are defined by the file name definition or cast unit position. The options are:                                                                                                                                 |
|                                 | • **No**: 000 written in the field (default)  
<p>|                                 | • <strong>Always 1</strong>: 001 written in the field regardless if the files names are unique or not |</p>
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From selection</td>
<td>If the cast units in the export selection would have identical file names, they will be exported with only 1 file, and the total quantity of the set is written in the field.</td>
</tr>
<tr>
<td>From total in model</td>
<td>The total quantity of the cast units with identical position anywhere in the model is written in the field.</td>
</tr>
</tbody>
</table>

**Unitechnik export: MOUNPART block data tab**

On this tab, you can add data attributes only, no geometric attributes. The attributes are either optional or obligatory. The length of some of the fields may be limited in the UT format, so keep the strings short.

How to use **Text[Template]#Counter**:

- Text can be any text including punctuation marks.
- Write templates in brackets [].
- # adds a running number if the data content is the same in several entries.
- You can enter several templates and use text delimiters.
- If you start the **Text[Template]#Counter** with a template, add a space as the first character before the bracket.
- Template attributes are read from the main part of the embed assembly.
- You can also use attributes that refer to another hierarchy level.
- You can use `<VALUE>` to inquire a part UDA and `{VALUE}` to inquire an assembly UDA. This makes it possible to use a shorter string instead of having to use a template property to designate UDAs.
- Data field and file name options with #Counter logic keep the counter series separate from each other when necessary. Only objects with the same object type and matching data string as a base are put into the same counter series. For data fields other than HEADER block fields, these counter series are also distinct within each export file and data section.

**NOTE** Steel parts have a tab **Unitechnik Mountpart**, where you can specify data which then overwrites the settings defined on the **MOUNPART block data** tab.

When specifying object names: If names consist of several words, enclose those in quotation marks and use spaces between words, for example, "WORD1 WORD2".

For several options, you need to specify the related value in the **Custom UDA or string** field.
### Option Description

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type of mounting part</strong></td>
<td>You can define the type of mounting part in the <code>MOUNTPART</code> block by UDA, class or name.</td>
</tr>
<tr>
<td><strong>Installation type</strong></td>
<td>Specify the installation type of the embed by defining a UDA, class, name or user-defined text.</td>
</tr>
<tr>
<td><strong>Reference number</strong></td>
<td>You can define the reference number of a mounting part in the <code>MOUNTPART</code> block by UDA.</td>
</tr>
<tr>
<td><strong>Mountpart name</strong></td>
<td>Define the <code>MOUNTPART</code> name using one of the available options.</td>
</tr>
<tr>
<td><strong>Insulation name</strong></td>
<td>Specify a different mountpart name source for the insulation.</td>
</tr>
<tr>
<td><strong>Cut mountpart name</strong></td>
<td>Specify a different mountpart name source for the cut part mountparts.</td>
</tr>
<tr>
<td><strong>Info 1 text (UT 6.0)</strong></td>
<td>Information field is filled with the selected data.</td>
</tr>
<tr>
<td><strong>Info 2 text (UT 6.0)</strong></td>
<td>Information field is filled with the selected data.</td>
</tr>
</tbody>
</table>

**Unitechnik export: Line attributes tab**

Line attributes are exported automatically according to the element and opening edge shape. If the factory does not use Unitechnik standard line attribute codes, you can override these exported codes. Sometimes line attribute values that are exported in the Unitechnik files are not suitable for the particular situation. For example, to preserve lightness in the model or extensive product standardization, you might have fewer chamfers in the model than there will be in the actual structure. For this reason, you might want to override some line attributes in the export so that the model remains light, but the exported Unitechnik files are correct. You can do this by using the options on the **Line attributes** tab.

**NOTE** When specifying object names: If names consist of several words, enclose those in quotation marks and use spaces between words, for example, "WORD1 WORD2".

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Export line attributes</strong></td>
<td>Select whether the line attribute values are used for contours.</td>
</tr>
<tr>
<td><strong>for contour</strong></td>
<td>(Export line attributes for contour)</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| or for holes | Export line attributes for cutouts in the export.
| • None | Line attribute values are not used. |
| • All lines | Line attribute values are used for all lines. |
| • Outmost lines only | Line attribute values are used only for the outermost lines in the part: |

This option is available only for contours.

| Override scanned line attributes | Limit the override to specific cases. The options are All, Rotated, Not rotated, First shell and Second shell. The first option affects the 3 override settings above, and the second option affects the 3 settings below. Rotated and Not rotated apply to all rotations in XY direction, manual and automatic. |

<p>| Border line overriding | You can enter up to six border line modifications in the line attribute export. |
| No border lines are overridden. |
| Vertical outermost border lines at the start are overridden. |</p>
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Option" /></td>
<td>Horizontal outermost border lines at the bottom are overridden.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Option" /></td>
<td>Vertical outermost border lines at the end are overridden.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Option" /></td>
<td>Horizontal outermost border lines at the top are overridden.</td>
</tr>
<tr>
<td><img src="image4.png" alt="Option" /></td>
<td>Vertical outermost border lines are overridden.</td>
</tr>
<tr>
<td><img src="image5.png" alt="Option" /></td>
<td>Horizontal outermost border lines are overridden.</td>
</tr>
<tr>
<td><img src="image6.png" alt="Option" /></td>
<td>Horizontal and vertical outermost border lines are overridden.</td>
</tr>
<tr>
<td><img src="image7.png" alt="Option" /></td>
<td>All inclined outermost border lines are overridden.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="option1.png" alt="Image" /></td>
<td>All outermost border lines are overridden.</td>
</tr>
<tr>
<td><img src="option2.png" alt="Image" /></td>
<td>All vertical border lines, except the outermost border lines are overridden.</td>
</tr>
<tr>
<td><img src="option3.png" alt="Image" /></td>
<td>All horizontal border lines, except the outermost border lines are overridden.</td>
</tr>
<tr>
<td><img src="option4.png" alt="Image" /></td>
<td>All vertical and horizontal border lines except the outermost border lines are overridden.</td>
</tr>
<tr>
<td><img src="option5.png" alt="Image" /></td>
<td>All border lines except outermost border lines are overridden.</td>
</tr>
<tr>
<td><img src="option6.png" alt="Image" /></td>
<td>All border lines except the horizontal and vertical outermost border lines are overridden.</td>
</tr>
<tr>
<td><img src="option7.png" alt="Image" /></td>
<td>All border lines are overridden.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="image" alt="Scanned CUTOUT line attributes are overridden. This affects window openings, for example." /></td>
<td>Scanned <strong>CUTOUT</strong> line attributes are overridden. This affects window openings, for example.</td>
</tr>
<tr>
<td><strong>Orig. attr. , New attr.</strong></td>
<td>Define the original attribute (<strong>Orig. attr.</strong>) and the attribute that will be used in the export (<strong>New attr.</strong>). In the example below the horizontal outermost border line at the top would get a line attribute value 0033 originally, but the value will be overridden, and the line attribute value in the Unitechnik file will be 0040.</td>
</tr>
<tr>
<td><img src="image" alt="Special formwork for object (classes or names)" /></td>
<td>Specify a special formwork object using a class or a name. The edge of the exported contour with this specified object will then be exported with code 0002 by default. This setting also works for reinforcement. In <strong>Attribute code</strong>, you can specify a custom line attribute code for special formwork for an object.</td>
</tr>
<tr>
<td><strong>Export line attributes for cutouts</strong></td>
<td>Select whether all line attributes are exported for openings.</td>
</tr>
<tr>
<td><strong>Max, Min</strong></td>
<td>The width of the chamfer is max 30 mm and the depth of the tongue and groove max 30 mm. If not within the tolerance, they are handled as special formwork 0002.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Export angle of 1st and last vertical border</strong></td>
<td>Select whether you want to export the angle of cut at the first and last vertical border.</td>
</tr>
<tr>
<td><strong>Edge chamfer splits line</strong></td>
<td>Split the edge of the exported contour to have more line attributes exported for one edge.</td>
</tr>
</tbody>
</table>

**Unitechnik export: Pallet tab**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Placing on pallet</strong></td>
<td>Define if the placing is checked from the start or end of the pallet.</td>
</tr>
<tr>
<td><strong>X offset at start or end</strong></td>
<td>Define if the X offset at start or end of the pallet is checked.</td>
</tr>
<tr>
<td><strong>Y offset from alignment</strong></td>
<td>Specify the Y offset of elements on the pallet.</td>
</tr>
<tr>
<td><strong>Align in Y axis</strong></td>
<td>Align elements in Y direction. You can select whether to align</td>
</tr>
<tr>
<td></td>
<td>• element upper edge to pallet upper edge</td>
</tr>
<tr>
<td></td>
<td>• element upper edge to pallet center line</td>
</tr>
<tr>
<td></td>
<td>• element center line to pallet center line</td>
</tr>
<tr>
<td></td>
<td>• element lower edge to pallet center line</td>
</tr>
<tr>
<td></td>
<td>• element lower edge to pallet lower edge</td>
</tr>
<tr>
<td></td>
<td>• element to the center of the pallet in Y direction</td>
</tr>
<tr>
<td><strong>Clearance between cast units</strong></td>
<td>Define if the clearance between the cast units is checked.</td>
</tr>
<tr>
<td><strong>Same cast unit thickness needed</strong></td>
<td>Define if the cast unit thickness is checked.</td>
</tr>
<tr>
<td><strong>Sequence in pallet</strong></td>
<td>When you have selected <strong>Combined, n slabdate, 1 part</strong> as the output file structure on the <strong>Main</strong> tab, you can select the logic of sequencing panels on pallet using main part or cast unit ACN or number, main part UDA or main part template, or Unitechnik transport UDAs. You can set the sequence as <strong>Ascending</strong> or <strong>Descending</strong>.</td>
</tr>
</tbody>
</table>

**Unitechnik export: Symbols tab**

Configure the details of mountpart symbols and symbols for braced girders used in the export.
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| Special assemblies export                    | The options are No, Yes, *(spec_assemblies_def.txt)*, and Yes, no rotation on pallet. The options affect the exported geometry of the embeds. The real geometry is replaced by the geometry defined in text files. Each embed is defined as a symbol consisting of a set of lines, a set of arcs, or a circle. The default name of the text file is *spec_assemblies_def.txt*, and is searched for in the model folder. Use **Special export assembly file name** to define the name and the location of the text file. The special export assembly file name can also be read from folders defined for XS_FIRM and XS_PROJECT. Special assembly symbol definition file supports embed template properties and its values or embed names that have blank spaces. Embed template property values or embed names have to be enclosed in quotation marks. By default, the symbol definitions are mapped according to the exported embed designations. Designation can be any part property, which is controlled on the MOUNPART block data tab with the Mountpart name setting. The required structure of the text file is written in distinct rows, and the first row has to have the number of subsequent lines defining the geometry:  
  - Designation(text)  
    Number_of_lines_defined(number)  
  - S(representing single line)  
    Start_coors-X,Y (number number) End_coors-X,Y(number number) |
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>S</td>
<td>representing single line</td>
</tr>
<tr>
<td>Start_coors-X,Y(number number)</td>
<td>End_coors-X,Y(number number)</td>
</tr>
</tbody>
</table>

Example of the file:

```
Quicky 4
S -100 100 -100 -100
S 100 100 -100 -100
S -100 -100 100 -100
S -100 100 100 100
Quicky S 2
S -50 0 50 0
S 0 -50 0 50
E-Doze 2
S -100 100 100 100
S 0 -100 0 0
```

You can use S for a line, K for a circle, and B for an arc, and the coordinates are related to the embed insertion point.

A line is defined with 4 coordinates, start (X,Y), end (X,Y). Example: S -50 -50 50 50

A circle is defined with one radius value around the insertion coordinate. Example: K 100

An arc is defined with a radius value and relative start and end angles, with 0 angle pointing towards positive X direction, and increases counterclockwise.

Embeds in special assembly symbol definition file can also be designated by template property and its value in format [TEMPLATE:VALUE] instead of the exported embed designation.

Example of using template property:
The geometry of all embeds (from example with designations Quicky, QuickyS, E-Doze) are replaced by geometry defined in the text file. In the following example, the part number 1 (the name is Beam) was not found in the text file so the geometry is exported according to default settings from export dialog. On the opposite side the part number 2 (the name is Quicky) was found, so the geometry is replaced.

You can also define the def export code, insertion point logic and embed z-positioning on the first definition row:

- Designation(text)
- Number_of_lines_defined(number)
- Def_export_code(number, see above)
- Insertion_position(number 1-5) z-position (PALLET / BOTTOM / MIDDLE)
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>To specify the insertion point position of embeds in using the</td>
<td>spec_assemblies_def.txt file:</td>
</tr>
<tr>
<td>spec_assemblies_def.txt file:</td>
<td>1 = Subassembly center of gravity</td>
</tr>
<tr>
<td>2 = Subassembly bounding box</td>
<td>center of gravity</td>
</tr>
<tr>
<td>3 = Main part center of gravity</td>
<td>4 = Extended main part center of gravity</td>
</tr>
<tr>
<td>5 = Main part bounding box center of gravity</td>
<td>If you select <strong>Yes, no rotation on pallet</strong>, the embed symbols are placed according to the panel rotation, but the symbols themselves are not rotated.</td>
</tr>
<tr>
<td>Special embeds</td>
<td><strong>Class or name list</strong></td>
</tr>
<tr>
<td>When defining special embeds as names, and object names consist of</td>
<td>When defining special embeds as names, and object names consist of several words, enclose those in quotation marks and use spaces between words, for example, &quot;WORD1 WORD2&quot;.</td>
</tr>
<tr>
<td>several words, enclose those in quotation marks and use spaces</td>
<td></td>
</tr>
<tr>
<td>between words, for example, &quot;WORD1 WORD2&quot;.</td>
<td></td>
</tr>
<tr>
<td>Opening with corner symbols</td>
<td>Specify classes or names of parts or cut parts for openings that will be exported with corner symbols instead of mountpart representation.</td>
</tr>
<tr>
<td>All cutouts as corner symbols</td>
<td>Export rectangular cutouts as 4 corner symbol mount parts by defining the classes or names. You can define the size of the symbol in the dialog box.</td>
</tr>
<tr>
<td><strong>Cutpart former</strong></td>
<td>Specify a representation for the exported cutpart formers. The options are <strong>Default</strong>, <strong>As corner symbols</strong> and <strong>As centerline</strong>.</td>
</tr>
<tr>
<td><strong>Draw girder width symbol</strong></td>
<td>Specify if the braced girders exported with end symbol mountpart should also have a line representing the girder width.</td>
</tr>
</tbody>
</table>
| **Draw girder in second shell**                                        | Specify if the braced girders should be exported in the second shell of the **
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>double wall. You can also specify the length of the longitudinal line.</td>
<td></td>
</tr>
</tbody>
</table>

**Unitechnik export: Log files tab**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log file directory path</td>
<td>Define the path for a log file. If the path is empty, then the log file is saved in the same location as the export files.</td>
</tr>
<tr>
<td>Create main Log file</td>
<td>Select whether to create a one main log file.</td>
</tr>
<tr>
<td>Create Log file for each file</td>
<td>Select whether a log file is created separately for each export file.</td>
</tr>
<tr>
<td>Write history to log file and UDA</td>
<td>Create a log file containing the history of the exported parts. You can also select to write the information to the UDA UT_export_history of the main part. The following data is gathered: export time, part information, export path and file, and who has performed the export.</td>
</tr>
<tr>
<td>Show error dialog boxes</td>
<td>Select whether an error message is shown, for example, when exported parts are not numbered correctly or when the embedded parts have no parent part.</td>
</tr>
<tr>
<td>Write file name to UDA</td>
<td>Select to write the full export file name (File name with extension) or the export file name without the file name extension (File name without extension) to hidden main part UDA UT_FILE_NAME.</td>
</tr>
</tbody>
</table>

**Best practices in modeling, validating and exporting for Unitechnik**

The following guidance helps you to ensure the best possible result from the BVBS export.

For exact instructions on the Unitechnik export, export settings, and on other related topics, see Unitechnik (page 404).

Pre-research

Before you start modeling, find out the following:

- What are the fabrication requirements and constraints?
- What is the complexity level of the products?
- What information is desired from the model?
  - Production geometry for reinforcement mesh, loose rebars, embeds
• Project and product attributes
• What Unitechnik versions does the CAM system support?

Before your first project:
• Model a test model with each of the typical products.
• Choose your modeling components and modeling settings.
• Test the Unitechnik export with each of the typical products and draft suitable settings.
• Draft a company modeling guideline for collecting the information about modeling, drawing creation, export and other practices in one place.

Modeling

General
Designers should aim to model with good precision taking into account the fabrication requirements of the products. The required level of accuracy varies from product to product, and some details need to have exactly correct geometry whereas others can be included as attributes that will be sufficient for production purposes.

As production only needs certain amount of information, some data needs to be in drawings that will not be used within the export files and vice versa. The goal is to have an error free model, which is modeled in a disciplined and structured fashion so that it will be easy to include or exclude information in both drawing and export file creation. All information will be used by production, and therefore it is very important to have correct information, because also export might be prevented if data is missing (such as material data or other). Any mistakes are hard to notice until the actual production stage.

Additional information can be brought to both the drawing and production file using user-defined attributes (UDAs), which can be within each object, or on the project level. UDAs are defined on the HEADER block data specification, SLABDATE block data specification, Mounting part data specification and Reinf. data specification tabs in the export dialog box. Some mandatory fields have to filled as agreed, such as project number, product type and drawing number, otherwise import is prevented. For more information about the different tabs, see Unitechnik (page 404).

The best practice is to:
1. Finalize the detailing of a product.
2. Do a test export of the product with ready-made setting (for that product type) and inspect the resulting file and make any adjustments if necessary.
3. Create the drawing and edit it.
4. Finalize the drawing and send the drawing and a production file to a team member for approval.
5. Later on a designated person will send the production files in suitable sets.
6. Control the design status on object-level within the model to keep track of design, approval and changes, as well as the export files sets.

Object geometry will be used for plotting and shuttering as well as fabricating the mesh, and cutting and bending the reinforcement. Each object type should have a distinct NAME and CLASS setting, to later control the export content.

In the model objects are represented hierarchically. This means that the object to be exported is a cast unit and within the cast unit there is the concrete main part. Other parts or reinforcement can be attached to the main part directly, or by first formulating a sub-assembly, which will have its own hierarchy and main part.

**Unitechnik geometric objects**

The 3D Tekla Structures objects are translated to suit the Unitechnik format.
Contour and openings

Each object should have unified contour. There may be openings through the element.

More than one contour causes problems for plotting the contour and placing the shuttering. Having more than one contour is usually unintended, and caused by either having a concrete part that has not been designated as an embed, or the contour scanning resulting in two separate objects due to a cut or recess.

The orientation of the object and contour is controlled by the modeling direction, using the top-in-form setting within the model and the various settings within the export dialog box. Setting the top-in-form in the model is important because that is how Tekla Structures understands how the object
will be produced, which affects both the export file and the drawings. As a rule of thumb, slabs and panels should be laid out on their wide face, with no extending parts or rebars towards the pallet, and any embeds and gaps that require additional filler pieces against the pallet. These filler embeds should have 0 weight and should be excluded from drawings and volume calculations.  

If the edge has a shape that needs to be identified for a shuttering robot, this is indicated by using line attribute codes (for chamfers, recesses or teeth). These should be modeled using ready-made components, chamfers or cuts. These will always be in the geometrical object's contour and cutout. In export, they can be mapped automatically according to the Unitechnik standard, or you can set an automatic override in the export.  

In the usual case, CUTOUT represents a full-depth opening, while recesses in the face are represented by embeds, MOUNPART.  

For elements with standardized shape, such as pre-stressed slabs, the profile can be included as attribute information.  

Controlling the contour in the model is done by having an object profile, which will be extruded to create the main part geometry. This basic geometry can then be adjusted by using cuts within the model. Each cut should have a distinct class or part set, so including and excluding them in export geometry can be adjusted later. We recommend that you model any cuts or filler embeds with systematic orientation, and for example, start and end handles should also be modeled in the panel length direction.  

The initial cut parts are to be added to the cast unit, knowing that they will be listed on reports and shown on drawings. To exclude these purely production related elements from reports and drawings use filters and rules.  

In the example below the initial cut parts were kept and added to the cast unit. The cut part name is set to "FORMWORK", the class is 111 (orange), and the material name is Zero_weight.
The following example shows exactly the same wall panel, but without the formwork parts – they have been filtered out.
Example chart of classes for modeling cuts (Cut included = as CUTOUT, mountpart included = as MOUNPART):

<table>
<thead>
<tr>
<th>Type of cut</th>
<th>Modeled</th>
<th>Exported</th>
</tr>
</thead>
<tbody>
<tr>
<td>Window opening</td>
<td>Cut with class 601 (component)</td>
<td>Cut included</td>
</tr>
<tr>
<td>Door opening</td>
<td>Cut with class 601 (component)</td>
<td>Cut included</td>
</tr>
<tr>
<td>Other opening through the element</td>
<td>Cut with class 601 (component)</td>
<td>Cut included</td>
</tr>
<tr>
<td>Rectangular recess in the middle of element</td>
<td>Cut with class 602, filler embed part with class</td>
<td>Cut excluded, filler mountpart included</td>
</tr>
<tr>
<td>Rectangular recess on the contour</td>
<td>Cut with class 602, filler embed part with class</td>
<td>Cut excluded, filler mountpart included</td>
</tr>
<tr>
<td>Non-rectangular recess</td>
<td>Cut with class 602, filler embed part with class</td>
<td>Cut excluded, filler mountpart included</td>
</tr>
<tr>
<td>Cuts around embed components</td>
<td>Cut with class 602</td>
<td>Cut excluded</td>
</tr>
<tr>
<td>Chamfer on the edge</td>
<td>Chamfer or cut with class 603</td>
<td>As line attribute</td>
</tr>
<tr>
<td>Type of cut</td>
<td>Modeled</td>
<td>Exported</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>--------------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Groove or tongue shape on the edge</td>
<td>Cut with class 603 (component)</td>
<td>As line attribute</td>
</tr>
</tbody>
</table>

**Embeds**

Embeds are presented as mountparts. Steel plates for connections, lifting embeds, electric boxes or grout tubes are examples of mountparts. Each embed should be added as a sub-assembly to the main cast unit. Embeds are usually modeled with ready-made components, and it is important to check that the tools have correct materials and attributes, and that the embed hierarchy is correct. Embeds should be classified by a distinct class (recommended 100 - 109, other steel parts as 99). Steel parts can also be recognized automatically.

- There are various options available for presenting the embeds: exact geometry, a bounding box or a symbol.
- Embeds modeled as rebars can be turned into mountparts.
- Small cuts within the embed modeling components should usually be excluded, which can be done by separately identifying them with class.
- Insulation layers can be added as mountpart identified by class.
- Surface treatment can be exported as mountparts. Surface objects are not supported.
- Additional attributes can be added to each mountpart.

Remember the following:

- Apply meaningful names or identification codes to embeds, such as the component main part.
- Embed parts and sub-assemblies added to the cast unit must fully be added to the cast unit of Tekla Structures. Embeds or other connection entities not assigned to a cast unit of Tekla Structures will not be taken into account when exporting to UT file.
- Use logical hierarchical structure, and select a sensible main part for an embed sub-assembly.
- Check sub-assembly hierarchies. Only 2 levels within the sub-assembly is recommended.
- Check placing, classes, positioning, naming.
- Embed UDA tab settings for tailoring embed representation.
• Keep a list of all embeds and reinforcement in the project including their names and classes.

<table>
<thead>
<tr>
<th>Embed name</th>
<th>Numbering prefix</th>
<th>Modeling Class</th>
<th>Embed UT designation</th>
<th>Embed UT representation</th>
<th>Quantity unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grout Tube</td>
<td>GT</td>
<td>102</td>
<td>Name+profile+length</td>
<td>Line</td>
<td>m</td>
</tr>
<tr>
<td>Lifting Hook</td>
<td>LH-S</td>
<td>102</td>
<td>Name+size+length</td>
<td>Symbol ___</td>
<td>m</td>
</tr>
</tbody>
</table>

**Cut and bent reinforcement and reinforcement mesh**

*Cut and bent reinforcement* can be modeled by using standard rebar modeling functionalities or components. Rebars should be correctly attached to correct main parts, but this is rarely an issue if modeling carefully.

Usually the elements have a very high number of reinforcement but not necessarily all have to be brought into the export file, only the ones that need to be produced according to correct geometry or need to be quantified. In some cases, it is good idea to exclude the protruding rebars from cast units for better export. Bent rebar shapes will be presented as unfolded and in the xy plane in most of the viewers. 3D bent rebars are not supported by the format.

Reinforcement has automatically assigned reinforcement type to designate it in the production system. You can override this logic by manually adding reinforcement type in rebar UDAs for desired groups.

The mesh bars are automatically assigned to reinforcement types 1 and 2 or 5 and 6. The types 1, 2, 5 and 6 represent the installation layer in the form. 1 and 2 for mesh in bottom face, 5 and 6 on the top face.

Rebars can also be grouped and classified as cage objects by using rebar UDAs. It is very important to ensure that rebars are not accidentally grouped into mesh or cage.

![Tekla Structures Rebar UDA](image)

Additional attributes can be added to each bar group as well as to each bar.
Unitechnik supports both planar mesh and bent mesh. Mesh can be modeled as mesh objects or as crossing bar groups. If modeled as bar groups, the bars need to be identified using class (recommended a double digit class, e.g. 13 - 19) or name in the export dialog. If there are no bar groups to be designated as mesh, it is important to not use this setting.

The modeled cuts are also used for cutting meshes and bars within the Tekla Structures object.

Tekla Structures has several tools for creating mesh for precast objects, such as Mesh Bars, Mesh Array and Wall Panel Reinforcement.

Additional attributes can be added to each mesh object as well as to each bar within the mesh.

Remember the following:

- Model according to production constraints.
- Check placing, classes, positioning, naming.
- A mesh can be designed or created in the Tekla Structures model with mesh objects but also using bar groups. If mesh is bent in two directions, it can only be modeled as bar groups. The UT file export has several options to influence the mesh creation towards the end result.
- A mesh in the Tekla Structures cast unit, consisting of longitudinal and cross wire, should be defined either by
  - the same class (color)
  - the same name
- Do a differentiation of name and class per mesh having for instance bottom and top mesh within one wall shell.
- Furthermore, it is a good practice to apply loose or additional rebar to a dedicated class. Depending on the factory equipment and the processes involved it might be necessary to exclude certain rebars from a cast unit when exporting to the UT file. This can easily be achieved by excluding such rebars by class in question from the export. Class can also be used to distinguish rebars for non-automated production.
- There are advanced functions to validate mesh, or to add additional wires for stabilizing if the mesh has openings. Check the dialog box settings on the Reinforcement (page 404) tab.

In the example below the wall panel reinforcement rebar and mesh are created based on the suggested logic.

The mesh color has been set to red, class 79, its additional reinforcement to blue, class 88. Other reinforcement, also being added to the mesh manually later on in the production process, is set to yellow, class 6, and green, class 87. Reinforcement belonging to embeds are set to purple, class 7. With such a structure it is very easy to exclude rebar from automated mesh production and declare the UT file content as per factory or MC requirement.
Braced girders

Braced girders for half-cast or layered structures are identified by having a sub-assembly consisting of rebar groups and designating them with a specific class that is defined in export dialog box (recommended class 105). The top chord should be the main part of the sub-assembly.

Girders modeled from steel parts or rebars are both supported but rebars are recommended.

The best way to model braced girders is using modeling components such as the Braced Girders tool from Tekla Warehouse.
Strands

Strands should be modeled as rebar groups. Strand rebar groups are typically reinforcement type 9. The best way to model strands is the Hollow Core Reinforcement Strands tool.

Strands should be quite standard so in the production file they can represented with an identifier within the main part such as a Strand Code and quantity of strands. With the Hollow Core Reinforcement Strands tool this strand code can be automatically included in the slabdate data, otherwise it has to be manually controlled using UDAs.

Product information

Product information besides the geometry can be added as textual or numerical information. This data can be on any level of the hierarchy, but most important product information will be included in the HEADER and SLABDATE.

The following is automatically added:

- Names of the order and the element (but these have to be set in the export dialog)
- Product maximum dimensions, length, width in slab-block and thickness in product-block
- Total weight in the slabdate block
- Product material in the slabdate block in the layer data. Many layers can be exported but in most cases using only 1 layer provides best results.
- Product coordinates within the project (model) in the header block
- Product type (this needs to be set within the main part UDA) in the header block
- Reinforcement type in the rodstock block
- Reinforcement cage group numbers
- Transport information

Other recommended manual information:

- The name of the modeler
- The design status
- Bar and mountpart labeling
- The quantity of the strands (if applicable)
- Erection sequence (if applicable)

Other optional manual information:

- Project information
- Mountpart special instructions
• Concreting special instructions
In addition, any UDA or manual text can be added to info fields.

Product type
As a mandatory setting, the UT product type must be set for each main part of a cast unit.
The product type is not set by default. Select a product type for the element selected from the model from the predefined list of option.
We recommend that you save the UT product type in modeling settings and components.
The most commonly used types are:
• Solid wall
• Element slab
• Sandwich Element
• Double wall (1st stage)
• Double wall (2nd stage)
• Solid floor
Note that it is very important to define the double wall and sandwich wall correctly for both shells.
You can also define product types of your own in addition to the predefined types.
We also recommend that you systematically gather information about the product and keep it up to date.

<table>
<thead>
<tr>
<th>Products</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product Name</td>
</tr>
<tr>
<td>Hollow Core</td>
</tr>
</tbody>
</table>

Company-specific modeling guidelines
• Use classes to control element geometry and part/rebar filtering.
  • Included/excluded, automated/non-automated, mesh/loose bars
• Define UDA content to define the product
  • Project UDAs
• Unitechnik product types, location, additional info
• What to do with different types of element openings and recesses
  • Shuttered, plotted or excluded
• Use standard edge shuttering shapes
• Define standard meshes, rebars and embeds according to factory requirements
  • Wire sizes, spacings, bendings, overhangs, maximum dimensions, cutting
• Define top-in-form face for pallet orientation
• Create export settings for each product, and tailor them for each project

Attribute information

Project attributes
To streamline and obtain best possible results it is highly recommended to have the Tekla Structures cast units to be exported and processed by the Unitechnik file well structured. The modeling technique has a direct impact on the outcome of the UT file.

The following instructions give a guideline on the mandatory and the most needed settings to be set in the Tekla Structures model.

The UT file contains a dedicated header block with general information about the project where the cast unit to be manufactured belongs to.

Within the UT file export dialog box the content of the UT file header block can be defined by using the project settings of the Tekla Structures Structures model. All relevant information should be set in the beginning of the project in Project properties.
User-defined attributes (UDAs)

Each main part of a cast unit in Tekla Structures to be exported to an UT file requires additional information to be stored in the model. You can use user-defined attributes (UDAs) for this purpose. The UDAs are defined in the Tekla Structures objects.inp file which is present for each configuration but its content can differ per Tekla Structures user role. In the Precast configuration this file can be found in the ..\ProgramData\Tekla Structures <version>\environments\common folder.
In UT file export the **Unitechnik** tab must be available for precast elements.

**Element naming**

The UT file contains geometric information of the cast unit to be manufactured as well as its properties such as names and materials.

We recommend that you apply a meaningful naming to all elements of a cast unit (main part, embed part, rebar), as this will improve the readability of a UT file when being reviewed on the precast production control system. In most systems, the PDF drawing name should match the Unitechnik export file name.

**Element numbering**

Unique numbering is usually needed. ACN numbering is very handy for making sure that the export separates each piece into its traceable own export file and PDF drawing, rebar positions can be included into bar objects using a logic that suits the production.
Element color coding
Tekla Structures elements, such as parts and reinforcements, can easily be filtered by its class.

Self-validating the export file

- Validate after the export.
- Go through the geometrical objects within the slab-blocks and visualize them one by one.
- Investigate possible errors in notifications, logs and viewer.
- Check the date modified and naming of the files.
- Check the main attributes for HEADER and SLABDATE.
- Check orientation on pallet.
- Check contour and line attributes.
- Check the quantity of exported objects.
- Smoke test the rebar and mesh geometry. Check that the mesh production constraints have been taken into account, and translated correctly.
- Check the resulting embed plotting.
- If there are any issues, fix those in Tekla Structures, re-export and re-validate.
- Do not import to CAM unless you have checked the export files properly.
- Keep in separate folders (to be checked / faulty / checked and ready for import).

BVBS

You can export reinforcement geometry in the Bundesvereinigung Bausoftware (BVBS) format. The result is a text file in the ASCII format with a file name extension .abs.

The supported version of the BVBS format is 2.0 from 2000.

Tekla Structures versions from 2021 onwards support BVBS 3.0 from 2018. The syntax of the BVBS 3.0 file format follows otherwise the BVBS 2.0 file format specification, but a support for coupler and thread data has been added.

You can export bent reinforcing bars, reinforcing bar groups and reinforcement meshes, which can be rectangular, polygonal, non-bent or bent, and may include cuts. The export of hooks is also supported.

Reinforcing bars that have bendings with two or more variable radius values are exported fully conforming with the BVBS specification so that radius element and leg elements are written separately. If this causes compatibility issues within your own environment and other tools using the BVBS files, you
can still go back to the older way of exporting by setting the advanced option
`XS_BVBS_EXPORT_ARC_COMPATIBLE_TO_OLDER_METHOD` to `TRUE` in an `.ini`
file, for example, in `user.ini`.

To ensure the best possible export result, see Best practices in BVBS export
(page 498).

**Export in BVBS format**

1. Ensure that numbering is up to date.
2. Go to the properties of the cast units and reinforcement that you plan to
   export, and edit the user-defined attributes on the **BVBS** tab as required.
   The user-defined attributes are environment specific.
3. Select the cast units with the desired reinforcement content, or select the
   reinforcement.
4. On the **File** menu, click **Export** --> **BVBS**.
   The **Export BVBS** dialog box is displayed.
5. Define the BVBS export settings:
   a. On the **Parameters** tab:
      * select which reinforcement to export
      * define how and where to export the BVBS file or files, and include
        the revision into the file name
      * select which BVBS elements to export
      * define class numbers for girders
      You can use saved selection filters to exclude reinforcement bars or
      meshes matching with the selected filter.
   b. On the **Data content** tab:
      * define how to export drawing data
      * give the reinforcement position source
      * give the project number
      * select whether you want to export the private data block and
        select the data items for this additional block
   c. On the **Advanced** tab:
      * round rebar lengths for 2D bent bars
      * define which bending radius is used to calculate the arc length
      * make meshes out of rebars, and give UDA name for grouping
      * include detailed data of mesh bars in the export
• export tapered reinforcing bar groups as multiple separate reinforcing bar items
• define the order of the items in the output file
• define the export of reinforcement coupler data
• define whether to combine single rebars or rebar groups by their position number, with the total bar quantity, or handle each single rebar or rebar group individually

BVBS export uses arc geometry in two cases:
• For circular rebars such as spirals or hoops.
• When bent rebar has more than 1 bending radius, the bends with the larger radius are exported as arc sections.

d. On the **Checking** tab, select whether you want to run additional checks for the reinforcing bars.

e. On the **UDAs** tab, define the UDA fields to be used, and the content to write into reinforcement, part, cast unit and pour object UDAs.

6. Click **Export**.

The BVBS file or files in the .abs format are exported to the folder specified in the **Output file** area. You can check the export report by clicking the report link that appears at the bottom of the dialog box.

**BVBS export settings**

Use the **Export BVBS** dialog box to control the BVBS export settings.

**Parameters tab**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Model objects to be exported</strong></td>
<td>Select which reinforcing bars or meshes are exported.</td>
</tr>
<tr>
<td>• <strong>Reinforcement of all cast units in the model:</strong> Exports reinforcing bars or meshes in all cast units in the model. If there are cast units that do not have reinforcing bars or meshes, no empty files are created.</td>
<td></td>
</tr>
<tr>
<td>• <strong>Reinforcement of selected cast units:</strong> Exports reinforcing bars or meshes in the cast units you have selected in the model.</td>
<td></td>
</tr>
<tr>
<td>• <strong>Selected reinforcement only:</strong> Exports the reinforcing bars or meshes you have selected in the model or in the drawing. This option also exports selected rebar assemblies. When you select this option, you can export only to a single file.</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>• <strong>Reinforcement of selected cast units (totals by all positions):</strong> Exports reinforcing bars or meshes in all the cast units that have the same cast unit position as any of the selected cast unit positions. For example, if a cast unit with the cast unit position W-120 is selected, the reinforcing bars or meshes in all the cast units that have position W-120 are exported even though not all of them were selected.</td>
<td></td>
</tr>
<tr>
<td>• <strong>Reinforcement of selected pours:</strong> Exports a set of reinforcement in the selected pour. Select the pour in the pour view. Ensure that you have used the <strong>Calculate pour units</strong> command to include the rebars in the pour.</td>
<td></td>
</tr>
</tbody>
</table>

| Excluding reinforcement by filter | Exclude reinforcing bars or meshes by selecting any of the selection filters. Reinforcing bars or meshes that match the filter are excluded. |
| Output file - Single file | Export all BVBS information into one .abs file. Enter the file name in the box or click the ... button to browse for the file. If you do not enter a path, the file is saved in the model folder. |
| Output file - One file per each cast unit | Export each cast unit reinforcement content to its own file. The files are created under the folder that you define in the Folder name box, or you can browse for the folder using the ... button. Use the **File naming template** list to select how the created files are automatically named. You can use multiple assembly template properties in the file name. Type the template properties in the box and separate them with spaces. The combination will be separated by underscores in the exported file name. |
| Include revision into file name | Select to include revision into file name. Select one of the following options to include it in the output file name: • **Revision mark:** REVISION.MARK, default value • **Revision number:** REVISION.NUMBER • **Rev<Revision mark>:** same as Revision mark but the text Rev comes first |
### Setting | Description
--- | ---
• **Rev<Revision number>:** same as Revision number but the text Rev comes first

**Mapping file**
Define the mapping file used in mapping the name of the reinforcement material or grade to another name. This allows you to match the requirements of the software processing of the BVBS data if there are different reinforcement materials or grades to be used. By default, the mapping file `bvbs_export.dat` is located in the model folder, but it can also be used from the folders defined by the advanced options XS_SYSTEM, XS_PROJECT, and XS_FIRM.

See "Reinforcement material and grade mapping file example" below for an example of the `bvbs_export.dat` mapping file.

**BVBS elements to be exported**
Select which item types are exported. The options are:
• 2D reinforcement bars (BF2D)
• 3D reinforcement bars (BF3D)
• Spiral reinforcement coils (BFWE)
• Reinforcement meshes (BFMA)
• Lattice girders (BFGT)

If you select Lattice girders (BFGT), enter the class numbers used in the model for the lattice girder bars in the Class numbers for girder box. The lattice girder may contain two or three chord bars and one or two diagonal zig-zag bars. The lattice girder length and other attributes are taken from the main chord (usually top chord).

Any such lattice girders should be modeled with a distinct class from other reinforcement to ensure that other rebars will not be processed by the function.

Braced girders are recognized automatically by the GIRDER_TOP_GUID UDA, added by the Braced Girder modeling components. If the Lattice girders (BFGT) option is not enabled, braced girders are exported as normal rebars, unless excluded.
### Setting | Description
--- | ---
**Class numbers for girder** | Enter the class attribute for recognizing lattice girders. The class should be same for all rebars within a girder.

**Data content tab**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Drawing name source</strong></td>
<td>In BVBS file each row/rebar has a data field for <strong>Drawing number of the respective drawing (drawing name)</strong> and <strong>Index of the respective drawing (drawing revision)</strong>. With the option <strong>Drawing name source</strong> you can control how the values for these data fields will be set.</td>
</tr>
<tr>
<td><strong>Cast unit position</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Drawing Name</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Drawing Mark</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Drawing Title1</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Drawing Title2</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Drawing Title3</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Fixed text</strong></td>
<td><strong>If you select this, enter the text in User-defined drawing name.</strong></td>
</tr>
<tr>
<td><strong>Reinforcement UDA</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Reinforcement template</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Cast unit template</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Assembly template</strong></td>
<td>By selecting the option <strong>Fixed text</strong> you can enter the values in the dialog box and same (&quot;fixed&quot;) values will be written for every exported rebar. If any of the other options is selected, the drawing name and revision will be taken from the cast unit or cast unit drawing of the rebar. When you use the option <strong>Assembly template</strong> and a rebar assembly exists, the rebar assembly is always read. Otherwise, the cast unit is read.</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Assembly template</strong></td>
<td>The option <strong>Assembly template</strong> takes data from the closest assembly hierarchy level and <strong>Cast unit template</strong> from the top cast unit.</td>
</tr>
<tr>
<td></td>
<td>Note that it depends on the receiving system of the BVBS file how important and for what purpose this data will be used. From Tekla Structures perspective, using this data field is not obligatory.</td>
</tr>
<tr>
<td><strong>User-defined drawing name</strong></td>
<td>Enter a text string to be used for the drawing in the export.  This option is available only when you have selected the <strong>Fixed text</strong> option in <strong>Drawing name source</strong>.</td>
</tr>
<tr>
<td><strong>Rev</strong></td>
<td>Drawing revision (index). This option is available only when you have selected the option <strong>Fixed text</strong> in <strong>Drawing name source</strong>.</td>
</tr>
<tr>
<td><strong>Position source</strong></td>
<td>Define the source of the position. The options are <strong>Reinforcement position</strong>, <strong>Reinforcement UDA</strong>, <strong>Reinforcement template</strong>, and <strong>Fixed text</strong>.</td>
</tr>
<tr>
<td></td>
<td>For <strong>Reinforcement template</strong>, enter the name of an attribute. For example, to obtain the reinforcement shape code, enter SHAPE, or to obtain the reinforcement position number, enter POS.</td>
</tr>
<tr>
<td></td>
<td>For <strong>Reinforcement template</strong>, you also enter multiple template attributes and use empty space as a separator. For example, enter SHAPE POS.</td>
</tr>
<tr>
<td><strong>User-defined reinforcement position</strong></td>
<td>Define the reinforcement UDA position number. Exported item with the same position number but different UDA position number will be exported to different rows.</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Project number</strong></td>
<td>Define the project number. The options are:</td>
</tr>
<tr>
<td></td>
<td><strong>Project Properties</strong>: The export fetches the project number information from the project properties set in Tekla Structures.</td>
</tr>
<tr>
<td></td>
<td><strong>Project properties UDA</strong>: The export uses the UDA name entered in the User-defined project number box.</td>
</tr>
<tr>
<td></td>
<td><strong>Fixed text</strong>: The export uses the text entered in the User-defined project number box.</td>
</tr>
<tr>
<td><strong>User-defined project number</strong></td>
<td>Define the UDA project number or a text string to be used as the project number.</td>
</tr>
<tr>
<td><strong>Private data block</strong></td>
<td>With <strong>Private data block</strong> you can control whether the private data block is exported (<strong>Export private data block</strong>) and select the data items for this additional block. The following data types are available:</td>
</tr>
<tr>
<td></td>
<td>- Reinforcement report property (integer, float or text)</td>
</tr>
<tr>
<td></td>
<td>- User-defined attribute (integer, float or text)</td>
</tr>
<tr>
<td></td>
<td>- Open API object property</td>
</tr>
<tr>
<td></td>
<td>- Assembly report property (integer, float or text)</td>
</tr>
<tr>
<td></td>
<td>Click the <strong>New...</strong> button to add new predefined private data fields to the list. Enter information about the data item.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Name in list</strong></td>
</tr>
<tr>
<td></td>
<td>The text shown in the <strong>Private data block</strong> list.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Field identifier (one lower case letter)</strong></td>
</tr>
<tr>
<td></td>
<td>The field code which separates the individual data fields in the private data block. It can be any lower case letter. Typically, it is a</td>
</tr>
</tbody>
</table>
good practice to use a different value for each data item but this is not required. The receiving system may also be able to read only certain data fields.

- **Property or UDA name**
  The value defines which data will be inquired from the reinforcement object. Note that a non-existing property will be not exported.

- **Property data type**
  The value has to match the actual selected property. The options are:
  - Reinforcement report property Integer/Reinforcement report property Float/Reinforcement report property Text
  - User defined attribute - Integer/User defined attribute - Float/User defined attribute - Text
  - Open API object property
  - Assembly report property Integer/Assembly report property Float/Assembly report property Text

You can also edit and remove data fields, and change their order.

<table>
<thead>
<tr>
<th>Advanced tab</th>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Rounding</strong></td>
<td><strong>Round</strong></td>
<td>Round rebar lengths for 2D bent bars. Mesh and 3D rebars are not affected. To round the lengths, first select an option for the <strong>Round</strong> setting. The options are:</td>
</tr>
<tr>
<td></td>
<td><strong>Round lengths to</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Round leg lengths to</strong></td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Yes</td>
<td>Uses the nearest rounding value.</td>
<td></td>
</tr>
<tr>
<td>Up</td>
<td>Rounds the lengths up.</td>
<td></td>
</tr>
<tr>
<td>Down</td>
<td>Rounds the lengths down.</td>
<td></td>
</tr>
</tbody>
</table>

For the **Round** options **Up** and **Down**, there is a preliminary tolerance for small length differences up to 0.2 mm before performing the rounding. This ensures that values very close to exact increment are not rounded when it is not necessary.

**Round lengths to** rounds the total rebar lengths in the corresponding BVBS field in the header block, and the available values are 1 (default), 5, 10, and 25.

**Round leg lengths to** rounds the leg lengths in the geometry block, and the available values are 1 (default), 5, and 10.

**Bending**

**Bent leg arc radius**

This setting defines which bending radius is used to calculate the arc length: Bending radius to the rebar center line (**Center line**), which is the default for most interfaces, or to the rebar inner edge (**Inner edge**). If you select **Inner edge**, the bending radius is shortened with half of the rebar nominal diameter.

The BVBS export uses arc geometry in two cases:

- For circular rebars such as spirals or hoops.
- When bent rebar has more than 1 bending radius, the bends with the larger radius are exported as arc sections.

**Meshes**

**Try to make meshes of rebars**

Select whether the export tries to automatically form meshes of a single reinforcing bar or of a group reinforcing bars and export them as a
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>mesh instead of separate 2D bars.</td>
<td>The options are:</td>
</tr>
<tr>
<td>Yes, group rebars by class</td>
<td></td>
</tr>
<tr>
<td>Yes, group rebars by name</td>
<td></td>
</tr>
<tr>
<td>Yes, group rebars by grade</td>
<td></td>
</tr>
<tr>
<td>Yes, group rebars by UDA</td>
<td></td>
</tr>
<tr>
<td>Yes, group rebar assemblies</td>
<td>To form a mesh, the reinforcing bars need to belong to the same part, be straight, be on the same plane, and have equal filtering attribute values. All grouping methods can handle rebar assemblies.</td>
</tr>
<tr>
<td>UDA name for grouping</td>
<td>If you selected the value Yes, group rebars by UDA for Try to make meshes of rebars, enter the UDA name for grouping.</td>
</tr>
<tr>
<td>Exporting of mesh bar data (@X.@Y.)</td>
<td>Use this setting to control whether the detailed data on mesh bars is included in the exported data of the mesh. The appropriate option depends on the needs and capabilities of the receiving system. The data is needed if it will be used, for example, for mesh fabrication.</td>
</tr>
<tr>
<td>• Custom and cut catalog meshes only</td>
<td>Detailed bar data is included only for custom meshes and catalog meshes that have additional cuts, openings or skewed edges.</td>
</tr>
<tr>
<td>• All meshes</td>
<td>Detailed bar data is written for all meshes.</td>
</tr>
<tr>
<td>• None meshes</td>
<td>Detailed bar data is not written to any of the meshes.</td>
</tr>
<tr>
<td>Tapered reinforcement groups: Tapered rebar groups need to have linear spacing.</td>
<td></td>
</tr>
<tr>
<td>Export stepped bars as separate items</td>
<td>By default, a stepped group is exported as a single string with the</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Stepping length</td>
<td>Stepping length defined in a certain data block. If you select the value <strong>Yes</strong> for <strong>Export stepped bars as separate items</strong>, all tapered reinforcing bar groups are exported as multiple separate reinforcing bar items even if they have regular spacing and could be exported as one single stepped reinforcing bar item. If all the tapered bars within the group have the same geometry and length, they will be exported within a single BVBS string as a regular group would, regardless of this setting.</td>
</tr>
<tr>
<td>Sorting</td>
<td>Use this setting to define the order of the items in the output files. The options are: <strong>No sorting</strong>, <strong>By diameter, smaller size first</strong>, <strong>By diameter, bigger size first</strong>, <strong>By position number</strong></td>
</tr>
<tr>
<td>Totaling</td>
<td>Select either of the following options: <strong>Yes</strong>: Single rebars or rebar groups are combined by their position number, with the total bar quantity. This is the default option. <strong>No</strong>: Each single rebar or rebar group is handled individually and exported. This leads to a larger BVBS file, but the advantage is that each single rebar and rebar group can be identified and handled by its own GUID, and the BVBS file will reflect the model objects or IFC exported rebars.</td>
</tr>
</tbody>
</table>
Mechanical connections tab

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coupler</td>
<td>You can export coupler and thread data.</td>
</tr>
<tr>
<td>Export reinforcement coupler data</td>
<td>Set <strong>Export reinforcement coupler data</strong> to <strong>Yes</strong> to export coupler or thread data. Enter the UDAs for the connection method, product, and product code for the rebar start and rebar end separately, for example METHOD_START, METHOD_END, PRODUCT_START, PRODUCT_END, CODE_START, and CODE_END. Note that the UDAs depend on the creation tool and may differ from the examples. The UDA representing the method must be of type INTEGER, and the UDAs representing product and code must be of type STRING.</td>
</tr>
</tbody>
</table>

Checking tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check reinforcement</td>
<td>Select whether you want to run additional checks for the following: <strong>Reinforcement diameters</strong> (separated with spaces) <strong>Minimum cutting length</strong> of reinforcing bars <strong>Maximum cutting length</strong> of the reinforcing bars <strong>Minimum leg length</strong> for straight sections between the bends <strong>Maximum weight</strong> of individual bars When you select the <strong>Check reinforcement</strong> check box, and the values of the exported reinforcing bar are less than the minimum or greater than the maximum, a warning is written to the export log file.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>The log file entry contains the ID of the reinforcing bar. You can locate the reinforcing bar in the model by selecting the appropriate row in the log file. Note that the reinforcing bar is still exported normally and only the additional warning is given. Note that when the check is activated, the length of lattice girders is also checked. A warning is added in the log when the check fails. The length of the main chord defines the exported length of the lattice girder.</td>
<td></td>
</tr>
</tbody>
</table>

**UDAs tab**

On this tab you can define the UDA fields to be used (UDA), and the content to write into reinforcement, part, cast unit and pour object UDAs (UDA content). You can tag UDAs based on release code, release status, release date and released by information. You can also select whether existing UDAs are checked and handled by using the setting Check existing UDAs. The options are No, Prevent export, Report to log, Report to log and overwrite, and Overwrite only.

**BVBS export file description (.abs)**

The content of the BVBS export file .abs is described below. The example data structure represents a 2D bar, which is either straight, or bent on one plane at most. Section H is the header section (identification and general information), and section G is the geometry section (production geometry).

For detailed BVBS interface description, see BVBS-Guideline Data exchange of reinforcement data on the official site of the BVBS organization.

(1) BVBS element (product type)
(2) Project number
(3) Drawing number (in this example, cast unit position number)
(4) Drawing revision number (not in use in this example)
(5) Rebar position number
(6) Single rebar length
(7) Product quantity
(8) Single rebar weight
(9) Rebar diameter
(10) Material grade
(11) Bending diameter (a straight bar)
(12) Rebar layer (not in use the BVBS export)
(13) Step tapering for a tapered rebar series if grouping tapered enabled in export settings (no tapering in this example)
(14) Leg length (only 1 leg in this example)
(15) Bending angle after the leg
(16) Checksum for correct data transfer. Checksum is a sum operation based on the converted numerical values of the ASCII characters on a BVBS row.

Reinforcement material and grade mapping file example

Example of the mapping file bvbs_export.dat:

```
// ++++++++++++++++++++++++++++++++++++++++++++++++++
// Grade/Material mapping
// Tekla Structures grade <tab> Alternative material name/code
// ++++++++++++++++++++++++++++++++++++++++++++++++++

#GRADE
H 500E
RB 500E
HR 500E
R 300E
D 300E
```
**Reinforcing bar length calculation in BVBS export**

The length of the reinforcing bar is calculated according to the BVBS specification. The length also depends on the bending angle. Lengths L1 and L2 are exported.

A basic distinction is made between bends (with standard diameter of mandrel 4*ds) and arches (with specification of angle and radius). Bends are marked with the bending pin symbol in the image. For further explanation of segment lengths see the current version of EN ISO 3766.

If you set the advanced option `XS_USE_USER_DEFINED_REBAR_LENGTH_AND_WEIGHT` to `TRUE`, the user-defined length value is exported as the overall length for the reinforcing bar.

Note that the BVBS format specifications define that the overall length of the bar is ignored if the data contains actual geometry data. Some other software applications may still use the overall length values in the BVBS file for calculating quantities. The exported overall length in Tekla Structures is the same length as shown in reports.

**Best practices in BVBS export**

The following guidance helps you to ensure the best possible result from the BVBS export.
For exact instructions on the BVBS export, export settings, export file description, and the reinforcing bar length calculation in the BVBS export, see BVBS (page 483).

- Export only those reinforcement types that the production control system and machinery support.
  - Ensure that the rebar sizes, bending roll sizes, leg lengths and angles, spacings, and overhangs are within the machinery constraints.
- Model your parts and reinforcement with systematic naming and classes.
  - Create and maintain clear selection filters to exclude undesired rebar content.
- Use a file naming logic that results in unique file names, which can be traced back to the export set.
  - Export in larger sets that can be systematically traced into a specific building section or a drawing.
  - Using the default option for cast unit position will export the total amount of rebars in all relevant cast units to be combined into the same file. There might be problems with the quantities if the amount of cast units changes later on. Instead, you can use Assembly template as the File naming template, and a unique identifier to ensure that only rebars from one cast unit are within one export file.
- Keep track of the export sets in the model using part/pour UDAs.
  - After the first export, it is easy to lose track which rebars have been exported already.
  - Using rebar UDAs is heavier for the model database.
- Use private block to transfer extra information - Note that some import interfaces do not support private block.

**ELiPLAN**

ELiPLAN is a software for resource planning, scheduling, and management for precast concrete fabricators. ELiPLAN import and export automate the data transfer between Tekla Structures and ELiPLAN.

The data transfer between Tekla Structures and ELiPLAN consists of four parts:

1. Exporting ELiPLAN data file from Tekla Structures.
2. Importing ELiPLAN data file into ELiPLAN.
3. Exporting ELiPLAN status data file from ELiPLAN.
4. Importing ELiPLAN status data file into Tekla Structures.

The import of an ELiPLAN data file into ELiPLAN supports the incremental approach, which means that ELiPLAN is able to create, update, and delete
parts in its database. This means that precast detailers can export the most up-to-date data files whenever the Tekla Structures model has been changed.

Similar incremental support is included in the import of an ELiPLAN status data file to Tekla Structures. To keep the status and schedule data up to date in a Tekla Structures model, we recommend you update the status data regularly.

In the ELiPLAN export, the part geometry (profile, cuts, openings, and notches) is always automatically exported. You need to define the plotter data and the necessary attributes. Every time you export, you need to export all the parts that have been exported before to ensure proper change management in ELiPLAN. Same applies to the import. The export is based on part GUIDs, and the import is based on the project name/number and part GUIDs.

**NOTE** The format and contents of the ELiPLAN status data file imported to Tekla Structures differs from the data file that is exported from Tekla Structures to ELiPLAN.

For more information about the best practices in ELiPLAN export, see Best practices in ELiPLAN export (page 522).

**Export an ELiPLAN data file**

You need to export everything that is ready. If you are using a shared model, first check the situation by checking the drawings, for example.

1. Add ELiPLAN information to ELiPLAN user-defined attributes of the parts.
   This is optional, the product types and product codes are defined automatically. There are numerous ways to alter these for the export besides the manual UDA handling. See later sections.
   For more information about the UDAs, see ELiPLAN user-defined attributes in this same article.

2. On the **File** menu, click **Export --> ELiPLAN**.
   The Export ELiPLAN file dialog box is displayed.

3. Define the ELiPLAN export properties on the **Parameters**, **Plotter data**, **Weep holes**, **Data content Data settings**, and **EliX content** tabs. For more information about the export properties on different tabs, see further down in this same article. There is no setting for controlling the export of element corner cuts created by line cuts in the model. These are exported with a dedicated type code to the ELiPLAN file.

4. On the **Parameters** tab, set **Scope of export** to **All** or **Selected**.
   You should always bring every element that is ready to ELiPLAN with every round to ensure that any design changes are taken into the system as well. The model might have some non-relevant or not-ready cast units, which is why it is recommended to use **Selected** to control which ones are being exported. Conceptual cast units can be taken, but then you need to
keep track of these elements, for example, by using a UDA. You also need to ensure their GUID stays the same in the later export rounds.

5. Click **Create**.

By default, the export file `eliplan.eli` is created in the current model folder, in a `.\EP_files` subfolder. The export file is written with UTF-8 encoding.

**ELiPLAN export settings**

Use the **Export ELiPLAN file** dialog box to control the ELiPLAN export properties.

**Parameters tab**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Scope of export**              | Select whether all parts or only selected parts are exported. Because of the incremental import of ELiPLAN, you need to select the same parts, and some additional parts again, if needed, when exporting the next time, to make sure that any design changes are taken into the system as well. Otherwise ELiPLAN assumes that the parts missing from the subsequent file have been deleted in the Tekla Structures model.

We recommend you to always use the **All** option. Use the **Selected** option when you are exporting parts for the first time, if you are exporting from unfinished model or in special cases. Use the filtering option to control the product or phase scope. |
<p>| <strong>Export using filter</strong>          | Specify a selection filter. The parts to export are selected on the basis of the specified selection filter. |
| <strong>Numbering must be up to date to export</strong> | Set this setting to <strong>Yes</strong> to prevent export when the numbering is not up to date. This prevents the export of unfinished cast units. |</p>
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Export version number</strong></td>
<td>The elements need to have a unique identifier. The options are GUID, ID, ACN and FloorMES.</td>
</tr>
<tr>
<td></td>
<td><strong>1.01 (ID)</strong> should only be used when the export is done only once, because of the changing IDs.</td>
</tr>
<tr>
<td></td>
<td>Use <strong>2.00 (GUID)</strong>, because IDs will change when reopening the model, resulting in duplicates in export.</td>
</tr>
<tr>
<td></td>
<td>Select <strong>2.00 (ACN)</strong> to export elements with ACN.</td>
</tr>
<tr>
<td></td>
<td>The <strong>3.0 (Plant Control)</strong> version file format is intended for interfacing with newer Elematic FloorMES versions, and is also based on GUID. The file format has been extended with additional data fields, and therefore it is not backwards compatible.</td>
</tr>
<tr>
<td></td>
<td>Version 3.0 of the export supports the export of accessory code to plotter data, and the export of accessory code for openings. Furthermore, with the export version 3.0, a plotter record of type BL is exported for the hollow core elements to define the side that has been cut. The border line record is exported as a line parallel with the longer side of the hollow core element.</td>
</tr>
<tr>
<td><strong>Export version type</strong></td>
<td>Select the type of the export version. The options are <strong>Eli</strong> and <strong>EliX</strong>.</td>
</tr>
<tr>
<td></td>
<td>The <strong>Eli</strong> option only exports the production data file with the file extension .eli.</td>
</tr>
</tbody>
</table>
|                              | The **EliX** option creates a package with a special file extension .elix. The package contains the production data file together with the drawing PDFs from the folder path that has been specified on the **EliX content** tab.
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Information about files included in the EliX</strong></td>
<td>Information about files included in the EliX package are written in the export log file. The EliX option is applicable for the release version number 3.0 and newer only.</td>
</tr>
<tr>
<td><strong>Output file name</strong></td>
<td>The name and location of the export file created. The default name is eliplan.eli. You can import this file into ELiPLAN. Use the ... button to select another location.</td>
</tr>
<tr>
<td></td>
<td>The eliplan.eli file includes, among other things, material information. The accessory code, which is the material description, is in the #Materials block.</td>
</tr>
<tr>
<td></td>
<td>The accessory code is based on the material type as follows:</td>
</tr>
<tr>
<td></td>
<td>• For concrete material the default accessory code is same as the material name.</td>
</tr>
<tr>
<td></td>
<td>• For mesh, reinforcing bars, or strands the default accessory code is grade</td>
</tr>
<tr>
<td></td>
<td>• For embedded material the default accessory code is name</td>
</tr>
<tr>
<td></td>
<td>The export file is written with UTF-8 encoding.</td>
</tr>
<tr>
<td><strong>Open exported file after processing</strong></td>
<td>Open the exported file in the associated application after the processing has been completed.</td>
</tr>
<tr>
<td><strong>Data conversion file</strong></td>
<td>With this file you can convert the parametric profile names into the ELiPLAN product codes, and the material descriptions into the ELiPLAN accessory codes. You need to create the file yourself when necessary.</td>
</tr>
<tr>
<td></td>
<td>The default file name is eliplan_export.dat, and this file can be located in any folder. Use the ... button to select another location.</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>The data conversion file can also be read from folders defined for XS_FIRM and XS_PROJECT. The data conversion file eliplan_export.dat contains string pairs separated with one or more tabs. The string on the left side is the profile name or Tekla Structures material description and the string on the right side is the corresponding ELiPLAN data. Data conversion supports case insensitive text, which means that it does not distinguish between uppercase and lowercase letters when looking for strings to be replaced. The data conversion file supports the use of the wildcard asterisk (<em>) in regular expressions in the first column for finding strings from Tekla Structures objects. For example, you can type L</em>FT to find LØFT or LIFT or LOFT. Accessories, such as steel embeds and insulation blocks, can be quantified as piece count or with custom measurement units.</td>
<td></td>
</tr>
</tbody>
</table>

Note that the ELiPLAN codes depend on the fabricator, and the codes that are valid for one fabricator are likely to be not valid for other fabricators.
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setting</td>
<td>You can disable/enable the usage of the data conversion file by clearing the <strong>Enabled/Disabled</strong> check box next to the <strong>Data conversion file</strong> setting. For an example of data conversion file contents, see <strong>Sample_for_Eliplan_Data_Conversion.dat</strong>.</td>
</tr>
<tr>
<td>Filter by part: Element data</td>
<td>Enter a list of classes or to be excluded from or included in the export. This contains the class numbers or names used for concrete parts. Separate the classes or names with a space. You can also specify a selection filter for filtering element data, materials or secondary concrete elements.</td>
</tr>
<tr>
<td>Filter by part: Material quantities</td>
<td>Enter a list of classes or to be excluded from or included in the export. This contains the class numbers or names used for materials. Separate the classes or names with a space. You can also specify a selection filter for filtering materials.</td>
</tr>
<tr>
<td>Filter by part: Secondary concrete</td>
<td>Enter a list of classes or names to be excluded from or included in the export. This contains the class numbers or names used for secondary concrete parts. Separate the classes or names with a space. You can also specify a selection filter for filtering secondary concrete elements.</td>
</tr>
<tr>
<td>Create log file</td>
<td>Select whether a log file is created. Creating a log file is recommended to ensure that the exported file is correct. The log will notify you about the number of exported cast units and, for example, if: • Export failed because numbering not done.</td>
</tr>
</tbody>
</table>
Some cast units could not be exported.
- Some cast units were ignored by filters, or they are CIP.
- Embeds or cuts to be plotted are completely outside the parts.
- Some of the material or product type data conversion mapping is not recognized.

The name and location of the created log file. Use the ... button to select another location.

Select how to export cutout data. The options are:
- **All**: Exports all data.
- **Full depth cuts only**: Exports data only on the cuts that go through the whole part. Does not export recess data.
- **None**: Does not export any cutout data.

It is recommended to use **Full depth cuts only**, because otherwise small recesses are included in the plotting on both faces.

Overlapping cutouts are combined in the export file.

This setting exists for hollowcore and slab products, and for wall and sandwich wall products separately.

Select whether to export data of embeds. The options are:
- **Yes**: Exports data on embeds.
- **No**: Does not export any data on embeds.
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Export of filled cores</strong></td>
<td>Select whether to export the geometry of filled slab cores. The options are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Yes</strong>: Exports the geometry of filled slab cores.</td>
</tr>
<tr>
<td></td>
<td>• <strong>No</strong>: Does not export the geometry of filled slab cores.</td>
</tr>
<tr>
<td></td>
<td>Note that the position in Z is exported for filled cores. The export of the Z coordinate for all items in the PLOTTER block is controlled the <strong>Export embed Z position</strong> on the <strong>Data content</strong> tab.</td>
</tr>
<tr>
<td><strong>Export of inner cores</strong></td>
<td>Select whether to export the geometry of the inner cores of the hollow cores. The options are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Yes</strong>: Exports the geometry of the inner cores of the hollow cores.</td>
</tr>
<tr>
<td></td>
<td>• <strong>No</strong>: Does not export the geometry of inner cores of the hollow cores.</td>
</tr>
<tr>
<td><strong>Export of weep holes</strong></td>
<td>Select whether to export data of weep holes. <strong>Yes</strong> exports the weep holes according to the settings defined on the <strong>Weep holes</strong> tab. <strong>No</strong> (default) does not export any data on weep.</td>
</tr>
<tr>
<td><strong>Wall and sandwich wall products</strong>:</td>
<td>See the descriptions for <strong>Export of cutout data</strong> and <strong>Export of embed data</strong> above.</td>
</tr>
<tr>
<td><strong>Plot additional reinforcement</strong></td>
<td>Plot additional reinforcement as bounding box. The options are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>None</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Class</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Name</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Grade</strong></td>
</tr>
<tr>
<td><strong>Plot cutout/embed as lines</strong></td>
<td>Export cutouts and embeds as lines. The options are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>None</strong></td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Plot irregular cutout/recess</strong></td>
<td>The <em>As lines</em> option exports as lines the bounding box cutouts and recesses that overlap a diagonal edge. By default, they are exported as box. Note that we recommend you to use the default setting if the factory uses anElematic Modifier machine to ensure correct data processing.</td>
</tr>
<tr>
<td><strong>Plot lifters</strong></td>
<td>Specify how the lifter geometry should be plotted - as outline or as center point.</td>
</tr>
<tr>
<td><strong>Exclude cut parts by</strong></td>
<td>Use to exclude cut parts from export based on the cut part properties. The options are:</td>
</tr>
<tr>
<td></td>
<td>- None</td>
</tr>
<tr>
<td></td>
<td>- Class</td>
</tr>
<tr>
<td></td>
<td>- Name</td>
</tr>
<tr>
<td></td>
<td>- Material</td>
</tr>
<tr>
<td></td>
<td>This setting is a handy filter for reducing amount of extra cuts in plotting.</td>
</tr>
<tr>
<td><strong>Exclude embeds by</strong></td>
<td>Use to exclude embeds from exported plotting data embeds by:</td>
</tr>
<tr>
<td></td>
<td>- None</td>
</tr>
<tr>
<td></td>
<td>- Class</td>
</tr>
<tr>
<td></td>
<td>- Name</td>
</tr>
<tr>
<td></td>
<td>- Material</td>
</tr>
<tr>
<td></td>
<td>You can define one or more values for the selected property.</td>
</tr>
<tr>
<td><strong>Exclude above z position</strong></td>
<td>Select whether to exclude from exported plotting data embeds or cuts that are above the specified Z position. The Z position is the depth</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>of the element on the pallet, that is how many millimeters the lowest point of the embed is above the pallet surface. You can define one or more values for the selected property. The options are:</td>
<td></td>
</tr>
<tr>
<td>None</td>
<td></td>
</tr>
<tr>
<td>Embeds</td>
<td></td>
</tr>
<tr>
<td>Cuts</td>
<td></td>
</tr>
<tr>
<td>Embeds and cuts</td>
<td></td>
</tr>
</tbody>
</table>

Weep holes tab

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weep holes offset</td>
<td>Specify the weep hole offsets:</td>
</tr>
<tr>
<td></td>
<td>• <strong>At end zones</strong>: Provides weep holes at the slab end zones of the hollowcore.</td>
</tr>
<tr>
<td></td>
<td>• <strong>At end zones recess/ opening</strong>: Provides weep holes at recesses or openings for the end zones of hollowcore.</td>
</tr>
<tr>
<td></td>
<td>• <strong>At filled cores</strong>: Provides weep holes around filled cores. Filled core parts can be specified by class or by name.</td>
</tr>
<tr>
<td></td>
<td>• <strong>At lifting loops</strong>: Provides weep holes at lifting loops.</td>
</tr>
<tr>
<td></td>
<td>• <strong>At middle only, length less than</strong>: Export weep holes only at the middle of elements with a length less than the specified length.</td>
</tr>
<tr>
<td></td>
<td>• <strong>At notch</strong>: Provides weep holes at notches.</td>
</tr>
<tr>
<td></td>
<td>• <strong>At side recess/opening</strong>: Provides weep holes at side pockets.</td>
</tr>
</tbody>
</table>
### Setting | Description
--- | ---
**No** (default): Does not export any data on weep.  
**Merge weep holes, closer than:**  
Merge weep holes if they are within the specified distance.

### Data content tab

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Project name, Project number** | Use these settings to specify the project name and project number written in the exported file. The options are Project UDA, Project template, and User-defined text.  
The maximum length of the project number is 12 characters (usually digits), and the maximum length of the project name 37 characters (string). This is the maximum number of characters that the export file accepts.  
Note that the ELiPLAN file must have a valid project number that needs to match the project number in the ELiPLAN database, otherwise the ELiPLAN file import will not succeed. |
| **Comment 1 - 3** | In the comment fields you can provide extra information to be included at the start of the export file.  
The options are:  
**No comment**  
**Tekla Structures version**  
**Model name**  
**User name**  
**User-defined text**  
The comments are only for viewing the export file and will not be read in to ELiPLAN. |
<p>| <strong>Product code</strong> | Select the default product code mapping, which then should |</p>
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>correspond with any data conversion strings.</td>
</tr>
<tr>
<td></td>
<td>Any content in the ELiPLAN Product Code (EP_PRODUCT_CODE) UDA field always overwrites the Product code string determined by the export settings.</td>
</tr>
<tr>
<td></td>
<td>You can specify multiple UDAs by separating them with a blank space. In output, the content of UDAs will be written in the same order, separated by blank spaces.</td>
</tr>
<tr>
<td>Accessory code</td>
<td>Specify the accessory code for standard embeds such as steel parts. This will be the code written to each embed in the #Plotter (if applicable) and #Materials blocks, and the chosen option should be used as a base for further data conversion mapping. The default option is NAME</td>
</tr>
<tr>
<td></td>
<td>You can specify multiple UDAs by separating them with a blank space. In output, the content of UDAs will be written in the same order, separated by blank spaces.</td>
</tr>
<tr>
<td>Material code</td>
<td>Specify the material code for other materials besides accessories. This will be the code written to each non-embed material in the #Materials block, and the chosen option should be used as a base for further data conversion mapping. The default option sets a varying logic specific for each material type, such as concrete or reinforcement.</td>
</tr>
<tr>
<td></td>
<td>You can specify multiple UDAs by separating them with a blank space. In output, the content of UDAs will be written in the same order, separated by blank spaces.</td>
</tr>
<tr>
<td>Erection section</td>
<td>Read the erection section from a user-defined attribute (UDA) or from a custom property (Template).</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Erection sequence</td>
<td>Read the erection sequence from a user-defined attribute (<strong>UDA</strong>) or from a custom property (<strong>Template</strong>).</td>
</tr>
<tr>
<td>Export material data</td>
<td>Select whether to include or exclude the detailed material data (receipt) of parts. If you have no use for material data in ELiPLAN (you have no material handling module in ELiPLAN), select <strong>No</strong> to exclude the data from the file and to reduce the file size. Note that once you have transferred the file with the material data (<strong>Yes</strong>) you should never switch off (<strong>No</strong>) the export of material data in subsequent exports.</td>
</tr>
<tr>
<td>Export rebar bending data</td>
<td>Select whether to include or exclude the detailed rebar bending information. If you do not need this data in ELiPLAN, select <strong>No</strong> to exclude the data from the file and to reduce the file size. Note that once you have transferred the file with the rebar bending data (<strong>Yes</strong>) you should never switch off (<strong>No</strong>) the export of rebar bending data in subsequent exports.</td>
</tr>
<tr>
<td>Export embed Z position</td>
<td>Select whether to include or exclude the Z level of embeds.</td>
</tr>
<tr>
<td>Notes</td>
<td>Use UDA or template attribute to add extra information to be viewed at the factory, such as design status, change status or general comment. Select what type of notes you want to export: UDA, a template attribute or your own text. Then enter the UDA, template attribute, or text.</td>
</tr>
<tr>
<td>Stack, Pile number, Pile level</td>
<td>The export of stack results is supported starting from ELiPLAN export version 3.0. You can select if the</td>
</tr>
</tbody>
</table>
### Data settings tab

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UDA for unit conversion</td>
<td>Specify a UDA for unit conversion. When a valid unit is specified in this UDA, then the specified unit is used for the unit conversion instead of the default unit, or the unit defined in the conversion file.</td>
</tr>
<tr>
<td>Unit for element dimensions</td>
<td>Select the unit to be used for the element dimensions. Information about the unit selected for element dimensions is written in the header in version 3.0 of the ELiPLAN export.</td>
</tr>
<tr>
<td>Unit for rebar length</td>
<td>Select the unit for the length of reinforcing bars. Information about the unit selected for rebar lengths is written in the header in version 3.0 of the ELiPLAN export.</td>
</tr>
<tr>
<td>No. of digits after decimal point</td>
<td>Select the number of digits after the decimal separator (0 - 3). The default is 1 digit after the decimal separator.</td>
</tr>
<tr>
<td>Tag for lifters</td>
<td>Use to identify lifting loops by their name or class (default). Also rebar objects can be specified as lifters using a class or a name. It is also possible to specify multiple classes or names. If the name consists of multiple words then it has to be enclosed in quotation marks. Additionally, a user-defined attribute (UDA), or a template attribute (Template) can be specified to use a</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>specific property with a specific value to recognize lifters. When lifting loops are identified, the plotter instruction type is changed from WPL to LL.</td>
</tr>
<tr>
<td>Tag for filled cores</td>
<td>You can enter either a single string (the name) or multiple strings. Tekla Structures will then use the entered name or names as filter criteria to determine filled cores from the model. Depending on the selected option, the placement of the weep holes will be calculated and written to the export file.</td>
</tr>
<tr>
<td>Prefix for ID</td>
<td>Enter a prefix (letter) to use with the ID number.</td>
</tr>
<tr>
<td>Position number type</td>
<td>Select whether to export the cast unit position number, assigned control number (ACN), or cast unit position number and ACN.</td>
</tr>
<tr>
<td>Remove numbering separator</td>
<td>Select whether a position number separator is used in numbering. The default is No.</td>
</tr>
<tr>
<td>Tag special elements</td>
<td>Set this option to Yes to set a special tag for elements that have notch cuts. This option marks hollow-cores with notches with SK denominator (N for uncut slabs).</td>
</tr>
<tr>
<td>Strand code</td>
<td>Specify a UDA or a template attribute to read the strand code. Default reads the value from the UDA TS_STRAND_CODE. You can also specify a custom property using the option Template.</td>
</tr>
<tr>
<td>Net area calculation</td>
<td>Select Exclude all cuts to exclude all cuts, or Exclude full depth cuts only to exclude full depth cuts only from the net area calculation, or Gross area to export gross area as net area. You can also specify a custom property using the option Template. The whole assembly is checked. You are now notified via log when the net area calculation fails.</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Weight calculation</td>
<td>Select which weight will be exported. The options are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default</strong>: reports the weight defined by the attribute <strong>CAST_UNIT.WEIGHT_NET</strong>.</td>
</tr>
<tr>
<td></td>
<td>• <strong>WEIGHT</strong>: reports the weight defined by the attribute <strong>WEIGHT</strong>.</td>
</tr>
<tr>
<td></td>
<td>• <strong>WEIGHT NET</strong>: reports the weight defined by the attribute <strong>WEIGHT_NET</strong>.</td>
</tr>
<tr>
<td></td>
<td>• <strong>CAST UNIT WEIGHT</strong>: reports the weight defined by the attribute <strong>CAST_UNIT.WEIGHT</strong>.</td>
</tr>
<tr>
<td></td>
<td>• <strong>MAIN PART WEIGHT</strong>: reports the weight defined by the attribute <strong>WEIGHT</strong>.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Template</strong>: reports the weight defined by a specified template attribute or custom property.</td>
</tr>
<tr>
<td></td>
<td>• <strong>User-defined density</strong>: reports the result of the user-defined density value * object volume.</td>
</tr>
<tr>
<td>Include sub-materials</td>
<td>Export sub-materials of concrete material. Sub-materials are exported in the #SUBMATERIAL section of data conversion file.</td>
</tr>
<tr>
<td>Decimal mark</td>
<td>Set period (.) or comma (,) as the decimal mark depending on ELiPLAN settings.</td>
</tr>
</tbody>
</table>

**EliX content tab**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cast unit drawings</td>
<td>Specify the folder path that you want to read for any cast unit drawing PDFs. The content of this folder will be included in the exported .elix zip file in EliX export.</td>
</tr>
<tr>
<td>Unitechnik files</td>
<td>Specify the folder path that you want to read for any Unitechnik files. The content of this folder will be included in the exported .elix zip file in EliX export.</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------</td>
</tr>
<tr>
<td></td>
<td>in the exported .elix.zip file in EliX export.</td>
</tr>
</tbody>
</table>

**ELiPLAN data conversion file**

The data conversion file contains string pairs separated with one or more tabs. The string on left side is the profile name or Tekla Structures material description and the string on right side is the corresponding ELiPLAN data. The mapping can also contain the unit for quantity for material codes.

You can combine several mappings in one, because the product and material code conversion is based on tags separated with the pipe character (“|”). A matching conversion is used when any tags are found in the source file.

Note that the ELiPLAN codes depend on the fabricator and the codes which are valid for one fabricator are most probably not valid for other fabricators.

The product code and the material code can be defined separately: mappings following the line #PRODUCT CODES are used for product code conversion and mappings following the line #MATERIAL CODES are used for material conversion.

Example of a data conversion file:

```
#PRODUCT CODES
//
// Hollow-core slabs
//
265X1200    HCS27
320X1200    HCS32
400X1200    HCS40
//
// Beams
//
BEAM|RCDL      B_LP2P
BEAM|RCL    B_LP
BEAM        B_SK

#MATERIAL CODES
//
// reinforcement
//
A500HW|6     TW6     kg
A500HW|8     TW8     kg
A500HW|10    TW10    kg
A500HW|12    TW12    kg
A500HW|16    TW16    kg
A500HW|20    TW20    kg
A500HW|25    TW25    kg
A500HW|32    TW32    kg
//
// Strands
//
1570/1770   1570/1770     m
//
// Meshes
//
B500K|8/8-200/200    B500K8-200     m2
```
You can combine several mappings in one, because the product and material code conversion is based on tags separated with the pipe character ("|"). Make sure that you use matching case.

**ELiPLAN export file (.eli)**

The .eli file contents are described below.

Header data for file info

The geometry of the elements is reported in the #Pieces and #Plotter blocks:

#Pieces:
- Contains a unique data row for each slab.
- Has a unique data row for each slab.
- For hollowcore slabs, the outer measurements are reported in the #Pieces block based on the min (x, y) and max (x, y) values of the slab. These measurements describe a rectangle, parallelogram or trapezium. The thickness, profile and additional information of the slab is reported.
- In the #Pieces block you can separately flag slabs that have cuts in the edges.

#Plotter:
- Contains data for individual plotting operations by element, such as embeds, recesses, and through-cuts.
- The #Plotter block also contains geometrical data that is arranged by the slab position. The operations are performed on each slab on the basis of the position number.
- Each plotting operation is on its own row (formwork accessories, recesses, cross sections).
- In the export settings you can define the plotting data scope included in the export.
- The shapes can be lines, rectangles or circles.
- The order of the rows is not important, they will be reorganized in ELiPLAN.
• If the geometry cannot be presented as a rectangle or a circle inside the slab boundaries, it will be presented as a line.

• Overlapping plotting with the outer boundaries defined by the #Pieces data has been minimized, and crossing the edges is prevented.

#Materials:
• Contains data for material quantities by element.

#Bars:
• Contains data for rebar shapes by element.

Example of an export file:

```
2.00;1;04.06.2019 11:49:15
# Pieces
56a109f8-562c-4aa5-882a-a45cc7be9b95;B_LP2P;B/1;1200.00;0.00;0.00;500.00;600.00;0.00;3628.80;1.51;4.32;1.08;;PHASE 1;;N;0;
3dbe09b6-1b35-44e7-a18f-0c492a71b6a6;HCS32;HC/1;600.00;600.00;0.00;700.00;0.00;320.00;0.00;1655.09;0.69;4.20;4.06;;PHASE 1;;N;0;
1d2c4018-daa3-4b5d-801a-4a1e491db41f;HCS32;HC/1;600.00;600.00;0.00;320.00;0.00;320.00;2765.20;1.15;7.20;6.93;;PHASE 1;;N;0;
5b003ef7-2c79-4e4d-844f-51616ad0584d;HCS32;HC/1;600.00;600.00;0.00;1200.00;0.00;320.00;2747.86;1.14;7.20;6.89;;PHASE 1;;N;0;
e670a8ac-c034-4fa9-b5e3-0a17461502fb;HCS32;HC/2;600.00;600.00;0.00;1200.00;0.00;320.00;2446.78;1.02;6.89;6.13;;PHASE 1;;N;0;
868229bf-36ed-4b87-9d2e-e7c36962b181;HCS32;HC/3;4875.00;4000.00;0.00;1200.00;0.00;320.00;2044.57;0.85;5.85;5.12;;PHASE 1;;N;0;
# Plotter
HCS32;HC/3;LI;LI;5750.00;1200.00;600.00.00;850.00;0.00;0.00;
# Materials
B_LP2P;B/1;C35;1.51;
HCS32;HC/1;C40;0.69;
HCS32;HC/3;1570/1770;18.00;
HCS32;HC/2;C40;1.15;
HCS32;HC/3;1570/1770;36.00;
HCS32;HC/3;C40;1.14;
HCS32;HC/3;1570/1770;34.69;
HCS32;HC/4;C40;1.02;
HCS32;HC/5;C40;0.85;
HCS32;HC/5;1570/1770;24.22;
# Bars
```

**Import an ELiPLAN status data file**

If you have a status data file that has been created in ELiPLAN, you can import the status and scheduling information to your Tekla Structures model.

1. On the **File** menu, click **Import --> ELiPLAN**.

   The **Import ELiPLAN status data** dialog box opens.

2. Click the ... button next to the **Import file name** box to browse for the file to be imported.
3. Click **Create**.

Tekla Structures updates the status and schedule data for parts in the Tekla Structures model. When the data is read, a log file is displayed.

The log file shows the parts whose data is updated correctly. It also provides information on possible problems that may have occurred. When you select a row in the log file, Tekla Structures automatically selects the corresponding part in the model. The overall status information is shown at the end of the log file.

Tekla Structures stores the actual status data in the user-defined attributes of the parts. To view the data, open the part properties, click the **User-defined attributes** button and go to the **ELiPLAN** tab.

**ELiPLAN user-defined attributes**

In addition to normal model data, you can add additional information in the user-defined attributes of the parts. The additional information can be transferred from Tekla Structures and used in ELiPLAN.

The product type and product code user-defined attributes override the automatic product type and product code. Other user-defined attributes are reserved for ELiPLAN import.

---

**Product type**

The product type affects how ELiPLAN considers the part dimensions length, length2, deltaL, width, height, and thickness.

The product type user-defined attribute overrides the product type defined in the ELiPLAN export dialog box.
To set the product type, select a suitable product type option from the list. Normally you should be able to use the default **Auto**, but in some cases you may need to override the default.

If needed, you can override the product type value set in the dialog box in the following way:

- You can enter a value for the user-defined attribute **EP_TYPE** in the `objects.inp` file.
- You can enter a value for the user attribute **EP_TYPE** in the **Profile catalog**.

In the **Profile catalog**, the attribute value is given as a number. The values are as follows:

- Slab = 1
- Beam = 2
- Column = 3
- Wall = 4
- Sandwich wall = 5
- Stair = 6

**Product code**

The product code user-defined attribute overrides the product code defined in the ELiPLAN export dialog box.

You have alternative ways to give the product code. The ELiPLAN export tries to define the product code in the following order:

1. You can enter a value for the product code in the ELiPLAN user-defined attributes dialog box.
2. You can enter a value for the user-defined attribute **EP_CODE** of the cast unit main part in the `objects.inp` file.
3. You can enter a value for user attribute **EP_CODE** in the **Profile catalog**.
4. You can use the data conversion file to convert parametric profile names to a product code.
5. The main part name is exported as the main part name if none of the previous methods succeeded.

**Erection sequence**

Precast parts are erected in a certain sequence. Use the sequence to help the scheduling of the production in ELiPLAN. You can give the estimated erection sequence by giving the sequence number for parts.

**Ready for production**

Set this option to **Yes** when the designer or detailer has finished the part and the part is ready for production. The default is **No**, which means that the data
is transferred to ELiPLAN for preliminary planning only, and the part is not sent for production until the attribute is set to Yes and a new file is transferred to ELiPLAN.

**ELiPLAN status data**

The **ELiPLAN status data** is meant to be read-only information and used to visualize the data in a Tekla Structures model.

**Set up your UDAs in the model or profile catalog for mapping object types, profiles and materials**

For more information on how to set up your UDAs in the model or profile catalog for mapping object types, profiles and materials to suit the ELiPLAN export, see [EliPLAN/ELiPOS export guide](#).

**Handling sub-materials in ELiPLAN export**

**NOTE** To enable the calculations as well as the transfer to the ELiPLAN file, the option **Include sub-materials** must be set to **Yes** on the **Data settings** tab in the **Export to ELiPLAN file** dialog box.

---

The ELiPLAN export serves the purpose of providing production-related data for precast units. Quantities are provided as well as other relevant information. From a material point of view, the amount of concrete as well as the quantities of pieces (ref, embeds, reinforcement, etc.), is transferred.

Referring to the main material concrete, the ELiPLAN export does not provide information on the concrete mixture - the concrete recipes are handled by the fabrication or production system. However, the including the sub-materials allows the calculation of the sub-materials, such as water, sand, and gravel, which are required for the composition of the concrete type.

To enable the calculations and the export of the sub-materials, additional information must be added to the ELiPLAN mapping file, usually named `eliplan_export.dat`. Below is an example with explanations:

```
#SUBMATERIAL
C35/45 SUBMATERIAL_1 0.2
C35/45 SUBMATERIAL_2 0.8
C35/45 SUBMATERIAL_3 0.1
```

Essential is the block identifier `#SUBMATERIAL` where the actual sub-material definitions are made. The logic of entering data follows the same logic as the other blocks and records in the mapping file, use the tabulator key to separate the entries.

- The first record in the block represents the material used in the Tekla Structures model, chosen from the Tekla Structures material catalog, C35/40 in the above example.
• The second record represents a sub-material, SUBMATERIAL_1 in the above example.

• The third record represents the calculation factor for the sub-material, 0.2 in the above example.

About factors

Note that the example factors are only used to explain the functionality. When you start to use the functionality, we recommend that you refer to the official concrete type recipes to determine the correct factors.

• Concrete density (as per catalog definition) = example 2450 kg/m3

• SUBMATERIAL_1 should be used to report the amount of cement = example 0.2

• The calculation of the amount of cement per m3 = 2450 x SUBMATERIAL_1 factor = 490 kg

• SUBMATERIAL_2 should be used to report the amount of sand, gravel, and crushed stones = example 0.8

• The calculation of the amount of cement per m3 = 2450 x SUBMATERIAL_2 factor = 1960 kg

• SUBMATERIAL_3 should be used to report the amount of water = example 0.1

• The calculation of the amount of cement per m3 = 2450 x SUBMATERIAL_3 factor = 490 kg

If there is a need to modify the sub-materials further, for example, if the name needs to be mapped or the type of unit needs to be changed, the existing ELiPLAN export mapping functionality takes care of that. As with other entities, the mapping is done within the #MATERIAL CODES block. Here is an example:

#MATERIAL CODES

SUBMATERIAL_1 CEMENT t
SUBMATERIAL_2 SAND t
SUBMATERIAL_3 WATER t

Examples of ELiPLAN files

Click the links below to see examples of ELiPLAN files. You can open the files with a standard text editor.

• ELiPLAN data conversion file: Sample_for_Eliplan_Data_Conversion.dat.

• ELiPLAN export file: Sample_for_Export_Eliplan.eli

• ELiPLAN import file: Sample_for_Import_Eliplan.sql
**Best practices in ELiPLAN export**

The following guidance helps you to ensure the best possible result from the ELiPLAN export.

For exact instructions on the ELiPLAN export, export settings, and on other related topics, see **ELiPLAN (page 499)**.

**Pre-research**

Before you start, find out the following:

- Which elements are produced?
- What are the bed sizes and other fabrication requirements?
- What should be plotted?
- Are embed and rebar quantities desired?
- What kind of product and material codes are being used?
- What additional information is desired from the model?
- Is it needed to bring process information back to the model?

Before you start a project:

- Collect product codes and material article numbers.
- Create the data conversion file, include any necessary codes, and test with sample products that the data conversion table works as intended.
- Use automatic settings or choose the most suitable input method.
- Numbering logic:
  - For ELiPLAN, every element should be unique and traceable.
  - Data scope: Geometry, attribute, materials
    - Which products and materials to include?
    - Which plotter data to include?
    - Draft a modeling guideline to categorize model objects with specific class/name/other attribute
    - Fabrication requirements: dimensions, profiles, maximum weight
    - Document everything in the modeling guideline

**Best practices in ELiPLAN export**

The following guidance helps you to ensure the best possible result from the ELiPLAN export.

For exact instructions on the ELiPLAN export, export settings, and on other related topics, see **ELiPLAN (page 499)**.
Workflow

- Model according to modeling guideline, depending on fabrication requirements.
- Model precast objects with their embedded content.
- If hollow-core geometry is used for plotting within ELiPOS, ensure that recesses and embed positions are accurate.
- Set up profile and material catalogs according to fabrication requirements.
- Adjust the profile catalog and modeling settings so that the mapping to the ELiPLAN system is done correctly.
- Ensure that you use the materials and profiles that you have mapped.
- Define standard export settings in line with the modeling guideline.
- In newer Tekla Structures versions, always use GUID or ACN as the element identifier.
- Number the model. Use Tekla Structures numbering for creating drawings, and assembly control numbering (ACN) to track unique elements.
- Use automatic data conversion and product types.
- Add design status information to precast objects and import the status to ELiPLAN using additional UDAs to communicate the design status. Also mark the objects that have been sent to production.
- Always check the resulting file and the export log:
  - Ensure that there is no strange mapping in the product or material codes.
  - Validate the export files in the production software, as there is no viewer available.

HMS

You can export model data of hollow core slabs in the HMS format. The result is a .sot file.

HMS stands for Hollowcore Manufacturing System and it is developed in the Netherlands. You can export data of hollow core slabs from Tekla Structures to HMS. HMS uses the data in manufacturing processes.

Export in HMS format

1. Select the model objects that you want to include in the export.
2. On the File menu, click Export --> HMS.
   The Export HMS dialog box opens.
3. Define the export properties as required. For more information, see the HMS export settings section below.

4. Click the ... button to browse for the folder where you want to save the file.
   The \HMS folder under the model folder is the default.

5. Enter a name for the file.
   The file name extension is .sot.

6. Click Save.

7. Select the Add revision to file name check box and select the revision number if required.
   The revision number is added to the HMS export file as follows:
   hms_export_file<revision>.sot

8. Select the Open log file after export check box if you want to see the log after export.
   HMS Export creates the log file in the file export folder.

9. Click Export to create the HMS export file.

**HMS Export settings**
You can include project data, slab data, and steel part information in the HMS export.

**Project data tab**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Name</td>
<td>You can include project data, such as customer name and site address, in the HMS export file.</td>
</tr>
<tr>
<td>Customer Number</td>
<td></td>
</tr>
<tr>
<td>Contractor Name</td>
<td></td>
</tr>
<tr>
<td>Site Address</td>
<td></td>
</tr>
<tr>
<td>Site City</td>
<td></td>
</tr>
<tr>
<td>Section Name</td>
<td></td>
</tr>
<tr>
<td>Project Status</td>
<td></td>
</tr>
<tr>
<td>Remark 1</td>
<td></td>
</tr>
<tr>
<td>Remark 2</td>
<td></td>
</tr>
<tr>
<td>Remark 3</td>
<td></td>
</tr>
</tbody>
</table>

The boxes have the following values available:

- **Empty**
  The item is not included in the HMS export file.

- **Text**
  Enter the text in the box next to the item.

- **Project UDA**
  The data comes from the project’s user-defined attributes.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Object, Project Address, Project Info 1 - 2</td>
<td>The data comes from the project information.</td>
</tr>
<tr>
<td>Export file</td>
<td>Define a name and location for the export file. The file name extension is .sot. By default, the export file goes to the \HMS folder under model folder.</td>
</tr>
<tr>
<td>Add revision to file name</td>
<td>Add the revision number to the HMS export file:</td>
</tr>
<tr>
<td></td>
<td>hms_export_file&lt;revision&gt;.sot.</td>
</tr>
<tr>
<td>Open log file after export</td>
<td>Open the log file after export. The HMS export creates the log file in the file export folder.</td>
</tr>
</tbody>
</table>

Slab data tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position Number</td>
<td>Assigned Control Number (ACN) is the only option.</td>
</tr>
<tr>
<td>Slab Remarks</td>
<td>The options are:</td>
</tr>
<tr>
<td>Element Type</td>
<td>• Empty</td>
</tr>
<tr>
<td>End Label</td>
<td>The item is not included in the HMS export file.</td>
</tr>
<tr>
<td></td>
<td>• Text</td>
</tr>
<tr>
<td></td>
<td>Enter the text in the box next to the item.</td>
</tr>
<tr>
<td></td>
<td>• UDA</td>
</tr>
<tr>
<td></td>
<td>The data comes from the project’s user-defined attributes</td>
</tr>
<tr>
<td>Slab Name</td>
<td>The options are:</td>
</tr>
<tr>
<td></td>
<td>• Profile</td>
</tr>
<tr>
<td></td>
<td>Select to export the whole profile name.</td>
</tr>
<tr>
<td></td>
<td>• Thickness</td>
</tr>
<tr>
<td></td>
<td>Select to export only the profile height.</td>
</tr>
</tbody>
</table>
### Slab Mark

The options are:
- **Assembly position**
  Select to export the complete cast unit position.
- **Assembly serial number**
  Select to export the cast unit serial number only.

### Bay number

Select the default UDA or UDA of your choice. The value type of the default UDA is integer, and it must be type integer for any other chosen UDA as well.

### Slab Weight Units

Select the weight unit.

### Live/dead load

Enter the default live/dead load to be exported.

For hollow core slab calculation, you can define a default live load/ dead load (KN/m2) for slabs.

If you do not define this data here, you must enter the default values for each slab in HMS software later.

### Slab scope tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exclude parts</td>
<td>Enter the class or the name of the model object, text, UDA or a template attribute to exclude the data.</td>
</tr>
<tr>
<td>Hook Points</td>
<td>Select the data that is exported.</td>
</tr>
<tr>
<td>Electric boxes</td>
<td></td>
</tr>
<tr>
<td>Weld plate</td>
<td></td>
</tr>
<tr>
<td>Solid fill</td>
<td></td>
</tr>
<tr>
<td>Filled area</td>
<td></td>
</tr>
<tr>
<td><strong>Empty</strong></td>
<td>The item is not included in the HMS export file.</td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td>Select to include the name.</td>
</tr>
<tr>
<td><strong>Text</strong></td>
<td>Enter the text in the box next to the item to include the text.</td>
</tr>
<tr>
<td><strong>Class</strong></td>
<td>Enter the class of the model object in the box to include the class.</td>
</tr>
</tbody>
</table>
### Hook point name

Select to include hook point name in export.

- **Name**
  Select to include the name.

- **Text**
  Enter the text in the box next to the item to include the text.

- **UDA**
  The data comes from the user-defined attributes.

- **Template**
  The data comes from a template attribute.

### Weld plate name

Select to include weld plate name in export.

- **Name**
  Select to include the name.

- **Text**
  Enter the text in the box next to the item to include the text.

- **UDA**
  The data comes from the user-defined attributes.

- **Template**
  The data comes from a template attribute.

### Reinforcement tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Export strand code</strong></td>
<td>Select to include strand code in export.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Export strand pull force</td>
<td>Select to export pull force data.</td>
</tr>
<tr>
<td>Custom top strands</td>
<td>Enter the quantity, diameter, distance and pull force for custom strands. The custom strand settings are meant to be used if no strands are modeled. If there are modeled strands, the custom strands will be included in addition.</td>
</tr>
<tr>
<td>Custom bottom strands</td>
<td></td>
</tr>
<tr>
<td>Additional strands</td>
<td>Additional strands can be used to designate any other specific rebar object to be exported as strand, as only strand objects are included in the export by default.</td>
</tr>
<tr>
<td></td>
<td>• Name</td>
</tr>
<tr>
<td></td>
<td>Enter the strand name.</td>
</tr>
<tr>
<td></td>
<td>• Class</td>
</tr>
<tr>
<td></td>
<td>Enter the class in the box next to the item to include the class.</td>
</tr>
<tr>
<td></td>
<td>• UDA</td>
</tr>
<tr>
<td></td>
<td>The data comes from the user-defined attributes. Enter the name and value of the UDA.</td>
</tr>
<tr>
<td></td>
<td>• Template</td>
</tr>
<tr>
<td></td>
<td>The data comes from a template attribute. Enter the template attribute and the value.</td>
</tr>
<tr>
<td>Reinforcement</td>
<td>Reinforcement can be included in the export as cross bars by specifying them in the Reinforcement setting.</td>
</tr>
<tr>
<td></td>
<td>• Name</td>
</tr>
<tr>
<td></td>
<td>Enter the reinforcement name.</td>
</tr>
<tr>
<td></td>
<td>• Class</td>
</tr>
<tr>
<td></td>
<td>Enter the class in the box next to the item to include the class.</td>
</tr>
<tr>
<td></td>
<td>• UDA</td>
</tr>
<tr>
<td></td>
<td>The data comes from the user-defined attributes. Enter the name and value of the UDA.</td>
</tr>
</tbody>
</table>
Options tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boundary line</td>
<td>Export the boundary line <strong>Along cut side of the slab</strong> or <strong>Along uncut side of the slab.</strong></td>
</tr>
<tr>
<td>Export Hook Box</td>
<td>Select to include hook data.</td>
</tr>
<tr>
<td>Export HP name</td>
<td>Select to export hook point names. If you do not select this option, only the XY coordinates are exported.</td>
</tr>
<tr>
<td>Export inner cores</td>
<td>Select to include detailed information on hollow cores in export.</td>
</tr>
<tr>
<td>Include full cut to contour</td>
<td>Select to include in export full cut in the contour block (<strong>CO</strong>). If not selected, the full cut is written as an individual cut (<strong>SP</strong>).</td>
</tr>
<tr>
<td>Generate drain/weep holes</td>
<td>Select to include drain holes and weep holes in export. You can also specify the offset.</td>
</tr>
</tbody>
</table>

3.15 CAD

The CAD import and export tools support several formats to import and export models. You can import a maximum of 10,000 parts. If the number of parts exceeds this, Tekla Structures displays a warning message, and does not import the model.

**CAD import and export formats**

The table below lists the supported import and export file types.

<table>
<thead>
<tr>
<th>Option</th>
<th>Import</th>
<th>Export</th>
<th>Imports from/Exports to</th>
</tr>
</thead>
<tbody>
<tr>
<td>SDNF</td>
<td>✔</td>
<td>✔</td>
<td>SDNF (Steel Detailing Neutral File) is used in importing to and exporting</td>
</tr>
<tr>
<td>Option</td>
<td>Import</td>
<td>Export</td>
<td>Imports from/Exports to</td>
</tr>
<tr>
<td>------------</td>
<td>--------</td>
<td>--------</td>
<td>------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>from several different CAD systems.</td>
</tr>
<tr>
<td>HLI</td>
<td>✔</td>
<td>✔</td>
<td>HLI (High Level Interface). IEZ AG Speedikon software</td>
</tr>
<tr>
<td>Plantview</td>
<td>✔</td>
<td></td>
<td>Plantview design system</td>
</tr>
<tr>
<td>SDNF (PDMS)</td>
<td>✔</td>
<td>✔</td>
<td>Plant Design Management System. Aveva 3D plant design software.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Data is exported as PDMS via SDNF link. Tekla Structures writes the information of finish field in the member class attribute, whereas in SDNF export it omits the class information.</td>
</tr>
<tr>
<td>XML</td>
<td>✔</td>
<td>✔</td>
<td>ArchiCAD modeling system.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>There are some limitations in the export:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Conversion files are not used.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Holes, bolts and welds are not exported.</td>
</tr>
</tbody>
</table>

In addition to the CAD import tool, also FEM import is available in the **New Import Model** dialog box. The steps for **FEM import (page 338)** are the same as for the CAD import.

**Import a CAD model**

1. On the **File** menu, click **Import --> CAD**.
   
   The **Import Models** dialog box is displayed.

2. Select the import type **Import CAD**.

3. Click **New** and enter a new name for the import file in the **New Import Model** dialog box.

4. In the **New Import Model** dialog box, click the **Properties...** button to define the import settings, which depend on the selected import type.

   For more information about the import-type-specific settings, see the settings and their descriptions in sections below.
5. Click **OK** to apply the changed properties.
6. In the **New Import Model** dialog box, click **OK**.
7. Select the import model name from the list and click **Import**.
8. In the **Import Models** dialog box, select which version of parts to import.
9. Click **Accept all**.

The **Accept all** option is generally used if importing a new model over an existing one. If you have changed the model and want to re-import it, you can also reject all changes by clicking **Reject all**, or accept or reject individual changes by clicking **Select individual**.

10. Tekla Structures displays the message **Do you want to save the import model for subsequent imports?** Click **Yes**.

Tekla Structures adds the import model in the model view.

11. Right-click the model view and select **Fit work area to entire model** to ensure that the imported model is completely visible.

12. If parts are missing, check the **Depth up** and **Depth down** values in the **View Properties** dialog box and change them if necessary.

**NOTE** In SDNF import, if you want to import information that Tekla Structures parts do not have, you can use the SDNF extension line in the SDNF file to be imported, and the **REVISION_NUMBER** user-defined attribute in Tekla Structures.

For more information about the SDNF interoperability, see **SDNF**.

### Settings of the CAD import

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Conversion tab</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Profile conversion file</strong></td>
<td>Define the conversion files you want to use. The maximum conversion file path length is 255 characters.</td>
</tr>
<tr>
<td><strong>Material conversion file</strong></td>
<td>Conversion files map Tekla Structures profile and material names with names used in other software.</td>
</tr>
<tr>
<td><strong>Twin profile conversion file</strong></td>
<td>For more information about conversion files, see .</td>
</tr>
<tr>
<td><strong>Parameters tab</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Input file</strong></td>
<td>The file that you want to import. You can also browse for the file. The default value is <strong>import.lis</strong>. The maximum folder path length is 255 characters.</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>Define the input file or model type: SDNF, HLI, Plantview, SDNF (PDMS), XML</td>
</tr>
<tr>
<td><strong>Origin X, Origin Y, Origin Z</strong></td>
<td>Define the origin coordinates to place the file in a specific location.</td>
</tr>
<tr>
<td><strong>SDNF tab</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Pos_No</strong></td>
<td>Enter a prefix and a start position number for parts. This settings relates to the <strong>Position number type</strong> setting.</td>
</tr>
<tr>
<td><strong>SDNF version number</strong></td>
<td>Set the SDNF format type to <strong>2.0</strong> or <strong>3.0</strong>. SDNF 3.0 is generally the format to select. However, with StruCAD it is better to share SDNF 2.0 files.</td>
</tr>
<tr>
<td><strong>Apply cuts and fittings</strong></td>
<td>Set to <strong>Yes</strong> (default) to apply cuts and fittings in the import. These will only be included if contained within the SDNF file.</td>
</tr>
<tr>
<td><strong>Consider offsets</strong></td>
<td>Set to <strong>Yes</strong> to create offsets. In most cases you should select <strong>Yes. No</strong> (default) positions part creation points at part end points.</td>
</tr>
<tr>
<td></td>
<td>In most cases you should select <strong>Yes. No</strong> (default) positions part creation points at part end points.</td>
</tr>
<tr>
<td><strong>Create log file</strong></td>
<td>Select <strong>Create</strong> to write a new log file and delete the previous log file each time you import the model.</td>
</tr>
<tr>
<td></td>
<td>If the import fails, examine the log file to find out why. Check the log file even if the import seems to have succeeded.</td>
</tr>
<tr>
<td></td>
<td>Select <strong>Append</strong> (default) to add the log file information is at the end of the existing log file.</td>
</tr>
<tr>
<td></td>
<td>If yo do not need a log file, select <strong>No</strong>.</td>
</tr>
<tr>
<td><strong>Display log file</strong></td>
<td>Select <strong>With external viewer</strong> to display the log file in a text editor.</td>
</tr>
<tr>
<td></td>
<td>Select <strong>On dialog</strong> to create a separate list dialog box in which the file can only be viewed.</td>
</tr>
<tr>
<td></td>
<td>If you do not want to display the file, select <strong>No</strong>.</td>
</tr>
<tr>
<td><strong>Log file name</strong></td>
<td>Enter the log file name or browse for an existing log file.</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Position number type</strong></td>
<td>The SDNF file contains identifiers that can be included in a part’s user-defined attributes, or used as part position numbers. <strong>Select Part position</strong> if you want the identifier to become the part's position number. Do not use the <strong>Pos_No</strong> option with this option. <strong>Select Universal ID</strong> if you want the identifier to become a user-defined attribute for the part. For file imports from PDS or PDMS then the Universal ID option is the normal case. To make user-defined attributes visible in the dialog boxes, you need to add them to the <strong>objects.inp</strong> file.</td>
</tr>
<tr>
<td><strong>Plantview</strong> tab</td>
<td><strong>Material</strong> Select the material grade.</td>
</tr>
<tr>
<td><strong>Report</strong> tab</td>
<td><strong>Create report</strong> Set to <strong>Yes</strong> to create a report.</td>
</tr>
<tr>
<td></td>
<td><strong>Display report</strong> Set to <strong>Yes</strong> to display the report.</td>
</tr>
<tr>
<td></td>
<td><strong>Report template</strong> Select the report template.</td>
</tr>
<tr>
<td></td>
<td><strong>Report file name</strong> Enter the report file name or browse for a report file.</td>
</tr>
<tr>
<td></td>
<td>If you do not give the report any other name, the report is saved with the name <strong>import_revision_report.rpt</strong> in the model folder.</td>
</tr>
<tr>
<td><strong>Advanced</strong> tab</td>
<td><strong>Action when objects status is (compared to)</strong> Previous plan lists the objects in your model, compared with the objects in the file to be imported. They can be <strong>New</strong>, <strong>Modified</strong>, <strong>Deleted</strong>, or <strong>Same</strong>. Tekla Structures compares the state of imported objects with those in your model. They can be <strong>Not in model</strong>, <strong>Different</strong>, or <strong>Same</strong>. Use the options under <strong>Not in model</strong>, <strong>Different</strong>, and <strong>Same</strong> to specify the actions when importing changed objects. The options are <strong>No action</strong>, <strong>Copy</strong>, <strong>Modify</strong>, or <strong>Delete</strong>. Usually there is no need to change the defaults.</td>
</tr>
</tbody>
</table>
### Settings of the FEM import

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Conversion tab</strong></td>
<td></td>
</tr>
<tr>
<td>Profile conversion file</td>
<td>Define the conversion files you want to use.</td>
</tr>
<tr>
<td>Material conversion file</td>
<td>Conversion files map Tekla Structures profile and material names with names used in other software.</td>
</tr>
<tr>
<td>Twin profile conversion file</td>
<td>For more information about conversion files, see .</td>
</tr>
<tr>
<td><strong>Parts tab</strong></td>
<td></td>
</tr>
<tr>
<td>Part Pos_No</td>
<td>Enter a prefix and a start position number.</td>
</tr>
<tr>
<td>Assembly Pos_No</td>
<td></td>
</tr>
<tr>
<td><strong>Parameters tab</strong></td>
<td></td>
</tr>
<tr>
<td>Input file</td>
<td>The name of the file you want to import. You can also browse for the file.</td>
</tr>
<tr>
<td>Type</td>
<td>Select the input file type: DSTV, SACS, Monorail, Staad, Stan 3d, Bus</td>
</tr>
<tr>
<td>Origin X, Origin Y, Origin Z</td>
<td>Define the origin coordinates to place the file in a specific location.</td>
</tr>
<tr>
<td>Default yield stress limit</td>
<td>The Default material when yield stress &lt; limit setting is used for SACS import file. Define the material to use if yield stress is less than the limit.</td>
</tr>
<tr>
<td>Default material when yield stress &gt;= limit</td>
<td>The setting Default material when yield stress &gt;= limit is used for SACS or DSTV import files. For SACS, this field defines the material to use if yield stress is greater than or equal to the limit. For DSTV you can enter the material grade here, if it is not included in the import file.</td>
</tr>
<tr>
<td>Default material when yield stress &lt; limit</td>
<td></td>
</tr>
<tr>
<td>Combine members</td>
<td>To combine several elements in the FEM model into one part in Tekla Structures, set Combine members to Yes.</td>
</tr>
<tr>
<td>Max length for combining</td>
<td>For example, if a beam in a file consist of more than one element, and you select Yes, the elements are combined to form one beam in the Tekla Structures model.</td>
</tr>
<tr>
<td></td>
<td>If you use the value No, Tekla Structures creates a beam for each element in the FEM model.</td>
</tr>
<tr>
<td>Max length for combining</td>
<td><strong>Max length for combining</strong> is only applied if you set Combine members to Yes. Use this setting to define the maximum length for combining parts. Tekla Structures combines elements into one part</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Staad tab</td>
<td></td>
</tr>
<tr>
<td>Material</td>
<td>Select the material grade.</td>
</tr>
<tr>
<td>Report tab</td>
<td></td>
</tr>
<tr>
<td>Create report</td>
<td>Set to Yes to create a report.</td>
</tr>
<tr>
<td>Display report</td>
<td>Set to Yes to display the report.</td>
</tr>
<tr>
<td>Report template</td>
<td>Select the report template. Your can also browse for the template.</td>
</tr>
<tr>
<td>Report file name</td>
<td>Enter the report file name or browse for a report file. If you do not give the report any other name, the report is saved with the name import_revision_report.rpt in the model folder.</td>
</tr>
<tr>
<td>DSTV tab</td>
<td></td>
</tr>
<tr>
<td>Version</td>
<td>Select the DSTV version.</td>
</tr>
<tr>
<td>Import static elements</td>
<td>If the DSTV file to be imported contains a static and a CAD model, you can choose which one to import. Answering Yes to Import static elements imports the static model. Answering Yes to Import other elements imports the CAD model.</td>
</tr>
<tr>
<td>Import other elements</td>
<td></td>
</tr>
<tr>
<td>Stan 3d tab</td>
<td></td>
</tr>
<tr>
<td>Scale</td>
<td>Specify the scale of the import model. You can import Stan 3d without specifying the scale as long as both the Tekla Structures model and the import model are in millimeters. If the Stan 3d file is in millimeters, use the scale 1. If the Stan 3d file is in meters, use the scale 1000.</td>
</tr>
<tr>
<td>Material</td>
<td>Enter the material for the parts to import.</td>
</tr>
<tr>
<td>Bus tab</td>
<td></td>
</tr>
<tr>
<td>Pos_No</td>
<td>Indicate the Pos_No of the girders, columns, braces and cantilevers you import.</td>
</tr>
<tr>
<td>Material</td>
<td>Enter the material for the parts to import.</td>
</tr>
<tr>
<td>Name</td>
<td>Enter the name of the parts to import.</td>
</tr>
<tr>
<td>Class</td>
<td>Enter the class of the parts to import.</td>
</tr>
<tr>
<td>Beams behind plane</td>
<td>The value Yes aligns the tops of all beams at the floor level.</td>
</tr>
<tr>
<td>Advanced tab</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Action when objects status is (compared to) Previous plan     | - lists the objects in your model, compared with the objects in the file to be imported. They can be **New, Modified, Deleted, or Same**.  
  
  Tekla Structures compares the state of imported objects with those in your model. They can be **Not in model, Different, or Same**.  
  
  Use the options under **Not in model, Different, and Same** to specify the actions when importing changed objects. The options are **No action, Copy, Modify, or Delete**.  
  
  Usually there is no need to change the defaults. |

**Re-import a CAD model**
Sometimes you have already imported a model, but because of some changes, you need to re-import it.

The profile and material conversion files need to be the same as defined in the original model import.

The following instructions also apply to CIMsteel (cis/2) models.

1. Open Tekla Structures and a model where you have already imported an existing CAD model.
2. On the **File** menu, click **Import --> CAD**.
3. Select the import type in the **Type** list.
   - For CAD models, this will generally be for SDNF format files only.
4. Enter a new name for the imported model in the **Name** box.
   - The total path and filename cannot be longer than 80 characters. If the total path is too long, a message is displayed saying "File name and path is too long. Please, place the file into another directory." Also, if you use the same name as in the original import, Tekla Structures gives the warning message "Illegal name for import model."
5. Click the **Properties...** button and ensure that the profile material conversion files on the **Conversion** tab are the same as adopted in the original model import.
6. Go to the **Advanced** tab and define the actions Tekla Structures takes when importing changed objects:
   - The left-hand column, **Previous plan**, lists the state of the objects in your model, compared with the state of objects in the file to be imported. They can be **New, Modified, Deleted, or Same**.
• The objects can be Not in model, Different, or Same.
• Use the list boxes in the rows under Not in model, Different, or Same to specify the actions to take when importing changed objects. The options are No action, Copy, Modify, or Delete.
  You can select Delete only for Deleted objects. You can only use Delete to delete objects that have been deleted from your model, not from the imported model.
• Normally, default settings would be used by most users.

7. Click OK or Apply.
8. Click Import in the Import Models dialog box to import the updated model.
9. Create reports on the Report tab to compare the various imports.

Export a CAD model
You can export a CAD model in several formats.

NOTE Before you start an SDNF export, check that the advanced option has not been set in the Export category of the Advanced options dialog box.

1. Open a Tekla Structures model.
2. On the File menu, click Export --> CAD.
   The Export CAD dialog box opens.
3. Enter the paths to the required conversion files on the Conversion tab, enter the parameters on the Parameters tab, and depending on the export format, define the settings on the SDNF or XML tab.
   For more information about the export settings, see the CAD export settings section below.
4. Select the parts in the model to export.
5. Click Apply and Create.
   Tekla Structures creates the export file in your current model folder.

CAD model export settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conversion</td>
<td></td>
</tr>
</tbody>
</table>

Import to and export from Tekla Structures 538 CAD
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile conversion file</td>
<td>Define the conversion files you want to use.</td>
</tr>
<tr>
<td>Material conversion file</td>
<td>Conversion files map Tekla Structures profile and material names with names used in other software.</td>
</tr>
<tr>
<td>Twin profile conversion file</td>
<td>For more information about conversion files, see.</td>
</tr>
<tr>
<td><strong>Parameters</strong> tab</td>
<td></td>
</tr>
<tr>
<td>Output file</td>
<td>The file name of the exported file. You can also browse for the file.</td>
</tr>
<tr>
<td>Type</td>
<td>Select the export format: HLI, SCIA, SDNF, PDMS, SDNF (PDMS), XML</td>
</tr>
<tr>
<td>Origin X, Origin Y, Origin Z</td>
<td>Define the origin coordinates to place the exported model in a specific location.</td>
</tr>
<tr>
<td>PML tab: this format is no longer supported</td>
<td></td>
</tr>
<tr>
<td>SDNF tab</td>
<td></td>
</tr>
<tr>
<td>SDNF version number</td>
<td>Select the SDNF version to be used in the export. With StruCAD, use SDNF version 2.0.</td>
</tr>
<tr>
<td>Apply cuts and fittings</td>
<td>Select Yes (default) applies cuts and fittings in the export.</td>
</tr>
<tr>
<td>Position number type</td>
<td>The SDNF file contains identifiers, which can be included in a part's user-defined attributes, or as position numbers. You have the following options:</td>
</tr>
<tr>
<td>• Part position</td>
<td>The identifier becomes the part's position number. Do not use the Part Pos_No fields with this option.</td>
</tr>
<tr>
<td>• Assembly position</td>
<td>The identifier becomes the assembly's position number.</td>
</tr>
<tr>
<td>• Universal ID</td>
<td>The identifier becomes a user-defined attribute for the part.</td>
</tr>
<tr>
<td>To make user-defined attributes visible, you need to add them to the objects.inp file.</td>
<td></td>
</tr>
<tr>
<td>Consider offsets</td>
<td>To ignore the offset records during export, select No, and to take them into account, select Yes.</td>
</tr>
<tr>
<td></td>
<td>This setting does not affect the actual start and end point information, only the offset. Tekla Structures writes the start and end points based</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>PDMS phase offset</td>
<td>PDMS phase offset defines phase offset for exported parts. For example, if the first phase in Tekla Structures model is 1 and you enter 10 for phase offset, Tekla Structures parts in another software get the phase from 11 and up.</td>
</tr>
<tr>
<td>Engineering Firm</td>
<td>Enter the name of the engineering company.</td>
</tr>
<tr>
<td>Client</td>
<td>Enter the name of the client.</td>
</tr>
<tr>
<td>Structure ID</td>
<td>Enter a unique identification number for the exported model.</td>
</tr>
<tr>
<td>Project ID</td>
<td>Enter a unique identification number for the exported project.</td>
</tr>
<tr>
<td>Revision Number</td>
<td>Enter an optional revision number. Tekla Structures takes the revision number from the user-defined attributes (REVISION_NUMBER) of the model. If this field is blank, Tekla Structures uses a revision number from the Export CAD dialog box (Revision Number).</td>
</tr>
<tr>
<td>Issue Code</td>
<td>Tekla Structures writes an issue code in the header section of the output file. For PDMS, this value should always be &quot;Tekla Structures&quot;.</td>
</tr>
<tr>
<td>Design Code</td>
<td>Define the design code to be used in structural design.</td>
</tr>
<tr>
<td>XML tab</td>
<td></td>
</tr>
<tr>
<td>Units</td>
<td>Specify unit conversions (MM, M, IN, FT). For example, for a Tekla Structures model created using millimeters, select IN to convert all part dimensions to inches in the output file.</td>
</tr>
<tr>
<td>XML structure ID</td>
<td>Unique identification number for the exported model. You must always enter the identification ID. Tekla Structures uses this value to identify the model if you re-export it.</td>
</tr>
<tr>
<td>XML structure name</td>
<td>Unique name of the exported model.</td>
</tr>
</tbody>
</table>

### 3.16 Import user-defined attribute values

You can import user-defined attribute (UDA) values to a model from a text file. For example, you can import a list of manufactured or checked assemblies.
You can also clear existing user-defined attribute values through attribute import.

You can import attribute values to Tekla Structures model objects, drawings, and reference model objects (if configured, see Add UDAs in reference models). You define matching criteria for the attribute import in your input file, and you can additionally limit the import scope to objects you select in the model or to reference model objects.

The input file can be:

- Exported from other software.
- Created manually using any standard text editor, for example, Microsoft Notepad.
- Created from Microsoft Excel by saving the file with the **Save as** command to **Text (Tab-delimited) (*.txt)** format.
- A simple Tekla Structures report containing the partGUIDs and user-defined attributes.

**NOTE** There are alternative ways to import data into user-defined attributes. For example, user-defined attributes can be filled in when you import IFC objects and convert them to native Tekla Structures objects. There are also several extensions in Tekla Warehouse that allow you to modify user-defined attribute data.

### Input file structure for importing values into user-defined attributes

You can import user-defined attribute (UDA) values into Tekla Structures models from input files, which are delimited text files.

#### Delimiters in input files

A delimiter is a character that separates different fields that are on the same line.

You can delimit fields with any ASCII character that does not appear in the names or values of the attributes that you are importing. You can use several alternative delimiters in the same input file. Common delimiter characters include the comma, tab, semicolon, and space.

#### Field and value definitions in input files

In the input file, the first line is a header that defines the fields for the rest of the input file. All other lines in the input file contain the values for the fields that you named on the first line.

The first line must contain at least one **key field** that identifies the model objects or drawings, and at least one user-defined attribute name that identifies a user-defined attribute field into which you want to import new
values. Note that the names of many of the fields are different than the field labels that you see in the user interface. The user-defined attribute names are defined in the objects.inp files that apply to the model (see the reference about how to read the file).

The configuration file `import_macro_data_types.dat` (which is explained further ahead) defines which fields you can use in the attribute import and what is each attribute's data type. It is not possible to add or change the key fields, but you can edit the set of user-defined attributes. Values are imported as strings (text) unless a different data type is defined for the attribute in the `import_macro_data_types.dat` file.

**Available key fields for input files**

The key fields for model objects are:

<table>
<thead>
<tr>
<th>Key field</th>
<th>Example</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>GUID</td>
<td>ID4FEAFC88-0000-0004-3133-343038303031</td>
<td>Tekla Structures assigns the user-defined attributes on this line in the input file to the model object that has a GUID value of ID4FEAFC88-0000-0004-3133-343038303031.</td>
</tr>
<tr>
<td>ASSEMBLY_POS or MARK</td>
<td>A3</td>
<td>Tekla Structures assigns the user-defined attributes on this line in the input file to the assembly that has an ASSEMBLY_POS value of A3.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Repeat this line for each assembly you want to include.</td>
</tr>
<tr>
<td>PHASE</td>
<td>2</td>
<td>Tekla Structures assigns the user-defined attributes on this line in the input file to the assembly that has a PHASE value of 2.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You must also use ASSEMBLY_POS as a key field with this option.</td>
</tr>
</tbody>
</table>

The key fields for drawing objects are:

<table>
<thead>
<tr>
<th>Key field</th>
<th>Example</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>TYPE_NAME</td>
<td>A D4</td>
<td>Tekla Structures assigns the user-defined attributes on this line in the input file to the drawing that has a TYPE value of A and a MARK value of D4.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Use both key fields in the input file.</td>
</tr>
<tr>
<td>ID</td>
<td>134</td>
<td>Tekla Structures assigns the user-defined attributes in this line in the input file to the drawing object that has an ID value of 134.</td>
</tr>
</tbody>
</table>
Empty values in input files

Some lines in the input file might not have a value for all of the attribute fields. For example, there might be two or more consecutive delimiter characters between values.

These empty values can be either skipped during import without making any changes to user-defined attributes, or you can use these empty values to erase existing user-defined attribute values in your model. By default, empty values are skipped. To clear existing values instead, set the advanced option XS_ERASE_UDA_VALUE_WITH_ATTRIBUTE_IMPORT_NULL_AND_BLANK to TRUE in an ini file.

Reading order for input files

Tekla Structures reads the input file in order starting from the first line. If there are duplicate key fields on the following lines, only the first occurrence is imported.

Data files (import_macro_data_types.dat) for importing values into user-defined attributes

To import a value into a user-defined attribute, the field name and data type must be correctly defined in the import_macro_data_types.dat data file. You can add, edit, and remove user-defined attribute fields into which data is imported.

NOTE  Do not edit the key fields section of the file. It is not possible to add new key fields.

Location of data files

The default data file is located in the system folder in the environment folder, such as C:\ProgramData\Trimble\Tekla Structures\<version>\environments\common\system. There might also be a localized version of the file in the environment that you are using.

Do not make changes to the default files. Instead, create a copy of the file and store it in a different location, for example, in the firm folder or in the attributes folder in the model folder. This way, your changes are not overwritten when you reinstall or upgrade Tekla Structures. When the same file exists in multiple locations, the default folder search order is followed and only the first file that is read is used.

Content of data files

The import_macro_data_types.dat file is plain text. You can modify the file using any standard text editor, such as Microsoft Notepad.

Each line in the file is a field definition that can contain the following attributes in this order:
1. **User-defined attribute name.** Write the internal field name as defined for the field in an objects.inp file.

   For example, in the objects.inp definition
   
   ```
   attribute( "USER_FIELD_1", "j_user_field_1", string, "%s", no, none, "0.0", "0.0"),
   ```
   
   the user-defined attribute name is USER_FIELD_1.

2. **Data type.**

   The value can be: **INT** (integer), **STRING** (text), **FLOAT** (decimal number), or **DATE** (date fields with a calendar widget). If the value is missing or incorrect, the value defaults to **STRING**.

   A value type mismatch does not prevent importing data, but the results might not always be correct depending on the data and the field. For example, date fields might be set incorrectly if the data type is not **DATE**. However, you can import a number with the integer data type into a text field without problems.

   Fields with option lists are defined as number fields of the **INT** value type. For example, object locks can be set to **No**, **Yes** and **Organization** with the corresponding numbers 0, 1 and 2 in the input file.

3. **Conversion factor** (optional, **FLOAT** only). For converting imperial values to metric values in imperial environments.

   **NOTE** We recommend that you check the **FLOAT** values to avoid conversion factor errors.

4. **Comment** (optional). Any characters that follow the previous definitions are ignored and can be used for writing your comments. However, we recommend that you avoid adding comments on the same line as definitions. The file is easier to read if you write most comments on separate lines.

   Tekla Structures treats lines that start with double forward slash characters (//) as comments and ignores the whole line when reading the file.

   **Examples:**

   ```
   //Regular attributes
   
   R1_ISSUED_FOR_APPRL, STRING
   R1_DATE_APPROVED, DATE
   
   //Attribute with conversion factor and comment
   
   shear1, FLOAT, 4448.2222, For kips
   ```
Examples of input files for importing values into user-defined attributes

Example input file for parts
This input file is tab delimited.

\texttt{ASSEMBLY\_POS} and \texttt{PHASE} are the key fields. Tekla Structures adds several user-defined attributes to the assemblies with values that match those listed in the \texttt{ASSEMBLY\_POS} and \texttt{PHASE} columns.

For example, an assembly with the \texttt{ASSEMBLY\_POS} (assembly number) of B5 in phase 1 gets the following user-defined attributes:

\begin{itemize}
  \item \texttt{STATUS}: 3
  \item \texttt{USER\_PHASE}: 6
  \item \texttt{USER\_ISSUE}: 3/25/2019
\end{itemize}

\begin{verbatim}
ASSEMBLY_POS PHASE STATUS USER_PHASE USER_ISSUE
B1  1  7  3  3/25/2019
B2  1  7  3  3/25/2019
B3  1  7  3  3/25/2019
B4  1  7  3  3/25/2019
B5  1  3  6  3/25/2019
B1  1  3  5  3/26/2019
B2  2  3  4  3/26/2019
\end{verbatim}

The input file contains two entries for B1. In this case, Tekla Structures writes the message "\texttt{Duplicate entry in input file.}" in the log file and only imports the first entry in the file. So in this example, B1 will have the following user-defined attributes after the attribute import:

\begin{itemize}
  \item \texttt{STATUS}: 7
  \item \texttt{USER\_PHASE}: 3
  \item \texttt{USER\_ISSUE}: 3/25/2019
\end{itemize}

Example input file for drawings
This input file is tab delimited.

\texttt{TYPE} and \texttt{NAME} are the key fields. Tekla Structures adds a value for the user-defined attribute \texttt{User field 4} to drawings with values that match those listed in the \texttt{TYPE} and \texttt{NAME} columns.

For example, a drawing with the \texttt{TYPE} A (assembly drawing) and \texttt{NAME} B.2 gets the value 4 in the \texttt{User field 4}.

\begin{verbatim}
TYPE  NAME  DRAWING\_USERFIELD\_4
A  B.1  3
A  B.2  4
A  C.1  1
A  C.2  2
\end{verbatim}
Process an input file for importing values into user-defined attributes

NOTE This operation overwrites any existing attribute values for matching objects if the input file contains a value for the field.

By default, empty values are skipped. To clear existing values instead, set the advanced option XS_ERASE_UDA_VALUE_WITH_ATTRIBUTEIMPORT_NULL_AND_BLANK to TRUE in an .ini file.

1. If you want to import user-defined attributes to a selected area in the Tekla Structures model, select an area in the model.

2. On the File menu, click Import --> Attributes.

   The Import Attribute dialog box opens.

3. Click the ... button next to the Input file box to select the input file to be imported.

   You can also enter the file path. The path length is 255 characters.

4. Select the settings for the import.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input file delimiters</td>
<td>Select a delimiter or several alternative delimiters used in the input file. You can delimit fields with any ASCII character that does not appear in the name or value of any of the attributes that you are importing.</td>
</tr>
</tbody>
</table>
| Input scope                 | • **Default, Entire model**
   Tekla Structures assigns the user-defined attribute values of objects in the input file to matching objects in the model.  
   • **Selection only**
   Tekla Structures only assigns the user-defined attribute values of objects in the input file to matching objects in the selected area of the model. 
   Use this option to import user-defined attributes to models. Do not use it for drawings. 
   • **Reference models**
   Tekla Structures assigns the user-defined attribute values of objects in the input file to matching objects in reference models. |

Import to and export from Tekla Structures 546 Import user-defined attribute values
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Create log file     | • **Create**  
Create a new log file named `attribute_import.log` in the current model folder each time you import the user-defined attributes. Any previous attribute import log files are overwritten.  
• **Append**  
Adds log entries to the `attribute_import.log` file in the current model folder each time you import the user-defined attributes. If the log file does not exist, Tekla Structures creates it.  
• **No**  
Does not create a log file. |
| Display log file    | • **No**  
The log file is not shown.  
• **On dialog**  
The log file is shown when the import is complete. |

5. Click **Create** to import the file.

If you selected the option to show the log file, Tekla Structures shows the log file in a separate window, and you can click a log entry to select the corresponding object in the model.
Tekla Warehouse is a service for collaboration, and for storing and sharing Tekla Structures content.

Tekla Warehouse provides centralized access to a wide range of content that you can use in your Tekla Structures models.

With Tekla Warehouse you can:

- Publish your content online.
- Use your company network or a commercial file storage and synchronization service to share content.
- Save content locally for private use.

In Tekla Warehouse, content is organized into *collections*.

Tekla Structures collections contain official Tekla Structures content that you can use in your models. The content is grouped by geographical area. There is also a global folder for content that is not location specific.

Tekla Warehouse has the following content categories:

- Applications
- Custom components
- 3D products
- Profiles
- Materials
- Bolts
- Reinforcement
- Model setup files
- Drawing setup files
- Report templates

**Accessing Tekla Warehouse**

To open Tekla Warehouse while using Tekla Structures, do one of the following:
• On the **File** menu, click **Extend --> Tekla Warehouse**.
• Go to **Quick Launch**, and start typing **Tekla Warehouse**.

**Tekla Warehouse Service**

Tekla Warehouse consists of the Tekla Warehouse web site (https://warehouse.tekla.com/) and the Tekla Warehouse Service.

You need Tekla Warehouse Service to benefit from all the features Tekla Warehouse offers, for example, easy installation of content into a Tekla Structures model, or local and network collections.

**See also**

For more information on Tekla Warehouse, go to Tekla Warehouse and click **About**, or see **Getting started with Tekla Warehouse**.
5 Disclaimer

© 2024 Trimble Inc. and affiliates. All rights reserved.

Use of the Software and of this Software Manual are governed by a License Agreement which determines whether you are an authorized user of the Software and the Software Manual. The warranties and disclaimers set forth in the License Agreement apply to the Software and the Software Manual. Neither the Trimble entity granting the license nor any of its affiliates assume responsibility that the text is free of technical inaccuracies or typographical errors. The right to make changes and additions to this manual is reserved.

Trimble and certain product names are registered trademarks of Trimble Inc. in the United States, the European Union and other countries and may have similar statutory protections. Trademarks of third parties are not mentioned in this Manual to suggest an affiliation with or endorsement by their owners.

Elements of the software described in this Manual may be the subject of pending patent applications in the European Union and/or other countries.

Portions of this software:
EPM toolkit © 1995–2006 Jotne EPM Technology a.s., Oslo, Norway. All rights reserved.

Portions of this software make use of Open CASCADE Technology software. Open Cascade Express Mesh Copyright © 2019 OPEN CASCADE S.A.S. All rights reserved.

FLY SDK - CAD SDK © 2012 VisualIntegrity™. All rights reserved.

This application incorporates Open Design Alliance software pursuant to a license agreement with Open Design Alliance. Open Design Alliance Copyright © 2002–2020 by Open Design Alliance. All rights reserved.

CADhatch.com © 2017. All rights reserved.

RapidXml C++ library © All rights reserved.

FlexNet Publisher © 2016 Flexera Software LLC. All rights reserved. This product contains proprietary and confidential technology, information and creative works owned by Flexera Software LLC and its licensors, if any. Any use, copying, publication, distribution, display, modification, or transmission of such technology in whole or in part in any form or by any means without the
prior express written permission of Flexera Software LLC is strictly prohibited. Except where expressly provided by Flexera Software LLC in writing, possession of this technology shall not be construed to confer any license or rights under any Flexera Software LLC intellectual property rights, whether by estoppel, implication, or otherwise.

To see the third party open source software licenses, go to Tekla Structures, click **File menu --> Help --> About Tekla Structures --> 3rd party licenses** and then click the option.
Index

A
ABS files
file description.................................483
analysis & design
direct links........................................314
Robot...............................................335
SAP2000............................................335
systems...........................................313
ASCII files........................................344
e-exporting........................................386
file description.................................386
importing.........................................386
assigning objects to export layers
exporting as 2D DWG or DXF (old export)....250
assigning objects to export layers
exporting as 2D DWG, DXF, or DGN...239
attaching
point clouds....................................279

B
base points
3D DGN export.................................267
3D DWG or DXF export.......................235
reference models.............................165
BAT files
creating NC files in DXF format...........345
BCF Topics........................................113
BLEND files
reference models.............................163
BUS files
importing........................................338
BVBS................................................402
best practices....................................498
calculating bar length.........................483
export settings.................................483
export file description........................483
exporting..........................................483,498

C
assigning objects to export layers
exporting as 3D DWG, DXF, or DGN...239
attaching
point clouds....................................279

D
defining customized line type mappings
(old export)........................................250
e-exporting........................................250
e-exporting (old export)........................250
2D DWG, DXF, or DGN files
export settings....................................239
exporting..........................................239
exporting..........................................239
exporting..........................................239

E
exporting (old export).........................250
export layers.....................................239
export settings....................................239
exporting..........................................239

3
3D DGN files
base points.......................................267
export settings....................................235
exporting..........................................235
object group color representations...267
v7 export...........................................267
v8 export...........................................267
3D DWG or DXF files
base points.......................................235
export settings....................................235
exporting..........................................235
object group color representation.....235
old export..........................................235
3D PDF
exporting..........................................273
publishing.........................................273
3D Viewer..........................................109
3DS files
reference models..............................163

A
ABS files
file description.................................483
analysis & design
direct links........................................314
Robot...............................................335
SAP2000............................................335
systems...........................................313
ASCII files........................................344
e-exporting........................................386
file description.................................386
importing.........................................386
assigning objects to export layers
exporting as 2D DWG or DXF (old export)....250
assigning objects to export layers
exporting as 2D DWG, DXF, or DGN...239
attaching
point clouds....................................279

B
base points
3D DGN export.................................267
3D DWG or DXF export.......................235
reference models.............................165
BAT files
creating NC files in DXF format...........345
BCF Topics........................................113
BLEND files
reference models.............................163
BUS files
importing........................................338
BVBS................................................402
best practices....................................498
calculating bar length.........................483
export settings.................................483
export file description........................483
exporting..........................................483,498

552
creating NC files in DXF format........... 345
default line types
  in drawings (old export)........... 250
defining customized line type mappings (old export)................. 250
detecting changes
  exporting results to Excel........ 185
detecting reference model changes
  comparing versions................. 175
  exporting changes................. 175
  reference models................. 175
  updating changes................. 175
DGN files
  exporting............................ 265
  importing............................ 265
DGN files
  export levels........................ 239
  export settings..................... 239
  exporting drawings................ 239
  exporting 3D DGN.................... 267
  importing............................ 265
  inserting as reference model....... 265
  level rules.......................... 239
  objects supported in DGN insert... 265
  objects in export layers.......... 239
  reference models................... 163
direct links
  ISM............................................ 338
  STAAD.Pro.................................... 338
direct links................................ 143,314
  ISM............................................ 336
drawing export.......................... 239
drawing files
  deleting unnecessary............... 100
drawings
  exporting as 2D DWG or DXF (old export)
  in multi-user mode.................. 99
DXF files
  base points.......................... 235
  exporting 3D.......................... 235
  settings.............................. 235
DXF files................................. 233
  creating from NC files............. 345,383
  defining customized line type mappings (old export)........... 250
  drawing export layers (old export)........... 250
  export example (old export)......... 250
  export layers....................... 239
  export settings..................... 239
  exporting............................. 239,258
  exporting drawings................ 239
  exporting as 2D DWG or DXF (old export)........... 250
  importing............................. 234
  layer rules........................... 239
  objects in export layers.......... 239
  objects in export layers (old export)... 250
  reference models................... 163
DSTV files
  converting to DXF..................... 345
  creating from NC files............. 383
  DSTV file description............. 383
  DSTV format
  MIS export............................ 384
dstv2dxf_conversion.bat.............. 383
DWG files
  base points.......................... 235
  exporting 3D.......................... 235
  settings.............................. 235
DWG files................................ 233
  defining customized line type mappings (old export)........... 250
  drawing export layers (old export)........... 250
  export example (old export)......... 250
  export layers....................... 239
  export settings..................... 239
  exporting............................. 239
  exporting as 2D DWG or DXF (old export)........... 250
  importing............................. 234
  layer rules........................... 239
  objects in export layers.......... 239
  objects in export layers (old export)... 250
  reference models................... 163
DXF files
  base points.......................... 235
  exporting 3D.......................... 235
  settings.............................. 235
DXF files................................. 233
  creating from NC files............. 345,383
  defining customized line type mappings (old export)........... 250
  drawing export layers (old export)........... 250
  export example (old export)......... 250
  export layers....................... 239
  export settings..................... 239
  exporting............................. 239
  exporting as 2D DWG or DXF (old export)........... 250
  importing............................. 234
  layer rules........................... 239
  objects in export layers.......... 239
  objects in export layers (old export)... 250
  reference models................... 163

554
EJE format..................................................................384
ELI files.....................................................................402
ELiPLAN........................................................................402
ELiPLAN export.......................................................499
ELiPLAN entities.......................................................499
entities.....................................................................499
IFC export...............................................................218
EPC format..................................................................384
error messages in multi-user mode..............................91
examples.....................................................................196
converting IFC objects.............................................196
setting up layers for DWG export (old export)..............250,258
EXCEL files................................................................
reference model change detection.............................185
reference model change detection.............................175
export layers................................................................
2D DWG or DXF export (old export)............................250
copying to another project (old export).........................250
drawing 2D DWG or DXF export)...............................239
drawing export (old export).........................................250
drawing export)........................................................239
export levels................................................................
drawing 2D DGN export).............................................239
drawing export)........................................................239
exporting...................................................................
2D DWG, DXF, or DGN files........................................239
3D DGN files..............................................................267
3D DWG or DXF export settings.................................235
3D DWG or DXF files.................................................235
3D PDF files...............................................................273
ASCII files.................................................................386
BVBS..........................................................................498
BVBS files...................................................................483
CAD models................................................................530
CAD export file types.................................................530
CAD export settings..................................................530
checking exported IFC model.......................................233
compatible software..................................................143
compatible formats...................................................143
drawings as 2D DWG or DXF (old export)......................250
drawings as 2D DWG or DXF files (old export).............258
drawings as 2D DWG, DXF, or DGN files...........................239
DSTV files..................................................................338
ELiPLAN.....................................................................522,523
ELiPLAN files.............................................................499
export as DWG or DXF example (old export)...................250
export DWG/DXF example.........................................258
from Tekla Structures...............................................162
HLI files.....................................................................530
HMS files...................................................................524
IFC export settings.....................................................218
IFC4 files....................................................................218
IFC4 files.....................................................................218
Import Manager..........................................................292
MICROSAS files..........................................................338
MIS lists....................................................................384
old 3D DWG or DXF export........................................235
SDNF files...................................................................530
setting up layers for DWG export (old export)..............258
SketchUp.................................................................278
STAAD files................................................................338
supported types.......................................................162
U3D files....................................................................273
Unitechnik..................................................................467
Unitechnik files..........................................................404
XML files....................................................................530
Fabtrol XML files........................................................344
FBX files.....................................................................163
reference models.......................................................163
FEM files....................................................................530
importing.................................................................530
| FEM files | importing ................................................ 338 |
| file formats .................................................. 142 |
| file types  |
| data files ..................................................... 540 |
| firm folders  |
| exporting drawings (old export) .............. 250 |
| fittings  |
| in NC files ................................................... 345 |
| For Browser ..................................................... 109 |
| For Windows .................................................. 109 |
| formats  |
| compatible ...................................................... 143 |
| G GLFT files  |
| reference models ............................................. 163 |
| groups  |
| create for reference models .............. 165 |
| H HLI files  |
| exporting ....................................................... 530 |
| importing ....................................................... 530 |
| HMS ................................................................. 402 |
| exporting from Tekla Structures .......... 524 |
| project data in export ..................... 524 |
| slab data in export ............................... 524 |
| steel part data in export .................. 524 |
| I IFC files  |
| checking exported IFC model ............. 233 |
| IFC files  |
| defining property sets for export .......... 212 |
| export ......................................................... 211 |
| export settings ............................................. 218 |
| exporting ...................................................... 218 |
| mapping IFC entities .................................. 218 |
| reference models ......................................... 163 |
| using Organizer spatial hierarchy in export ............................................. 218 |
| IFC2x3 data files ............................................. 540 |
| export settings ............................................. 218 |
| exporting ...................................................... 218 |
| IFC ................................................................. 192 |
| conversion class values ..................... 196 |
| converted objects ......................................... 196 |
| converting IFC objects ...................... 196 |
| importing ....................................................... 195 |
| inserting ...................................................... 195 |
| object converter ............................................. 196 |
| object conversion settings .................. 196 |
| object conversion limitations .............. 196 |
| profile conversion logic .................... 196 |
| reference model assemblies ............... 192 |
| supported schemas ......................................... 195 |
| IGES files  |
| reference models ............................................. 163 |
| importing  |
| ASCII files ..................................................... 386 |
| BUS files ....................................................... 338 |
| CAD import file types ......................... 530 |
| CAD import settings ............................. 530 |
| CAD models ..................................................... 530 |
| compatible software ....................................... 143 |
| compatible formats ......................................... 143 |
| DGN files ....................................................... 265 |
| DSTV files ..................................................... 338 |
| DWG files ....................................................... 234 |
| DXF files ....................................................... 234 |
| ELiPLAN files .................................................. 499 |
| FEM files ....................................................... 338 |
| from Tekla Structural Designer ............ 317 |
| HLI files ......................................................... 530 |
| IFC reference models ............................... 195 |
| in Tekla Structures ....................................... 162 |
| Layout Manager .............................................. 292 |
| MONORAIL files ............................................... 338 |
| PDF to model .................................................... 272 |
| Plantview files ............................................... 530 |
| re-importing CAD files ............................. 530 |
| reference models ......................................... 165 |
| SACS files ...................................................... 338 |
| SDNF files ...................................................... 530 |
| STAN 3D files .................................................. 338 |
| supported types ............................................. 162 |
| user-defined attribute values .............. 540 |
XML files................................................. 530
industry standards.......................... 142
INP files............................................ 173
inquiring reference model contents........ 188
inserting DGN files.......................... 265
IFC reference models....................... 195
objects supported in DGN insert......... 265
PDF to model....................................... 272
point clouds.................................... 279
reference models............................. 163
reference models................................ 165
installing reference model plug-ins...... 163
integrating Tekla Tedds.................... 324
interoperability compatible software.... 143
compatible formats.......................... 143
ISM direct link.................................. 336,338
K
KISS format MIS export....................... 384
L
LandXML files inserting........................ 270
LandXML files reference models.......... 163
layers assigning objects in 2D DWG/DXF export ........................................ 239
assigning objects in 2D DWG or DXF export (old export).......................... 250
copying to another project (old export)... 250
exporting as 2D DWG or DXF.............. 239
exporting as 2D DWG or DXF (old export)........................................... 250
Layout Manager base point.................. 310
base points.................................... 293,301
benchmark point............................. 310
coordinates.................................... 310
datum point..................................... 310
drawing scale................................. 301
datum point..................................... 310
export............................................ 301
exporting....................................... 292
groups.......................................... 293
import............................................ 304
importing........................................ 292
layout arcs..................................... 300
layout lines.................................... 299
layout points.................................. 298
levels assigning objects in 2D DGN export... 239
exporting as 2D DGN......................... 239
line cuts in NC files.......................... 345
line types customizing (old export)........ 250
defining customized line type mappings (old export)............................. 250
exporting as 2D DWG or DXF (old export)............................................ 250
mapping (old export)........................ 250
linking documents Tekla Tedds Integrator.................................. 324
linking models to Trimble Connect projects........... 108
location reference models.................. 165
locking reference models.................. 174
M
mapping line types defining customized line type mappings (old export)........ 250
exporting as 2D DWG or DXF (old export)............................................ 250
master models saving.......................... 93
MICROSAS files exporting................... 338
MIS lists......................................... 344
exporting....................................... 384
file types information.......................... 384
formats.............................................. 384
model history
  collecting...................................... 89
  model revision comments.................. 89
  viewing.......................................... 89
Model Sharing
  reading in...................................... 23
  updating........................................ 23
MONORAIL files
  importing....................................... 338
multi-user models
  master models.................................. 86
  working models................................ 86
multi-user databases
  checking........................................ 92
  removing inconsistencies.................. 92
multi-user mode
  access rights................................. 102
  active multi-users............................ 91
  advantages.................................... 78
  autosaving..................................... 88
  deleting unnecessary drawing files... 100
  drawing files.................................. 98
  drawings........................................ 99
  error messages................................ 91
  locking models................................ 87
  locks for drawings........................... 100
  numbering...................................... 97,98
  overview....................................... 78
  permissions.................................... 102
  privileges..................................... 102
  saving in....................................... 93
multi-user models
  converting..................................... 84
  copying......................................... 90
  repairing....................................... 92
  saving........................................... 87
  shutting down.................................. 90
  switching between multi-user and single-
  user models................................... 84
multi-user server
  as a service.................................... 80
  installing...................................... 80
  restarting...................................... 80
  uninstalling................................... 80

N
NC files
  contour marking................................ 345
  creating....................................... 345
  creating in DXF format...................... 345
  DSTV file description....................... 345
  fittings......................................... 345
  line cuts....................................... 345
  NC file headers............................... 345
  pop-marks...................................... 345
  tube NC files.................................. 345
NC/DSTV files..................................... 344
NCP files
  pop-mark settings............................ 345
NCS files
  contour marking settings................... 345
  numbering
    in multi-user mode........................ 97,98

O
OBJ files
  reference models............................. 163
object group color representation
  3D DWG or DXF export......................... 235
object group color representations
  3D DGN export................................ 267
objects.inp...................................... 173
offset
  reference models............................. 165
opening
  reference models list....................... 168
overlay models
  adding.......................................... 130
  adjusting scale and position.............. 130
  inquiring..................................... 130
  removing...................................... 130
  showing and hiding......................... 130
  versions...................................... 134
overlay models
  benefits....................................... 133

P
Palletizer.......................................... 402
PDF files
<table>
<thead>
<tr>
<th>Feature</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>exporting to 3D PDF</td>
<td>273</td>
</tr>
<tr>
<td>inserting to model</td>
<td>272</td>
</tr>
<tr>
<td>reference models</td>
<td>163</td>
</tr>
<tr>
<td>PDMS/E3D</td>
<td>386</td>
</tr>
<tr>
<td>PFXF files</td>
<td></td>
</tr>
<tr>
<td>exporting</td>
<td>387</td>
</tr>
<tr>
<td>Plantview files</td>
<td>530</td>
</tr>
<tr>
<td>PLY files</td>
<td></td>
</tr>
<tr>
<td>reference models</td>
<td>163</td>
</tr>
<tr>
<td>point clouds</td>
<td></td>
</tr>
<tr>
<td>attaching</td>
<td>279</td>
</tr>
<tr>
<td>detaching</td>
<td>279</td>
</tr>
<tr>
<td>limitations</td>
<td>279</td>
</tr>
<tr>
<td>point count</td>
<td>279</td>
</tr>
<tr>
<td>storage</td>
<td>279</td>
</tr>
<tr>
<td>supported file formats</td>
<td>279</td>
</tr>
<tr>
<td>pop-marks</td>
<td></td>
</tr>
<tr>
<td>creating in NC files</td>
<td>345</td>
</tr>
<tr>
<td>NCP settings files</td>
<td>345</td>
</tr>
<tr>
<td>precast fabrication</td>
<td>402</td>
</tr>
<tr>
<td>precast planning tools</td>
<td>402</td>
</tr>
<tr>
<td>Precast Production Export</td>
<td>402</td>
</tr>
<tr>
<td>privileges.inp</td>
<td></td>
</tr>
<tr>
<td>changing access rights</td>
<td>102</td>
</tr>
<tr>
<td>controlling access to lock and unlock objects</td>
<td>102</td>
</tr>
<tr>
<td>controlling access to numbering setup</td>
<td>102</td>
</tr>
<tr>
<td>controlling access to save standard files</td>
<td>102</td>
</tr>
<tr>
<td>options</td>
<td>102</td>
</tr>
<tr>
<td>user-defined attribute Locked</td>
<td>102</td>
</tr>
<tr>
<td>project folders</td>
<td></td>
</tr>
<tr>
<td>exporting drawings (old export)</td>
<td>250</td>
</tr>
<tr>
<td>property comparison tolerances</td>
<td>181</td>
</tr>
<tr>
<td>property sets</td>
<td></td>
</tr>
<tr>
<td>defining in IFC export</td>
<td>212</td>
</tr>
<tr>
<td>modifying</td>
<td>212</td>
</tr>
<tr>
<td>PRP files</td>
<td></td>
</tr>
<tr>
<td>reference models</td>
<td>163</td>
</tr>
<tr>
<td>publishing</td>
<td></td>
</tr>
<tr>
<td>3D PDF files</td>
<td>273</td>
</tr>
<tr>
<td>PXML files</td>
<td>402</td>
</tr>
<tr>
<td>reference models</td>
<td></td>
</tr>
<tr>
<td>base points</td>
<td>165</td>
</tr>
<tr>
<td>clipping</td>
<td>168</td>
</tr>
<tr>
<td>coordinates</td>
<td>165</td>
</tr>
<tr>
<td>detecting changes</td>
<td>168</td>
</tr>
<tr>
<td>groups</td>
<td>165</td>
</tr>
<tr>
<td>hiding and showing</td>
<td>168</td>
</tr>
<tr>
<td>highlighting in model view</td>
<td>168</td>
</tr>
<tr>
<td>importing</td>
<td>165</td>
</tr>
<tr>
<td>inserting</td>
<td>165</td>
</tr>
<tr>
<td>loading</td>
<td>163</td>
</tr>
<tr>
<td>location</td>
<td>165</td>
</tr>
<tr>
<td>offset</td>
<td>165</td>
</tr>
<tr>
<td>opening reference models list</td>
<td>168</td>
</tr>
<tr>
<td>refreshing</td>
<td>168</td>
</tr>
<tr>
<td>rotating</td>
<td>168</td>
</tr>
<tr>
<td>rotation</td>
<td>165</td>
</tr>
<tr>
<td>scale</td>
<td>165</td>
</tr>
<tr>
<td>showing details</td>
<td>168</td>
</tr>
<tr>
<td>showing layers</td>
<td>168</td>
</tr>
<tr>
<td>showing object details</td>
<td>168</td>
</tr>
<tr>
<td>supported formats</td>
<td>163</td>
</tr>
<tr>
<td>updating</td>
<td>168</td>
</tr>
<tr>
<td>user-defined attributes</td>
<td>168</td>
</tr>
<tr>
<td>reference models</td>
<td></td>
</tr>
<tr>
<td>attaching</td>
<td>126</td>
</tr>
<tr>
<td>downloading</td>
<td>126</td>
</tr>
<tr>
<td>exporting</td>
<td>126</td>
</tr>
<tr>
<td>removing</td>
<td>126</td>
</tr>
<tr>
<td>updates</td>
<td>126</td>
</tr>
<tr>
<td>uploading</td>
<td>126</td>
</tr>
<tr>
<td>versions</td>
<td>126</td>
</tr>
<tr>
<td>zooming to</td>
<td>126</td>
</tr>
<tr>
<td>reference model plug-ins</td>
<td></td>
</tr>
<tr>
<td>installing</td>
<td>163</td>
</tr>
<tr>
<td>reference models</td>
<td></td>
</tr>
<tr>
<td>locking</td>
<td>174</td>
</tr>
<tr>
<td>reference models</td>
<td></td>
</tr>
<tr>
<td>adding user-defined attributes to objects</td>
<td>190</td>
</tr>
<tr>
<td>assemblies</td>
<td>192</td>
</tr>
<tr>
<td>benefits</td>
<td>133</td>
</tr>
<tr>
<td>change management</td>
<td>175</td>
</tr>
<tr>
<td>checking hierarchy</td>
<td>190</td>
</tr>
<tr>
<td>checking contents</td>
<td>188</td>
</tr>
<tr>
<td>defining comparison sets</td>
<td>181</td>
</tr>
<tr>
<td>detecting changes</td>
<td>175</td>
</tr>
<tr>
<td>exporting change detection results to Excel</td>
<td>185</td>
</tr>
<tr>
<td>Error Messages</td>
<td>Exporting Users</td>
</tr>
<tr>
<td>---------------</td>
<td>----------------</td>
</tr>
<tr>
<td>63</td>
<td>34</td>
</tr>
</tbody>
</table>

**Tekla Model Sharing**

<table>
<thead>
<tr>
<th>Backing Up</th>
<th>Baselines</th>
<th>Best Practices</th>
<th>Browsing Shared Models</th>
<th>Catalogs</th>
<th>Conflicts</th>
<th>Excluding Model</th>
<th>Introduction</th>
<th>Joining Model</th>
<th>Licenses</th>
<th>Multi-User Model</th>
<th>Numbering</th>
<th>Object IDs</th>
<th>Object Types</th>
<th>Organizer</th>
</tr>
</thead>
<tbody>
<tr>
<td>60</td>
<td>32,60</td>
<td>60</td>
<td>19</td>
<td>49</td>
<td>49</td>
<td>33</td>
<td>10</td>
<td>19</td>
<td>10</td>
<td>48</td>
<td>60</td>
<td>60</td>
<td>49</td>
<td>49</td>
</tr>
</tbody>
</table>

**Tekla Structural Designer**

<table>
<thead>
<tr>
<th>Exporting to</th>
<th>Importing from</th>
<th>Re-importing from</th>
<th>Calculations</th>
<th>Integrating with Tekla Structures</th>
</tr>
</thead>
<tbody>
<tr>
<td>322</td>
<td>317</td>
<td>320</td>
<td>324</td>
<td>324</td>
</tr>
</tbody>
</table>

**Tekla Warehouse**

<table>
<thead>
<tr>
<th>Backing Up</th>
<th>Baselines</th>
<th>Best Practices</th>
<th>Browsing Shared Models</th>
<th>Catalogs</th>
<th>Conflicts</th>
<th>Excluding Model</th>
<th>Introduction</th>
<th>Joining Model</th>
<th>Licenses</th>
<th>Multi-User Model</th>
<th>Numbering</th>
<th>Object IDs</th>
<th>Object Types</th>
<th>Organizer</th>
</tr>
</thead>
<tbody>
<tr>
<td>60</td>
<td>32,60</td>
<td>60</td>
<td>19</td>
<td>49</td>
<td>49</td>
<td>33</td>
<td>10</td>
<td>19</td>
<td>10</td>
<td>48</td>
<td>60</td>
<td>60</td>
<td>49</td>
<td>49</td>
</tr>
</tbody>
</table>

**Tekla Structural Designer**

<table>
<thead>
<tr>
<th>Exporting to</th>
<th>Importing from</th>
<th>Re-importing from</th>
<th>Calculations</th>
<th>Integrating with Tekla Structures</th>
</tr>
</thead>
<tbody>
<tr>
<td>322</td>
<td>317</td>
<td>320</td>
<td>324</td>
<td>324</td>
</tr>
</tbody>
</table>

**Tekla Warehouse Service**

<table>
<thead>
<tr>
<th>Description</th>
<th>Tekla Structures.lin</th>
</tr>
</thead>
<tbody>
<tr>
<td>250</td>
<td></td>
</tr>
</tbody>
</table>

**tekla_dstv2dxf.def**

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>383</td>
</tr>
</tbody>
</table>

**tekla_dstv2dxf.exe**

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>383</td>
</tr>
</tbody>
</table>

**tekla_dstv2dxf_<env>.def**

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>383</td>
</tr>
</tbody>
</table>

**Templates**

<table>
<thead>
<tr>
<th>Drawing Export</th>
<th>TRB Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>239</td>
<td>163</td>
</tr>
</tbody>
</table>

**Trimble Connector**

<table>
<thead>
<tr>
<th>Launching</th>
<th>Overview</th>
<th>Reference Models</th>
</tr>
</thead>
<tbody>
<tr>
<td>124</td>
<td>124</td>
<td>126</td>
</tr>
</tbody>
</table>

**Trimble Connect**

<table>
<thead>
<tr>
<th>3D Viewer</th>
<th>BCF Topics</th>
<th>For Browser</th>
<th>For Windows</th>
<th>Launching</th>
<th>Linking Models to Trimble Connect Projects</th>
<th>Matching Views</th>
<th>Overview</th>
<th>Select Same Objects in Tekla Structures and Trimble Connect</th>
<th>Unlinking Models from Trimble Connect Projects</th>
</tr>
</thead>
<tbody>
<tr>
<td>109</td>
<td>113</td>
<td>109</td>
<td>109</td>
<td>107</td>
<td>108,113</td>
<td>139</td>
<td>107</td>
<td>139</td>
<td>108</td>
</tr>
</tbody>
</table>

**Trimble Connect**

<table>
<thead>
<tr>
<th>Overlay Models</th>
<th>Reference Models</th>
<th>Reference Model Versions</th>
<th>Reference Model Updates</th>
</tr>
</thead>
<tbody>
<tr>
<td>133</td>
<td>126</td>
<td>126</td>
<td>126</td>
</tr>
</tbody>
</table>

**Trimble Connector**

<table>
<thead>
<tr>
<th>Overlay Models</th>
<th>Reference Models</th>
<th>Reference Model Updates</th>
</tr>
</thead>
<tbody>
<tr>
<td>130</td>
<td>133</td>
<td>133</td>
</tr>
</tbody>
</table>

**TSEP Files**

<table>
<thead>
<tr>
<th>Reference Models</th>
<th>TSMD Files</th>
<th>Tube NC Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>163</td>
<td>315</td>
<td>345</td>
</tr>
</tbody>
</table>

**TSMD Files**

<table>
<thead>
<tr>
<th>Reference Models</th>
<th>Tube NC Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>163</td>
<td>345</td>
</tr>
</tbody>
</table>

**Tube NC Files**

<table>
<thead>
<tr>
<th>Reference Models</th>
<th>Tube NC Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>163</td>
<td>345</td>
</tr>
</tbody>
</table>
U
U3D files
  exporting............................................. 273
UDAs
  importing values................................. 540
UNI files............................................. 404
Unitechnik........................................... 402
  assemblies......................................... 404
  best practices................................. 467
  classes........................................... 404
  embeds............................................ 404
  export limitations........................... 404
  export settings................................. 404
  exporting....................................... 404, 467
  files............................................... 404
  folder path...................................... 404
  insulation........................................ 404
  line attributes................................ 404
  log files......................................... 404
  mounting parts................................ 404
  pallet............................................. 404
  reinforcement................................ 404
  surface.......................................... 404
  symbols......................................... 404
  validation....................................... 404
  version.......................................... 404
uploading model to Trimble Connect...... 110
user-defined attributes
  importing.......................................... 540
UXML files.......................................... 402, 404

X
XML files
  exporting.......................................... 530
  importing.......................................... 530
XML files
  reference models............................... 270
XS_USE_OLD_DRAWING_EXPORT................. 239, 250

Z
ZIP files
  exporting.......................................... 387